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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO9 Test Case AvnFPS TAF 1.0 

2.2 Reference Documents 
• Legacy NWS Test Case: Baseline_AvnFPS_TAF_OB8.1. 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
Test case verifies that the 30-Hour TAF functionality works properly with or without the 
transmit privilege. 
 

3.1 Assumptions, Constraints and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested. 
• The Text Workstation has been started. 
• This test case is a regression test of capabilities delivered in TO9 with the 

introduction of the 30-Hour TAF. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents.  

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The AvnFPS Monitor dialog and configuration files are displayed and the results outlined in 
section 4.0 are met. The AvnFPS GUIs to be tested include: 
 

• AvnFPS Menu 
• AvnFPS Monitor 
• AvnFPS TAF Editor 
• AvnFPS Loader 
• AvnFPS QC 
• AvnFPS Transmission Queue 
• Directory 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
Test User should not be able to transmit a TAF product with xmit_privilege = ‘0’ 

1.  From the CAVE menu bar, Mouse Button 
(MB) 1 click ‘CAVE’ -> ‘New’ -> ‘Aviation’ -> 
‘AvnFPS Menu…’. 

The AvnFPS Menu window appears.  

2.  Verify user ‘Test2’ is not present. The user ‘Test2’ is not present.  
3.  Open a terminal and navigate to the 

operator’s local copy of the aviation 
configuration file (e.g., cave/etc/aviation). 

A terminal opens. 
The aviation configuration file is present. 

 

4.  Edit the aviationForecasterConfig.xml file, 
adding ‘Test2’ as a new forecaster and 
setting the transmit privilege to ‘0’.  
Save the changes to the configuration file. 

The new forecaster and transmit privilege in 
the aviationForecasterConfig.xml file is 
saved. 

 

5.  Close the terminal window. The terminal closes.  
6.  Close and restart the AvnFPS Menu (refer 

to step 1). 
The AvnFPS Menu window appears.  

7.  Verify user ‘Test2’ is present. The user ‘Test2’ is present.  
8.  Select the user ‘Test2’.  

With ‘local’ highlighted on the lower list, 
MB1 click the ‘TAFs’ button. 

The AvnFPS Monitor window opens.   

9.  Verify that the following buttons are 
enabled: TAF Editor, Climate, Plot, and 
Backup.  
Verify the following items are displayed in 
green color: 
XMIT-px2f, DATA-px2f, INGEST-px2f and 
Queue button. 

The listed buttons are enabled. The XMIT-
px2f, DATA-px2f, INGEST-px2f and Queue 
button are displayed green. 

 

10.  Select the TAF Editor button to edit the 
TAF. 

The AvnFPS TAF Editor window displays 
without loading a TAF forecast (blank 
screen).  

 

11.  Verify the Editor recipe tab near the top of 
the TAF Editor is selected. 
Verify that there is no ‘Send’ button in the 
top row of buttons.  
Verify that the buttons appear in the 
following order: ‘Load’, ‘Syntax’, ‘QC’, 
‘Save’, and ‘Restore’. 
Note that for TO 10, the ‘Send’ button 
appears between the ‘QC’ and ‘Save’ 
buttons. 
MB1 click the Viewer tab. 

No ‘Send’ button is present. 
The top row of buttons is in the stated order. 
The Viewer tab displays in the AvnFPS TAF 
Editor window. 
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Step # Action Result Pass/Fail 
12.  Select ‘File’ -> ‘Close’ in the AvnFPS TAF 

Editor. 
Select ‘File’ -> ‘Quit’ in the AvnFPS Monitor. 
Click on the ‘X’ in the AvnFPS Menu 
window. 

The AvnFPS TAF Editor, AvnFPS Monitor, 
and AvnFPS Menu windows close. 

 

Test User is able to transmit a TAF product with xmit_privilege = ‘1’ 
 13. Open a terminal and navigate to the aviation 

configuration file (e.g., /cave/etc/aviation). 
A terminal opens. 
The aviation configuration file is present. 

 

14.  Edit the aviationForecasterConfig.xml file by 
setting the transmit privilege for user ‘Test’ 
to ‘1’.  
Save the changes to the configuration file. 

The transmit privilege in the 
aviationForecasterConfig.xml file is saved. 

 

15.  On the terminal, select ‘File’ -> ‘Close’. The terminal closes.  
16.  Restart the AvnFPS Menu by repeating step 

1 above. 
The AvnFPS Menu window appears.  

17.  Select the user ‘Test2’.  
With ‘local’ highlighted on the lower list, 
MB1 click the ‘TAFs’ button. 

The AvnFPS Monitor window opens.   

18.  Verify that the following buttons are 
enabled: TAF Editor, Climate, Plot, and 
Backup.  
Verify that the following items are displayed 
in green color: 
XMIT-px2f, DATA-px2f, INGEST-px2f and 
Queue button. 

The listed buttons are enabled. The XMIT-
px2f, DATA-px2f, INGEST-px2f and Queue 
button are displayed green. 

 

19.  Select the TAF Editor button to edit the 
TAF. 

The AvnFPS TAF Editor window displays 
without loading forecast (blank screen).  

 

20.  Verify that the Editor tab near the top of the 
TAF Editor is selected. 
Verify that the following appear in the top 
row of buttons, in the following order: ‘Load’, 
‘Syntax’, ‘QC’, ‘Send’, ‘Save’, and ‘Restore’. 
Verify the TAF Editor’s menu bar contains 
the ‘File’, ‘Options’, ‘Edit’, and ‘Help’ pull-
down menus. 

The top row of buttons is in the stated order  

21.  Select the ‘Load’ button to load the TAF 
forecast. 

The AvnFPS Loader window displays along 
with the different products and sites.  
Verify the Forecast Type ‘Routine’ radio 
button is selected. 
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22.  From the AvnFPS Loader window, select 
any combination of products and sites. Then 
select ‘latest’ from the ‘Initialize from:’ drop-
down menu and MB1 click the ‘OK’ button. 
Note: If you want to select more than one 
products or sites, either MB1 click and drag 
the cursor (this works for consecutive 
items), MB1 click at the items while pressing 
down the Ctrl key, or MB1 click and drag the 
cursor while pressing down the Shift key. 
Edit the TAF(s). 

The AvnFPS Loader window closes. 
The selected product and site data displays 
and the associated site id displays on the 
first tab. 
The TAF(s) is/are editable. 

 

23.  In the ‘Tools’ text field, use the pull-down 
menu to select the ‘AdjustTimes’ tool.  
Then MB1 click the ‘Apply’ button to update 
the TAF start times. 

One or more group valid times changed to 
reflect current hour. 

 

24.  In the ‘Tools’ text field, use the pulldown 
menu to select the ‘UseMetarForPrevailing’ 
tool.  
Then MB1 click the ‘Apply’ button to update 
the TAFs. 

One or more TAFs changed to reflect the 
current METAR. 

 

25.  Select the ‘Syntax’ button to perform the 
Syntax Quality Control for TAF. 
If an error is found, continue to step #26. 
Otherwise continue to step #27. 

The system attempts to decode all forecasts 
and check their syntax. 
If any errors are found, the whole relevant 
phrase is highlighted in color according to the 
type of errors. 

 

26.  To view an explanatory message, MB1 the 
message display button at the very bottom 
right corner of the 'AvnFPS TAF Editor' 
dialog.   
Verify an explanatory message displays. 

An explanatory message displays in the 
message log. 

 

27.  To check the Quality Control (QC) of 
individual TAFs, MB3 click the ‘QC’ button. 
 
 
 

The AvnFPS QC pop-up window displays.  

28.  To perform a current weather check, select 
the Current Wx check box. 
If Error found, continue to step #29, else 
continue to step #30. 

The system performs a quick check for 
changing conditions while forecasts are 
prepared or when a routine issue forecast is 
prepared well in advance of the transmission 
window. If there are no invalid entries found 
during the checking process then the “Wx 
QC - OK” message displays on the status 
bar at the bottom of the screen. If current 
observation and the weather in the first line 
of the forecast do not match, an explanatory 
message displays in the message log. 
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29.  To view a message of the highlighted text, 
MB1 while pointing at the offending text.  
Note: If you have an error flagged, but are 
certain that the forecast is correct and either 
the software or directive is wrong, MB1 
‘Clear Errors’ (located under the ‘File’ menu) 
before MB1 clicking ‘Send’. 
 

The balloon message shows output of the 
current weather check. 
 

 

30.  Note: The forecast must successfully pass 
QC in order to be sent. 
Select the ‘Send’ button. 

The AvnFPS Send dialog window displays 
and verifies the Transmit time. 
 

 

31.  Select a forecaster from the list and set the 
‘Transmit at’ time.  
Then MB1 click the ‘OK’ button. 

The AvnFPS Send dialog closes. 
The forecast is transmitted to the Queue in 
the pending section. 
Record the transmit time. _____________ 

 

32.  To view the transmission log file, select 
‘Open Terminal window’ and type in the 
following: 
cd /awips/adapt/avnfps/3.4/xmit/pending 

Verify that the file is in the pending directory.  

33.  To view the forecast that was transmitted, 
MB1 click the ‘Queue’ button on the 
AvnFPS Monitor GUI. 

The AvnFPS Transmission Queue dialog 
displays with the following buttons are 
enabled: 
Close, Refresh, View, Remove, Retransmit, 
and Help. 

 

34.  Under the Directory section, select the 
‘Pending’ pop-up button. 

The forecast entry transmitted from Step 30 
displays on the list of the products waiting for 
a specific time before they are transmitted. 

 

35.  Note: The transmission server checks the 
queue every 15 seconds. When the 
transmission time recorded in step 31 is 
reached, the forecast is sent to the NWS 
gateway. It may take awhile for the product 
from the pending directory to appear in the 
sent directory. 
To verify the forecast entry that was 
transmitted from Step 31 was sent 
successfully, select the ‘Send’ pop-up 
button under the Directory section. 

Verify that the transmitted forecast entry 
displays on the list of the products that were 
successfully sent. 

 

36.  To view the transmission log file, select 
‘Open Terminal window’ and type in the 
following: 
cd /awips/adapt/avnfps/3.4/xmit/sent 

Verify that the file is in sent directory.  

37.  MB1 click the ‘Close’ button from the 
AvnFPS Transmission Queue dialog. 

The AvnFPS Transmission Queue dialog 
closes. 

 



Test Case AvnFPS TAF 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0001 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0001 / 21 Nov. 2008 8 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

38.  In the AvnFPS TAF Editor window, MB1 
click the ‘Save’ button to save the current 
TAF. 

The current TAF bulletin is saved into a 
temporary text database product, 
‘CCCWRKTAF’, where CCC is your node id 
(provided the Text Workstation has been 
started from the ‘CAVE’ -> ‘New’ menu prior 
to MB1 clicking the ‘Save’ button to save the 
current TAF). 

 

39.  MB1 click the ‘Clear’ button. The current TAF bulletin is removed.  
40.  Select the ‘Restore’ button to restore the 

previously saved current TAF bulletin. 
The saved current TAF bulletin is restored 
and displayed on the screen (provided the 
Text Workstation is started from the ‘CAVE’ -
> ‘New’ menu prior to clicking the ‘Restore’ 
button to restore the previously saved current 
TAF bulletin from the text database). 

 

41.  MB1 click the ‘Clear’ button. The restored current TAF bulletin is 
removed. 

 

42.  Select ‘Restore From’ under the ‘File’ menu. The saved current TAF bulletin is restored 
and displayed on the screen (provided the 
Text Workstation is started from the ‘CAVE’ -
> ‘New’ menu prior to clicking the ‘Restore’ 
button to restore the previously saved current 
TAF bulletin from the text database). 

 

43.  Select a filename. The pop-up window displays along with the 
filename. 

 

44.  MB1 click the ‘OK’ button. The saved current TAF is restored and 
displays on the screen. 

 

45.  Close all opened windows and exit the 
AvnFPS application. 

All windows close.  

46.  End of test.   
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 

SYSR2073.40 AvnFPS TAF Monitor Window's File pulldown's Quit selection shall provide the 
capability to close of AvnFPS TAF Monitor Window. 12 

SYSR2073.48 The TAF Editor shall provide forecaster-specific functionality including syntax 
checking, climate and current weather consistency checks. 25-29 

SYSR2073.49 The TAF Editor shall allow the user the capability to invoke the editor in either of 
two distinct modes: edit mode and view mode. 10-11 

SYSR2073.51 The TAF Editor shall allow the user the capability to apply predefined operations 
to the text in the editor. 21-22 

SYSR2073.52 The TAF Editor shall provide the predefined Load capability, which shall invoke 
the forecast selection dialog. 21 

SYSR2073.53 
The Forecast Selection Dialog shall provide the user the capability to load a text 
product based on the parameters of: product identifier, site, initialization option, 
and forecast type. 

22 

SYSR2073.54 The TAF Editor shall provide the predefined Syntax Quality Check capability, 
which shall follow the guidance specified by NWSI 10-813. 25 

SYSR2073.55 
The TAF Editor shall provide the predefined Weather Check capability, which 
shall provide an indication of whether the current observation and the weather in 
the first line of the forecast are consistent. 

28 

SYSR2073.56 If inconsistent, Weather Check shall highlight the first line of the forecast. 28 

SYSR2073.57 
The TAF Editor shall provide the predefined Climate Quality Check capability, 
which shall follow the prescribed algorithm cited in Appendix C of Aviation 
Forecast Preparation System: System and User Guide, V3.5, 15 June 2007. 

27 

SYSR2073.60 The TAF Editor shall provide the predefined Save capability to save the current 
TAF bulletin as a temporary file. 38, 42-44 

SYSR2073.61 The TAF Editor shall provide the predefined Restore capability to restore a TAF 
bulletin previously stored as a temporary file. 40 

SYSR2073.62 The TAF Editor shall provide the predefined Send capability to send a TAF 
bulletin. 30-31 

SYSR2073.64 The TAF Editor shall provide the predefined Clear capability to clear the current 
TAF bulletin from the text editor. 39 

SYSR2073.65 The TAF Editor shall allow the user the capability to apply user-defined 
operations to the text in the editor. 22-24 

SYSR2073.70 The TAF Editor's Menu Bar shall provide the user three distinct pulldown menus: 
File, Options, and Edit. 20 

SYSR2073.77 The TAF Editor's File pulldown's Close selection shall shut down the TAF Editor. 12 

SYSR2073.157 The aviation plug-in shall provide the operator the capability to configure the 
names of the forecasters. 2-7 

SYSR2937 The AWIPS System shall create the TAF product as produced by the Aviation 
Services AVNFPS Application. ALL 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO9 Test Case AvnFPS TAF 1.0 

2.2 Reference Documents 
• Legacy NWS Test Case: Baseline_AvnFPS_TAF_OB8.1. 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
Test case verifies that the 30-Hour TAF functionality works properly with or without the 
transmit privilege. 
 

3.1 Assumptions, Constraints and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested. 
• The Text Workstation has been started. 
• This test case is a regression test of capabilities delivered in TO9 with the 

introduction of the 30-Hour TAF. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents.  

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The AvnFPS Monitor dialog and configuration files are displayed and the results outlined in 
section 4.0 are met. The AvnFPS GUIs to be tested include: 
 

• AvnFPS Menu 
• AvnFPS Monitor 
• AvnFPS TAF Editor 
• AvnFPS Loader 
• AvnFPS QC 
• AvnFPS Transmission Queue 
• Directory 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
Test User should not be able to transmit a TAF product with xmit_privilege = ‘0’ 

1.  From the CAVE menu bar, Mouse Button 
(MB) 1 click ‘CAVE’ -> ‘New’ -> ‘Aviation’ -> 
‘AvnFPS Menu…’. 

The AvnFPS Menu window appears.  

2.  Verify user ‘Test2’ is not present. The user ‘Test2’ is not present.  
3.  Open a terminal and navigate to the 

operator’s local copy of the aviation 
configuration file (e.g., cave/etc/aviation). 

A terminal opens. 
The aviation configuration file is present. 

 

4.  Edit the aviationForecasterConfig.xml file, 
adding ‘Test2’ as a new forecaster and 
setting the transmit privilege to ‘0’.  
Save the changes to the configuration file. 

The new forecaster and transmit privilege in 
the aviationForecasterConfig.xml file is 
saved. 

 

5.  Close the terminal window. The terminal closes.  
6.  Close and restart the AvnFPS Menu (refer 

to step 1). 
The AvnFPS Menu window appears.  

7.  Verify user ‘Test2’ is present. The user ‘Test2’ is present.  
8.  Select the user ‘Test2’.  

With ‘local’ highlighted on the lower list, 
MB1 click the ‘TAFs’ button. 

The AvnFPS Monitor window opens.   

9.  Verify that the following buttons are 
enabled: TAF Editor, Climate, Plot, and 
Backup.  
Verify the following items are displayed in 
green color: 
XMIT-px2f, DATA-px2f, INGEST-px2f and 
Queue button. 

The listed buttons are enabled. The XMIT-
px2f, DATA-px2f, INGEST-px2f and Queue 
button are displayed green. 

 

10.  Select the TAF Editor button to edit the 
TAF. 

The AvnFPS TAF Editor window displays 
without loading a TAF forecast (blank 
screen).  

 

11.  Verify the Editor recipe tab near the top of 
the TAF Editor is selected. 
Verify that there is no ‘Send’ button in the 
top row of buttons.  
Verify that the buttons appear in the 
following order: ‘Load’, ‘Syntax’, ‘QC’, 
‘Save’, and ‘Restore’. 
Note that for TO 10, the ‘Send’ button 
appears between the ‘QC’ and ‘Save’ 
buttons. 
MB1 click the Viewer tab. 

No ‘Send’ button is present. 
The top row of buttons is in the stated order. 
The Viewer tab displays in the AvnFPS TAF 
Editor window. 
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Step # Action Result Pass/Fail 
12.  Select ‘File’ -> ‘Close’ in the AvnFPS TAF 

Editor. 
Select ‘File’ -> ‘Quit’ in the AvnFPS Monitor. 
Click on the ‘X’ in the AvnFPS Menu 
window. 

The AvnFPS TAF Editor, AvnFPS Monitor, 
and AvnFPS Menu windows close. 

 

Test User is able to transmit a TAF product with xmit_privilege = ‘1’ 
 13. Open a terminal and navigate to the aviation 

configuration file (e.g., /cave/etc/aviation). 
A terminal opens. 
The aviation configuration file is present. 

 

14.  Edit the aviationForecasterConfig.xml file by 
setting the transmit privilege for user ‘Test’ 
to ‘1’.  
Save the changes to the configuration file. 

The transmit privilege in the 
aviationForecasterConfig.xml file is saved. 

 

15.  On the terminal, select ‘File’ -> ‘Close’. The terminal closes.  
16.  Restart the AvnFPS Menu by repeating step 

1 above. 
The AvnFPS Menu window appears.  

17.  Select the user ‘Test2’.  
With ‘local’ highlighted on the lower list, 
MB1 click the ‘TAFs’ button. 

The AvnFPS Monitor window opens.   

18.  Verify that the following buttons are 
enabled: TAF Editor, Climate, Plot, and 
Backup.  
Verify that the following items are displayed 
in green color: 
XMIT-px2f, DATA-px2f, INGEST-px2f and 
Queue button. 

The listed buttons are enabled. The XMIT-
px2f, DATA-px2f, INGEST-px2f and Queue 
button are displayed green. 

 

19.  Select the TAF Editor button to edit the 
TAF. 

The AvnFPS TAF Editor window displays 
without loading forecast (blank screen).  

 

20.  Verify that the Editor tab near the top of the 
TAF Editor is selected. 
Verify that the following appear in the top 
row of buttons, in the following order: ‘Load’, 
‘Syntax’, ‘QC’, ‘Send’, ‘Save’, and ‘Restore’. 
Verify the TAF Editor’s menu bar contains 
the ‘File’, ‘Options’, ‘Edit’, and ‘Help’ pull-
down menus. 

The top row of buttons is in the stated order  

21.  Select the ‘Load’ button to load the TAF 
forecast. 

The AvnFPS Loader window displays along 
with the different products and sites.  
Verify the Forecast Type ‘Routine’ radio 
button is selected. 
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22.  From the AvnFPS Loader window, select 
any combination of products and sites. Then 
select ‘latest’ from the ‘Initialize from:’ drop-
down menu and MB1 click the ‘OK’ button. 
Note: If you want to select more than one 
products or sites, either MB1 click and drag 
the cursor (this works for consecutive 
items), MB1 click at the items while pressing 
down the Ctrl key, or MB1 click and drag the 
cursor while pressing down the Shift key. 
Edit the TAF(s). 

The AvnFPS Loader window closes. 
The selected product and site data displays 
and the associated site id displays on the 
first tab. 
The TAF(s) is/are editable. 

 

23.  In the ‘Tools’ text field, use the pull-down 
menu to select the ‘AdjustTimes’ tool.  
Then MB1 click the ‘Apply’ button to update 
the TAF start times. 

One or more group valid times changed to 
reflect current hour. 

 

24.  In the ‘Tools’ text field, use the pulldown 
menu to select the ‘UseMetarForPrevailing’ 
tool.  
Then MB1 click the ‘Apply’ button to update 
the TAFs. 

One or more TAFs changed to reflect the 
current METAR. 

 

25.  Select the ‘Syntax’ button to perform the 
Syntax Quality Control for TAF. 
If an error is found, continue to step #26. 
Otherwise continue to step #27. 

The system attempts to decode all forecasts 
and check their syntax. 
If any errors are found, the whole relevant 
phrase is highlighted in color according to the 
type of errors. 

 

26.  To view an explanatory message, MB1 the 
message display button at the very bottom 
right corner of the 'AvnFPS TAF Editor' 
dialog.   
Verify an explanatory message displays. 

An explanatory message displays in the 
message log. 

 

27.  To check the Quality Control (QC) of 
individual TAFs, MB3 click the ‘QC’ button. 
 
 
 

The AvnFPS QC pop-up window displays.  

28.  To perform a current weather check, select 
the Current Wx check box. 
If Error found, continue to step #29, else 
continue to step #30. 

The system performs a quick check for 
changing conditions while forecasts are 
prepared or when a routine issue forecast is 
prepared well in advance of the transmission 
window. If there are no invalid entries found 
during the checking process then the “Wx 
QC - OK” message displays on the status 
bar at the bottom of the screen. If current 
observation and the weather in the first line 
of the forecast do not match, an explanatory 
message displays in the message log. 
 

 



Test Case AvnFPS TAF 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0001 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0001 / 21 Nov. 2008 7 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

29.  To view a message of the highlighted text, 
MB1 while pointing at the offending text.  
Note: If you have an error flagged, but are 
certain that the forecast is correct and either 
the software or directive is wrong, MB1 
‘Clear Errors’ (located under the ‘File’ menu) 
before MB1 clicking ‘Send’. 
 

The balloon message shows output of the 
current weather check. 
 

 

30.  Note: The forecast must successfully pass 
QC in order to be sent. 
Select the ‘Send’ button. 

The AvnFPS Send dialog window displays 
and verifies the Transmit time. 
 

 

31.  Select a forecaster from the list and set the 
‘Transmit at’ time.  
Then MB1 click the ‘OK’ button. 

The AvnFPS Send dialog closes. 
The forecast is transmitted to the Queue in 
the pending section. 
Record the transmit time. _____________ 

 

32.  To view the transmission log file, select 
‘Open Terminal window’ and type in the 
following: 
cd /awips/adapt/avnfps/3.4/xmit/pending 

Verify that the file is in the pending directory.  

33.  To view the forecast that was transmitted, 
MB1 click the ‘Queue’ button on the 
AvnFPS Monitor GUI. 

The AvnFPS Transmission Queue dialog 
displays with the following buttons are 
enabled: 
Close, Refresh, View, Remove, Retransmit, 
and Help. 

 

34.  Under the Directory section, select the 
‘Pending’ pop-up button. 

The forecast entry transmitted from Step 30 
displays on the list of the products waiting for 
a specific time before they are transmitted. 

 

35.  Note: The transmission server checks the 
queue every 15 seconds. When the 
transmission time recorded in step 31 is 
reached, the forecast is sent to the NWS 
gateway. It may take awhile for the product 
from the pending directory to appear in the 
sent directory. 
To verify the forecast entry that was 
transmitted from Step 31 was sent 
successfully, select the ‘Send’ pop-up 
button under the Directory section. 

Verify that the transmitted forecast entry 
displays on the list of the products that were 
successfully sent. 

 

36.  To view the transmission log file, select 
‘Open Terminal window’ and type in the 
following: 
cd /awips/adapt/avnfps/3.4/xmit/sent 

Verify that the file is in sent directory.  

37.  MB1 click the ‘Close’ button from the 
AvnFPS Transmission Queue dialog. 

The AvnFPS Transmission Queue dialog 
closes. 
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38.  In the AvnFPS TAF Editor window, MB1 
click the ‘Save’ button to save the current 
TAF. 

The current TAF bulletin is saved into a 
temporary text database product, 
‘CCCWRKTAF’, where CCC is your node id 
(provided the Text Workstation has been 
started from the ‘CAVE’ -> ‘New’ menu prior 
to MB1 clicking the ‘Save’ button to save the 
current TAF). 

 

39.  MB1 click the ‘Clear’ button. The current TAF bulletin is removed.  
40.  Select the ‘Restore’ button to restore the 

previously saved current TAF bulletin. 
The saved current TAF bulletin is restored 
and displayed on the screen (provided the 
Text Workstation is started from the ‘CAVE’ -
> ‘New’ menu prior to clicking the ‘Restore’ 
button to restore the previously saved current 
TAF bulletin from the text database). 

 

41.  MB1 click the ‘Clear’ button. The restored current TAF bulletin is 
removed. 

 

42.  Select ‘Restore From’ under the ‘File’ menu. The saved current TAF bulletin is restored 
and displayed on the screen (provided the 
Text Workstation is started from the ‘CAVE’ -
> ‘New’ menu prior to clicking the ‘Restore’ 
button to restore the previously saved current 
TAF bulletin from the text database). 

 

43.  Select a filename. The pop-up window displays along with the 
filename. 

 

44.  MB1 click the ‘OK’ button. The saved current TAF is restored and 
displays on the screen. 

 

45.  Close all opened windows and exit the 
AvnFPS application. 

All windows close.  

46.  End of test.   



Test Case AvnFPS TAF 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0001 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0001 / 21 Nov. 2008 9 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 

SYSR2073.40 AvnFPS TAF Monitor Window's File pulldown's Quit selection shall provide the 
capability to close of AvnFPS TAF Monitor Window. 12 

SYSR2073.48 The TAF Editor shall provide forecaster-specific functionality including syntax 
checking, climate and current weather consistency checks. 25-29 

SYSR2073.49 The TAF Editor shall allow the user the capability to invoke the editor in either of 
two distinct modes: edit mode and view mode. 10-11 

SYSR2073.51 The TAF Editor shall allow the user the capability to apply predefined operations 
to the text in the editor. 21-22 

SYSR2073.52 The TAF Editor shall provide the predefined Load capability, which shall invoke 
the forecast selection dialog. 21 

SYSR2073.53 
The Forecast Selection Dialog shall provide the user the capability to load a text 
product based on the parameters of: product identifier, site, initialization option, 
and forecast type. 

22 

SYSR2073.54 The TAF Editor shall provide the predefined Syntax Quality Check capability, 
which shall follow the guidance specified by NWSI 10-813. 25 

SYSR2073.55 
The TAF Editor shall provide the predefined Weather Check capability, which 
shall provide an indication of whether the current observation and the weather in 
the first line of the forecast are consistent. 

28 

SYSR2073.56 If inconsistent, Weather Check shall highlight the first line of the forecast. 28 

SYSR2073.57 
The TAF Editor shall provide the predefined Climate Quality Check capability, 
which shall follow the prescribed algorithm cited in Appendix C of Aviation 
Forecast Preparation System: System and User Guide, V3.5, 15 June 2007. 

27 

SYSR2073.60 The TAF Editor shall provide the predefined Save capability to save the current 
TAF bulletin as a temporary file. 38, 42-44 

SYSR2073.61 The TAF Editor shall provide the predefined Restore capability to restore a TAF 
bulletin previously stored as a temporary file. 40 

SYSR2073.62 The TAF Editor shall provide the predefined Send capability to send a TAF 
bulletin. 30-31 

SYSR2073.64 The TAF Editor shall provide the predefined Clear capability to clear the current 
TAF bulletin from the text editor. 39 

SYSR2073.65 The TAF Editor shall allow the user the capability to apply user-defined 
operations to the text in the editor. 22-24 

SYSR2073.70 The TAF Editor's Menu Bar shall provide the user three distinct pulldown menus: 
File, Options, and Edit. 20 

SYSR2073.77 The TAF Editor's File pulldown's Close selection shall shut down the TAF Editor. 12 

SYSR2073.157 The aviation plug-in shall provide the operator the capability to configure the 
names of the forecasters. 2-7 

SYSR2937 The AWIPS System shall create the TAF product as produced by the Aviation 
Services AVNFPS Application. ALL 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: OHD HydroGen-DCS3397-OB8.1. 
• Software Test Plan for the Advanced Weather Interactive Processing System 

Project, Contract #DG133W-05-CQ-1067, January 2009. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the creation of the XML file and a hydrograph for a point using 
HydroGen.  
 
3.1 Assumptions, Constraints and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders.  They are included here for purposes of continuity and traceability 
with the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case.  Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.   
 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory 

paths, optional use of pgAdmin III). 
1.  Open a terminal window. A terminal window opens.  
2.  Setup environment variables by executing the 

following commands: 
 
export db_name=<database> [Enter] (e.g., 
hd_ob81xxx) 
export PGHOST=<database host> [Enter] (e.g., 
dx1) 
export PGUSER=pguser [Enter] 

The environment variables are set to those 
specifics input. 

 

3.  Identify candidate test stations and SHEF codes for 
generating a hydrograph by executing the following 
query: 
 
psql –d <database> -c  
“select distinct (lid) 
from fcstheight 
where pe=’HG’ and ts=’FF’ and lid in (select lid 
from rating group by 1 having count(*) > 0);” 

A list of stations will be given.  

4.  Perform the query below: 
 
Psql –d <database> -c 
“select * 
from HgStation;” 
 
Note: Select one station that exists in both the list 
from Step 2 and the output from the query above. 

Note the lid and pe for the selected station. 
For the rest, the lid will be referred to as <lid> 
and pe as <pe>. If you are able to find a 
station, Skip to Step 6. 
 
If you are unable to find a station that exists in 
both lists, then pick a location id from the list 
generated in Step 2, and not its lid. 

 

5.  Identify one type source for the selected station in 
the height table by performing this query: 
 
Psql –d <database> -c 
“select distinct (ts) 
from Height 
where lid=’<lid>’;” 

Query generated.  

6.  Insert a record for the selected location into the 
HgStation table: 
 
psql –d <database> -c 
“insert into HgStation 
value (‘<lid>’, ‘HG’, ‘<obs ts>’, ‘FE’);” 

A record with the specified value is inserted 
into the HgStation table. 

 

7.  For the station, insert an observation that is below 
the rating curve by executing the following query: 
 

Query is generated, from the output list of 
observation, select the observation for which 
the obstime column is the most recent. For this 
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Step # Action Result Pass/Fail 
Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory 

paths, optional use of pgAdmin III). 
psql –d <database> -c 
“select * 
from height 
where lid = ‘<lid>’ and pe=’HG’ and ts=’<obs ts>;” 

observation note its value as <old stage> and 
its obstime as <obstime>. 

8.  Perform the query below: 
 
psql –d <database> -c 
“select * 
from rating 
where lid=’<lid>’;” 

Query is generated, based on the output list of 
rating curve points, choose a stage below the 
smallest stage value. This stage will be 
referred to as <new stage>. 

 

9.  Put the stage chosen in Step 7 into the observation 
chosen in Step 6 by perform the following query: 
 
psql –d <database> -c 
“update height set value=<new stage> 
where lid=’<lid>’ and ts=’<obs ts>’ and 
obstime=’<obstime>’;” 

The observation chosen in Step 6 will change 
such that its value is that chosen in Step 7.  
Perform the query in next step (step 9) to 
verify. 

 

10.  Psql –d <database> -c 
Select hsa, rfc, rb 
From location 
Where lid=’<lid>’; 

Note the returned values for the columns as 
<hsa>, <rfc>, and <rb>, respectively. They are 
used in the next step. 

 

11.  Create necessary ‘FE’ type source data by running 
the following command: 
 
<DIRECTORY> [Enter] 

A window with the title of “Filter IDs” displays.  

12.  From the HSAs list in the window, select <hsa>.  
From the RFCs list, select <rfc>. From the RBs list, 
select <rb> and click the “Done” button. 

The window closes and output is sent to 
stdout.  The first line of the output starts with, 
“executing: <DIRECTORY>.  The execution 
finishes after a few seconds. 

 

13.  Edit the data in the test database to be for a 
duration other than instantaneous by executing the 
following queries: 
 
psql –d <database> -c 
“update height set dur = 1006 
where lid =’<lid>’, and pe = ‘<pe>’;” 
 
psql –d <database> -c 
“update fcstheight set dur = 1006 
where lid = ‘<lid>’ and pe = ‘<pe>’ and ts = ‘FE’;” 

Data in the database for the two tables are 
edited so that the dur column is equal to 
‘1006’.  

 

14.  Create the hg.cfg file to generate hydrographs for 
the selected forecast point: 
 

The file hg.cfg is created.  
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Step # Action Result Pass/Fail 
Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory 

paths, optional use of pgAdmin III). 
cd <DIRECTORY> [Enter] 
 
cp hg.cfg.baseline hg.cfg [Enter] 

15.  Edit the hg.cfg file as follows: 
 
Replace “xxx” with “<wfo>” after the equal sign in 
the lines setting the values for wfoXMLlist, 
wfoHGlist, wfoHistoryList, and wfo.  Be sure to set 
it to be all caps for the wfo line. 
 
Set the value for DBname to be equal to 
<database> 
 
Comment out the lines setting rb, ldad, and 
webserver, by inserting a ‘#’ at the beginning of the 
lines. 
 
Insert the following two lines at the end of the file: 
Fdo = “<space bar>TEST DISCLAIMER<space 
bar>“ [Enter] 
Title = “TEST TITLE” [Enter] 

The hg.cfg file updates.  

16.  Execute HydroGen to generate an XML file and a 
hydrograph for the chosen forecast point: 
 
cd /awips/hydroapps/HydroGen/bin [Enter] 
 
run_hg_genXML 

HydroGen executes.  After completion, files 
are placed in each of these two directories: 
 
<DIRECTORY> 
<DIRECTORY> 
 

 

17.  In the images directory, open up the file that has a 
name that includes the station’s lid.  Verify the 
following: 
 

• It should be a hydrograph with a NOAA 
water mark in the background.  

• In the graphic, a box in the upper left 
corner of the plot area should contain 
within it the phrase “TEST DISCLAIMER” 
in green. 

• In the graphic, the title, located at the top 
of the graphic, should say “TEST TITLE”. 

• If the graphic is produced, this 
requirement is verified, since the duration 
for the data was changed from 0 to 1006. 

Verified.  

18.  In the xml directory, open up the file that has a 
name that includes the station’s lid and look at the 

Verified.  
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Step # Action Result Pass/Fail 
Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory 

paths, optional use of pgAdmin III). 
entry for the changed observation. The easiest way 
to find the entry is to search for <new stage>. The 
flow value corresponding to the <new stage> value 
should be -999. 

19.  Undo the changes made in Step 7 and 13 by 
executing the following queries: 
 
psql –d <database> -c 
“update height set dur = 0 
where lid =’<lid>’, and pe = ‘<pe>’;” 
 
psql –d <database> -c 
“update fcstheight set dur = 0 
where lid = ‘<lid>’ and pe = ‘<pe>’ and ts = ‘FE’;” 
 
“psql –d <database> -c 
update the height set value=<old stage> 
where lid=’<lid>’ and ts=’<obs ts>’ and 
obstime=’<obstime>’;” 

The original duration code and observed value 
are recovered. 

 

20.  Exit the terminal Terminal exits.  
End of Hydroview Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• Text Products 1.0 

2.2 Reference Documents 
• Legacy NWS GFE Test Cases: Acceptance Test Case ID Number: ac010; 

tp001-tp031; ui029-ue031; and ui45. 
• Legacy NWS GFE Test Cases for Test Areas AC – VP. 
• Section 3.1.3 of the AWIPS D-2D User’s Manual Build 8.1. 
• Software Test Plan for the Advanced Weather Interactive Processing System 

Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS I test bed application. 
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the capability of the Text Products functionality contained in GFE.  
Products include the Area Forecast Discussion (AFD); Area Forecast Matrices (AFM); Coded 
Cities Forecast (CCF); Fire Weather Forecast (FWF); Fire Weather Forecast Tabular 
(FWFTabular); Fire Weather Matrices (FWM); Point Forecast Matrices (PFM); Tabular State 
Forecast (SFT); Special Weather Statement (SPS); Hazardous Weather Outlook (Hazard_HWO); 
Non-Precipitation (Hazard_NPW); FireWx Watch/Warning (Hazard_RFW); Convective Watch 
(Hazard_WCN); and Winter Wx Product (Hazard_WSW). 
 

3.1 Assumptions, Constraints, and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• The GFE Perspective is displayed. 
• Data has been ingested. 
• Several weather elements are loaded. 
• There are multiple grids available for the weather elements (at minimum T, 

Td, Wind, Wx, and Hazards weather elements). 
• Grids are populated with model data and all interpolation processes have been 

done.  In addition, the forecast has been saved.   
• The edit areas for CCF, FWM PFM and SFT text products have been created. 
• A Convective Watch (e.g., Severe Thunderstorm or Tornado Watch) has been 

ingested. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents.  

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case.  Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.   
 

3.4 Test Outputs 
The Text Products will be returned and the results outlined in section 4.0 are met. 

3.4.1 GFE GUIs Tested 
• Publish To Official 
• Process Monitor 
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• Formatter Launcher 
• Local Formatter 
• Define Text Products 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
Product Generation 

1.  Bring up the Process Monitor dialog by 
selecting ‘Products’ -> ‘Process Monitor’. 

The Process Monitor dialog opens.  

2.  Bring up the Formatter Launcher dialog by 
selecting ‘Products’ -> ‘Formatter Launcher’.  
Select each of the following products in the 
Products list:   
- Area Forecast Discussion (AFD) 
- Coded Cities Forecast (CCF) 
- Hydrologic Outlook (ESF) 
- Fire Weather Forecast (FWF) 
- Fire Weather Forecast Tabular (FWFTabular) 
- Fire Weather Matrices (FWM) 
- Spot Forecast (FWS) 
- NowCast (NOW) 
- Point Forecast Matrices (PFM) 
- Public Information Statement (PNS) 
- Fire Danger Statement (RFD) 
- Tabular State Forecast (SFT) 
- Special Weather Statement (SPS) 
- Zone Forecast Product (ZFP) 
- Flood Watch (Hazard_FFA) 
- Hazardous Weather Outlook (Hazard_HWO) 
- Non-Precipitation (Hazard_NPW) 
- FireWx Watch/Warning (Hazard_RFW) 
- Convective Watch (Hazard_WCN) 
- Winter Wx Product (Hazard_WSW) 

As each product is chosen, a new tab 
appears in the Formatter Launcher 
dialog. 

 

3.  Cycle through each tab in the Formatter 
Launcher dialog, set a zone selection for those 
products that require one, MB1 click the ‘Run 
Formatter’  icon, then select default entries 
from the individual dialogs for each product. 

Each product is run through the Formatter 
Launcher.  After each formatter has 
finished, the output text displays in the 
text window.  

 

4.  Note in the Process Monitor Dialog that all of 
the items are queued to run, and one is running. 

  

5.  Look at each product and verify that it seems 
reasonable.  Look at the log using the  
icon.  Scan the log for any errors.  If a product 
fails, the output text will not be displayed; rather 
the log window will be displayed with the error.  
After each product has been verified, click the 
red ‘X’ to dismiss that tab. 

Verified. 
The tab closes. 
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Step # Action Result Pass/Fail 
6.  Repeat steps 3 – 5 for the Site Specific 

Forecasts (SPOT), FWS product. 
The product is run through the Formatter 
Launcher.  After each formatter has 
finished, the output text displays in the 
text window.  

 

7.  Repeat steps 3 – 5 for the Area Forecast 
Matrices, AFM product. 

The product is run through the Formatter 
Launcher.  After each formatter has 
finished, the output text displays in the 
text window.  

 

8.  After all of the products have been run without 
errors, complete steps 9 – 10.  Then repeat 
steps 1 – 2, except change the issuance time 
and other options on each product generation 
Values dialog that is presented.   

As expected.  

9.  Publish all data to the Official database 
selecting ‘Products’ -> ‘Publish To Official’.  
From the Publish To Official dialog, select ‘Set 
Selected’ and then select ‘Publish’. 

The ‘Publish To Official’ dialog appears. 
 
The selected grids are published.  The 
‘Publish To Official’ dialog closes. 

 

10.  Initialize the required edit areas for this test by 
opening up a terminal window, changing your 
directory to the GFESuite "bin" directory, and 
running this command: 
run/setupTextEA 

  

11.  Test the Baseline and Region versions of the 
formatters:  
From the Local Formatter dialog, MB1 click on 
‘Products’ -> ‘Baseline’.  Run each Baseline 
product to completion and verify that it produces 
reasonable output.  From the Local Formatter 
dialog, MB1 click on ‘Products’ -> ‘Region’.  
Run each Region product to completion and 
verify that it produces reasonable output. 

As expected.  

12.  Create a new table product by selecting ‘GFE’ -
> ‘Define Text Products’.  This brings up the 
Define Text Products dialog.  Over the left 
column (Text Products), MB3 popup and select 
‘New...’.  Enter ac010 as the name of the 
product, and ensure that the type is ‘table’.  
MB1 click ‘OK’.   

A table template is displayed in the 
python window. 

 

13.  Modify the edit areas.  From the Python editor 
window, MB1 click on ‘File’ -> ‘Save’, then ‘File’ 
-> ‘Exit’.  Close the Define Text Products dialog 
after verifying that ‘ac010’ appears in the dialog 
window.  

Verified.  

14.  From the Formatter Launcher dialog's Product 
menu, select only the ‘ac010’ entry.  Then run 
the product.   

The product is generated and the output 
appears in a new Python window. 
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Step # Action Result Pass/Fail 
15.  Delete the ‘ac010’ table product by selecting 

‘GFE’ -> ‘Define Text Products’.  This brings up 
the Define Text Products dialog.  Over the left 
column ‘ac010’ entry, MB3 popup and select 
‘Delete...’.  A confirmation dialog is displayed.   
Press ‘OK’.   

The entry is deleted after the confirmation 
message is answered. 

 

16.  Close the External Programs (e.g., Process 
Monitor) dialog.  Close the Formatter Launcher 
dialog. 

The External Programs/Process Monitor 
and Formatter Launcher dialogs close. 

 

End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR2069 The AWIPS system shall implement the GFE Formatter Launcher.  
SYSR2070 The AWIPS system shall implement the GFE Formatter Data Interface.  

SYSR2997 

The AWIPS System shall create the FWS - Site Specific Forecasts (SPOT) 
product as produced by the Public and Fire Weather Services GFE 
Application. 

 

SYSR2998 
The AWIPS System shall create the NOW - Short Term Forecast product as 
produced by the Public and Fire Weather Services GFE Application.  

SYSR3004 
The AWIPS System shall create the AFM - Area Forecast Matrices product as 
produced by the Public and Fire Weather Services GFE Application.  

SYSR3049 

The AWIPS System shall create the RFD – Rangeland Fire Danger product 
as produced by the Public and Fire Weather Services Text Workstation Editor 
Application. 
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1.0 SCOPE 
See the TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1   Source Documents 
• Derived Parameters-Gridded  

 

2.2  Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The AWIPS D-2D User’s Manual Build 8.1. 
• The Silver Spring NWS AWIPS 1 test bed application.  
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0  TEST CASE DESCRIPTION 
This test case demonstrates the display of derived parameters from gridded data developed as 
part of the TO10 tasking. Display of the parameters infers database storage completed. In 
addition, changes to the baselined volume browser implemented during TO10 will be tested. 
 

3.1 Assumptions, Constraints, and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• An internet connection is available. 
• Live gridded data flow. Canned data can be substituted if the live data flow 

does not contain the data required to test specific implemented derived 
parameters. 

• Localization previously set. 
• A random sample of derived parameters will be demonstrated. 
• TO10 testing will begin with step 45 of these procedures. Regression testing 

of steps 1-44 will occur prior to DT (during PDT). Results of these procedures 
will be included in the Final TO10 test report.  

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 

3.4 Test Outputs 
The images and data will be displayed in CAVE.
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4.0   TEST SCENARIO 

Step Action Result Pass/Fail 
1.  From the test workstation open CAVE.  CAVE successfully launches. The 5-D panel (4 

smaller panels on the left and one larger main panel) 
displays.  

 

2.  Zoom so that a CONUS-sized area 
displays centered on approximately 
Kansas City.  

The main panel displays an area centered on the 
CONUS that includes some of Mexico and Canada.   

3.  Open the Volume Browser by selecting 
‘Volume’, ‘Browser…’. 

Volume Browser opens. The user is able to make 
selections from Sources, Fields, and Planes.  

Thickness (dZ) 
4.  Ensure the browser is in Plan view. 

Under Sources select ‘Grid’ and ‘GFS 
40’. For Fields select ‘Hgt…Pres’ and 
‘Thickness’. In Planes select ‘Pres’, ‘Misc 
Layers’, ‘1000-500mb’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’.  

The derived parameter 1000-500mb thickness is 
displayed in the main CAVE window.  

5.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

6.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.   

Relative Humidity (RH) 
7.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘NAM 40’. For Fields 
select ‘Moist’ and ‘RH’. In Planes select 
‘Pres’, ‘500mb’. Select ‘Load’. Note: If 
there are multiple entries under the 
Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameter relative humidity is displayed 
in the main CAVE window.  

8.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

9.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Wind Speed (wSp) 
10.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘GFS 90’. For Fields 
select ‘Wind’ and ‘Wind Isotachs’. In 
Planes select ‘Pres’, ‘250 mb’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter 250mb wind isotachs is 
displayed in the main CAVE window.  

11.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  
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Step Action Result Pass/Fail 
12.  In the Volume Browser select ‘Edit’, 

‘Clear all’. 
The prior Volume Browser selections are cleared.  

Dewpoint Dep (DpD) 
13.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘NAM40’. For Fields 
select ‘Moist’ and ‘Dewpoint Dep’. In 
Planes select ‘Pres’, ‘850mb’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter dewpoint dep is displayed in 
the main CAVE window.  

14.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

15.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Dewpoint Temperature (DpT) 
16.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘NAM12’. For Fields 
select ‘Moist’ and ‘Dewpoint’. In Planes 
select ‘Pres’, ‘700mb’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameter dewpoint is displayed in the 
main CAVE window.  

17.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

18.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Specific Humidity (SHx) 
19.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘RUC80’. For Fields 
select ‘Moist’ and ‘Specific Humidity’. In 
Planes select ‘Pres’, ‘1000mb’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter specific humidity is displayed 
in the main CAVE window.  

20.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

21.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  
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Step Action Result Pass/Fail 
Equiv Potential Temperature (EPT) 
22.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘NAM40’. For Fields 
select ‘Moist’ and ‘ThetaE’. In Planes 
select ‘Pres’, ‘925mb’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameter equiv. potential temperature 
is displayed in the main CAVE window.  

23.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

24.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Potential Temperature (PoT) 
25.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘GFS40’. For Fields 
select ‘Temp’ and ‘Potential Temp’. In 
Planes select ‘Pres’, ‘925mb’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter potential temperature is 
displayed in the main CAVE window.  

26.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

27.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Mixing Ratio (mixRat) 
28.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘RUC40’. For Fields 
select ‘Moist’ and ‘Mixing Ratio’. In 
Planes select ‘Pres’, ‘1000mb’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter mixing ratio is displayed in 
the main CAVE window.  

29.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

30.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Wet Bulb Temperature (TW) 
31.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘GFS40’. For Fields 
select ‘Temp’ and ‘Wet Bulb Temp. In 
Planes select ‘Pres’, ‘925mb’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter wet bulb temperature is 
displayed in the main CAVE window.  
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Step Action Result Pass/Fail 
32.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 

window.  

33.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Streamline Analysis  
34.  In the Volume Browser, under Sources, 

select ‘Grid’ and ‘GFS40’. For Fields 
select ‘Wind Isotachs’. In Planes select 
‘Pres’, ‘250’. Select ‘Load’.  

Isotachs for 250mb display.  

35.  RMB click and hold over the wind speed 
legend. Select “Load as Streamline”. 
Turn off (Unload) the isotach display.  

Streamlines for 250mb display. The isotach display 
is removed from the display.  

36.  RMB click and hold over the Streamline 
legend. Select “Load as Image”. 

Image of isotach speeds for 250mb displays under 
the streamlines. The streamlines should roughly 
follow the main band of jet stream winds. 

 

37.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

38.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

39.  Repeat steps 34-38 using the NAM40 
grid and 700mb for the pressure level. 

Image of isotach speeds for 700mb displays under 
the streamlines. The streamlines should roughly 
follow the main band of jet stream winds. 

 

40.  From the menu bar change the density 
of the streamlines. 

The number of streamlines either decreases or 
increases depending on the density chosen.  

41.  Repeat steps 34 and 35 (don’t display as 
an image) using the NAM12 grid and 
1000mb. 

Streamlines for 1000mb display.  

42.  Zoom over a feature such as a “L” or “H” 
pressure center. 

Streamlines increase in density and detail.  

43.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

44.  In the Volume Browser select ‘Edit’, 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

End of TO9 Test 
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Step Action Result Pass/Fail 
Begin TO10 Test 
The following steps will request data via the Baseline Volume Browser 
Potential Vorticity 
45.  In the Volume Browser, under Sources, 

select ‘Grid’ -> ‘GFS40’. For Fields select 
‘Derived’ -> ‘Pot Vorticity’. In Planes 
select ‘Pres’ -> ‘500mb’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameter Potential Vorticity is 
displayed in the main CAVE window.  

46.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

47.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Relative Vorticity 
48.  In the Volume Browser, under Sources, 

select ‘Grid’ -> ‘NAM12’. For Fields 
select ‘Derived’ -> ‘Rel Vorticity’. In 
Planes select ‘Misc’ -> ‘Surface’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter Relative Vorticity is displayed 
in the main CAVE window.  

49.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

50.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

3-Hour Precipitation Accumulation 
51.  In the Volume Browser, under Sources, 

select ‘Grid’ -> ‘RUC80’. For Fields 
select ‘Sfc/2D’ -> ‘3 Hr Precip Accum’. In 
Planes select ‘Misc’ -> ‘Surface’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter 3 Hr Precipitation 
Accumulation is displayed in the main CAVE 
window. 

 

52.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

53.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  
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Step Action Result Pass/Fail 
Storm Relative Flow Right Mover 
54.  In the Volume Browser, under Sources, 

select ‘Grid’ -> ‘NAM80’. For Fields 
select ‘Other’ -> ‘Storm Rel Flow RM’. In 
Planes select ‘Misc’ -> ‘Surface’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter Storm Relative Flow RM is 
displayed in the main CAVE window.  

55.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

56.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Moisture Flux & Moisture Flux Magnitude 
57.  In the Volume Browser, under Sources, 

select ‘Grid’ -> ‘GFS90’. For Fields select 
‘Basic’ -> ‘Moisture Flux’. Also select 
‘Basic’ -> ‘Moisture Flux Mag’. In Planes 
select ‘Pres’, ‘850mb’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameters Moisture Flux and Moisture 
Flux Magnitude are displayed in the main CAVE 
window. 

 

58.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

59.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Shear Magnitude Cross Section 
60.  Set the display type to Cross Section. The Volume Browser menus modify to display 

menus and menu items associated with Cross 
Section displays. 

 

61.  In the Volume Browser, under Sources, 
select ‘Grid’ -> ‘GFS40’. For Fields select 
‘Other’ -> ‘Shear Mag’. In Planes select 
‘Specified’ -> ‘Line A’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameter Shear Magnitude is 
displayed on a Cross Section chart in the main 
CAVE window. 

 

62.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

63.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Computed CAPE Time Height 
64.  Set the display type to Time Height. The Volume Browser menus modify to display 

menus and menu items associated with Time Height 
displays. 
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Step Action Result Pass/Fail 
65.  In the Volume Browser, under Sources, 

select ‘Grid’ -> ‘GFS40’. For Fields select 
‘Other’ -> ‘Computed CAPE’. In Planes 
select ‘Points’ -> ‘TsectA’. Select ‘Load’. 
Note: If there are multiple entries under 
the Product Selection List, select a single 
entry and then ‘Load’. 

The derived parameter Computed CAPE is 
displayed on a Time Height chart in the main CAVE 
window. 

 

66.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

67.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

ThetaE Lapse Rate Var vs Hgt 
68.  Set the display type to Var vs Hgt. The Volume Browser menus modify to display 

menus and menu items associated with Var vs Hgt 
displays. 

 

69.  In the Volume Browser, under Sources, 
select ‘Grid’ -> ‘GFS40’. For Fields select 
‘Basic’ -> ‘ThetaE Lapse Rate’. In Planes 
select ‘Points’ -> ‘VarHgt A’. Select 
‘Load’. Note: If there are multiple entries 
under the Product Selection List, select a 
single entry and then ‘Load’. 

The derived parameter ThetaE Lapse Rate for Point 
A is displayed on a Var vs Hgt chart in the main 
CAVE window. 

 

70.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

71.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

Temperature (Radar Elevation) Time Series 
72.  Set the display type to Time Series. The Volume Browser menus modify to display 

menus and menu items associated with Time Series 
displays. 

 

73.  In the Volume Browser, under Sources, 
select ‘Grid’ -> ‘Radar’. For Fields select 
‘Basic’ -> ‘Temperature’. In Planes select 
‘Tilts’ -> ‘0.5 deg’. Select ‘Load’. Note: If 
there are multiple entries under the 
Product Selection List, select a single 
entry and then ‘Load’. 

The temperature for the 0.5 degree elevation is 
displayed on a Time Series chart in the main CAVE 
window. 

 

74.  Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE 
window.  

75.  In the Volume Browser select ‘Edit’ -> 
‘Clear all’. 

The prior Volume Browser selections are cleared.  

End of TO10 Test 
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5.0   TO9 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR2095 The AWIPS system shall implement a Meteo Library Extension for 

access by uEngine Tasks. 
ALL 

SYSR2096 The AWIPS system shall implement Derived Parameters for grid and 
point data. 

ALL 

SYSR1584 The user shall be able to display streamlines for wind data. 34-44 
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6.0   TO10 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
 



 

This document includes data that shall not be duplicated, used, or disclosed – in whole or in part – outside the Government for 
any purpose other than to the extent provided in contract DG133W-05-CQ-1067. However, the Government shall have the right 
to duplicate, use, or disclose the data to the extent provided in the contract. This restriction does not limit the Government’s right 
to use information contained in this data if it is obtained from another source without restriction. The data subject to this 
restriction are contained in all sheets. 
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Change History 

Revision Date Affected Pages Explanation of Change 
Draft 21 Nov. 2008 ALL Initial Draft (Note: Builds on the TO8 and TO9 WarnGen test 

cases.) 
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1.0 SCOPE 

See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO8 Test Case WarnGen 1.0 
• TO9 Test Case WarnGen 2.0 

2.2 Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing System 

Project, Contract #DG133W-05-CQ-1067, January 2009. 
• Section 5 of the AWIPS D-2D User’s Manual Build 8.1. 
• The Silver Spring NWS AWIPS 1 test bed application. 
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 

This test case demonstrates the extensions and WarnGen templates (including life cycle controls) 
for a Convective Flash Flood Warning, Extreme Wind Warning, Extreme Wind Warning SVS 
(FOLLOWUP), Flash Flood with Svr Tstm, Flash Flood Statement, non-convective FFW (Dam 
Break), non-convective Flash Flood Statement, Areal Flood Warning, Areal Flood Warning 
FOLLOWUP, Areal Flood Advisory, and Areal Flood Advisory FOLLOWUP. 

3.1 Assumptions, Constraints and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested. 
• The Text Workstation has been started. 
• The clock is set to local time. 
• Localization is set to OAX. 
• Actions, Results, and Requirements highlighted in yellow indicate requirements 

and/or capabilities to be included in the scope of future task orders. They are included 
here for purposes of continuity and traceability with the original AWIPS I test case 
documents.  

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  
 

3.4 Test Outputs 
The data will be displayed using CAVE capabilities. 
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4.0 TEST SCENARIO 

Step Action Result Pass/Fail 
Duration Configuration 

1.  Mouse Button (MB) 1 click ‘CAVE’ -> ‘New’ -> ‘Text 
Workstation’ 

The Text Workstation and Text 1 
windows open.  (Note: The Text 1 
window may be closed.) 

 

2.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen GUI appears. 

 

3.  In the WarnGen GUI, MB1 click the ‘Other’ radio 
button.   
Select ‘Areal Flood Advisory’ from the dropdown 
menu. 

The ‘Areal Flood Advisory’ template is 
selected. 

 

4.  Verify a ‘20’ minute option is not available under the 
‘Duration’ dropdown menu. 

Verified.  

5.  Open a Konsole and navigate to the ‘fla_default.cfg’ 
file (cave/etc/warngen). 
Then edit the file (e.g., vi) by adding a ‘20’ minute 
duration period. 
Save the file (e.g., :wq). 

The ‘fla_default.cfg’ file is modified and 
the changes are saved. 

 

6.  In the WarnGen GUI, select another template from 
the dropdown menu (e.g., Areal Flood Warning) and 
toggle back to the Areal Flood Advisory option.  This 
refreshes the WarnGen GUI window. 

The WarnGen template is toggled back 
to the Areal Flood Advisory. 

 

7.  Expand the ‘Duration’ dropdown menu and verify a 
‘20’ appears as an option. 

Verified.  

8.  In the D2D display, note the default storm speed (kts) 
and direction (degrees).  

Noted.  

9.  Close the WarnGen GUI. The WarnGen GUI closes.  
Storm Track Direction and Speed Configuration 

10.  In the Konsole, navigate to the 
severethunderstorm_OAX.cfg (cave/etc/warngen). 
Then edit the file (e.g., vi) by changing the 
defaultSpeedKt and defaultDirection values. 
Save the file (e.g., :wq). 

The ‘severethunderstorm_OAX.cfg’ file 
is modified and the changes are saved. 

 

11.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen GUI appears. 
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Step Action Result Pass/Fail 
12.  In the main pane, click and hold MB1 on the ‘Drag 

me to Storm’ point and drag it to another location. 
Compare the vector orientation and speed with that 
noted in step 8. 

A vector appears with the point near 
the center of the line, tick marks, and 
time values at the starting point, 
current/endpoint, and arrowhead. 
The default settings modified in step 9 
are reflected in the initial vector’s storm 
speed and direction. 
An initial warning area hatched box 
appears. 

DR #813 

13.  Close the WarnGen GUI. The WarnGen GUI closes.  
14.  In the Konsole, navigate to the 

severethunderstorm_OAX.cfg (cave/etc/warngen). 
Then edit the file (e.g., vi) by reverting the changes 
back to the original defaultSpeedKt and 
defaultDirection values (20kts and 225 degrees 
respectively). 
Save the file (e.g., :wq). 

The ‘severethunderstorm_OAX.cfg’ file 
is modified and the changes are saved. 

 

15.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen GUI appears. 

 

16.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location. 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

17.  Close the WarnGen GUI. The WarnGen GUI closes.  
18.  Close the Konsole. The WarnGen GUI closes.  
19.  Clear anything displayed in the main pane. The main pane displays a blank map.  

Initial Setup 
20.  Change the scale from the tool bar drop down menu 

to ‘WFO’. 
The WFO scale displays in the main 
pane, focusing on the OAX CWA. 

 

21.  From the ‘Maps’ dropdown menu, select ‘County 
Names’. 

The county names appear in the 
associated county. 

 

22.  MB3 click and hold on the County Names product ID 
in the product legend and select ‘Change Color’.  
Select the color red and MB1 click ‘OK’. 

The County Names change to red.  

23.  From the ‘Maps’ dropdown menu, select ‘CWAs’. The CWAs appear in the main pane.  
24.  MB3 click and hold on the CWA product ID in the 

product legend and select ‘Change Color’.  
Select the color yellow and MB1 click ‘OK’. 

The CWA boarders change to yellow.  
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Step Action Result Pass/Fail 
25.  From the ‘Maps’ dropdown menu, select ‘Cities’. The Cities appear in the main pane.  
26.  MB1 click the Density dropdown menu on the tool bar 

and select ‘0.5’. 
The number of cities displayed in the 
main pane is reduced. 

 

27.  MB1 click ‘koax’ -> ‘koax 4 Bit Products’ -> ‘koax 4bit 
Reflectivity’ -> ‘0.5 Refl’. 

The ‘koax 0.5 Reflectivity (Z)’ product 
displays in the main pane. 

 

Tornado Warning 
Issuing initial Tornado Warning 

28.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen GUI appears. 

 

29.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

30.  Press the right arrow key on the keyboard once. The oldest radar image in the loop 
displays. The point is relabeled ‘Drag 
me to Storm’ and appears at the 
starting point of the vector. 

 

31.  MB1 click and hold the ‘Drag me to Storm’ point and 
drag it to another location.   
 

The vector rotates accordingly. The 
spacing between the tick marks adjusts 
accordingly. 
The hatched warning box remains at its 
current position. 

 

32.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

33.  Click MB1 on the ‘Track’ button under the ‘Redraw 
Box on Screen from:’ section. 

The hatched box is redrawn on the 
vector. 

 

34.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 
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Step Action Result Pass/Fail 
35.  MB1 click on the ‘Warned/Hatched Area’ button 

under the ‘Redraw Box on Screen from:’ section. 
The polygon’s vertices  are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

36.  MB1 click on ‘Tornado’ in the ‘Product type’ section. The selection is made as indicated by 
the radio button.  The BASIS FOR 
WARNINGS and CALLS TO ACTION 
sections update to display items 
applicable for Tornado Warnings. 

 

37.  Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The 
ending time of the warning updates 
with the change in duration. 
The vector contracts and the time at 
the arrowhead modifies. 

DR #813 

38.  MB1 within the Optional bullets section, select items 
such that the following Tornado Template 
Parameters are highlighted: 

 BASIS FOR WARNING: Confirmed large 
tornado 

 CALLS TO ACTION: Severe Tornado 
 CALLS TO ACTION: If caught outside 
 CALLS TO ACTION: Don’t outrun in car 

Then click MB1 on the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

39.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: TOR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

40.  Verify the Tornado Warning text contains the 
Tornado Template Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Tornado Warning statement. 

 

41.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 
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Step Action Result Pass/Fail 
42.  Verify the Tornado Warning text contains the 

counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Tornado 
Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

43.  Verify the Tornado Warning text contains the VTEC 
code above the BULLETIN section. The VTEC code 
should be in the following format: 
/O.NEW.KOAX.TO.W.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

44.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

45.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

46.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 

 

47.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

48.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

49.  Note the VTEC code (the ‘TO.W.xxxx’ portion in 
particular). 

 
TO.W.________________ 

 

50.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

51.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 

 

52.  MB1 click the WarnGen button in the toolbar and 
select the ‘Tornado’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR) or reissued (NEW). 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR) or reissued 
(NEW). 
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Step Action Result Pass/Fail 
53.  Create another Tornado Warning by repeating steps 

11-30, but choosing different options within the 
‘WarnGen: Operational’ window. 

The new Tornado Warning displays in 
the text window. 

 

54.  Verify the VTEC code in the warning is different from 
the first Tornado Warning (e.g., TO.W.0001 becomes 
TO.W.0002). 

The VTEC code from the first warning 
was persisted.  The second Tornado 
Warning contains updated VTEC 
coding. 

 

55.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

56.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 

 

57.  MB1 click the WarnGen button in the toolbar and 
select the ‘Tornado’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR) or reissued (NEW).  Verify two lines 
similar to the following appear: 

 COR.KOAX.TO.W.xxxx(NEW) 
 NEW.KOAX.TO.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR) or reissued 
(NEW). 

 

Correcting a Tornado Warning (COR) 
58.  In the WarnGen GUI, from the ‘Correct/Reissue’ 

dropdown, select the ‘COR’ product. 
The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

59.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

60.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: TOR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 10 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
61.  Verify the Tornado Warning text contains the 

Tornado Template Parameters selected. 
The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Tornado Warning statement. 

 

62.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

63.  Verify the Tornado Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Tornado 
Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

64.  Verify the Tornado Warning text contains the VTEC 
code above the BULLETIN section. The VTEC code 
should be in the following format: 
/O.COR.KOAX.TO.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

65.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

66.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 
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67.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 

 

68.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

69.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

70.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

71.  MB1 click the WarnGen button in the toolbar, select 
the Tornado radio button, and verify a line similar to 
the following appears: 

 ‘COR.KOAX.TO.W.xxxx(NEW)’ 

Verified.  
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Step Action Result Pass/Fail 
72.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 

window closes. 
 

Continuing a Tornado Warning (CON) by Issuing a Follow-Up for a Tornado Warning (SVS) 
73.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button. 
‘FOLLOWUP’ appears in the dropdown 
menu. 

 

74.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

75.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

76.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select additional warning bulletins. 
Then MB1 click the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

77.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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78.  Verify the Tornado Warning text contains the 
Tornado Template Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Tornado Warning statement. 

 

79.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

80.  Verify the Tornado Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Tornado 
Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 
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Step Action Result Pass/Fail 
81.  Verify the Tornado Warning text contains the VTEC 

code above the BULLETIN section. The VTEC code 
should be in the following format: 
/O.CON.KOAX.TO.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

82.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

83.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 
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84.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 

 

85.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

86.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

87.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

88.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 

 

89.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button, and MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify a line similar to the following appears: 

 ‘COR.KOAX.TO.W.xxxx(CON) 

Verified. 
 

 

Continuing/Canceling a Tornado Warning (CON/CAN) 

90.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button. 

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

91.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

92.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 
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Step Action Result Pass/Fail 
93.  Modify the warning polygon to remove at least one 

county from the original warning polygon. 
Select additional warning bulletins. 
Then MB1 click the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

94.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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95.  Verify the Tornado Warning text contains the 
Tornado Template Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Tornado Warning statement. 

 

96.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

97.  Verify the Tornado Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Tornado 
Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

98.  Verify the Tornado Warning text contains the VTEC 
code above the BULLETIN section. The 2 lines of 
VTEC code should be in the following format: 
/O.CAN.KOAX.TO.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/O.CON.KOAX.TO.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

99.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

100.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

101.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 
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Step Action Result Pass/Fail 
102.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

103.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

104.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

105.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 

 

106.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button, and MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify two lines similar to the following appear:  

 ‘COR.KOAX.TO.W.xxxx(CON)’ 
 ‘COR.KOAX.TO.W.xxxx(CAN)’ 

Verified. 
 

 

Reissuing a Tornado Warning (NEW) 
107.  In the WarnGen GUI, MB1 click on the ‘Tornado’ 

radio button. 
‘Update List’ appears in the dropdown 
menu. 

 

108.  From the ‘Update List’ dropdown, select the ‘NEW’ 
product. 

The storm vector and polygon appear. 
The polygon is editable. 

 

109.  Modify the polygon, duration and for the warning text 
product. 
Then MB1 click the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

110.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: TOR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 
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Step Action Result Pass/Fail 
111.  Verify the Tornado Warning text contains the 

Tornado Template Parameters selected. 
The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Tornado Warning statement. 

 

112.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 
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113.  Verify the Tornado Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Tornado 
Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

114.  Verify the Tornado Warning text contains the VTEC 
code above the BULLETIN section. The VTEC code 
should be in the following format: 
/O.NEW.KOAX.TO.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

115.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

116.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 
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117.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 

 

118.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

119.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

120.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

121.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 
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Step Action Result Pass/Fail 
122.  MB1 click the WarnGen button in the toolbar, select 

the Tornado radio button, and verify two lines similar 
to the following appear:  

 ‘COR.KOAX.TO.W.xxxx(NEW)’ 
 ‘NEW.KOAX.TO.W.xxxx’ 

Verified.  

Cancelling a Tornado Warning (CAN) 
123.  In the WarnGen GUI, MB1 click the ‘Other’ radio 

button.  Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button.  From 
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ 
product. 

The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

124.  MB1 click the ‘Create Text’ button. The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

125.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

126.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

127.  Verify the Tornado Warning text contains the 
counties encompassed by the polygon. 

The counties are listed in the Tornado 
Warning statement. 

DR #869 

128.  Verify the Tornado Warning text contains the VTEC 
code above the BULLETIN section. The VTEC code 
should be in the following format: 
/O.CAN.KOAX.TO.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

129.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 
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Step Action Result Pass/Fail 
130.  Verify the location and motion of the weather event 

exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

131.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 

 

132.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

133.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

134.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

135.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 

 

136.  MB1 click the WarnGen button in the toolbar, select 
the Tornado radio button, and verify a line similar to 
the following appears: 

 ‘COR.KOAX.TO.W.xxxx(CAN)’ 

Verified.  

137.  Close the WarnGen GUI. The WarnGen GUI closes.  
Expiring a Tornado Warning (EXP) 

138.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

139.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A first guess vector appears with the 
point near the center of the line, tick 
marks, and time values at the starting 
point, current/endpoint, and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

140.  Press the right arrow key on the keyboard once. The oldest radar image in the loop 
displays. The point is relabeled ‘Drag 
me to Storm’ and appears at the 
starting point of the vector. 
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Step Action Result Pass/Fail 
141.  MB1 click and hold the ‘Drag me to Storm’ point and 

drag it to another location.   
 

The vector is redrawn. The spacing 
between the tick marks adjusts 
accordingly. 
The hatched warning box remains at its 
current position. 

 

142.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

143.  Click MB1 on the ‘Track’ button under the ‘Redraw 
Box on Screen from:’ section. 

The hatched box is redrawn on the 
vector. 

 

144.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 

 

145.  MB1 click on the ‘Warned/Hatched Area’ button 
under the ‘Redraw Box on Screen from:’ section. 

The polygon’s vertices  are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 

 

146.  MB1 click on ‘Tornado’ in the ‘Product type’ section. The selection is made as indicated by 
the radio buttons.  The BASIS FOR 
WARNINGS and CALLS TO ACTION 
sections update to display items 
applicable for Tornado Warnings. 

 

147.  Select the ‘Duration:’ to 10 min. The duration is set to 10 min. The 
ending time of the warning updates 
with the change in duration. 
The vector contracts and the time at 
the arrowhead modifies. 

DR #813 

148.  Using Control and MB1 within the Optional bullets 
section, select or deselect items such that the 
following Tornado Template Parameters are 
highlighted: 

 BASIS FOR WARNING: Confirmed large 
tornado 

 CALLS TO ACTION: Severe Tornado 
 CALLS TO ACTION: If caught outside 

Then click MB1 on the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
149.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: TOR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

150.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

151.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

152.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

153.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button and 
verify the created warning is able to be expired 
(EXP). 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 

 

154.  Select the EXP product. The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

155.  MB1 click the ‘Create Text’ button. The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
156.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Tornado Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

157.  Verify the Tornado Warning text contains the current 
date and time attributes and the correct header 
information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

158.  Verify the Tornado Warning text contains the 
counties encompassed by the polygon. 

The counties are listed in the Tornado 
Warning statement. 

DR #869 

159.  Verify the Tornado Warning text contains the VTEC 
code above the BULLETIN section. The VTEC code 
should be in the following format: 
/O.EXP.KOAX.TO.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

160.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

161.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

162.  Verify the text warning contains a presence of closing 
$$. 

The Tornado Warning text contains a 
presence of closing $$. 

 

163.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Tornado Warning is saved. 
The text window displays the saved 
warning. 

 

164.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 21 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
165.  Ingest the warning text file into the ‘warning’ endpoint 

(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

166.  Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX 
window closes. 

 

167.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button.   
Verify in the ‘FOLLOWUP’ dropdown menu that an 
expired product (EXP) line similar to the following 
appears: 

 ‘COR.KOAX.TO.W.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the FOLLOWUP 
dropdown menu. 

 

168.  Close the WarnGen GUI. The WarnGen GUI closes.  
Severe Thunderstorm Warning 
Issuing a Severe Thunderstorm Warning 

169.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

170.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

171.  Press the right arrow key on the keyboard once. The oldest radar image in the loop 
displays. The point is relabeled ‘Drag 
me to Storm’ and appears at the 
starting point of the vector. 

 

172.  MB1 click and hold the ‘Drag me to Storm’ point and 
drag it to another location.   
 

The vector rotates accordingly. The 
spacing between the tick marks adjusts 
accordingly. 
The hatched warning box remains at its 
current position. 

 

173.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

174.  Click MB1 on the ‘Track’ button under the ‘Redraw 
Box on Screen from:’ section. 

The hatched box is redrawn on the 
vector. 
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Step Action Result Pass/Fail 
175.  MB1 click and hold on a vertex and dragging it to 

another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

176.  MB1 click on the ‘Warned/Hatched Area’ button 
under the ‘Redraw Box on Screen from:’ section. 

The polygon’s vertices  are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

177.  MB1 click on ‘Severe Thunderstorm’ in the ‘Product 
type’ section if not selected by default. 

The selection is made as indicated by 
the radio button.  The BASIS FOR 
WARNINGS and CALLS TO ACTION 
sections update to display items 
applicable for Severe Thunderstorm 
Warnings. 

 

178.  Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The 
ending time of the warning updates 
with the change in duration. 
The vector contracts and the time at 
the arrowhead modifies. 

DR #813 

179.  MB1 within the Optional bullets section, select items 
such that the following Severe Thunderstorm 
Template Parameters are highlighted: 

 BASIS FOR WARNING: Doppler radar 
indicated 

 THREAT: 60mph wind 
 THREAT: Penny size hail 
 CALLS TO ACTION:  Svr t-storms can 

produce tornadoes… 
Then click MB1 on the ‘Create Text’ button. 

The Tornado Warning text appears in a 
‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
180.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

181.  Verify the Severe Thunderstorm Warning text 
contains the Severe Thunderstorm Template 
Parameters selected. 

The BASIS FOR WARNING, THREAT 
and CALLS TO ACTION exist in the 
Severe Thunderstorm Warning 
statement. 

 

182.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

183.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Severe 
Thunderstorm Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

184.  Verify the Severe Thunderstorm Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.NEW.KOAX.SV.W.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

185.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

186.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

187.  Verify the text warning contains a presence of closing 
$$. 

The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

188.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
189.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMATOROAX’ 
window (not in edit mode). 

 

190.  Note the VTEC code (the ‘SV.W.xxxx’ portion in 
particular). 

 
SV.W.________________ 

 

191.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

192.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

193.  MB1 click the WarnGen button in the toolbar and 
select the ‘Severe Thunderstorm’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR) or reissued (NEW). 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR) or reissued 
(NEW). 

 

194.  Create another Severe Thunderstorm Warning by 
repeating steps 152-171, but choosing different 
options within the ‘WarnGen: Operational’ window. 

The new Severe Thunderstorm 
Warning displays in the text window. 

 

195.  Verify the VTEC code in the warning is different from 
the first Severe Thunderstorm Warning (e.g., 
SV.W.0001 becomes SV.W.0002). 

The VTEC code from the first warning 
was persisted.  The second Severe 
Thunderstorm Warning contains 
updated VTEC coding. 

 

196.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

197.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

198.  MB1 click the WarnGen button in the toolbar and 
select the ‘Severe Thunderstorm’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR) or reissued (NEW).  Verify two lines 
similar to the following appear: 

 COR.KOAX.SV.W.xxxx(NEW) 
 NEW.KOAX.SV.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR) or reissued 
(NEW). 
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Step Action Result Pass/Fail 
Correcting a Severe Thunderstorm Warning (COR) 

199.  In the WarnGen GUI, from the ‘Correct/Reissue’ 
dropdown, select the ‘COR’ product. 

The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

200.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 

 

201.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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202.  Verify the Severe Thunderstorm Warning text 
contains the Severe Thunderstorm Template 
Parameters selected. 

The BASIS FOR WARNING, THREAT 
and CALLS TO ACTION exist in the 
Severe Thunderstorm Warning 
statement. 

 

203.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

204.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Severe 
Thunderstorm Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

205.  Verify the Severe Thunderstorm Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.COR.KOAX.SV.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

206.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 
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Step Action Result Pass/Fail 
207.  Verify the location and motion of the weather event 

exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

208.  Verify the text warning contains a presence of closing 
$$. 

The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

209.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 

 

210.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 

 

211.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

212.  MB1 click the WarnGen button in the toolbar, select 
the Severe Thunderstorm radio button, and verify a 
line similar to the following appears: 

 ‘COR.KOAX.SV.W.xxxx(NEW)’ 

Verified.  

213.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

Continuing a Severe Thunderstorm Warning (CON) by Issuing a Follow-Up for a  
Severe Thunderstorm Warning (SVS) 

214.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button.  Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button.   
 

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

215.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

216.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

217.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select additional warning bulletins. 
Then MB1 click the ‘Create Text’ button. 

The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
218.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

219.  Verify the Severe Thunderstorm Warning text 
contains the Severe Thunderstorm Template 
Parameters selected. 

The BASIS FOR WARNING, THREAT 
and CALLS TO ACTION exist in the 
Severe Thunderstorm Warning 
statement. 

 

220.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

221.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Severe 
Thunderstorm Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

222.  Verify the Severe Thunderstorm Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.CON.KOAX.SV.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

223.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

224.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

225.  Verify the text warning contains a presence of closing 
$$. 

The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

226.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
227.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 

 

228.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

229.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

230.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button, and MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify a line similar to the following appears: 

 ‘COR.KOAX.SV.W.xxxx(CON) 

Verified. 
 

 

Continuing/Canceling a Severe Thunderstorm Warning (CON/CAN) 
231.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

232.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

233.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

234.  Modify the warning polygon to remove at least one 
county from the original warning polygon. 
Select additional warning bulletins. 
Then MB1 click the ‘Create Text’ button. 

The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 

 

235.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 
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Step Action Result Pass/Fail 
236.  Verify the Severe Thunderstorm Warning text 

contains the Severe Thunderstorm Template 
Parameters selected. 

The BASIS FOR WARNING, THREAT 
and CALLS TO ACTION exist in the 
Severe Thunderstorm Warning 
statement. 

 

237.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 
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238.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Severe 
Thunderstorm Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

239.  Verify the Severe Thunderstorm Warning text 
contains the VTEC code above the BULLETIN 
section. The 2 lines of VTEC code should be in the 
following format: 
/O.CAN.KOAX.SV.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/O.CON.KOAX.SV.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

240.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

241.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

242.  Verify the text warning contains a presence of closing 
$$. 

The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

243.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 

 

244.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 

 

245.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  
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Step Action Result Pass/Fail 
246.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 

window closes. 
 

247.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button and 
MB1 click the ‘FOLLOWUP’ dropdown menu. 
Verify two lines similar to the following appear:  

 ‘COR.KOAX.SV.W.xxxx(CON)’ 
 ‘COR.KOAX.SV.W.xxxx(CAN)’ 

Verified. 
 

 

Reissuing a Severe Thunderstorm Warning (NEW) 
248.  In the WarnGen GUI, MB1 click on the ‘Severe 

Thunderstorm’ radio button. 
‘Update List’ appears in the dropdown 
menu. 

 

249.  From the ‘Update List’ dropdown, select the ‘NEW’ 
product. 

The storm vector and polygon appear. 
The polygon is editable. 

 

250.  Modify the polygon, duration and for the warning text 
product. 
Then MB1 click the ‘Create Text’ button. 

The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 

 

251.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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252.  Verify the Severe Thunderstorm Warning text 
contains the Severe Thunderstorm Template 
Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the Severe 
Thunderstorm Warning statement. 

 

253.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

254.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Severe 
Thunderstorm Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 
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Step Action Result Pass/Fail 
255.  Verify the Severe Thunderstorm Warning text 

contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.NEW.KOAX.SV.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

256.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

257.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

258.  Verify the text warning contains a presence of closing 
$$. 

The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

259.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 

 

260.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 

 

261.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

262.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

263.  MB1 click the WarnGen button in the toolbar, select 
the Severe Thunderstorm radio button, and verify two 
lines similar to the following appear:  

 ‘COR.KOAX.SV.W.xxxx(NEW)’ 
 ‘NEW.KOAX.SV.W.xxxx’ 

Verified.  
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Step Action Result Pass/Fail 
Cancelling a Severe Thunderstorm Warning (CAN) 

264.  In the WarnGen GUI, MB1 click the ‘Other’ radio 
button.  Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button. 
From the ‘FOLLOWUP’ dropdown menu, select the 
‘CAN’ product. 

The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

265.  MB1 click the ‘Create Text’ button. The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 

 

266.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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267.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

268.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 

The counties are listed in the Severe 
Thunderstorm Warning statement. 

DR #869 

269.  Verify the Severe Thunderstorm Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.CAN.KOAX.SV.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

270.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

271.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 
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Step Action Result Pass/Fail 
272.  Verify the text warning contains a presence of closing 

$$. 
The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

273.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 

 

274.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 

 

275.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

276.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

277.  MB1 click the WarnGen button in the toolbar, select 
the Severe Thunderstorm radio button, and verify a 
line similar to the following appears: 

 ‘COR.KOAX.SV.W.xxxx(CAN)’ 

Verified.  

278.  Close the WarnGen GUI. The WarnGen GUI closes.  
Expiring a Severe Thunderstorm Warning (EXP) 

279.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

280.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A first guess vector appears with the 
point near the center of the line, tick 
marks, and time values at the starting 
point, current/endpoint, and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

281.  Press the right arrow key on the keyboard once. The oldest radar image in the loop 
displays. The point is relabeled ‘Drag 
me to Storm’ and appears at the 
starting point of the vector. 

 

282.  MB1 click and hold the ‘Drag me to Storm’ point and 
drag it to another location.   
 

The vector is redrawn. The spacing 
between the tick marks adjusts 
accordingly. 
The hatched warning box remains at its 
current position. 
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Step Action Result Pass/Fail 
283.  In the ‘WarnGen’ window, select the following: 

-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

284.  Click MB1 on the ‘Track’ button under the ‘Redraw 
Box on Screen from:’ section. 

The hatched box is redrawn on the 
vector. 

 

285.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 

 

286.  MB1 click on the ‘Warned/Hatched Area’ button 
under the ‘Redraw Box on Screen from:’ section. 

The polygon’s vertices  are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 

 

287.  MB1 click on ‘Severe Thunderstorm’ in the ‘Product 
type’ section. 

The selection is made as indicated by 
the radio button.  The BASIS FOR 
WARNINGS and CALLS TO ACTION 
sections update to display items 
applicable for Severe Thunderstorm 
Warnings. 

 

288.  Select the ‘Duration:’ to 10 min. The duration is set to 10 min. The 
ending time of the warning updates 
with the change in duration. 
The vector contracts and the time at 
the arrowhead modifies. 

DR #813 

289.  Using Control and MB1 within the Optional bullets 
section, select or deselect items such that the 
following Severe Thunderstorm Template 
Parameters are highlighted: 

 BASIS FOR WARNING: Confirmed large 
Severe Thunderstorm 

 CALLS TO ACTION: Severe Thunderstorm 
 CALLS TO ACTION: If caught outside 

Then click MB1 on the ‘Create Text’ button. 

The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
290.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVR 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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291.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 

 

292.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 

 

293.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

294.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Select ‘Severe Weather Statement’ from the 
dropdown menu below the ‘Other’ radio button and 
verify the created warning is able to be expired 
(EXP). 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 

 

295.  Select the EXP product. The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

296.  MB1 click the ‘Create Text’ button. The Severe Thunderstorm Warning 
text appears in a ‘Text Warngen’ 
window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
297.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Severe Thunderstorm Warning 
text remains displayed in the text 
window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

298.  Verify the Severe Thunderstorm Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

299.  Verify the Severe Thunderstorm Warning text 
contains the counties encompassed by the polygon. 

The counties are listed in the Severe 
Thunderstorm Warning statement. 

DR #869 

300.  Verify the Severe Thunderstorm Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.EXP.KOAX.SV.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

301.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

302.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

303.  Verify the text warning contains a presence of closing 
$$. 

The Severe Thunderstorm Warning 
text contains a presence of closing $$. 

 

304.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Severe Thunderstorm Warning is 
saved. 
The text window displays the saved 
warning. 

 

305.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMASVROAX’ 
window (not in edit mode). 
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Step Action Result Pass/Fail 
306.  Ingest the warning text file into the ‘warning’ endpoint 

(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

307.  Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX 
window closes. 

 

308.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button.  Select ‘Severe Weather 
Statement’ from the dropdown menu below the 
‘Other’ radio button. 
Verify in the ‘FOLLOWUP’ dropdown menu that an 
expired product (EXP) that appears as follows: 

 ‘COR.KOAX.SV.W.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the FOLLOWUP 
dropdown menu. 

 

309.  Close the WarnGen GUI. The WarnGen GUI closes.  
Flash Flood Warning 
Issuing a Flash Flood Warning 

310.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

311.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

312.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

313.  MB1 click on ‘Flash Flood’ in the ‘Product type’ 
section. 

The selection is made as indicated by 
the radio button.  The REPORTED BY 
and CALLS TO ACTION sections 
update to display items applicable for 
Flash Flood Warnings. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

314.  Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The 
ending time of the warning updates 
with the change in duration. 
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Step Action Result Pass/Fail 
315.  MB1 click and hold on a vertex and dragging it to 

another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

316.  In the WarnGen GUI, MB1 click on the 
‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

317.  MB1 within the Optional bullets section, select items 
such that the following Flash Flood Template 
Parameters are highlighted: 

 REPORTED BY: Doppler radar indicated 
 CALLS TO ACTION: Urban flooding… 
 CALLS TO ACTION: Nighttime flooding… 
 CALLS TO ACTION: Camper safety… 

Then click MB1 on the ‘Create Text’ button. 

The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

318.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 
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319.  Verify the Flash Flood Warning text contains the 
Flash Flood Template Parameters selected. 

The REPORTED BY and CALLS TO 
ACTION exist in the Flash Flood 
Warning statement. 

 

320.  Verify the Flash Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 
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Step Action Result Pass/Fail 
321.  Verify the Flash Flood Warning text contains the 

counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Flash 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 
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322.  Verify the Flash Flood Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.FF.W.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.ER.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

323.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

324.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Warning text contains 
a presence of closing $$. 

 

325.  In the text window, replace the ‘!**REPORT**!’ line 
with a word or phrase. 
Replace the ‘!**NAME/INITIALS**!’ line with the 
user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Warning is saved. 
The text window displays the saved 
warning. 

 

326.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

327.  Note the VTEC code (the ‘FF.W.xxxx’ portion in 
particular). 

 
FF.W.________________ 

 

328.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

329.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 
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Step Action Result Pass/Fail 
330.  MB1 click the WarnGen button in the toolbar and 

select the ‘Flash Flood’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 NEW.KOAX.FF.W.xxxx 
 EXT.KOAX.FF.W.xxxx 
 COR.KOAX.FF.W.xxxx(NEW) 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

331.  Create another Flash Flood Warning by repeating 
steps 293-308, but choosing different options within 
the ‘WarnGen: Operational’ window. 

The new Flash Flood Warning displays 
in the text window. 

 

332.  Verify the VTEC code in the warning is different from 
the first Flash Flood Warning (e.g., FF.W.0001 
becomes FF.W.0002). 

The VTEC code from the first warning 
was persisted.  The second Flash 
Flood Warning contains updated VTEC 
coding. 

 

333.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

334.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

335.  MB1 click the WarnGen button in the toolbar and 
select the ‘Flash Flood’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 COR.KOAX.FF.W.xxxx(NEW) 
 NEW.KOAX.FF.W.xxxx 
 EXT.KOAX.FF.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

Correcting a Flash Flood Warning (COR) 
336.  In the WarnGen GUI, from the ‘Correct/Reissue’ 

dropdown, select the ‘COR’ product. 
The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

337.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
338.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 
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339.  Verify the Flash Flood Warning text contains the 
Flash Flood Template Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the Flash 
Flood Warning statement. 

 

340.  Verify the Flash Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 
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341.  Verify the Flash Flood Warning text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Flash 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 
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342.  Verify the Flash Flood Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.COR.KOAX.FF.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.ER.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

343.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

344.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Warning text contains 
a presence of closing $$. 

 

345.  In the text window, replace the ‘!**REPORT**!’ line 
with a word or phrase. 
Replace the ‘!**NAME/INITIALS**!’ line with the 
user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Warning is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
346.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

347.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

348.  MB1 click the WarnGen button in the toolbar, select 
the Flash Flood radio button, and verify a line similar 
to the following appears: 

 ‘COR.KOAX.FF.W.xxxx(NEW)’ 

Verified.  

349.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

Continuing a Flash Flood Warning (CON) by Issuing a Follow-Up for a Flash Flood Warning (FFS) 
350.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘Flash Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

351.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

352.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

353.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select the following warning bulletins: 

 SVR THREAT: Trained spotters reported 
 THREAT: 70 mph wind 
 CALLS TO ACTION: Turn around…dont 

drown 
Then MB1 click the ‘Create Text’ button. 

The Flash Flood Statement text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
354.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 
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355.  Verify the Flash Flood Statement text contains the 
Flash Flood Template Parameters selected. 

The SVR THREAT, THREAT and 
CALLS TO ACTION exist in the Flash 
Flood Statement text. 

 

356.  Verify the Flash Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 
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357.  Verify the Flash Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Flash 
Flood Statement text. 
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358.  Verify the Flash Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CON.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.ER.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

359.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

360.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 
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361.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Statement text 
contains a presence of closing $$. 

 

362.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Statement is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
363.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

364.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

365.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes. 

 

366.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button, 
Select ‘Flash Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.  
Then MB1 click the ‘FOLLOWUP’ dropdown menu. 
Verify a line similar to the following appears: 

 ‘COR.KOAX.FF.W.xxxx(CON) 

Verified. 
 

 

Extending a Flash Flood Warning (EXT) 
367.  In the WarnGen GUI, MB1 click the ‘Flash Flood’ 

radio button. 
Then MB1 click the ‘Correct/Extend /Reissue’ 
dropdown menu and select the ‘EXT’ product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

368.  Modify the polygon, the duration and bulletins to be 
displayed in the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

369.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 
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370.  Verify the Flash Flood Warning text contains the 
Flash Flood Template Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the Flash 
Flood Warning statement. 
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Step Action Result Pass/Fail 
371.  Verify the Flash Flood Warning text contains the 

current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 
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372.  Verify the Flash Flood Warning text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Flash 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 
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373.  Verify the Flash Flood Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXT.KOAX.FF.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.ER.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

374.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

375.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Warning text contains 
a presence of closing $$. 

 

376.  In the text window, replace the ‘!**REPORT**!’ line 
with a word or phrase. 
Replace the ‘!**NAME/INITIALS**!’ line with the 
user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Warning is saved. 
The text window displays the saved 
warning. 

 

377.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

378.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

379.  MB1 click the WarnGen button in the toolbar, select 
the Flash Flood radio button, MB1 click the 
‘Correct/Extend/Reissue’ dropdown menu and verify 
a line similar to the following appears: 

 ‘COR.KOAX.FF.W.xxxx(EXT)’  

Verified.  

380.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 
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Step Action Result Pass/Fail 
Continuing/Canceling a Flash Flood Warning (CON/CAN) 

381.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button.  Select ‘Flash Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

382.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

383.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

384.  Modify the warning polygon to remove at least one 
county from the original warning polygon. 
Select the following warning bulletins: 

 SVR THREAT: Doppler radar indicated 
 THREAT: 70 mph wind 
 THREAT: Penny size hail 
 CALLS TO ACTION: Nighttime flooding… 

Then MB1 click the ‘Create Text’ button. 

The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

385.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 
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386.  Verify the Flash Flood Warning text contains the 
Flash Flood Template Parameters selected. 

The SVR THREAT, THREAT and 
CALLS TO ACTION exist in the Flash 
Flood Warning statement. 

 

387.  Verify the Flash Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 
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388.  Verify the Flash Flood Warning text contains the 
counties encompassed by the polygon. 

The counties are listed in the Flash 
Flood Warning statement. 
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Step Action Result Pass/Fail 
389.  Verify the Flash Flood Warning text contains the 

VTEC code above the BULLETIN section. The 2 
lines of VTEC code should be in the following format: 
/O.CAN.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.ER.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
/O.CON.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.ER.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

390.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

391.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Warning text contains 
a presence of closing $$. 

 

392.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Warning is saved. 
The text window displays the saved 
warning. 

 

393.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

394.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

395.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes. 

 

396.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘Flash Flood 
Statement’ from the dropdown menu below the 
‘Other’ radio button.  Then MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify two lines similar to the following appear:  

 ‘COR.KOAX.FF.W.xxxx(CON)’ 
 ‘COR.KOAX.FF.W.xxxx(CAN)’ 

Verified. 
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Step Action Result Pass/Fail 
Reissuing a Flash Flood Warning (NEW) 

397.  In the WarnGen GUI, MB1 click on the ‘Flash Flood’ 
radio button. 

‘Extend/Reissue’ appears in the 
dropdown menu. 

 

398.  From the ‘Extend/Reissue’ dropdown, select the 
‘NEW’ product. 

The polygon appears. 
The polygon is editable. 

 

399.  Modify the polygon, duration and bulletins for the 
warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

400.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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401.  Verify the Flash Flood Warning text contains the 
Flash Flood Template Parameters selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the Flash 
Flood Warning statement. 

 

402.  Verify the Flash Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

403.  Verify the Flash Flood Warning text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Flash 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

404.  Verify the Flash Flood Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

405.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

406.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Warning text contains 
a presence of closing $$. 
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Step Action Result Pass/Fail 
407.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Warning is saved. 
The text window displays the saved 
warning. 

 

408.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

409.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

410.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

411.  MB1 click the WarnGen button in the toolbar, select 
the Flash Flood radio button, and verify three lines 
similar to the following appear: 

 ‘COR.KOAX.FF.W.xxxx(NEW)’ 
 ‘NEW.KOAX.FF.W.xxxx’ 
 ‘EXT.KOAX.FF.W.xxxx’ 

Verified.  

Cancelling a Flash Flood Warning (CAN) 
412.  In the WarnGen GUI, MB1 click the ‘Other’ radio 

button.  Select ‘Flash Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.  From 
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ 
product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

413.  MB1 click the ‘Create Text’ button. The Flash Flood Statement text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
414.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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415.  Verify the Flash Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

416.  Verify the Flash Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Flash 
Flood Statement text. 

DR #869 

417.  Verify the Flash Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CAN.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

418.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

419.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Statement text 
contains a presence of closing $$. 

 

420.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Statement is saved. 
The text window displays the saved 
warning. 

 

421.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

422.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  
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Step Action Result Pass/Fail 
423.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 

window closes. 
 

424.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Flash Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.   
Then MB1 click the ‘FOLLOWUP’ dropdown menu 
and verify a line similar to the following appears:  

 ‘COR.KOAX.FF.W.xxxx(CAN)’ 

Verified.  

425.  Close the WarnGen GUI. The WarnGen GUI closes.  
Expiring a Flash Flood Warning (EXP) 

426.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

427.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

428.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

429.  MB1 click on ‘Flash Flood’ in the ‘Product type’ 
section. 

The selection is made as indicated by 
the radio button.  The REPORTED BY 
and CALLS TO ACTION sections 
update to display items applicable for 
Flash Flood Warnings. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

430.  Select the ‘Duration:’ to 15 min. The duration is set to 15 min. The 
ending time of the warning updates 
with the change in duration. 

DR #813 
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Step Action Result Pass/Fail 
431.  MB1 click and hold on a vertex and dragging it to 

another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

432.  In the WarnGen GUI, MB1 click on the 
‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

433.  MB1 within the Optional bullets section, select items 
such that the following Flash Flood Template 
Parameters are highlighted: 

 REPORTED BY: Doppler radar indicated 
 CALLS TO ACTION: Urban flooding… 
 CALLS TO ACTION: Nighttime flooding… 
 CALLS TO ACTION: Camper safety… 

Then click MB1 on the ‘Create Text’ button. 

The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

434.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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435.  In the text window, replace the ‘!**REPORT**!’ line 
with a word or phrase. 
Replace the ‘!**NAME/INITIALS**!’ line with the 
user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Warning is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
436.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

437.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

438.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

439.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Select ‘Flash Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button. 
Then MB1 click the ‘FOLLOWUP’ dropdown menu to 
verify the created warning is able to expired (EXP). 
EXP.KOAX.FF.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 

 

440.  Select the EXP product. The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

441.  MB1 click the ‘Create Text’ button. The Flash Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

442.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Flash Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

 

443.  Verify the Flash Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

 

444.  Verify the Flash Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Flash 
Flood Statement text. 
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Step Action Result Pass/Fail 
445.  Verify the Flash Flood Statement text contains the 

VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXP.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

446.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

447.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

 

448.  Verify the text warning contains a presence of closing 
$$. 

The Flash Flood Statement text 
contains a presence of closing $$. 

 

449.  In the text window, replace the ‘!**REPORT**!’ line 
with a word or phrase. 
Replace the ‘!**NAME/INITIALS**!’ line with the 
user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Flash Flood Statement is saved. 
The text window displays the saved 
warning. 

 

450.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

451.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

452.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes. 

 

453.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Flash Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.   
Verify in the ‘FOLLOWUP’ dropdown menu that an 
expired product (EXP) similar to the following 
appears: 

 ‘COR.KOAX.FF.W.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the Update List 
dropdown menu. 

 

454.  Close the WarnGen GUI. The WarnGen GUI closes.  
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Step Action Result Pass/Fail 
Extreme Wind Warning 
Issuing an Extreme Wind Warning 

455.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

456.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

457.  Press the right arrow key on the keyboard once. The oldest radar image in the loop 
displays. The point is relabeled ‘Drag 
me to Storm’ and appears at the 
starting point of the vector. 

 

458.  MB1 click and hold the ‘Drag me to Storm’ point and 
drag it to another location.   
 

The vector rotates accordingly. The 
spacing between the tick marks adjusts 
accordingly. 
The hatched warning box remains at its 
current position. 

 

459.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

460.  Click MB1 on the ‘Track’ button under the ‘Redraw 
Box on Screen from:’ section. 

The hatched box is redrawn on the 
vector. 

 

461.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

462.  MB1 click on the ‘Warned/Hatched Area’ button 
under the ‘Redraw Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 
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Step Action Result Pass/Fail 
463.  MB1 click on ‘Other’ in the ‘Product type’ section.  

Then select ‘Extreme Wind Warning’ from the 
dropdown menu below the ‘Other’ radio button.   
 

The selection is made as indicated by 
the radio button.  The BASIS FOR 
WARNINGS and CALLS TO ACTION 
sections update to display items 
applicable for Extreme Wind Warnings. 

 

464.  Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The 
ending time of the warning updates 
with the change in duration. 
The vector contracts and the time at 
the arrowhead modifies. 

DR #813 

465.  MB1 within the Optional bullets section, select items 
such that the following Extreme Wind Warning 
Template Parameters are highlighted: 

 BASIS FOR WARNING: Doppler radar 
indicated 

 CALLS TO ACTION: CTA – Take cover now 
Then click MB1 on the ‘Create Text’ button. 

The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

466.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: EWW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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467.  Verify the Extreme Wind Warning text contains the 
Extreme Wind Warning Template Parameters 
selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Extreme Wind Warning statement. 

 

468.  Verify the Extreme Wind Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

469.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Extreme 
Wind Warning statement. 
The cities near the warning vector are 
included in the warning. 
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Step Action Result Pass/Fail 
470.  Verify the Extreme Wind Warning text contains the 

VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.EW.W.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

471.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

472.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 
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473.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 

 

474.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

475.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

476.  Note the VTEC code (the ‘EW.W.xxxx’ portion in 
particular). 

 
EW.W.________________ 

 

477.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

478.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

479.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR) or reissued (NEW). 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR) or reissued 
(NEW). 

 

480.  Create another Extreme Wind Warning by repeating 
steps 438-457, but choosing different options within 
the ‘WarnGen: Operational’ window. 

The new Extreme Wind Warning 
displays in the text window. 
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Step Action Result Pass/Fail 
481.  Verify the VTEC code in the warning is different from 

the first Extreme Wind Warning (e.g., EW.W.0001 
becomes EW.W.0002). 

The VTEC code from the first warning 
was persisted.  The second Extreme 
Wind Warning contains updated VTEC 
coding. 

 

482.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

483.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

484.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR) or reissued (NEW).  Verify two lines 
similar to the following appear: 

 COR.KOAX.EW.W.xxxx(NEW) 
 NEW.KOAX.EW.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR) or reissued 
(NEW). 

 

Correcting an Extreme Wind Warning (COR) 
485.  In the WarnGen GUI, from the ‘Correct/Reissue’ 

dropdown, select the ‘COR’ product. 
The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

486.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

487.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: EWW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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488.  Verify the Extreme Wind Warning text contains the 
Extreme Wind Warning Template Parameters 
selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Extreme Wind Warning statement. 
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Step Action Result Pass/Fail 
489.  Verify the Extreme Wind Warning text contains the 

current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

490.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Extreme 
Wind Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

491.  Verify the Extreme Wind Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.COR.KOAX.EW.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

492.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

493.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

494.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 

 

495.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

496.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

497.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

498.  MB1 click the WarnGen button in the toolbar, select 
the Other radio button, and verify a line similar to the 
following appears: 

 ‘COR.KOAX.EW.W.xxxx(NEW)’ 

Verified.  

499.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 
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Step Action Result Pass/Fail 
Continuing an Extreme Wind Warning (CON) by Issuing a Follow-Up for an Extreme Wind Warning (SVS) 

500.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button. 

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

501.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

502.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

503.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select additional warning bulletins. 
Then MB1 click the ‘Create Text’ button. 

The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

504.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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505.  Verify the Extreme Wind Warning text contains the 
Extreme Wind Warning Template Parameters 
selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Extreme Wind Warning statement. 

 

506.  Verify the Extreme Wind Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

507.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Extreme 
Wind Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

508.  Verify the Extreme Wind Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CON.KOAX.EW.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  
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Step Action Result Pass/Fail 
509.  Verify the Lat/Lon coordinates appear in the text 

warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

510.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

511.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 

 

512.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

513.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

514.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

515.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

516.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button and select ‘Extreme Wind 
Warning’.  Then MB1 click the ‘FOLLOWUP’ 
dropdown menu. 
Verify a line similar to the following appears: 

 ‘COR.KOAX.EW.W.xxxx(CON) 

Verified. 
 

 

Continuing/Canceling an Extreme Wind Warning (CON/CAN) 
517.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Then MB1 click ‘Extreme Wind Warning’. 
‘FOLLOWUP’ appears in the dropdown 
menu. 

 

518.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

519.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

520.  Modify the warning polygon to remove at least one 
county from the original warning polygon. 
Select additional warning bulletins. 
Then MB1 click the ‘Create Text’ button. 

The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
521.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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522.  Verify the Extreme Wind Warning text contains the 
Extreme Wind Warning Template Parameters 
selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Extreme Wind Warning statement. 

 

523.  Verify the Extreme Wind Warning statement text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

524.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Extreme 
Wind Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

525.  Verify the Extreme Wind Warning text contains the 
VTEC code above the BULLETIN section. The 2 
lines of VTEC code should be in the following format: 
/O.CAN.KOAX.EW.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/O.CON.KOAX.EW.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

526.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

527.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

528.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 

 

529.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
530.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

531.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

532.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

533.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button and select ‘Extreme Wind 
Warning’.  Then MB1 click the ‘FOLLOWUP’ 
dropdown menu. 
Verify two lines similar to the following appear:  

 ‘COR.KOAX.EW.W.xxxx(CON)’ 
 ‘COR.KOAX.EW.W.xxxx(CAN)’ 

Verified. 
 

 

Reissuing an Extreme Wind Warning (NEW) 
534.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Then MB1 click ‘Extreme Wind Warning’. 
‘Update List’ appears in the dropdown 
menu. 

 

535.  From the ‘Update List’ dropdown, select the ‘NEW’ 
product. 

The storm vector and polygon appear. 
The polygon is editable. 

 

536.  Modify the polygon, duration and for the warning text 
product. 
Then MB1 click the ‘Create Text’ button. 

The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

537.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: EWW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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538.  Verify the Extreme Wind Warning text contains the 
Extreme Wind Warning Template Parameters 
selected. 

The BASIS FOR WARNING and 
CALLS TO ACTION exist in the 
Extreme Wind Warning statement. 
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Step Action Result Pass/Fail 
539.  Verify the Extreme Wind Warning text contains the 

current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

540.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 
Verify cities near the warning vector are included in 
the pathcast.  

The counties are listed in the Extreme 
Wind Warning statement. 
The cities near the warning vector are 
included in the warning. 

DR #869 

541.  Verify the Extreme Wind Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.EW.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

542.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

543.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

544.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 

 

545.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

546.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

547.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

548.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

549.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button, and verify two lines similar to 
the following appear:  

 ‘COR.KOAX.EW.W.xxxx(NEW)’ 
 ‘NEW.KOAX.EW.W.xxxx’ 

Verified.  



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 65 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
Cancelling an Extreme Wind Warning (CAN) 

550.  In the WarnGen GUI, MB1 click the ‘Other’ radio 
button.  From the ‘FOLLOWUP’ dropdown menu, 
select the ‘CAN’ product. 

The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

551.  MB1 click the ‘Create Text’ button. The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

552.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 
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553.  Verify the Extreme Wind Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

554.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 

The counties are listed in the Extreme 
Wind Warning statement. 

DR #869 

555.  Verify the Extreme Wind Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CAN.KOAX.EW.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

556.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

557.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

558.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 
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Step Action Result Pass/Fail 
559.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

560.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

561.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

562.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

563.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button, and verify a line similar to the 
following appears: 

 ‘COR.KOAX.EW.W.xxxx(CAN)’ 

Verified.  

564.  Close the WarnGen GUI. The WarnGen GUI closes.  
Expiring an Extreme Wind Warning (EXP) 

565.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

566.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A first guess vector appears with the 
point near the center of the line, tick 
marks, and time values at the starting 
point, current/endpoint, and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

567.  Press the right arrow key on the keyboard once. The oldest radar image in the loop 
displays. The point is relabeled ‘Drag 
me to Storm’ and appears at the 
starting point of the vector. 

 

568.  MB1 click and hold the ‘Drag me to Storm’ point and 
drag it to another location.   
 

The vector is redrawn. The spacing 
between the tick marks adjusts 
accordingly. 
The hatched warning box remains at its 
current position. 
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Step Action Result Pass/Fail 
569.  In the ‘WarnGen’ window, select the following: 

-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

570.  Click MB1 on the ‘Track’ button under the ‘Redraw 
Box on Screen from:’ section. 

The hatched box is redrawn on the 
vector. 

 

571.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 

 

572.  MB1 click on the ‘Warned/Hatched Area’ button 
under the ‘Redraw Box on Screen from:’ section. 

The polygon’s vertices  are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 

 

573.  MB1 click on ‘Other’ in the ‘Product type’ section. The selection is made as indicated by 
the radio buttons.  The BASIS FOR 
WARNINGS and CALLS TO ACTION 
sections update to display items 
applicable for Extreme Wind Warnings. 

 

574.  Select the ‘Duration:’ to 10 min. The duration is set to 10 min. The 
ending time of the warning updates 
with the change in duration. 
The vector contracts and the time at 
the arrowhead modifies. 

DR #813 

575.  Using Control and MB1 within the Optional bullets 
section, select or deselect items such that the 
following Extreme Wind Warning Template 
Parameters are highlighted: 

 BASIS FOR WARNING: Confirmed large 
tornado 

 CALLS TO ACTION: Severe Tornado 
 CALLS TO ACTION: If caught outside 

Then click MB1 on the ‘Create Text’ button. 

The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
576.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: EWW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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577.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

578.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 

 

579.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

580.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button, and verify the created 
warning is able to be expired (EXP). 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 

 

581.  Select the EXP product. The storm vector and polygon appear. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

582.  MB1 click the ‘Create Text’ button. The Extreme Wind Warning text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
583.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: SVS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Extreme Wind Warning text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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584.  Verify the Extreme Wind Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

585.  Verify the Extreme Wind Warning text contains the 
counties encompassed by the polygon. 

The counties are listed in the Extreme 
Wind Warning statement. 

DR #869 

586.  Verify the Extreme Wind Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXP.KOAX.EW.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

587.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

588.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

589.  Verify the text warning contains a presence of closing 
$$. 

The Extreme Wind Warning text 
contains a presence of closing $$. 

 

590.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Extreme Wind Warning is saved. 
The text window displays the saved 
warning. 

 

591.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAEWWOAX’ 
window (not in edit mode). 
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Step Action Result Pass/Fail 
592.  Ingest the warning text file into the ‘warning’ endpoint 

(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

593.  Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX 
window closes. 

 

594.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Verify in the Update List dropdown menu that an 
expired product (EXP) line similar to the following 
appears: 

 ‘COR.KOAX.EW.W.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the Update List 
dropdown menu. 

 

595.  Close the WarnGen GUI. The WarnGen GUI closes.  
Non-Convective Flash Flood Warning 
Issuing a Non-Convective Flash Flood Warning 

596.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

597.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

598.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

599.  MB1 click on ‘Other’ in the ‘Product type’ section.  
Select ‘non-convective FFW’ from the dropdown 
menu below the ‘Other’ radio button.   

The selection is made as indicated by 
the radio button.  The PRIMARY 
CAUSE, DAM FAILURE REPORTED 
BY and CALLS TO ACTION sections 
update to display items applicable for 
Non-Convective Flash Flood Warnings. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

600.  Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The 
ending time of the warning updates 
with the change in duration. 

DR #813 
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Step Action Result Pass/Fail 
601.  MB1 click and hold on a vertex and dragging it to 

another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

602.  In the WarnGen GUI, MB1 click on the 
‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

603.  MB1 within the Optional bullets section, select items 
such that the following Non-Convective Flash Flood 
Template Parameters are highlighted: 

 PRIMARY CAUSE: levee failure 
 DAM FAILURE REPORTED BY: law 

enforcement 
 CALLS TO ACTION: Do not drive into water 

Then click MB1 on the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

604.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Warning text remains displayed in the 
text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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605.  Verify the Non-Convective Flash Flood Warning text 
contains the Non-Convective Flash Flood Template 
Parameters selected. 

The PRIMARY CAUSE, DAM 
FAILURE REPORTED BY and CALLS 
TO ACTION exist in the Non-
Convective Flash Flood Warning 
statement. 
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Step Action Result Pass/Fail 
606.  Verify the Non-Convective Flash Flood Warning text 

contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

607.  Verify the Non-Convective Flash Flood Warning text 
contains the counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Non-
Convective Flash Flood Warning 
statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

608.  Verify the Non-Convective Flash Flood Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.NEW.KOAX.FF.W.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

609.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

610.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Warning text contains a presence of 
closing $$. 

 

611.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Warning is saved. 
The text window displays the saved 
warning. 

 

612.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

613.  Note the VTEC code (the ‘FF.W.xxxx’ portion in 
particular). 

 
FF.W.________________ 

 

614.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

615.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 
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Step Action Result Pass/Fail 
616.  MB1 click the WarnGen button in the toolbar and 

select the ‘non-convective FFW’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 NEW.KOAX.FF.W.xxxx 
 EXT.KOAX.FF.W.xxxx 
 COR.KOAX.FF.W.xxxx(NEW) 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

617.  Create another Non-Convective Flash Flood Warning 
by repeating steps 579-594, but choosing different 
options within the ‘WarnGen: Operational’ window. 

The new Non-Convective Flash Flood 
Warning displays in the text window. 

 

618.  Verify the VTEC code in the warning is different from 
the first Non-Convective Flash Flood Warning (e.g., 
FF.W.0001 becomes FF.W.0002). 

The VTEC code from the first warning 
was persisted.  The second Non-
Convective Flash Flood Warning 
contains updated VTEC coding. 

 

619.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

620.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

621.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘non-
convective FFW’ from the dropdown menu below the 
‘Other’ radio button.   
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 COR.KOAX.FF.W.xxxx(NEW) 
 NEW.KOAX.FF.W.xxxx 
 EXT.KOAX.FF.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

Correcting a Non-Convective Flash Flood Warning (COR) 
622.  In the WarnGen GUI, from the ‘Correct/Reissue’ 

dropdown, select the ‘COR’ product. 
The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

623.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 74 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
624.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Warning text remains displayed in the 
text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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625.  Verify the Non-Convective Flash Flood Warning text 
contains the Non-Convective Flash Flood Template 
Parameters selected. 

The PRIMARY CAUSE, DAM 
FAILURE REPORTED BY and CALLS 
TO ACTION exist in the Non-
Convective Flash Flood Warning 
statement. 

 

626.  Verify the Non-Convective Flash Flood Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

627.  Verify the Non-Convective Flash Flood Warning text 
contains the counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Non-
Convective Flash Flood Warning 
statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

628.  Verify the Non-Convective Flash Flood Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.COR.KOAX.FF.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

629.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

630.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Warning text contains a presence of 
closing $$. 
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Step Action Result Pass/Fail 
631.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Warning is saved. 
The text window displays the saved 
warning. 

 

632.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

633.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

634.  MB1 click the WarnGen button in the toolbar, select 
the Non-Convective Flash Flood radio button, and 
verify a line similar to the following appears: 

 ‘COR.KOAX.FF.W.xxxx(NEW)’ 

Verified.  

635.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

Continuing a Non-Convective Flash Flood Warning (CON) by Issuing a Follow-Up for a  
Non-Convective Flash Flood Warning (FFS) 

636.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button.  Select ‘non-convective FFS’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

637.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

638.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

639.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select the following warning bulletins: 

 PRIMARY CAUSE:  
 DAM FAILURE REPORTED BY:  
 CALLS TO ACTION: Turn around…dont 

drown 
Then MB1 click the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Statement text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
640.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Statement text remains displayed in 
the text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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641.  Verify the Non-Convective Flash Flood Statement 
text contains the Non-Convective Flash Flood 
Template Parameters selected. 

The PRIMARY CAUSE, DAM 
FAILURE REPORTED BY and CALLS 
TO ACTION exist in the Non-
Convective Flash Flood Statement text. 

 

642.  Verify the Non-Convective Flash Flood Statement 
text contains the current date and time attributes and 
the correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

643.  Verify the Non-Convective Flash Flood Statement 
text contains the counties encompassed by the 
polygon. 

The counties are listed in the Non-
Convective Flash Flood Statement text. 

DR #869 

644.  Verify the Non-Convective Flash Flood Statement 
text contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.CON.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

645.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

646.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. 

DR #782 

647.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Statement text contains a presence of 
closing $$. 
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Step Action Result Pass/Fail 
648.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Statement is saved. 
The text window displays the saved 
warning. 

 

649.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

650.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

651.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes. 

 

652.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button, 
Select ‘non-convective FFS’ from the dropdown 
menu below the ‘Other’ radio button.  
Then MB1 click the ‘FOLLOWUP’ dropdown menu. 
Verify a line similar to the following appears: 

 ‘COR.KOAX.FF.W.xxxx(CON) 

Verified. 
 

 

Extending a Non-Convective Flash Flood Warning (EXT) 
653.  In the WarnGen GUI, MB1 click the ‘Other’ radio 

button.  Select ‘non-convective FFW’ from the 
dropdown menu below the ‘Other’ radio button.   
Then MB1 click the ‘Correct/Extend /Reissue’ 
dropdown menu and select the ‘EXT’ product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

654.  Modify the polygon, the duration and bulletins to be 
displayed in the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
655.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Warning text remains displayed in the 
text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

656.  Verify the Non-Convective Flash Flood Warning text 
contains the Non-Convective Flash Flood Template 
Parameters selected. 

The PRIMARY CAUSE, DAM 
FAILURE REPORTED BY and CALLS 
TO ACTION exist in the Non-
Convective Flash Flood Warning 
statement. 

 

657.  Verify the Non-Convective Flash Flood Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

658.  Verify the Non-Convective Flash Flood Warning text 
contains the counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Non-
Convective Flash Flood Warning 
statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

659.  Verify the Non-Convective Flash Flood Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.EXT.KOAX.FF.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

660.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

661.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Warning text contains a presence of 
closing $$. 
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Step Action Result Pass/Fail 
662.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Warning is saved. 
The text window displays the saved 
warning. 

 

663.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

664.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

665.  MB1 click the WarnGen button in the toolbar, select 
the Non-Convective Flash Flood radio button, MB1 
click the ‘Correct/Extend/Reissue’ dropdown menu 
and verify a line similar to the following appears: 

 ‘COR.KOAX.FF.W.xxxx(EXT)’  

Verified.  

666.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

Continuing/Canceling a Non-Convective Flash Flood Warning (CON/CAN) 
667.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘non-convective FFS’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu. 

 

668.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options. 

 

669.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane. 

 

670.  Modify the warning polygon to remove at least one 
county from the original warning polygon. 
Select the following warning bulletins: 

 PRIMARY CAUSE: 
 DAM FAILURE REPORTED BY: 
 CALLS TO ACTION:  

Then MB1 click the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
671.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Warning text remains displayed in the 
text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

672.  Verify the Non-Convective Flash Flood Warning text 
contains the Non-Convective Flash Flood Template 
Parameters selected. 

The PRIMARY CAUSE, DAM 
FAILURE REPORTED BY and CALLS 
TO ACTION exist in the Non-
Convective Flash Flood Warning 
statement. 

 

673.  Verify the Non-Convective Flash Flood Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

674.  Verify the Non-Convective Flash Flood Warning text 
contains the counties encompassed by the polygon. 

The counties are listed in the Non-
Convective Flash Flood Warning 
statement. 

DR #869 

675.  Verify the Non-Convective Flash Flood Warning text 
contains the VTEC code above the BULLETIN 
section. The 2 lines of VTEC code should be in the 
following format: 
/O.CAN.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
/O.CON.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

676.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

677.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Warning text contains a presence of 
closing $$. 
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Step Action Result Pass/Fail 
678.  In the text window, replace the ‘!**NAME/INITIALS**!’ 

line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Warning is saved. 
The text window displays the saved 
warning. 

 

679.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

680.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

681.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes. 

 

682.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘non-
convective FFS’ from the dropdown menu below the 
‘Other’ radio button.  Then MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify two lines similar to the following appear:  

 ‘COR.KOAX.FF.W.xxxx(CON)’ 
 ‘COR.KOAX.FF.W.xxxx(CAN)’ 

Verified. 
 

 

Reissuing a Non-Convective Flash Flood Warning (NEW) 
683.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘non-convective FFW’ from the 
dropdown menu below the ‘Other’ radio button.   

‘Extend/Reissue’ appears in the 
dropdown menu. 

 

684.  From the ‘Extend/Reissue’ dropdown, select the 
‘NEW’ product. 

The polygon appears. 
The polygon is editable. 

 

685.  Modify the polygon, duration and bulletins for the 
warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
686.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Warning text remains displayed in the 
text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

687.  Verify the Non-Convective Flash Flood Warning text 
contains the Non-Convective Flash Flood Template 
Parameters selected. 

The PRIMARY CAUSE, DAM 
FAILURE REPORTED BY and CALLS 
TO ACTION exist in the Non-
Convective Flash Flood Warning 
statement. 

 

688.  Verify the Non-Convective Flash Flood Warning text 
contains the current date and time attributes and the 
correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

689.  Verify the Non-Convective Flash Flood Warning text 
contains the counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Non-
Convective Flash Flood Warning 
statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

690.  Verify the Non-Convective Flash Flood Warning text 
contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.NEW.KOAX.FF.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

691.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

692.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Warning text contains a presence of 
closing $$. 

 

693.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Warning is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
694.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

695.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

696.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes. 

 

697.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘non-
convective FFW’ from the dropdown menu below the 
‘Other’ radio button.  Then verify three lines similar to 
the following appear: 

 ‘COR.KOAX.FF.W.xxxx(NEW)’ 
 ‘NEW.KOAX.FF.W.xxxx’ 
 ‘EXT.KOAX.FF.W.xxxx’ 

Verified.  

Cancelling a Non-Convective Flash Flood Warning (CAN) 
698.  In the WarnGen GUI, MB1 click the ‘Other’ radio 

button.  Select ‘non-convective FFS’ from the 
dropdown menu below the ‘Other’ radio button.  From 
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ 
product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

699.  MB1 click the ‘Create Text’ button The Non-Convective Flash Flood 
Statement text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

700.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Statement text remains displayed in 
the text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 
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Step Action Result Pass/Fail 
701.  Verify the Non-Convective Flash Flood Statement 

text contains the current date and time attributes and 
the correct header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

702.  Verify the Non-Convective Flash Flood Statement 
text contains the counties encompassed by the 
polygon. 

The counties are listed in the Non-
Convective Flash Flood Statement text. DR #869 

703.  Verify the Non-Convective Flash Flood Statement 
text contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.CAN.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

704.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

705.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Statement text contains a presence of 
closing $$. 

 

706.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Statement is saved. 
The text window displays the saved 
warning. 

 

707.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

708.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

709.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes.  

710.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘non-convective FFS’ from the dropdown 
menu below the ‘Other’ radio button.   
Then MB1 click the ‘FOLLOWUP’ dropdown menu 
and verify a line similar to the following appears:  

 ‘COR.KOAX.FF.W.xxxx(CAN)’ 

Verified.  
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Step Action Result Pass/Fail 
711.  Close the WarnGen GUI. The WarnGen GUI closes.  

Expiring a Non-Convective Flash Flood Warning (EXP) 
712.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 

A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

713.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

714.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

715.  MB1 click on ‘non-convective FFS’ in the ‘Product 
type’ section. 

The selection is made as indicated by 
the radio button.  The PRIMARY 
CAUSE, DAM FAILURE REPORTED 
BY and CALLS TO ACTION sections 
update to display items applicable for 
Non-Convective Flash Flood Warnings. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

716.  Select the ‘Duration:’ to 15 min. The duration is set to 15 min. The 
ending time of the warning updates 
with the change in duration. 

DR #813 

717.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 
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Step Action Result Pass/Fail 
718.  In the WarnGen GUI, MB1 click on the 

‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

719.  MB1 within the Optional bullets section, select items 
such that the following Non-Convective Flash Flood 
Template Parameters are highlighted: 

 PRIMARY CAUSE: 
 DAM FAILURE REPORTED BY:  
 CALLS TO ACTION: Urban flooding… 

Then click MB1 on the ‘Create Text’ button. 

The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

720.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Warning text remains displayed in the 
text window in edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

721.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Warning is saved. 
The text window displays the saved 
warning. 

 

722.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFWOAX’ 
window (not in edit mode). 

 

723.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

724.  Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX 
window closes.  
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Step Action Result Pass/Fail 
725.  MB1 click the WarnGen button in the toolbar and 

select the ‘Other’ radio button. 
Select ‘non-convective FFS’ from the dropdown 
menu below the ‘Other’ radio button. 
Then MB1 click the ‘FOLLOWUP’ dropdown menu to 
verify the created warning is able to expired (EXP).  
Verify the line similar to the following appears: 

 EXP.KOAX.FF.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 

 

726.  Select the EXP product. The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

727.  MB1 click the ‘Create Text’ button. The Non-Convective Flash Flood 
Warning text appears in a ‘Text 
Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

728.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FFS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Non-Convective Flash Flood 
Statement text remains displayed in 
the text window in edit mode. 
The AWIPS Header Block window 
closes. 

 

729.  Verify the Non-Convective Flash Flood Statement 
text contains the current date and time attributes and 
the correct header information. 

The date and time attributes exist. 
The header information is correct.  

730.  Verify the Non-Convective Flash Flood Statement 
text contains the counties encompassed by the 
polygon. 

The counties are listed in the Non-
Convective Flash Flood Statement text.  

731.  Verify the Non-Convective Flash Flood Statement 
text contains the VTEC code above the BULLETIN 
section. The VTEC code should be in the following 
format: 
/O.EXP.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

732.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  
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Step Action Result Pass/Fail 
733.  Verify the location and motion of the weather event 

exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line.  

734.  Verify the text warning contains a presence of closing 
$$. 

The Non-Convective Flash Flood 
Statement text contains a presence of 
closing $$. 

 

735.  In the text window, replace the ‘!**NAME/INITIALS**!’ 
line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Non-Convective Flash Flood 
Statement is saved. 
The text window displays the saved 
warning. 

 

736.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFFSOAX’ window 
(not in edit mode). 

 

737.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

738.  Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX 
window closes.  

739.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘non-convective FFS’ from the dropdown 
menu below the ‘Other’ radio button.   
Verify in the ‘FOLLOWUP’ dropdown menu that an 
expired product (EXP) that appears as follows: 

 ‘COR.KOAX.FF.W.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the Update List 
dropdown menu. 

 

740.  Close the WarnGen GUI. The WarnGen GUI closes.  
Areal Flood Warning 
Issuing an Areal Flood Warning 

741.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

742.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 
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Step Action Result Pass/Fail 
743.  In the ‘WarnGen’ window, select the following: 

-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons.  

744.  MB1 click on ‘Other’ in the ‘Product type’ section.  
Select ‘Areal Flood Warning’ from the dropdown 
menu below the ‘Other’ radio button.   

The selection is made as indicated by 
the radio button.  The primary cause 
other than rain and CALLS TO 
ACTION sections update to display 
items applicable for Areal Flood 
Warnings. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

745.  Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The 
ending time of the warning updates 
with the change in duration. 

DR #813 

746.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

747.  In the WarnGen GUI, MB1 click on the 
‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

748.  MB1 within the Optional bullets section, select items 
such that the following Areal Flood Template 
Parameters are highlighted: 

 primary cause other than rain: Ice Jam 
 CALLS TO ACTION: Do not drive into water 

Then click MB1 on the ‘Create Text’ button. 

The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 90 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
749.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

750.  Verify the Areal Flood Warning text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Warning statement. 

 

751.  Verify the Areal Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

752.  Verify the Areal Flood Warning text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

753.  Verify the Areal Flood Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.FA.W.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.IC.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

754.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

755.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Warning text contains 
a presence of closing $$. 

 

756.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Warning is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
757.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLWOAX’ 
window (not in edit mode). 

 

758.  Note the VTEC code (the ‘FA.W.xxxx’ portion in 
particular). 

 
FA.W.________________ 

 

759.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

760.  Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX 
window closes. 

 

761.  MB1 click the WarnGen button in the toolbar and 
select the ‘Areal Flood Warning’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 NEW.KOAX.FA.W.xxxx 
 EXT.KOAX.FA.W.xxxx 
 COR.KOAX.FA.W.xxxx(NEW) 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

762.  Create another Areal Flood Warning by repeating 
steps 724-739, but choosing different options within 
the ‘WarnGen: Operational’ window. 

The new Areal Flood Warning displays 
in the text window. 

 

763.  Verify the VTEC code in the warning is different from 
the first Areal Flood Warning (e.g., FA.W.0001 
becomes FA.W.0002). 

The VTEC code from the first warning 
was persisted.  The second Areal 
Flood Warning contains updated VTEC 
coding. 

 

764.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

765.  Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX 
window closes. 
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Step Action Result Pass/Fail 
766.  MB1 click the WarnGen button in the toolbar and 

select the ‘Other’ radio button.  Select ‘Areal Flood 
Warning’ from the dropdown menu below the ‘Other’ 
radio button.   
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 COR.KOAX.FA.W.xxxx(NEW) 
 NEW.KOAX.FA.W.xxxx 
 EXT.KOAX.FA.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

Correcting an Areal Flood Warning (COR) 
767.  In the WarnGen GUI, from the ‘Correct/Reissue’ 

dropdown, select the ‘COR’ product. 
The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

768.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

769.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

770.  Verify the Areal Flood Warning text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Warning statement. 

 

771.  Verify the Areal Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 
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Step Action Result Pass/Fail 
772.  Verify the Areal Flood Warning text contains the 

counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

773.  Verify the Areal Flood Warning text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.COR.KOAX.FA.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

774.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

775.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Warning text contains 
a presence of closing $$. 

 

776.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Warning is saved. 
The text window displays the saved 
warning. 

 

777.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLWOAX’ 
window (not in edit mode). 

 

778.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

779.  MB1 click the WarnGen button in the toolbar, select 
the Areal Flood radio button, and verify a line similar 
to the following appears: 

 ‘COR.KOAX.FA.W.xxxx(NEW)’ 

Verified.  

780.  Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX 
window closes. 
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Step Action Result Pass/Fail 
Continuing an Areal Flood Warning (CON) by Issuing a Follow-Up for an Areal Flood Warning (FLS) 

781.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button.  Select ‘Areal Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu.  

782.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options.  

783.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane.  

784.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select the following warning bulletins: 

 primary cause other than rain:  
 CALLS TO ACTION: Turn around…dont 

drown 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Statement text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

785.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

786.  Verify the Areal Flood Statement text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Statement text. 

 

787.  Verify the Areal Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

788.  Verify the Areal Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Statement text. DR #869 
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Step Action Result Pass/Fail 
789.  Verify the Areal Flood Statement text contains the 

VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CON.KOAX.FA.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

790.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

791.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. DR #782 

792.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Statement text 
contains a presence of closing $$.  

793.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Statement is saved. 
The text window displays the saved 
warning. 

 

794.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

795.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

796.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

797.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button, 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.  
Then MB1 click the ‘FOLLOWUP’ dropdown menu. 
Verify a line similar to the following appears: 

 ‘COR.KOAX.FA.W.xxxx(CON) 

Verified. 
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Step Action Result Pass/Fail 
Extending an Areal Flood Warning (EXT) 

798.  In the WarnGen GUI, MB1 click the ‘Other’ radio 
button.  Select ‘Areal Flood Warning’ from the 
dropdown menu below the ‘Other’ radio button.   
Then MB1 click the ‘Correct/Extend /Reissue’ 
dropdown menu and select the ‘EXT’ product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

799.  Modify the polygon, the duration and bulletins to be 
displayed in the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

800.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

801.  Verify the Areal Flood Warning text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Warning statement. 

 

802.  Verify the Areal Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

803.  Verify the Areal Flood Warning text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 
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Step Action Result Pass/Fail 
804.  Verify the Areal Flood Warning text contains the 

VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXT.KOAX.FA.W.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

805.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

806.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Warning text contains 
a presence of closing $$. 

 

807.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Warning is saved. 
The text window displays the saved 
warning. 

 

808.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLWOAX’ 
window (not in edit mode). 

 

809.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

810.  MB1 click the WarnGen button in the toolbar, select 
the Areal Flood radio button, MB1 click the 
‘Correct/Extend/Reissue’ dropdown menu and verify 
a line similar to the following appears: 

 ‘COR.KOAX.FA.W.xxxx(EXT)’  

Verified.  

811.  Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX 
window closes. 
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Step Action Result Pass/Fail 
Continuing/Canceling an Areal Flood Warning (CON/CAN) 

812.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 
button.  Select ‘Areal Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu.  

813.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options.  

814.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane.  

815.  Modify the warning polygon to remove at least one 
county from the original warning polygon. 
Select the following warning bulletins: 

 primary cause other than rain: 
 CALLS TO ACTION:  

Then MB1 click the ‘Create Text’ button. 

The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

816.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

817.  Verify the Areal Flood Warning text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Warning statement. 

 

818.  Verify the Areal Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

819.  Verify the Areal Flood Warning text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Warning statement. 

DR #869 
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Step Action Result Pass/Fail 
820.  Verify the Areal Flood Warning text contains the 

VTEC code above the BULLETIN section. The 2 
lines of VTEC code should be in the following format: 
/O.CAN.KOAX.FA.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
/O.CON.KOAX.FA.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

821.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

822.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Warning text contains 
a presence of closing $$. 

 

823.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Warning is saved. 
The text window displays the saved 
warning. 

 

824.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

825.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

826.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes. 
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Step Action Result Pass/Fail 
827.  MB1 click the WarnGen button in the toolbar and 

select the ‘Other’ radio button.  Select ‘Areal Flood 
Statement’ from the dropdown menu below the 
‘Other’ radio button.  Then MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify two lines similar to the following appear:  

 ‘COR.KOAX.FA.W.xxxx(CON)’ 
 ‘COR.KOAX.FA.W.xxxx(CAN)’ 

Verified. 
 

 

Reissuing an Areal Flood Warning (NEW) 
828.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘Areal Flood Warning’ from the 
dropdown menu below the ‘Other’ radio button.   

‘Extend/Reissue’ appears in the 
dropdown menu.  

829.  From the ‘Extend/Reissue’ dropdown, select the 
‘NEW’ product. 

The polygon appears. 
The polygon is editable. 

 

830.  Modify the polygon, duration and bulletins for the 
warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

831.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

832.  Verify the Areal Flood Warning text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Warning statement. 

 

833.  Verify the Areal Flood Warning text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

834.  Verify the Areal Flood Warning text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Warning statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 
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Step Action Result Pass/Fail 
835.  Verify the Areal Flood Warning text contains the 

VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.FA.W.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

836.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

837.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Warning text contains 
a presence of closing $$. 

 

838.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Warning is saved. 
The text window displays the saved 
warning. 

 

839.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLWOAX’ 
window (not in edit mode). 

 

840.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

841.  Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX 
window closes. 

 

842.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘Areal Flood 
Warning’ from the dropdown menu below the ‘Other’ 
radio button.  Then verify three lines similar to the 
following appear: 

 ‘COR.KOAX.FA.W.xxxx(NEW)’ 
 ‘NEW.KOAX.FA.W.xxxx’ 
 ‘EXT.KOAX.FA.W.xxxx’ 

Verified.  



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 102 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
Cancelling an Areal Flood Warning (CAN) 

843.  In the WarnGen GUI, MB1 click the ‘Other’ radio 
button.  Select ‘Areal Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.  From 
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ 
product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

844.  MB1 click the ‘Create Text’ button. The Areal Flood Statement text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

845.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

846.  Verify the Areal Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

847.  Verify the Areal Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Statement text. 

DR #869 

848.  Verify the Areal Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CAN.KOAX.FA.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

849.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

850.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Statement text 
contains a presence of closing $$. 
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Step Action Result Pass/Fail 
851.  In the text window, replace the ‘!**WARNING 

BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Statement is saved. 
The text window displays the saved 
warning. 

 

852.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

853.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

854.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes. 

 

855.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.   
Then MB1 click the ‘FOLLOWUP’ dropdown menu 
and verify a line similar to the following appears:  

 ‘COR.KOAX.FA.W.xxxx(CAN)’ 

Verified.  

856.  Close the WarnGen GUI. The WarnGen GUI closes.  
Expiring an Areal Flood Warning (EXP) 

857.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

858.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 
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Step Action Result Pass/Fail 
859.  In the ‘WarnGen’ window, select the following: 

-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

860.  MB1 click on ‘Areal Flood Statement’ in the ‘Product 
type’ section. 

The selection is made as indicated by 
the radio button.  The primary cause 
other than rain and CALLS TO 
ACTION sections update to display 
items applicable for Areal Flood 
Warnings. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

861.  Select the ‘Duration:’ to 15 min. The duration is set to 15 min. The 
ending time of the warning updates 
with the change in duration. 

DR #813 

862.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

863.  In the WarnGen GUI, MB1 click on the 
‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

864.  MB1 within the Optional bullets section, select items 
such that the following Areal Flood Template 
Parameters are highlighted: 

 primary cause other than rain: 
 CALLS TO ACTION: Urban flooding… 

Then click MB1 on the ‘Create Text’ button. 

The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
865.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLW 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Warning text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

866.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Warning is saved. 
The text window displays the saved 
warning. 

 

867.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLWOAX’ 
window (not in edit mode). 

 

868.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

869.  Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX 
window closes. 

 

870.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button. 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button. 
Then MB1 click the ‘FOLLOWUP’ dropdown menu to 
verify the created warning is able to expired (EXP).  
Verify the line similar to the following appears: 

 EXP.KOAX.FA.W.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 
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Step Action Result Pass/Fail 
871.  Select the EXP product. The polygon appears. 

The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

872.  MB1 click the ‘Create Text’ button. The Areal Flood Warning text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

873.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

 

874.  Verify the Areal Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

 

875.  Verify the Areal Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Statement text.  

876.  Verify the Areal Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXP.KOAX.FA.W.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

877.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

878.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line.  

879.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Statement text 
contains a presence of closing $$.  
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Step Action Result Pass/Fail 
880.  In the text window, replace the ‘!**WARNING 

BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Statement is saved. 
The text window displays the saved 
warning. 

 

881.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

882.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

883.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

884.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.   
Verify in the ‘FOLLOWUP’ dropdown menu that an 
expired product (EXP) that appears as follows: 

 ‘COR.KOAX.FA.W.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the Update List 
dropdown menu. 

 

885.  Close the WarnGen GUI. The WarnGen GUI closes.  
Areal Flood Advisory 
Issuing an Areal Flood Advisory 

886.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 
A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

887.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 
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Step Action Result Pass/Fail 
888.  In the ‘WarnGen’ window, select the following: 

-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons. 

 

889.  MB1 click on ‘Other’ in the ‘Product type’ section.  
Select ‘Areal Flood Advisory’ from the dropdown 
menu below the ‘Other’ radio button.   

The selection is made as indicated by 
the radio button.  The primary cause 
other than rain and CALLS TO 
ACTION sections update to display 
items applicable for Areal Flood 
Advisories. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

890.  Select the ‘Duration:’ to 3:00 hours. The duration is set to 3:00 hours. The 
ending time of the warning updates 
with the change in duration. 

DR #813 

891.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 

 

892.  In the WarnGen GUI, MB1 click on the 
‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

893.  MB1 within the Optional bullets section, select items 
such that the following Areal Flood Template 
Parameters are highlighted: 

 if not generic flood advisory: hydrologic 
 Hydrologic conditions/causes if applicable: 

snow melt 
 CALLS TO ACTION: Urban flooding 

Then click MB1 on the ‘Create Text’ button. 

The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
894.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Advisory text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
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895.  Verify the Areal Flood Advisory text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Advisory statement. 

 

896.  Verify the Areal Flood Advisory text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

897.  Verify the Areal Flood Advisory text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Advisory statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

898.  Verify the Areal Flood Advisory text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.FA.Y.0001.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.IC.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

899.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product. 

 

900.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Advisory text contains 
a presence of closing $$. 
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Step Action Result Pass/Fail 
901.  In the text window, replace the ‘!**WARNING 

BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Advisory is saved. 
The text window displays the saved 
warning. 

 

902.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

903.  Note the VTEC code (the ‘FA.Y.xxxx’ portion in 
particular). 

 
FA.Y.________________ 

 

904.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

905.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes. 

 

906.  MB1 click the WarnGen button in the toolbar and 
select the ‘Areal Flood Advisory’ radio button. 
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 NEW.KOAX.FA.Y.xxxx 
 EXT.KOAX.FA.Y.xxxx 
 COR.KOAX.FA.Y.xxxx(NEW) 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

907.  Create another Areal Flood Advisory by repeating 
steps 869-884, but choosing different options within 
the ‘WarnGen: Operational’ window. 

The new Areal Flood Advisory displays 
in the text window. 

 

908.  Verify the VTEC code in the warning is different from 
the first Areal Flood Advisory (e.g., FA.Y.0001 
becomes FA.Y.0002). 

The VTEC code from the first warning 
was persisted.  The second Areal 
Flood Advisory contains updated VTEC 
coding. 

 

909.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  
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Step Action Result Pass/Fail 
910.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 

window closes. 
 

911.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘Areal Flood 
Advisory’ from the dropdown menu below the ‘Other’ 
radio button.   
Then MB1 click the ‘Correct/Reissue’ dropdown 
menu to verify the created warning is able to be 
corrected (COR), extended (EXT) or reissued (NEW).  
Verify three lines similar to the following appear: 

 COR.KOAX.FA.Y.xxxx(NEW) 
 NEW.KOAX.FA.Y.xxxx 
 EXT.KOAX.FA.Y.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be corrected (COR), extended 
(EXT) or reissued (NEW). 

 

Correcting an Areal Flood Advisory (COR) 
912.  In the WarnGen GUI, from the ‘Correct/Reissue’ 

dropdown, select the ‘COR’ product. 
The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

913.  Change the duration and bulletins to be displayed in 
the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

914.  In the AWIPS Header Block, verify the following 
selections are set: 

 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Advisory text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

915.  Verify the Areal Flood Advisory text contains the 
Areal Flood Template Parameters selected. 

The primary cause other than rain and 
CALLS TO ACTION exist in the Areal 
Flood Advisory statement. 

 

916.  Verify the Areal Flood Advisory text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

917.  Verify the Areal Flood Advisory text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Advisory statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 
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Step Action Result Pass/Fail 
918.  Verify the Areal Flood Advisory text contains the 

VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.COR.KOAX.FA.Y.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

919.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

920.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Advisory text contains 
a presence of closing $$.  

921.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Advisory is saved. 
The text window displays the saved 
warning. 

 

922.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

923.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

924.  MB1 click the WarnGen button in the toolbar, select 
the Areal Flood radio button, and verify a line similar 
to the following appears: 

 ‘COR.KOAX.FA.Y.xxxx(NEW)’ 

Verified.  

925.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

Continuing an Areal Flood Advisory (CON) by Issuing a Follow-Up for an Areal Flood Advisory (FLS) 
926.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘Areal Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu.  

927.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options.  
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Step Action Result Pass/Fail 
928.  MB1 click the ‘CON’ option. The vector and polygon of the original 

warning appear on the main pane.  

929.  Modify the warning polygon, but do not remove any 
counties from the original warning polygon. 
MB1 click the ‘Warned/Hatched Area’ button. 
Note: The polygon can only be reduced in size. 
Select the following warning bulletins: 

• If not generic flood advisory: 
• Hydrologic conditions/causes if applicable:  
• CALLS TO ACTION: Turn around…dont 

drown 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Statement text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

930.  In the AWIPS Header Block, verify the following 
selections are set: 

• TTAAii: SAUS43 
• CCCC: KOAX 
• BBB: NOR 
• BBB Version: A (grayed out) 
• WSFO ID: OMA 
• Product Category: FLS 
• Product Designator: OAX 
• Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

931.  Verify the Areal Flood Statement text contains the 
Areal Flood Template Parameters selected. 

The if not generic flood advisory, 
Hydrologic conditions/causes if 
applicable, and CALLS TO ACTION 
exist in the Areal Flood Statement text. 

 

932.  Verify the Areal Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

933.  Verify the Areal Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Statement text. DR #869 

934.  Verify the Areal Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CON.KOAX.FA.Y.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  
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Step Action Result Pass/Fail 
935.  Verify the Lat/Lon coordinates appear in the text 

warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

936.  Verify the location and motion of the weather event 
exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line. DR #782 

937.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Statement text 
contains a presence of closing $$.  

938.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Statement is saved. 
The text window displays the saved 
warning. 

 

939.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

940.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

941.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

942.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button, 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.  
Then MB1 click the ‘FOLLOWUP’ dropdown menu. 
Verify a line similar to the following appears: 

• ‘COR.KOAX.FA.Y.xxxx(CON) 

Verified. 
 

 

Extending an Areal Flood Advisory (EXT) 
943.  In the WarnGen GUI, MB1 click the ‘Other’ radio 

button.  Select ‘Areal Flood Advisory’ from the 
dropdown menu below the ‘Other’ radio button.   
Then MB1 click the ‘Correct/Extend /Reissue’ 
dropdown menu and select the ‘EXT’ product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 

 

944.  Modify the polygon, the duration and bulletins to be 
displayed in the warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 



Test Case WarnGen 2.0 (Draft)  DCN AWP.TE.SWCTR/T010-0005 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 115 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step Action Result Pass/Fail 
945.  In the AWIPS Header Block, verify the following 

selections are set: 
• TTAAii: SAUS43 
• CCCC: KOAX 
• BBB: NOR 
• BBB Version: A (grayed out) 
• WSFO ID: OMA 
• Product Category: FLS 
• Product Designator: OAX 
• Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Advisory text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

946.  Verify the Areal Flood Advisory text contains the 
Areal Flood Template Parameters selected. 

The if not generic flood advisory, 
Hydrologic conditions/causes if 
applicable, and CALLS TO ACTION 
exist in the Areal Flood Advisory 
statement. 

 

947.  Verify the Areal Flood Advisory text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

948.  Verify the Areal Flood Advisory text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Advisory statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

949.  Verify the Areal Flood Advisory text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXT.KOAX.FA.Y.xxxx.YYMMDDTHHmmZ- 
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

950.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

951.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Advisory text contains 
a presence of closing $$.  
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Step Action Result Pass/Fail 
952.  In the text window, replace the ‘!**WARNING 

BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Advisory is saved. 
The text window displays the saved 
warning. 

 

953.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway? 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

954.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

955.  MB1 click the WarnGen button in the toolbar, select 
the Areal Flood radio button, MB1 click the 
‘Correct/Extend/Reissue’ dropdown menu and verify 
a line similar to the following appears: 

 ‘COR.KOAX.FA.Y.xxxx(EXT)’  

Verified.  

956.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

Continuing/Canceling an Areal Flood Advisory (CON/CAN) 
957.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘Areal Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.   

‘FOLLOWUP’ appears in the dropdown 
menu.  

958.  MB1 click on the ‘FOLLOWUP’ dropdown menu and 
verify the ‘CON’ and ‘CAN’ options are available. 

The list includes the ‘CON’ and ‘CAN’ 
options.  

959.  MB1 click the ‘CON’ option. The vector and polygon of the original 
warning appear on the main pane.  

960.  Modify the warning polygon to remove at least one 
county from the original warning polygon. 
Select the following warning bulletins: 

 if not generic flood advisory: 
 Hydrologic conditions/causes if applicable: 
 CALLS TO ACTION:  

Then MB1 click the ‘Create Text’ button. 

The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
961.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Advisory text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

962.  Verify the Areal Flood Advisory text contains the 
Areal Flood Template Parameters selected. 

The if not generic flood advisory, 
Hydrologic conditions/causes if 
applicable, and CALLS TO ACTION 
exist in the Areal Flood Advisory 
statement. 

 

963.  Verify the Areal Flood Advisory text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

964.  Verify the Areal Flood Advisory text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Advisory statement. DR #869 

965.  Verify the Areal Flood Advisory text contains the 
VTEC code above the BULLETIN section. The 2 
lines of VTEC code should be in the following format: 
/O.CAN.KOAX.FA.Y.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
/O.CON.KOAX.FA.Y.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
/00000.0.DM.000000T0000Z.000000T0000Z. 
000000T0000Z.00/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

966.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

967.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Advisory text contains 
a presence of closing $$.  
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Step Action Result Pass/Fail 
968.  In the text window, replace the ‘!**WARNING 

BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Advisory is saved. 
The text window displays the saved 
warning. 

 

969.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

970.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

971.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

972.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘Areal Flood 
Statement’ from the dropdown menu below the 
‘Other’ radio button.  Then MB1 click the 
‘FOLLOWUP’ dropdown menu. 
Verify two lines similar to the following appear:  

• ‘COR.KOAX.FA.Y.xxxx(CON)’ 
• ‘COR.KOAX.FA.Y.xxxx(CAN)’ 

Verified. 
  

Reissuing an Areal Flood Advisory (NEW) 
973.  In the WarnGen GUI, MB1 click on the ‘Other’ radio 

button.  Select ‘Areal Flood Advisory’ from the 
dropdown menu below the ‘Other’ radio button.   

‘Extend/Reissue’ appears in the 
dropdown menu.  

974.  From the ‘Extend/Reissue’ dropdown, select the 
‘NEW’ product. 

The polygon appears. 
The polygon is editable. 

 

975.  Modify the polygon, duration and bulletins for the 
warning text product. 
Then MB1 click the ‘Create Text’ button. 

The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 
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Step Action Result Pass/Fail 
976.  In the AWIPS Header Block, verify the following 

selections are set: 
 TTAAii: SAUS43 
 CCCC: KOAX 
 BBB: NOR 
 BBB Version: A (grayed out) 
 WSFO ID: OMA 
 Product Category: FLS 
 Product Designator: OAX 
 Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Advisory text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

977.  Verify the Areal Flood Advisory text contains the 
Areal Flood Template Parameters selected. 

The if not generic flood advisory, 
Hydrologic conditions/causes if 
applicable, and CALLS TO ACTION 
exist in the Areal Flood Advisory 
statement. 

 

978.  Verify the Areal Flood Advisory text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

979.  Verify the Areal Flood Advisory text contains the 
counties encompassed by the polygon. 
Verify cities in the warning polygon are included in 
the pathcast.  

The counties are listed in the Areal 
Flood Advisory statement. 
The cities in the warning polygon are 
included in the warning. 

DR #869 

980.  Verify the Areal Flood Advisory text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.NEW.KOAX.FA.Y.xxxx.YYMMDDTHHmmZ-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

981.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

982.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Advisory text contains 
a presence of closing $$.  

983.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Advisory is saved. 
The text window displays the saved 
warning. 
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Step Action Result Pass/Fail 
984.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 

button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

985.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

986.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

987.  MB1 click the WarnGen button in the toolbar and 
select the ‘Other’ radio button.  Select ‘Areal Flood 
Advisory’ from the dropdown menu below the ‘Other’ 
radio button.  Then verify three lines similar to the 
following appear: 

• ‘COR.KOAX.FA.Y.xxxx(NEW)’ 
• ‘NEW.KOAX.FA.Y.xxxx’ 
• ‘EXT.KOAX.FA.Y.xxxx’ 

Verified.  

Cancelling an Areal Flood Advisory (CAN) 
988.  In the WarnGen GUI, MB1 click the ‘Other’ radio 

button.  Select ‘Areal Flood Statement’ from the 
dropdown menu below the ‘Other’ radio button.  From 
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ 
product. 

The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

989.  MB1 click the ‘Create Text’ button. The Areal Flood Statement text 
appears in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

990.  In the AWIPS Header Block, verify the following 
selections are set: 

• TTAAii: SAUS43 
• CCCC: KOAX 
• BBB: NOR 
• BBB Version: A (grayed out) 
• WSFO ID: OMA 
• Product Category: FLS 
• Product Designator: OAX 
• Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 
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Step Action Result Pass/Fail 
991.  Verify the Areal Flood Statement text contains the 

current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

DR #782 

992.  Verify the Areal Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Statement text. DR #869 

993.  Verify the Areal Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.CAN.KOAX.FA.Y.xxxx.000000T0000Z-
YYMMDDTHHmmZ/ 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

994.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  

995.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Statement text 
contains a presence of closing $$.  

996.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Statement is saved. 
The text window displays the saved 
warning. 

 

997.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

998.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

999.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

1000.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.   
Then MB1 click the ‘FOLLOWUP’ dropdown menu 
and verify a line similar to the following appears:  

• ‘COR.KOAX.FA.Y.xxxx(CAN)’ 

Verified.  

1001.  Close the WarnGen GUI. The WarnGen GUI closes.  
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Step Action Result Pass/Fail 
Expiring an Areal Flood Advisory (EXP) 
1002.  MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads. 

A ‘Drag me to Storm’ labeled point 
displays in the center of the CAVE 
display. This point is in edit mode.  
The WarnGen window appears. 

 

1003.  In the main pane, click and hold MB1 on the ‘Drag 
me to Storm’ point and drag it to another location 
(ideally on a feature picked up by the radar). 

A southwest-northeast oriented vector 
appears with the point near the center 
of the line, tick marks, and time values 
at the starting point, current/endpoint, 
and arrowhead. 
An initial warning area hatched box 
appears. 

DR #813 

1004.  In the ‘WarnGen’ window, select the following: 
-Track type: One Storm 
-Edit: Box and Track 

The selections are made as indicated 
by the radio buttons.  

1005.  MB1 click on ‘Areal Flood Statement’ in the ‘Product 
type’ section. 

The selection is made as indicated by 
the radio button.  The if not generic 
flood advisory, Hydrologic 
conditions/causes if applicable, and 
CALLS TO ACTION sections update to 
display items applicable for Areal Flood 
Advisories. 
The storm motion vector is removed 
from the main display, leaving only the 
hatched polygon. 

 

1006.  Select the ‘Duration:’ to 3:00 hours. The duration is set to 3:00 hours. The 
ending time of the warning updates 
with the change in duration. 

DR #813 

1007.  MB1 click and hold on a vertex and dragging it to 
another location outside the koax’s CWA boundary. 
At the same time, ensure that multiple KOAX 
counties are included in the warning polygon. 

The hatched area expands within the 
enclosed box up to the CWA boundary 
but does not cross over the CWA 
boundary. 
Multiple KOAX counties are included in 
the polygon. 
Note: If the polygon encompasses a 
portion of a county less than a 
specified percentage of the size of a 
county, the portion will not be hatched. 
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Step Action Result Pass/Fail 
1008.  In the WarnGen GUI, MB1 click on the 

‘Warned/Hatched Area’ button under the ‘Redraw 
Box on Screen from:’ section. 

The polygon’s vertices are redrawn on 
the vector snapping back to the CWA 
border while creating additional 
vertices. 
Portions of the county not hatched, as 
discussed in step 16, are not included 
in the updated polygon. 

 

1009.  MB1 within the Optional bullets section, select items 
such that the following Areal Flood Template 
Parameters are highlighted: 

• if not generic flood advisory: 
• Hydrologic conditions/causes if applicable: 
• CALLS TO ACTION:  

Then click MB1 on the ‘Create Text’ button. 

The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

1010.  In the AWIPS Header Block, verify the following 
selections are set: 

• TTAAii: SAUS43 
• CCCC: KOAX 
• BBB: NOR 
• BBB Version: A (grayed out) 
• WSFO ID: OMA 
• Product Category: FLS 
• Product Designator: OAX 
• Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Advisory text remains 
displayed in the text window in edit 
mode. 
The AWIPS Header Block window 
closes. 

DR #868 
DR #870 

1011.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Advisory is saved. 
The text window displays the saved 
warning. 

 

1012.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

1013.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning).   
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

1014.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  
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Step Action Result Pass/Fail 
1015.  MB1 click the WarnGen button in the toolbar and 

select the ‘Other’ radio button. 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button. 
Then MB1 click the ‘FOLLOWUP’ dropdown menu to 
verify the created warning is able to expired (EXP).  
Verify the line similar to the following appears: 

• EXP.KOAX.FA.Y.xxxx 

The warning is ingested as verified by 
observing that the ingested warning 
can be expired (EXP). 

 

1016.  Select the EXP product. The polygon appears. 
The polygon is uneditable as indicated 
by the square vertex points. 
The bulletins are grayed out. 

 

1017.  MB1 click the ‘Create Text’ button. The Areal Flood Advisory text appears 
in a ‘Text Warngen’ window. 
An ‘AWIPS Header Block’ window 
appears. 

 

1018.  In the AWIPS Header Block, verify the following 
selections are set: 

• TTAAii: SAUS43 
• CCCC: KOAX 
• BBB: NOR 
• BBB Version: A (grayed out) 
• WSFO ID: OMA 
• Product Category: FLS 
• Product Designator: OAX 
• Addressee: 000 

Then MB1 click the ‘Enter’ button. 

The Areal Flood Statement text 
remains displayed in the text window in 
edit mode. 
The AWIPS Header Block window 
closes. 

 

1019.  Verify the Areal Flood Statement text contains the 
current date and time attributes and the correct 
header information. 

The date and time attributes exist. 
The header information is correct. 

 

1020.  Verify the Areal Flood Statement text contains the 
counties encompassed by the polygon. 

The counties are listed in the Areal 
Flood Statement text.  

1021.  Verify the Areal Flood Statement text contains the 
VTEC code above the BULLETIN section. The VTEC 
code should be in the following format: 
/O.EXP.KOAX.FA.Y.xxxx.000000T0000Z-
YYMMDDTHHmmZ / 
Where the date and time attributes in the VTEC code 
match the warning’s start and end dates and times 
(UTC).  

The VTEC code exists and is accurate.  

1022.  Verify the Lat/Lon coordinates appear in the text 
warning product (E.g., LAT…LON 4471 9981 4488 
9977…). 

The Lat/Lon information exists in the 
text product.  
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Step Action Result Pass/Fail 
1023.  Verify the location and motion of the weather event 

exists below the LAT…LON line in the text warning 
product. 

The location and motion of the weather 
event exists below the LAT…LON line.  

1024.  Verify the text warning contains a presence of closing 
$$. 

The Areal Flood Statement text 
contains a presence of closing $$.  

1025.  In the text window, replace the ‘!**WARNING 
BASIS**!’ and ‘‘!--*optional description of the path of 
the flood--!’ lines with a word or phrase and the 
‘!**NAME/INITIALS**!’ line with the user’s initials. 
MB1 click the ‘Save’ button. 
Then MB1 click the ‘Send’ button. 

The Areal Flood Statement is saved. 
The text window displays the saved 
warning. 

 

1026.  MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ 
button in the message box that states ‘Any unsaved 
changes will be lost.  Cancel anyway?’. 

A Confirm Cancel window opens. 
The Confirm Cancel window closes. 
The warning remains displayed in the 
‘Text WarnGen: OMAFLSOAX’ window 
(not in edit mode). 

 

1027.  Ingest the warning text file into the ‘warning’ endpoint 
(/awips/edex/opt/data/sbn/warning). 
(Note: The created warning needs to be manually 
ingested for display in WarnGen.  Direct save to 
ingest will be implemented in a later TO.) 

The warning is ingested.  

1028.  Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX 
window closes.  

1029.  MB1 click the WarnGen button in the toolbar, select 
the ‘Other’ radio button. 
Select ‘Areal Flood Statement’ from the dropdown 
menu below the ‘Other’ radio button.   
Verify in the ‘FOLLOWUP’ dropdown menu that an 
expired product (EXP) that appears as follows: 

• ‘COR.KOAX.FA.Y.xxxx(EXP)’ 

The warning is ingested as verified by 
observing that the expired product 
(EXP) exists in the Update List 
dropdown menu. 

 

1030.  Close the WarnGen GUI. The WarnGen GUI closes.  
End of TO10 Test 
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5.0 TO8 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
CAVE_TO8_013 CAVE shall contain a WarnGen capability  
CAVE_TO8_013.1 A 'WarnGen: Operational' GUI shall display when the WarnGen 

button is selected from the menu bar 
 

CAVE_TO8_013.3 WarnGen shall allow the user to designate the type of warning  
CAVE_TO8_013.4 WarnGen shall allow the user to select to warn on a single storm  
CAVE_TO8_013.5 WarnGen shall allow the user to select to warn on a line of storms  
CAVE_TO8_013.5.2 WarnGen shall allow the user to issue a Severe Thunderstorm 

Warning for a line of storms 
 

CAVE_TO8_013.5.3 WarnGen shall allow the user to issue a Tornado Warning for a 
single storm 

 

CAVE_TO8_013.16 WarnGen shall allow the user to designate the duration of the 
warning 

 

CAVE_TO8_013.18 WarnGen shall allow the user to establish a storm track  
CAVE_TO8_013.19 WarnGen shall allow the user to establish a warning area  
CAVE_TO8_013.19.1 WarnGen shall allow the user to redraw the warning box in CAVE 

using MB1 in the WarnGen: Operational window 
 

CAVE_TO8_013.20 WarnGen shall allow the user to select optional text bullets to be 
included in the warning text 

 

CAVE_TO8_013.22 WarnGen shall allow the user to send the warning information to 
the text window 

 

CAVE_TO8_013.28 WarnGen shall allow the user to Create the Text using MB1 on the 
'Create Text' button 

 

CAVE_TO8_013.28.1 WarnGen shall translate the storm path into text describing the 
speed and direction of the storm, and the counties and cities 
affected by the warning 

 

CAVE_TO8_013.28.2 WarnGen shall generate the warning text that includes any 
optional bullets selected 

 

CAVE_TO8_013.28.3 WarnGen text warning shall contain correct header information  
CAVE_TO8_013.28.4 WarnGen text warning shall contain proper UGC and VTEC codes  
CAVE_TO8_013.28.5 WarnGen text warning shall maintain time and Time Zone 

consistency 
 

CAVE_TO8_013.28.6 WarnGen text warning shall contain correct product type  
CAVE_TO8_013.28.8 WarnGen text warning shall contain a presence of closing $$  
CAVE_TO8_013.31 CAVE shall have the ability to overlay WarnGen on displayed 

weather data 
 

CAVE_TO8_013.32 CAVE shall contain the Warning by Polygon functionality  
CAVE_TO8_013.32.1 CAVE shall draw a hatched area encompassed by the drawn 

polygon 
 

CAVE_TO8_013.32.2 The hatched area shall be described by the LAT…LON 
coordinates in the text warning product 
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Number Description Test Step(s) 
CAVE_TO8_013.32.3 WarnGen shall not allow the warned area to cross over CWAs  
CAVE_TO8_013.32.8 WarnGen shall encode the location and motion of the weather 

event below the LAT…LON line in the text warning product 
 

CAVE_TO8_013.33 WarnGen shall be activated by using MB1 on the yellow WarnGen 
button on the CAVE menu bar 

 

EDEX_T08_019.16 EDEX shall implement VTEC coding through WarnGen  
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6.0 TO9 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR2094 The AWIPS system shall implement the Text Product Decoder for 

warnings.  

SYSR3054 

The AWIPS System shall create the SVR - Severe Thunderstorm 
Warning product as produced by the Public and Fire Weather Services 
WarnGen Application. 

 

SYSR3055 

The AWIPS System shall create the SVS - Severe Weather Statement 
product as produced by the Public and Fire Weather Services WarnGen 
Application. 

 

SYSR3056 

The AWIPS System shall create the TOR - Tornado Warning product as 
produced by the Public and Fire Weather Services WarnGen 
Application. 
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7.0 TO10 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• GHG Monitor 
 

2.2 Reference Documents 
• Software Test Plan for the Advanced Weather Interactive Processing System 

Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the capabilities in GFE that involve creating Hazards grids through 
the Make Hazard dialog, separating hazards and merging hazards. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested.  
• Actions, Results, and Requirements highlighted in yellow indicate requirements 

and/or capabilities to be included in the scope of future task orders. They are included 
here for purposes of continuity and traceability with the original AWIPS I test case 
documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon  and select ‘Other’. 
The Open Perspective dialog appears.  

2.  MB1 click ‘GFE’. Then MB1 click ‘OK’. The Open Perspective dialog closes. 
The GFE Perspective loads in CAVE. 

 

3.  From the Main Menu, select ‘Hazards’ -> 
‘MakeHazard’. 

The MakeHazard dialog box appears.  

4.  From the MakeHazard dialog box, select 
an available hazard from the hazard list. 
Then MB1 click and drag over the adjacent 
forecast zone map to select a forecast 
zone(s) for the hazard. Adjust the forecast 
start and end times (automatically set an 
hour apart) for the hazard at the column to 
the right. MB1 click ‘Run’ to save the 
selections.  

The selections are made and saved. The 
MakeHazard dialog remains open. 

 

5.  Repeat step 4 to create a second hazard. 
MB1 click ‘Run/Dismiss’ to save the 
selections. 

The selections are made and saved. The 
MakeHazard dialog closes. 

 

6.  From the Main Menu, MB1 click ‘Hazards’ -
> ‘MergeHazards’ to merge the Hazards on 
the main display. 

The Hazards merge.  

7.  From the Main Menu, MB1 click the ‘Save 

Forecast’ icon . The Save Forecast 
dialog box appears. MB1 click ‘Save 
Forecast’ to save changes made to the 
main display. 

The changes are saved.  

8.  From the Main Menu, select ‘Products’ -> 
‘Formatter Launcher’.  

The Formatter Launcher dialog box appears.  

9.  From the Formatter Launcher dialog box, 
select ‘Products’ -> ‘Hazard’ -> <the 
Hazard created above>. Then MB1 click 
the ‘Run Formatter’ icon  to run the 
Formatter Launcher. Verify that there is a 
message and that the VTEC code displays.  

A message displays in the text area. 
The VTEC code is present. 

 

10.  Close the Formatter Launcher dialog. The Formatter Launcher dialog closes.  
11.  In the Grid Manager, MB3 click and hold 

on a blank grid in the Hazards parm at a 
time in the future.  
Then select ‘Create From Scratch’ from the 
popup menu. 

The blank grid in the Grid Manager fills in with 
a gray grid (highlighted yellow since it is the 
selected grid). The grid is locked by the user 
as indicated by the green highlight.  

 



Test Case Hazards Grids (Draft)  DCN AWP.TE.SWCTR/T010-0006 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0006 / 21 Nov. 2008 5 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step # Action Result Pass/Fail 
12.  MB1 click the Edit Areas tool on the tool 

bar.  
Then draw a shape on the grid in the 
Spatial Editor. 

The Edit Areas tool is activated. 
An edit area is drawn in the Spatial Editor. 

 

13.  MB3 click and hold on the colorbar. In the 
popup menu, select ‘Set Pickup Value…’. 

The Define Discrete dialog appears.   

14.  Select a hazard from the dropdown menu. 
Then MB1 click the ‘Assign Value’ button. 

The edit area is assigned the selected 
hazard. 

 

15.  Draw a second edit area in the Spatial 
Editor. 

An edit area is drawn in the Spatial Editor.  

16.  In the Define Discrete dialog, select a 
different hazard. Then MB1 click the 
‘Assign Value’ button. 

The edit area is assigned the selected 
hazard. 

 

17.  Draw a third edit area in the Spatial Editor. An edit area is drawn in the Spatial Editor.  
18.  In the Define Discrete dialog, select a 

different hazard. Then MB1 click the 
‘Assign Value’ button. 

The edit area is assigned the selected 
hazard. 

 

19.  Close the Define Discrete dialog. The Define Discrete dialog closes.  
20.  Remove the edit area from the Spatial 

Editor by MB1 clicking the ‘Clear Edit Area’ 
button. 

The edit area is removed from the display.  

21.  From the menu bar, MB1 click ‘Hazards’ -> 
‘SeparateHazards’ to separate the Hazards 
on the main display. 

The Hazards separate into individual parms, 
one for each hazard. 

 

22.  MB1 click on the Pencil Tool on the 
toolbar. 

The Pencil Tool is activated.  

23.  Modify the hazards by MB1 dragging the 
cursor from inside the hazard area 
elsewhere, and releasing MB1 after 
returning to the hazard area. 

The hazards are modified.  

24.  From the menu bar, MB1 click ‘Hazards’ -> 
‘MergeHazards’ to merge the Hazards on 
the main display. 

The Hazards merge.  

25.  Verify all hazards merged successfully. Verified.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
 



 

This document includes data that shall not be duplicated, used, or disclosed – in whole or in part – outside the Government for 
any purpose other than to the extent provided in contract DG133W-05-CQ-1067. However, the Government shall have the right 
to duplicate, use, or disclose the data to the extent provided in the contract. This restriction does not limit the Government’s right 
to use information contained in this data if it is obtained from another source without restriction. The data subject to this 
restriction are contained in all sheets. 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO8 Text Display Edit 1.0 

2.2 Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• Section 4 of the AWIPS D-2D User’s Manual Build 8.1 
• Existing AWIPS 1 test procedures: 

– Baseline_TextDB_OB8.1 
– Checkout_4.3.9_TextWorkstation_OB8.1 
– Checkout_Text_Message_OB8.1 
– Checkout_TextWorkstation_OB8.1 
– Baseline_TextWKS_1.3.12.1_V1-E 
– TextWks_1.3.12.1 

• The Silver Spring NWS AWIPS I test bed application. 
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case, a replication of the TO8 test case of the same name, demonstrates the capability of 
CAVE to receive, recall, and display text products received via a live data feed (TO8 used 
“canned data”). This test case also demonstrates the capability to edit text products.  
 

3.1 Assumptions, Constraints, and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested. 
• The Text Workstation has been started. 
• The workstation is attached to a working printer. 
• TO10 testing repeats steps 1-47 with a live data feed. This test procedure was 

modified to remove the steps to create a text product required for prior tests. 
With a live data feed, these steps are not necessary. 

• Actions, Results, and Requirements highlighted in yellow indicate 
requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

• Text Generalization Pattern is deferred to a future TO, pending guidance from 
NWS (GSD). 

 

3.2 Recommended Hardware 
See Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 

3.4 Test Outputs 
• The text data will be displayed in the Text Window within CAVE. 
• Data will be printed from an attached printer. 
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4.0 TEST SCENARIO 

Step Action Result Pass/Fail 
Begin TO10 Test 
1.  Under the CAVE menu, click on ‘New’ and 

select ‘Text Workstation’. 
The Text Workstation control window and Text 
1 window open. 

 

2.  Select the ‘AFOS Browser’ button in the ‘Text 
1’ window. 

The Text 1 Browser window opens.  

3.  In the Text 1 Browser window, select: 
Origin: Central 
Class: Public 

The selections in the Node section change 
accordingly. 

 

4.  In the Text 1 AFOS Browser window, select a 
combination of available Nodes and Ctgry that 
return items in the Designator column. 

The Node and Ctgry become highlighted. 
Selections appear in the Designator and 
Display sections. The Node-Ctgry combination 
appears in the AFOS Cmd:  command line in 
the Text 1 window and ‘ALL:’ appears in the 
DISPLAY section. 

 

5.  Select an available item (one with a time and 
date or labeled as LATEST) in the Designator 
section. 

The item and its associated time become 
highlighted. The Designator item is also added 
in the AFOS Cmd: command line in the Text 1 
window. 

DR #797 

6.  Select ‘ALL:’ in the display section. Then 
select Load and Continue. 

The selected product is displayed in the Text 1 
window. The product name appears in the 
Text 1 window title. The AFOS Browser 
remains open. 

 

7.  Repeat steps 5-7 for another product. 
Then click the ‘Load and Continue’ button. 

The selected product displays in the text 
window. The previously displayed text product 
was removed from the text display. 

 

8.  Click on ‘Accum’. The ‘Accum’ box becomes selected.  
9.  Repeat steps 5 and 6 for another product. 

Then click the ‘Load and Close’ button. 
The selected product is added (Accum.) to the 
text product displayed in the Text 1 window. 
The product name appears in the Text 1 
window title. The AFOS Browser closes.  

 

10.  Unselect the ‘Accum’ option. 
Then click the ‘Clear’ button. 

The text window clears the text product.  

11.  In the AFOS Cmd: line, enter ‘OMAMTROMA’. 
Then press the ‘Enter’ key. 

The product is returned in the text window.  

12.  Click the ‘Clear’ button. The text window clears the text product.  
13.  Enter only a portion of a valid TTAAii CCCC 

(e.g., SAUS43) and press the ‘Enter’ key. 
An error message is returned stating no 
product in the database matches the request. 

 

14.  Click the ‘OK’ button. The message closes.  
15.  Click the ‘WMO Search’ button. 

 
A ‘Warning’ box appears asking the user to fill 
in the TTAAII and CCCC and press ENTER. 

 

16.  Click the ‘OK’ button. The ‘Warning’ window closes.  
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Step Action Result Pass/Fail 
17.  Enter a valid TTAAii CCCC (e.g., SAUS43 

KOAX) and press the ‘Enter’ key. 
The text product displays in the text window.  

18.  Click the ‘Clear’ button. The text window clears the text product.  
19.  Enter a valid AWIPS ID (e.g., TOROMA) into 

the ‘AWIPS ID’ text box. Then press the 
‘Enter’ key. 

The text product displays in the text window.  

20.  Click the ‘Clear’ button. The text window clears the text product.  
21.  In the Text 1 window, select the Enter Editor 

button. 
The Text 1 window becomes divided into a 
header section and a text section. A Header 
Block window also opens. 

 

22.  Enter ‘TST’ for the WSFO ID, Product 
Category and Product Designator in the 
‘Header Block’ window. Then click the ‘Enter’ 
button. 

A warning message appears that the ‘Product 
Designator TSTTSTTST is not in the list of 
valid products. Use it anyway?’ 

 

23.  Click the ‘Yes’ button. The ‘Header Block’ window closes. TSTTST 
appears in the header section. The user is in 
edit mode. 

 

24.  Create a message of 3 sentences in the text 
window. Ensure return was used after each 
sentence and at least one line is greater than 
85 characters where the line wraps 
automatically. 

The text is entered into the text window. The 
text wraps within the window. 

 

25.  Click and drag the mouse over a section of 
the text. Then click the ‘Cut’ button. 

The highlighted section is removed from the 
text product. 

 

26.  In a different area of the text product, click the 
‘Paste’ button. 

The cut portion of the text is pasted into the 
text product. 

 

27.  Click and drag the mouse over the entire text 
message.  
Then click the ‘Fill’ button. 

The space within the text created by the 
Enter/Return button is filled in. 

 

28.  Click and drag the mouse over a section of 
the text. Then click the ‘Copy’ button. 

The highlighted section is copied.  

29.  In a different area of the text product, click the 
‘Paste’ button. 

The copied portion of the text is pasted into 
the text product. 

 

30.  Click ‘Options’ in the menu bar, select ‘Font 
Size’, and select ‘Large’. 

The font size increases in size.  

31.  Click ‘INS’ from the edit menu bar. Choose 
‘Overstrike Mode’. 

‘INS’ changes to ‘OVR’.  

32.  Place the cursor within the text and type a 
word. 

The text entered over the existing text.  

33.  Click the ‘Save’ button. The message is saved as the AFOS Cmd: 
TSTTSTTST. 

 

34.  Click the ‘Cancel’ button. A ‘Confirm Cancel’ window appears stating 
‘Any unsaved changes will be lost. Cancel 
anyway?’. 
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Step Action Result Pass/Fail 
35.  Click the ‘Yes’ button. The ‘Confirm Cancel’ window closes. The text 

window exits from edit mode. 
 

36.  Click the ‘Clear’ button. The text window clears the text product.  
37.  In the AFOS Cmd: line, enter ‘TSTTSTTST’. 

Then press the ‘Enter’ key. 
The saved message is returned in the text 
window. 

 

38.  Click the ‘Clear’ button. The text window clears the text product.  
39.  Open the ‘Text 2’ window.  

  
A second text window opens.  

40.  From the ‘Text Workstation’ window, click on 
‘Windows’. 
Then click on ‘Hide All’. 

The ‘Text 1’ and ‘Text 2’ windows become 
hidden. 

 

41.  From the ‘Text Workstation’ window, click on 
‘Windows’. 
Then click on ‘Show All’. 

All text windows become visible.  

42.  In one of the text windows, click ‘File’ and 
select ‘Close’. 

The text window closes.  

43.  In another text window, display an available 
text product. 

The text product displays in the text window.  

44.  Print the text product by clicking on ‘File’ and 
selecting ‘Print All’. 

The text product prints from an attached 
printer. 

 

45.  Clear the text window. 
Then request an available text product via 
AFOS Browser. 

The text product displays.  

46.  Edit the text product. Then save the edits. The text product is modified and saved.  
47.  Clear the text window. 

Then request the edited product to verify the 
edits were saved. 

The text window clears. 
The text product displays the modifications. 

 

48.  From the ‘Text Workstation’ window, select 
‘File’. 
Then select ‘Exit’. 

All opened text windows and the ‘Text 
Workstation’ window close. 

 

End of TO10 Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
CAVE_TO8_004 CAVE shall contain a Text Editor with the look and feel, and 

functionality of the current AWIPS 1 text editor 
ALL 

CAVE_TO8_004.1 The Text Editor shall contain an AFOS Browser  
CAVE_TO8_004.1.1 The AFOS Browser shall allow the user to display text products in the 

text window by selecting the Node, Category and Designator. 
 

CAVE_TO8_004.1.5 The AFOS Browser shall allow the user to Load the selected text 
product while keeping the AFOS Browser open for further use. 

 

CAVE_TO8_004.1.6 The AFOS Browser shall allow the user to display the selected text 
product and close the AFOS Browser. 

 

CAVE_TO8_004.2 The Text Editor shall provide a print capability.  
CAVE_TO8_004.2.1 The print capability shall allow the user to create a hard copy of all 

text in the Text Window (Print All) using the menu bar. 
 

CAVE_TO8_004.4 The Text Editor shall provide a text/bulletin editing capability.  
CAVE_TO8_004.9 The user shall be able to close out the Text Editor Window.  
CAVE_TO8_004.11 The Text Editor shall provide the capability to Autowrap.  
CAVE_TO8_004.12 The Text Editor shall provide the capability to change font size.  
CAVE_TO8_004.13 The Text Editor shall provide the capability to overstrike using the 

menu bar. 
 

CAVE_TO8_004.24 The Text Editor shall contain WMO Search Dialog Box that indicates 
to the user to fill in the TTAAii and/or CCCC and press ENTER. 

 

CAVE_TO8_004.25 The Text Editor shall allow the user to open the Text Editor function.  
CAVE_TO8_004.26 The Text Editor shall allow the user to opt to accumulate text by 

appending subsequent text product retrievals to the display window. 
 

CAVE_TO8_004.28 The Text Editor shall allow the user to clear the Text Display window.  
CAVE_TO8_004.29 The Text Editor shall retrieve/display the AFOS product in the Text 

Display Window via the AFOS Cmd text window. 
 

CAVE_TO8_004.30 The Text Editor shall retrieve/display the AFOS product in the Text 
Display Window via the WMO TTAAii CCCC text window. 

 

CAVE_TO8_004.31 The Text Editor shall retrieve/display the AFOS product in the Text 
Display Window via the AWIPS ID text window. 

 

CAVE_TO8_004.32 The Text Editor shall launch the AWIPS Header Block GUI when the 
user enters the edit mode. 

 

CAVE_T08_004.33 The text editor function shall display edit functions in a menu bar 
fashion. 

 

CAVE_T08_004.33.1 The menu bar in the edit window shall provide the capability to save 
text. 

 

CAVE_T08_004.33.2 The menu bar in the edit window shall provide the capability to cut 
out text. 

 

CAVE_T08_004.33.3 The menu bar in the edit window shall provide the capability to copy 
text. 
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Number Description Test Step(s) 
CAVE_T08_004.33.4 The menu bar in the edit window shall provide the capability to paste 

text. 
 

CAVE_T08_004.33.5 The menu bar in the edit window shall provide the capability to 
remove hard returns from selected text (Fill). 

 

CAVE_T08_004.33.6 The menu bar in the edit window shall provide the capability to edit a 
bulletin header. 

 

CAVE_T08_004.33.8 The menu bar in the edit window shall provide the capability to cancel 
out of the editor function (cancel). 

 

CAVE_T08_004.33.10 The menu bar in the edit window shall provide the capability to 
overstrike text. 

 

CAVE_TO8_004.36 The Text Workstation shall allow the user to exit a Text Workstation.  
CAVE_TO8_004.37 The Text Workstation shall allow the user to open a Text Workstation.  
CAVE_TO8_004.38 The Text Workstation shall allow the user to "Hide All" workstation 

screens. 
 

CAVE_TO8_004.39 The Text Workstation shall allow the user to "Show All" workstation 
screens. 

 

 
 



 

This document includes data that shall not be duplicated, used, or disclosed – in whole or in part – outside the Government for 
any purpose other than to the extent provided in contract DG133W-05-CQ-1067. However, the Government shall have the right 
to duplicate, use, or disclose the data to the extent provided in the contract. This restriction does not limit the Government’s right 
to use information contained in this data if it is obtained from another source without restriction. The data subject to this 
restriction are contained in all sheets. 
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1.0 SCOPE 
See TO10 Software Test Plan. 



Test Case Hydroview (Draft)  DCN AWP.TE.SWCTR/T010-0008 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0008 / 21 Nov. 2008 2 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: Baseline_HYDRO_WHFS_Hydroview (OB8.3); 
Baseline_HYDRO_WHFS_Hydroview_OB8.1; 
Baseline_HYDRO_PointData.Control; Checkout_4.4.2_Hydroview_OB8.1. 

• Software Test Plan for the Advanced Weather Interactive Processing System 
Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
The purpose of this Test Procedure is to test and verify the functionality found within the current 
version of the WHFS Hydrologic Data Viewer application known as Hydroview. Also 
demonstrated in this test case is the Point Data Control functionality. As new functionality is 
added to this application, these test procedures will be updated to contain the steps required to 
test this new functionality. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested.  
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. Note that Pan and Zoom 
capabilities highlighted in yellow will be demonstrated following an approach 
consistent with current CAVE capabilities. Differences in approach from 
AWIPS I Hydroview may result in a variance or later revision. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from 
the dropdown menu if available. If not 
available, select ‘Other…’. Then select 
‘Hydro’ from the Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  From the ‘MapData’ pull-down menu, select 
‘Point Data Control…’. 

The Point Data Control window opens and 
the stations display in the Hydroview main 
window. 

 

3.  MB1 click the ‘Close’ button. The Point Data Control window closes.  
4.  From the ‘Help’ pull-down menu, select 

‘About’. 
An About window displaying the 
application’s name, version number and 
date is shown. 

 

5.  On the About window, MB1 click the ‘OK’ 
button. 

The About window closes.  

6.  From the ‘Help’ pull-down menu, select 
‘Map Legend’. 

This window displays a legend for Station 
icons and colors. These are the station 
icons and colors used by the Point Data 
Control option. Note: To make sure some 
stations exist in the Hydroview main 
window. 

 

7.  MB1 click the ‘Close’ button from the 
Station Legend window. 

The Station Legend window closes.  

8.  From the File pull-down menu, select ‘Save 
as Gif’. 

The Save as GIF window launches.  

9.  In the Save as GIF window, use the Filter 
and Directories selection boxes to choose a 
directory to save a GIF screen capture. In 
the Selection box, enter the name of the file 
to save the screen capture to (including the 
directory) followed by the ‘.gif’ file 
extension. For best results move the Save 
as GIF window off of the Hydroview display. 
MB1 click the ‘OK’ button. 

The Save as GIF window closes.  

10.  In a terminal, go to the directory where the 
screen capture was saved. Use the 
“display” command to display the GIF file. 

The Hydroview screen capture displays.  

11.  From the ‘File’ pull-down menu, select ‘Print 
Image’. 

The Hydroview image is sent to the printer 
specified by the whfs_printcommand_LX 
token. 

 

12.  From the ‘File’ pull-down menu, select ‘Print 
Reverse Image’. 

The Hydroview image is sent to the printer 
specified by the whfs_printcommand_LX 
token. The image will be displayed in 
reverse video (i.e., black as white and white 
as black). 
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Step # Action Result Pass/Fail 
13.  From the ‘Tools’ pull-down menu, select 

‘Point Zoom’ -> ‘Out’. 
The center of the geographic display is 
zoomed out. 

 

14.  From the ‘Tools’ pull-down menu, select 
‘Point Zoom’ -> ‘In’.  

The center of the geographic display is 
zoomed in. 

 

15.  Draw a rectangle on the geographic display 
by holding down the MB1. Then from the 
‘Tools’ pull-down menu, select ‘Areal 
Zoom’. 

The geographic display zooms in on the 
rectangular area drawn. 

 

16.  From the ‘Tools’ pull-down menu, select 
‘Areal Zoom’ again. 

The display returns to its previous zoom 
level. 

 

17.  From the ‘Tools’ pull-down menu, select 
‘Pan’ -> ‘Up’. 

The geographic display moves North.  

18.  From the ‘Tools’ pull-down menu, select 
‘Pan’ -> ‘Down’. 

The geographic display moves South.  

19.  From the ‘Tools’ pull-down menu, select 
‘Pan’ -> ‘Right’. 

The geographic display moves East.  

20.  From the Tools pull-down menu, select 
‘Pan’ -> ‘Left’. 

The geographic display moves West.  

21.  From the ‘Tools’ pull-down menu, select 
‘Recenter’. 

The cursor changes from an arrow into a 
leftward pointing hand that indicates that 
recenter functionality is active. 

 

22.  MB1 click on an area that is not in the 
center of the display. 

The display is recentered on the selected 
area. 

 

23.  From the ‘Tools’ pull-down menu, select 
‘Recenter’ again. Then MB1 click on the 
area that was originally at the center of the 
display. 

The geographic display returned to its 
previous viewing state and center. 

 

24.  From the ‘Tools’ pull-down menu, select 
‘Tool Bar’. 

A tool bar appears just below the row of pull-
down menus. The icons shown perform the 
same functions as the Zoom and Pan 
options found in the Tools pull-down menu. 

 

25.  From the ‘Tools’ pull-down menu, select 
‘Tool Bar’ again. 

The tool bar disappears.  

26.  From the ‘Tools’ pull-down menu, select 
‘Set Font’ -> ‘Small’. 

Alphanumeric text annotations on the 
Hydroview GUI display in their default, 
startup size. 

 

27.  From the ‘Tools’ pull-down menu, select 
‘Set Font’ -> ‘Very Small’. 

Alphanumeric text annotations on the 
Hydroview display become smaller when 
compared to previous size. 

 

28.  From the ‘Tools’ pull-down menu, select 
‘Set Font’ -> ‘Miniscule’. 

Alphanumeric text annotations on the 
Hydroview display become smaller when 
compared to previous size. This is the 
smallest font size. 
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Step # Action Result Pass/Fail 
29.  From the ‘Tools’ pull-down menu, select 

‘Set Font’ -> ‘Normal’. 
Alphanumeric text annotations on the 
Hydroview display become normal in font 
size. 

 

30.  From the ‘Tools’ pull-down menu, select 
‘Set Font’ -> ‘Large’. 

Alphanumeric text annotations on the 
Hydroview display become larger. 

 

31.  From the ‘Tools’ pull-down menu, select 
‘Set Font’ -> ‘Very Large’. 

Alphanumeric text annotations on the 
Hydroview display become larger than 
previous size. This is the largest font size. 

 

32.  From the ‘Projections’ pull-down menu, 
select ‘Polar Stereographic’. 

The geographic map displays a Polar 
Stereographic projection. 

 

33.  From the ‘Projections’ pull-down menu, 
select ‘HRAP’. 

The geographic map displays a HRAP 
projection. 

 

34.  From the ‘Projections’ pull-down menu, 
select ‘Flat Lat/Lon’. 

The geographic map displays a Flat Latitude 
/ Longitude projection. 

 

35.  From the ‘Overlays’ pull-down menu, select 
‘Streams/Lakes’ -> ‘No Streams/Lakes’. 

No streams or lakes are shown on the 
geographic display. 

 

36.  From the ‘Overlays’ pull-down menu, select 
‘Streams/Lakes’ -> ‘Major Streams/Lakes’. 

All major streams and lakes are shown on 
the geographic display if defined in the 
Overlay Configuration file. 

 

37.  From the ‘Overlays’ pull-down menu, select 
‘Streams/Lakes’ -> ‘All Streams/Lakes’. 

All streams and lakes are shown on the 
geographic display if defined in the Overlay 
Configuration file. 

 

38.  From the ‘Overlays’ pull-down menu, select 
‘Basin Boundaries’. 

This toggles the displaying of Basin 
Boundary outlines on the geographic display 
if defined in the Overlay Configuration file. 

 

39.  From the ‘Overlays’ pull-down menu, select 
‘Counties’. 

This toggles the displaying of County 
outlines on the geographic display if defined 
in the Overlay Configuration file. 

 

40.  From the ‘Overlays’ pull-down menu, select 
‘County Warning Areas’. 

This toggles the displaying of CWA outlines 
on the geographic display if defined in the 
Overlay Configuration file. 

 

41.  From the ‘Overlays’ pull-down menu, select 
‘RFC Boundaries’. 

This toggles the displaying of RFC 
Boundary outlines on the geographic display 
if defined in the Overlay Configuration file. 

 

42.  From the ‘Overlays’ pull-down menu, select 
‘States’. 

This toggles the displaying of State Borders 
on the geographic display if defined in the 
Overlay Configuration file. 

 

43.  From the ‘Overlays’ pull-down menu, select 
‘Zones’. 

This toggles the displaying of Zones on the 
geographic display if defined in the Overlay 
Configuration file. 

 

44.  From the ‘Overlays’ pull-down menu, select 
‘Cities/Towns’. 

This toggles the displaying of City locations 
on the geographic display if defined in the 
Overlay Configuration file. 
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Step # Action Result Pass/Fail 
45.  From the ‘Overlays’ pull-down menu, select 

‘Highways/Roads’ -> ‘Highways’. 
All Highways will be shown on the 
geographic display if defined in the Overlay 
Configuration file. 

 

46.  From the ‘Overlays’ pull-down menu, select 
‘Highways/Roads’ -> ’None’. 

No Highways or Roads are shown on the 
geographic display. 

 

47.  From the ‘Overlays’ pull-down menu, select 
‘HRAP’. 

This toggles the display of the HRAP grid on 
the geographic display if defined in the 
Overlay Configuration file. 

 

48.  From the ‘Overlays’ pull-down menu, select 
‘Lat/Lon Lines’. 

This toggles the display of Latitude and 
Longitude lines on the geographic display if 
defined in the Overlay Configuration file. 

 

49.  From the ‘Overlays’ pull-down menu, select 
‘Time Zones’. 

This toggles the display of Time Zone 
boundaries on the geographic display if 
defined in the Overlay Configuration file. 

 

50.  From the ‘Overlays’ pull-down menu, select 
‘Radar Locations’. 

This toggles the display of Radar locations 
on the geographic display if defined in the 
Overlay Configuration file. 

 

51.  From the ‘Overlays’ pull-down menu, select 
‘Radar Rings’. 

This toggles the display of the outline of a 
Radar’s coverage area on the geographic 
display if defined in the Overlay 
Configuration file. 

 

52.  On the ‘Overlays’ menu, the grayed out 
Basin Names listed below will be 
implemented in a future build: 
‘Hydro Service Areas’ 
‘Topography’ 
‘Maps Foreground’ 

No Action.  

53.  Double MB1 click on a station icon on the 
geographic display. 

The selected station is enclosed in a red 
square.  

 

54.  From the ‘MapData’ pull-down menu, select 
‘Station Selection’. 

The Station List window appears. The entry 
for the station enclosed in the red square on 
the Hydroview display is highlighted in the 
Station Selection list. 

 

55.  From the ‘Station List’, select another 
station. 

The station entry in the Station List becomes 
highlighted. A red rectangle is drawn around 
the station’s location on the Hydroview 
display. 

 

56.  In the ‘Station List’ window, double MB1 
click on a station. 

The time series control window is shown.   

57.  On the ‘Hydroview’ display, double MB1 
click on another station. 

A red rectangle is drawn around that station 
on the Hydroview display. 

 

58.  From the ‘Station List’ window, scroll down 
the station list, select another station and 
then use the ‘Search’ text box to find the 
station selected in step 59. 

The search feature will find the station in the 
list, highlight its entry in the station list and 
draw a red rectangle around its location on 
the Hydroview display. 
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Step # Action Result Pass/Fail 
59.  From the ‘Station List’ window, MB1 click 

the ‘Cancel’ button. 
The Station List window closes.  

60.  From the ‘MapData’ pull-down menu, select 
‘Refresh Data’. 

This queries the IHFS database and 
updates the station data shown on the 
Hydroview display. 

 

61.  From the ‘MapData’ pull-down menu, select 
‘Dam Locations’. 

The Dam Display Control window opens.  

62.  Select the ‘Map Data’ push-button on the 
Dam Display Control window. 

Dam icons along with their names display 
on the geographic window. 

 

63.  The Dam Display Control window provides 
the option to filter the displayed Dams by 
volume. Enter a value in the threshold 
volume text box (e.g. 100000) and then try 
each of the filters by options:  greater than, 
equal to, less than, and All.  
Each time a filter option is changed, MB1 
click the ‘Map Data’ button. 

The Dam icons are selectively displayed 
based on their volume, the dam volume 
threshold value and filter option chosen. 

 

64.  The Dam Display Control window allows 
the displayed dams to be limited within a 
specific area on the Hydroview display. 
This is controlled by a user-selectable 
center point and a latitude/longitude box 
centered on this point. Try modifying the 
‘lat/lon center point’ value and the ‘lat/long 
offsets’. Toggle the ‘enable’ button and 
select ‘Map Data’. 

The displayed dams are limited to the 
defined latitude/longitude box. 

 

65.  Select different combinations of the filters 
(Id, Name and Icon) in the Dam Display 
Control window. This allows the display to 
show or hide the Id, Name, and Icon. 

The Data is selectively displayed based on 
the filter chosen for Id, Name and Icon 
filters. 

 

66.  Place the mouse pointer over a dam 
location, click and hold MB3 and select 
‘DamCrest’ from the popup menu. 

The DamCrest application is launched for 
the selected dam. 
Output Manager window opens. 

 

67.  On the Dam Crest application window, MB1 
click ‘Close’ from the File pull-down menu. 

The Dam Crest application is closed.  

68.  Select the ‘Clear Data’ push-button on the 
Dam Display Control window. 

The Dams will be cleared from the 
geographic display. 

 

69.  From the Dam Display Control window, 
MB1 click the ‘Close’ button. 

The Dam Display Control window closes.  

70.  From the ‘MapData’ pull-down menu, select 
‘Best Estimate QPE’. 

The Display Best Estimate QPE window 
opens. 

 

71.  From the Display Best Estimate QPE 
window, MB1 click the ‘Show Data’ button. 

A MPE generated 1 hour Best Estimate 
QPE field displays in the Hydroview GUI. 
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Step # Action Result Pass/Fail 
72.  From the Display Best Estimate QPE 

window, MB1 click the ‘Time Lapse’ button 
and use the duration slider bar to set the 
duration to 6 hours. MB1 click the ‘Show 
Data’ button. 

A time lapse of 6 hours worth of MPE Best 
Estimate QPE fields displays in the 
Hydroview GUI. 

 

73.  From the Display Best Estimate QPE 
window, MB1 click the ‘|<<’ button adjacent 
to the time lapse toggle button. 

The time lapse stops and enters manual 
time lapse mode. The oldest QPE field in 
the time lapse is shown in the Hydroview 
display (the time of the product is shown in 
the lower left corner of the display). 

 

74.  From the Display Best Estimate QPE 
window, MB1 click the ‘<’ button to 
manually step backwards through each 
frame of the time lapse. 

Each time the ‘<’ button is clicked, the 
previous QPE frame in the time lapse is 
displayed. 

 

75.  From the Display Best Estimate QPE 
window, MB1 click the ‘>’ to manually step 
forward through each frame of the time 
lapse. 

Each time the ‘>’ button is clicked, the next 
QPE frame in the time lapse is displayed. 

 

76.  From the Display Best Estimate QPE 
window, MB1 click the restart timelapse 

button  to restart the automatic time 
lapse. 

The automatic time lapse resumes.  

77.  From the Display Best Estimate QPE 
window, MB1 click the ‘End Lapse’ button. 

The time lapse stops. The Hydroview 
display shows the Best Estimate QPE field 
which was displayed before the time lapse 
was started. 

 

78.  From the Display Best Estimate QPE 
window, MB1 click the ‘Accumulate’ toggle 
button. Set the duration slider bar to ‘24’. 
MB1 click the ‘Show Data’ button. 

An accumulation of 24 1-hour Best Estimate 
QPE fields displays in the Hydroview GUI. 

 

79.  From the Display Best Estimate QPE 
window, select ‘Basin’ from the ‘Display As’ 
combo box. MB1 click the ‘Show Data’ 
button. Use the grid, zone and county 
filters. 

The 24 hour accumulation is displayed as 
basin averaged precipitation amounts. 

 

80.  From the Display Best Estimate QPE 
window, select ‘day adjust’ and ‘hour adjust’ 
arrow buttons to increment / decrement the 
date and time. MB1 click ‘Show Data’. 

The displayed data should have changed 
according to the data and time selected. 

 

81.  From the Display Best Estimate QPE 
window, MB1 click the ‘Clear Data’ button. 

The QPE data are cleared from the MPE 
display. 

 

82.  From the Display Best Estimate QPE 
window, MB1 click the ‘Close’ button. 

The Display Best Estimate QPE window 
closes. 

 

83.  From the ‘MapData’ pull-down menu, select 
‘Flash Flood Guidance’. 

The Flash Flood Guidance window opens.  
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Step # Action Result Pass/Fail 
84.  Select a product from the top or near the 

top of the list, and MB1 click ‘Select’. 
A color map of zones displays, showing the 
current Flash Flood threat across the area. 
Warm colors are threats; cool colors are not 
threats. If the RFC for the WFO does not 
produce FFG data, the color for missing 
displays. 

 

85.  Select the ‘FFG Mode Gridded’ toggle 
button and select ‘WFO’ in the ‘FFG area’ 
filter. Select a product from the scroll list 
and MB1 click ‘Select’. 

A color map displays showing the Flash 
Flood threat across the area for the WFO. 

 

86.  With the ‘FFG Mode Gridded’ toggle button 
set, change the ‘FFG area’ to ‘RFC’. Select 
a product from the list. 

A color map displays showing the Flash 
Flood threat across the area for the RFC. 

 

87.  With the ‘FFG Mode Gridded’ toggle button 
set, choose different durations from the 
‘Dur’ filter. Select products from the list. 

The color map shows the Flash Flood threat 
for the selected duration. 

 

88.  With the ‘FFG Mode Gridded’ option set, 
select a product from the list. Test by 
choosing ‘Basin’ once and ‘Grid’ next time 
in the ‘Display As’ filter option. 

The color map shows the flash flood threat 
displayed on an HRAP grid when the 
Display As filter is ‘Grid’. The color map 
shows the flash flood threat displayed as 
averaged basin values when the Display As 
filter is ‘Basin’. 

 

89.  Set the ‘FFG Mode’ to ‘Areal’. The product list will update with areal FFG 
products. 

 

90.  With FFG Mode set to Areal, choose 
different Areal Types (Zone, County, Basin, 
All) and select products to display for them. 

The areal values display in the Hydroview 
viewer based on the selected Areal Type 
filter and the selected product from the FFG 
product list. The areal values display as 
colored numbers. The colors of the numbers 
correspond to the FFG color product legend. 

 

91.  With the ‘FFG Mode’ set to ‘Areal’, select 
different durations from the ‘Dur FFG’ 
option and display FFG products for them. 

The areal FFG values display for the 
selected duration. 

 

92.  With the ‘FFG Mode’ set to ‘Areal’, select a 
product from the list and test by 
selecting/deselecting the toggle buttons for 
‘Id’ and ‘Value’. 

The Areal FFG labels displayed on the 
Hydroview map are based on the toggle 
selection of the ‘Id’ and ‘Value’. If ‘Id’ is only 
selected then only Ids will be displayed. This 
holds the same with ‘Value’ toggle button. If 
both ‘Id’ and ‘Value’ are selected then both 
Ids and Values display. 

 

93.  MB1 click the ‘Clear’ button in the Flash 
Flood Guidance window. 

The FFG data are cleared from the 
Hydroview geographic display. 

 

94.  MB1 click the ‘Close’ in the Flash Flood 
Guidance window. 

The Flash Flood Guidance window closes.  
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Step # Action Result Pass/Fail 
95.  From the ‘LiveData’ pull-down menu, select 

‘Time Series Graphs/Tables’.  
The Time Series Control window opens in 
Station Selection mode with the station 
selected inside the red square on the 
Hydroview Display highlighted in the station 
list.  

 

96.  MB1 click the ‘Close’ button in the Time 
Series Control window. 

The Time Series Control window closes.  

97.  From the ‘LiveData’ pull-down menu, select 
‘Site Specific Headwater Model’. 

The SSHP application launches for the 
selected station. If that station is not 
configured for SSHP, an error dialog 
appears. Select the ‘OK’ button to close the 
dialog.  

 

98.  Select the ‘Exit Application’ push-button on 
the SSHP Control window. 

The SSHP application closes.  

99.  From the ‘LiveData’ pull-down menu, select 
‘Alert and Alarms Data’. 

The Alert and Alarm Data Values window 
opens. The scroll list shows the alert/alarm 
data. Also details for the item that is 
highlighted in the list will appear in the all 
appropriate text areas that is below the 
scroll list. 

 

100.  Select different values for the show filter: 
‘All’  
‘Observed’  
‘Forecast’ 

The scroll list will have only forecast data if 
‘Forecast’ is selected, only observed data if 
‘Observed’ is selected and both observed 
and forecast data if ‘All’ is selected. 

 

101.  Select different values for the show filter: 
‘Alert&Alarm’  
‘Alert’  
‘Alarm’ 

The scroll list will have only alert data if 
‘Alert’ is selected, only alarm data if ‘Alarm’ 
is selected and both alert and alarm data if 
‘Alert/Alarm’ is selected. 

 

102.  Select different values for the exceeding 
filter: 
‘Any Limit’ 
‘Rate-Of-Change’ 
‘Upper Limit’ 
‘Lower Limit’ 
‘Diff Limit’ 

The scroll list will have only rate-of-change 
data if ‘Rate-Of-Change’ is selected, only 
data that has exceed upper limit if ‘Upper 
Limit’ alarm is selected, only data that is 
lower than the set lower limit if ‘Lower limit’ 
is selected and all exceeded data if ‘Any 
Limit’ is selected. 

 

103.  Select ‘Sort By Time’. The data in the scroll list is displayed with 
their order sorted by validtime. 

 

104.  Select ‘Sort By Location’. The data in the scroll list is displayed with 
their order sorted by location id. 

 

105.  Select any item from the scroll list and MB1 
click the ‘Delete’ button. 

A dialog asking confirmation to delete 
appears. If you select ‘Yes’, that item will be 
deleted. 

 

106.  Select ‘Tabular Time Series and Graphical 
Time Series’ to bring up Time Series 
window. 

The Time Series Control window opens in 
Station Selection mode with the selected 
station highlighted.  
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Step # Action Result Pass/Fail 
107.  Select the ‘Close’ push-button on the Alert 

and Alarm Data Values window. 
The Alert and Alarm Data Values window 
closes. 

 

108.  From the ‘LiveData’ pull-down menu, select 
‘Questionable and Bad Data’. 

The Questionable and Bad Data window 
opens. Scroll List showing the questionable 
and bad data displays in the window. The qc 
description for the item that is highlighted in 
the list appears in the bottom QC 
Description box. 

 

109.  Select ‘Filter By Location’ and enter a 
location id. Press the Enter key on the 
keyboard after entering the location id. 

The scroll list has only the data that is 
pertaining to the location id provided. If there 
is not questionable and bad data found for 
that location id, it will give the message 
stating the data is unavailable. 

 

110.  Select different values for element from the 
available values: 
‘Height’ 
‘Temperature’ 
‘Ground’ 
‘Ice’ 

The scroll list has only the data that is 
pertaining to the selection made. If 
Temperature is selected, only temperature 
data is displayed and so on. 

 

111.  Enter the number of days (say 11) in the 
test box available for last days. 

The scroll list has the data that is pertaining 
to the past 11 days. 

 

112.  Select ‘Sort By Location’. The scroll list has the data sorted based on 
location id. 

 

113.  Select ‘Sort By Time’. The scroll list has the data sorted based on 
observation time. 

 

114.  Select ‘Sort By Shef Quality’. The scroll list has the data sorted based on 
shef quality (the SQ column). 

 

115.  Select ‘Sort By Quality Code’. The scroll list has the data sorted based on 
quality code (the QC column). 

 

116.  Highlight an item in the scroll list and MB1 
click ‘Set Missing’. 

The item is set to have its value missing and 
the item is removed from the scroll list 
displayed. 

 

117.  Highlight an item in the scroll list and MB1 
click ‘Delete Selected’. 

The item is moved to rejecteddata table in 
the database and the type field in the table 
has its value as ‘M’ (meaning it is manually 
sent to rejecteddata table and not through 
shefdecode). The item is removed from the 
scroll list displayed. 

 

118.  Select ‘Tabular Time Series and Graphical 
Time Series’ to bring up Time Series 
window. 

The Time Series Control window opens in 
Station Selection mode with the selected 
station highlighted.  

 

119.  Select the ‘Close’ push-button on the 
Questionable and Bad Data window. 

The Questionable and Bad Data window 
closes. 

 

120.  From the ‘LiveData’ pull-down menu, select 
‘Rejected Data Trash Can’. 

The Data Trash Can window opens. The 
scroll list has the rejected data displayed. 

 



Test Case Hydroview (Draft)  DCN AWP.TE.SWCTR/T010-0008 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0008 / 21 Nov. 2008 13 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step # Action Result Pass/Fail 
121.  Select ‘Filter By Location’ and enter a 

location id. 
The scroll list has only the rejected data that 
is pertaining to the location id provided. 

 

122.  Select ‘Filter By Physical Element’ and 
select any physical element from the 
physical element scroll list. 

The scroll list has only the rejected data that 
is pertaining to the physical element 
selected. 

 

123.  Uncheck the ‘Location’ toggle button. 
Select ‘Sort By Location’. 

The scroll list has the data sorted based on 
location id. 

 

124.  Select ‘Sort By Time’. The scroll list has the data sorted based on 
observation time. 

 

125.  Select the ‘Reject Type’ option to be either: 
‘All’ 
‘Auto’ 
‘Manual’ 

The scroll list has only the data that is 
manually rejected using the questionable 
and bad data window and MB1 clicking the 
‘Delete Selected’ button if the reject type 
option is ‘Manual’. The list will have only the 
data that is entered into rejecteddata table 
by shefdecode (automatic data) if the reject 
type is ‘Auto’. The list will have both the 
manual and auto data from the rejecteddata 
table if the reject type option is ‘All’. 

 

126.  Highlight an item in the scroll list and MB1 
click Move Selected to Data Tables’. 

The selected data are moved to its 
respective data table and the entry is 
removed from rejecteddata table. 

 

127.  Highlight an item in the scroll list and MB1 
click ‘Delete Selected’. 

The selected data is deleted from the 
rejecteddata table and the entry is removed 
from the scroll list. 

 

128.  MB1 click the ‘Delete All’ button. A confirmation window appears asking 
whether you want to delete all the data in 
the Rejected Data Trash Bin. This will delete 
all records from RejectedData table in the 
database. 

 

129.  Select ‘Close’ in the Data Trash Can 
window. 

The Data Trash Can window closes.  

130.  From the ‘LiveData’ pull-down menu, select 
‘Station Reporting Status/Latest 
Observations’. 

The Station Reporting Status window 
opens, showing the station ID, the station 
name, when the last observation was made, 
and when the latest data were received. 
This window updates if the shef_post_latest 
token is set to ‘ON’ in the 
/awips/hydroapps/.Apps_defaults_site file. 

 

131.  From the ‘List’ options, select ‘All Locations 
With Latest Data’. 

This results in the display of all the location 
with their latest data information in the scroll 
list.  

 

132.  From the ‘List’ option, select ‘Only 
Locations With Latest Data Older Than’. 

The ‘Hours Ago’ command line becomes 
active. 
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Step # Action Result Pass/Fail 
133.  In the ‘Hours Ago’ command line, type ‘12 

Hours’. Then press the ‘Enter’ key on the 
keyboard. 

All stations which have not reported in last 
12 hours display.  

 

134.  In the ‘Sort’ option, select ‘By Time’. The list is sorted by Observation Time (Z), 
with the most recent time at the top. 

 

135.  In the ‘Sort’ option, select ‘By Location’. The list is sorted by Location Id.  
136.  In the Station Reporting Status window, 

selected different stations in the top 
window.  

The Latest Data for Selected Station list in 
the bottom of the Station Reporting Status 
window updates to display the latest data 
elements received for that station. For 
reference purposes, the current time field 
updates to show the current time. Also, 
information about the station’s telemetry and 
dcp reporting status can also be seen in the 
bottom of the window. 

 

137.  In the Station Reporting Status window, 
select locations without any latest data. 

The list of stations for which latest 
observation data is not found in the 
database is shown in the scroll list. 

 

138.  Select the ‘Close’ push-button on the 
Station Reporting Status window. 

The Station Reporting Status window 
closes. 

 

139.  From the ‘LiveData’ pull-down menu, select 
‘Point Precipitation Accumulations’. 

The Point Precipitation Accumulations 
window opens. 

 

140.  Select the ‘Load Data’ push-button. Data is listed in the scrolled window based 
on the criteria selected. 

 

141.  The up and down arrow buttons are used to 
change the date and time to specify the end 
time. Change the end time using the arrows 
and select ‘Load Data’. 

Data is listed in the scrolled window based 
on the time and other criteria selected in the 
window. 

 

142.  Select ‘Filter By HSA’ button and select one 
or more item from the HSA scroll list and 
select ‘Load Data’. 

Data is listed based on the HSA selected in 
the scroll list and other criteria selected in 
the window. 

 

143.  Select the ‘Filter By Data Source’ button 
and select one or more item from the ‘PC’ 
or ‘PP’ scroll list. Then select ‘Load Data’. 

Data is listed based on the items selected in 
the scroll list and other criteria selected in 
the window. 

 

144.  Select option ‘Show Details’. Then select 
‘Load Data’. 

The summary has additional information 
about the displayed data report in brief. 
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Step # Action Result Pass/Fail 
145.  Select option ‘Add PP Reports as Needed’. 

Select ‘Load Data’. 
The summary shows the PP summed 
values which (if not selected) would 
otherwise be reported as MSG (missing) if 
there is no direct report for the mentioned 
duration window. The summed values are 
nothing but the value obtained by adding all 
PP reports available within that duration. 
Also, if the ‘Show Details’ options is 
selected, the reported summed PP values 
shows (24.0s) at the end of the line, which 
would have been (0.0s) meaning MSG if 
there is no PP report and the ‘Add PP 
Report As Needed’ is deselected. 

 

146.  Select ‘Sort By Location’. MB1 click the 
‘Load’ data button. 

The report is sorted by the location id.  

147.  Select ‘Sort by Value’. The report is sorted by their value with the 
highest value in the top. 

 

148.  Select ‘Other’ in the duration scroll list and 
type a number (say 7) in the text box and 
select load data. (No fraction values, even if 
providing only the whole number before the 
decimal point, will be considered)  

The report is based on the value supplied in 
the text box.  
If there is any other item selected in the 
duration scroll list (say 24) along with 
‘Other’, the report will have values for both 
24hr and 7 hr durations. 

 

149.  Select ‘By Location’ and enter a location id 
in the text box provided. Then select the 
‘Load Data’ button. 

The report displays for the location id 
mentioned. The report has additional 
information about the individual data 
reported in the specified duration with their 
reported time, quality code etc. 

 

150.  Select ‘Save and Close.’ A window for choosing the directory and file 
name to save the report appears. Specify 
the filename along with its path. The report 
is saved in that file. 

 

151.  Select ‘Print’. The report is printed.  
152.  Select the ‘Close’ push-button on the Point 

Precipitation Accumulations window. 
The Point Precipitation Accumulations 
window closes. 
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Step # Action Result Pass/Fail 
153.  Select a station by double MB1 clicking on 

a station in the map. From the ‘LiveData’ 
pull-down menu, select ‘Station Profile’. 

The Station Profile window opens for the 
selected station. 
The window has an elevation graph showing 
the river stream on which the selected 
station (gage) is located. It will also show 
other stations (gages) that are located on 
this stream. The graph also shows the latest 
observation for any of the gages located on 
the stream. The window has different 
stations that are located on this stream 
being listed on the station option. Upon 
selection of any station from this station 
option, the window shows its name, reach, 
action and flood stage information. 

 

154.  Select the ‘Close’ push-button on the 
Station Profile window. 

The Station Profile window closes.  

155.  From the ‘LiveData’ pull-down menu, select 
‘River Summary’. 

The River Summary window opens. The list 
of streams (rivers) displays in the scroll list. 

 

156.  Select an item in the scroll list. A flood stage map displays for the selected 
stream. This shows the flood, stage (red), 
warning stage (yellow), action stage (green) 
for all the stations located on this stream. 
The graph also shows the value (blue) for 
the station if available. 

 

157.  Select different values for stage basis: 
‘Max Obs/Fcst’ 
‘Observed’ 
‘Forecast’ 

The value (blue) color on the graph shows 
the max of obs/fcst if the ‘Max Obs/Fcst’ 
option is selected, the observed value if the 
‘Observed’ option is selected, or the 
forecast value if the ‘Forecast’ option is 
selected. The blue color does not appear if 
the value is not found. 

 

158.  Select the ‘Close’ push-button on the River 
Summary program. 

The River Summary program closes.  

159.  Select a station by double MB1 clicking on 
a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Staff Gage’. 

The Staff Gage window opens for that 
station. The window has a graph that shows 
the flood stage, action stage, warning stage, 
record stage, minor stage, major stage, 
bank full stage etc about the gage. The 
window also shows the name, basin, state, 
etc information for that station selected. 

 

160.  Select the ‘Close’ push-button from the 
bottom of the Staff Gage window. 

The Staff Gage window closes.  
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Step # Action Result Pass/Fail 
161.  Select a station by double MB1 clicking on 

a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Impact Statement Gage’. 

The Impact Statement window opens for 
that station. The impact window shows the 
impact value, impact pe, begin date, end 
data, tendency of the impact in the scroll list 
if data is found. On selecting an item in the 
scroll list, the characteristics display for that 
statement below the scroll list. The impact 
also displays in the text box in the bottom of 
the window. 

 

162.  Select the ‘Cancel’ push-button from the 
bottom of the Impact Statement window. 

The Impact Statement window closes.  

163.  Select a station by double MB1 clicking on 
the station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Low Water Statement’. 

The Low Water Statement window opens for 
that station. The window shows a list of 
lower and upper limits of a river physical 
element in the scrolled list in the top of the 
window. Selecting an entry in this list shows 
low water impact details in the information 
block in the lower window. 

 

164.  Select the ‘Close’ button on the Low Water 
Statement window. 

The Low Water Statement window closes.  

165.  Select a station by double MB1 clicking on 
a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Rating Curve’. 

The Rating Curve window opens for that 
station. The window shows the rating curve 
stage vs. flow graph. This graph is based on 
the shift value that is highlighted in the list 
box at the bottom of the screen, which has 
the shift value, shift data and its status 
(active-T inactive-F). The window shows the 
stage and discharge values in two different 
scroll lists: one with shift value applied and 
the other without shift value. The window 
also shows the flood stage and record flood 
stage on top of screen for the selected 
station. 

 

166.  Place the mouse at any point on the graph. 
Click and hold MB1 and keep moving the 
mouse. 

This results in showing the stage and flow 
(KCFS) values displayed on the top left 
corner of the window. The value is in 
correspondence to the mouse point on the 
map. 

 

167.  Select the ‘Close’ push-button from the 
bottom of the Rating Curve window. 

The Rating Curve window closes.  

168.  Select a station by double MB1 clicking on 
a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Data Sources’. 

The Data Sources window opens for that 
station. 

 



Test Case Hydroview (Draft)  DCN AWP.TE.SWCTR/T010-0008 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0008 / 21 Nov. 2008 18 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step # Action Result Pass/Fail 
169.  Select different values for the type option: 

‘Observer’ 
‘DCP’ 
‘Telemetry’ 

The data pertaining to the station selected 
and the type selected displays. In case of 
the scroll lists shown, the applicable value 
for the station and type are highlighted. 

 

170.  Select the ‘Close’ push-button from the 
bottom of the Data Sources window. 

The Data Sources window closes.  

171.  Select a station by double MB1 clicking on 
a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Contacts’. 

The Contacts window opens for that station. 
The contact window specifies the contact 
information for this station display in their 
order of escalation (1- to be the highest in 
the hierarchy in person of contact list for that 
station) in scroll list. All the available contact 
information for the item that is highlighted in 
the scroll list is shown in the information 
portion of the window. 

 

172.  Select the ‘Close’ push-button from the 
bottom of the Contacts window. 

The Contacts window closes.  

173.  Select a station by double MB1 clicking on 
a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Crest History’. 

The Crest History window opens for that 
station. The window shows the stage vs. 
year of occurrence map. 

 

174.  Choose different options for filter crests by 
selecting the following options: 
‘All’ 
‘Above Action Stage’ 
‘Below Action Stage’ 

The map displayed changes accordingly 
and the data displayed in the right side of 
the window also changes appropriately. 

 

175.  MB1 click on an ‘X’ on the map. The data displayed in the right side of the 
window changes appropriately. 

 

176.  Choose different options for the sort crests 
by option: 
‘Stage’ 
‘Date’ 
‘Flow’ 

The scroll list showing stage, flow, date and 
time is sorted based on date if ‘Date’ is 
selected, stage if ‘Stage’ is selected, or flow 
if ‘Flow’ is selected. 

 

177.  Select the ‘Close’ push-button from the 
bottom of the Crest History window. 

The Crest History window closes.  

178.  Select a station by double MB1 clicking on 
a station in the map. From the 
‘ReferenceData’ pull-down menu, select 
‘Text Reports’. 

The E-19 Report window opens for that 
station. 

 

179.  Scroll through the various types of reports 
in the Report option menu and try selecting 
them. 

Different reports display as different report 
option items are selected. 
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Step # Action Result Pass/Fail 
180.  With report option menu at E-19, scroll 

through the various values in page option 
menu and try selecting them. (Page option 
is shown only for E-19 report option.) 

Different reports display as different values 
selected for page option. 

 

181.  Select a report option value to be sorted 
station list. 

This shows the report of all the stations 
sorted based on location id. 

 

182.  Change the sort by option to: 
‘Name’ 
‘County’ 
‘Basin’ 
‘Observer’ 

The report of all the stations are sorted 
based on the location name if ‘Name’ is 
selected, county if ‘County’ is selected, 
basin if ‘Basin’ is selected, or observer 
name if ‘Observer’ is selected. 

 

183.  Select the report option value to be ‘Station 
Class’. 

This shows the report of all the stations 
detailing the station class information. 

 

184.  Select report option value to be ‘Service 
Backup’. 

This shows the report of all the stations 
detailing the list of stations sorted by station 
id. 

 

185.  Change the sort by option to: 
‘Station’ 
‘WFO’ 
‘HSA’ 

This shows the report of all the stations 
sorted based on the station id if ‘Station’ is 
selected, based on WFO if ‘WFO’ is 
selected, based on HSA if HSA’ is selected. 

 

186.  Select ‘Save’. A dialog showing the file name with the path 
displays, asking for confirmation to save. 
MB1 clicking the report saves the file. If 
cancel is selected, the dialog window 
closes. 

 

187.  Set the report option value to ‘E-19’. Select 
‘Print’. 
Select the contents that are needed in the 
printed report. Then select ‘Print’ to print 
the report. Select ‘Close’ to close this 
window. 

The report content window displays.  
The item prints. 
The window closes. 

 

188.  Select the ‘Close’ push-button from the 
bottom of the Report window. 

The Report window closes.  

189.  From the ‘Product’ pull-down menu, select 
‘Product Viewer’. 

The Product Viewer window opens.  

190.  From the ‘List’ option, select ‘Text Products 
in Database’. 

A list of products displays in the Product 
Information section. 

 

191.  If any products appear in the Product 
Information section, select one. 

The Product chosen display below.  

192.  Select the ‘Close’ push-button from the 
bottom of the Product Viewer window. 

The Product Viewer window closes.  

193.  Zoom into an area of interest by using MB2 
or the ‘Zoom’ and ‘Recenter’ tools from the 
‘Tools’ menu. 

The selected area of the map is enlarged 
and shows a greater level of detail. 
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Step # Action Result Pass/Fail 
194.  MB3 click and hold on the Hydro 

Perspective tab and select ‘Close’. 
The Hydro Perspective closes.  

End of Hydroview Test 
 

Start of Point Data Control Test 
195.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from 
the dropdown menu if available. If not 
available, select ‘Other…’. Then select 
‘Hydro’ from the Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

196.  From the ‘MapData’ pull-down menu, select 
‘Point Data Control…’. 

The Point Data Control window opens and 
the stations display in the Hydroview main 
window. 

 

197.  In the Presets/Query Mode Frame, MB1 
click on the Ad Hoc radio button 

The Ad Hoc radio button is red.  

198.  In the Elements frame, MB1 click on the 
first combo box and select ‘River’. * 
 
 
*In the second combo box (PE), the PEs 
that appear are the same ones that are in 
the ingestfilter table. This is true for Steps 
3-22. The elements that are listed in Action 
Steps 3-22 display in the same order in the 
first combo box. For example: 

• River 
• Rain 
• Snow 
• etc. 
 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter (look for it 
in Hydrobase) table with a value of ‘T’ for 
the ingest column. 
 
Some of the common PEs are: 

• Primary 
• HA – Reading Height 
• HB – Depth below Sfc 
• HC – Ceiling Height 
• HD – Head Height 
• HE – Regulating Gate 
• HG – River Stage 
• HI – Stage Trnd Indicator 
• HP – Pool Elevation 
• HQ – Distance to River 
• HS – Spillwy Forebay El 
• HT – Tailwater Elev 
• QC – Runoff Volume 
• QD – Canal Divers. Dsch 
• QI – Inflow Discharge 
• QR – River Discharge 
• QT – Total Discharge 
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Step # Action Result Pass/Fail 
199.  In the Elements frame, MB1 click on the 

first combo box and select ‘Rain’. 
In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• PC and PP 
• PC   Precip Accumulator 
• PP   Precip Increment 
• PR   Precip Rate 
• PT   Precip Type 

 

200.  In the Elements frame, MB1 click on the 
first combo box and select ‘Snow’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• SA   Areal Snowfall 
• SD   Snow Depth 
• SF   New Snowfall 
• SR   Snow Report 
• SS   Snow Density 
• ST   Snow Temp at Depth 
• SW   Snow Water Equiv 

 

201.  In the Elements frame, MB1 click on the 
first combo box and select ‘Temperature’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• TA   Air Temperature 
• TB   Soil Temp at Depth 
• TD   Dew Point Temp 
• TE   Air Temp at Elev 
• TM   Wet Bulb Temperature 
• TP   Pan water Temp 
• TS   Soil Temp at Sfc 
• TV  Veg Soil Temp 
• TW  Water Temperature 
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Step # Action Result Pass/Fail 
202.  In the Elements frame, MB1 click on the 

first combo box and select ‘Agriculture’. 
In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• AD   Reserved 
• AF   Sfc Frost Intensity 
• AM   Sfc Dew Intensity 
• AT   Time Below 25 deg F 
• AU   Time Below 32 deg F 
• AW   Leaf Wetness Time 

 

203.  In the Elements frame, MB1 click on the 
first combo box and select ‘Evaporation’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• EP   Evap Pan Increment 
• ET   Evap Trans Total 
• EV   Evap Lake Computed 

 

204.  In the Elements frame, MB1 click on the 
first combo box and select ‘FishCount’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• FS   Steelhead Fish Count 

 

205.  In the Elements frame, MB1 click on the 
first combo box and select ‘Ground’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• GD   Frost Penetr Depth 
• GR   Frost Report 
• GS   Ground State 
• GT   Sfc Frost Thawed Dep 
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Step # Action Result Pass/Fail 
206.  In the Elements frame, MB1 click on the 

first combo box and select ‘Ice’. 
In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• IC   Ice Cover 
• IE   Extent of Ice 
• IO   Extent of Open Water 
• IR   Ice Report 
• IT   Ice Thickness 

 

207.  In the Elements frame, MB1 click on the 
first combo box and select ‘Lake’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• LA   Lake Surface Area 
• LS   Lake Storage Volume 

 

208.  In the Elements frame, MB1 click on the 
first combo box and select ‘Moisture’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• MI   Moisture Index 
• MM   Wood Moisture 
• MS   Soil Moisture Amount 
• MT   Wood Temperature 

 

209.  In the Elements frame, MB1 click on the 
first combo box and select ‘GateDam’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• NN   Spillway Gate Number 
• NO   Spec. Gate Opening 
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210.  In the Elements frame, MB1 click on the 

first combo box and select ‘Pressure’. 
In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• PA   Atmospheric Pressure 
• PD   3-hour Press Change 
• PE   Press Characteristic 
• PL   Sea Level Pressure 

 

211.  In the Elements frame, MB1 click on the 
first combo box and select ‘Radiation’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• RI   Incoming Radiation 
• RP   Possible Radiation 
• RT   Total Radiation Time 
• RW   Totl Solar Radiation 

 

212.  In the Elements frame, MB1 click on the 
first combo box and select ‘Weather’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• XC   Total Sky Cover 
• XP   Past Weather 
• XR   Relative Humidity 
• XV   Visibility 
• XW   Present Weather 
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213.  In the Elements frame, MB1 click on the 

first combo box and select ‘Wind’. 
In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• UC   Accumulated Wind 
• UD   Wind Direction 
• UG   Wind Gust Speed 
• UL   Wind Travel Length 
• UP   Peak Wind Speed 
• UQ   Wind Direct & Speed 
• UR   Wind Dir at Peak Spd 
• US   Wind Speed 

 

214.  In the Elements frame, MB1 click on the 
first combo box and select ‘Power’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• VB   Battery Voltage 
• VE   Energy Gener Total 

 

215.  In the Elements frame, MB1 click on the 
first combo box and select ‘WaterQuality’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• WV   Water Velocity 

 

216.  In the Elements frame, MB1 click on the 
first combo box and select ‘YUnique’. 

In the Elements frame, the PEs that appear 
in the second combo box (PE) depend on 
what PE’s are in the ingestfilter table with a 
value of ‘T’ for the ingest column. 
 
Some of the common PEs are: 

• YA   15m Per Above Stage 
• YC   Random Rep Seq Num 
• YF   Forward Power 
• YG 
• YH 
• YI 
• YJ 
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217.  If the shef_procobs token value in the 

.Apps_defaults_site file is set to OFF, the 
first combo box in the Elements frame will 
have an option called ‘Processed’. 
 
If the token value is set to ‘ON’, the first 
combo box will not have an option called 
‘Processed’. 

If the token value of shef_procobs is set to 
‘OFF’, the PEs that appear in the second 
combo box (PE) in the Elements frame 
depend on what PE’s are in the ingestfilter 
table with a value of ‘T’ for the ingest 
column. 
 
Some of the common PEs are: 

• IR   Ice Report 
• PP   Precip Increment 
• QR   River Discharge 
• SI   Snow Depth on Ice 
• TA   Air Temperature 

 

218.  In the Value/Time frame, MB1 click on the 
up and down arrow of the first set of arrows 
on the left side. 

When the up arrow is clicked, the day is 
increased. For example, 2006-01-22 18:00 
changes to 2006-01-23 18:00.  
When the down arrow is clicked, the day is 
decreased. For example, 2006-01-23 18:00 
changes to 2006-01-22 18:00. 

 

219.  In the Value/Time frame, MB1 click on the 
up and down arrow of the second set of 
arrows on the right side. 

When the up arrow is clicked, the hour is 
increased. For example, 2006-01-22 18:00 
changes to 2006-01-22 19:00.  
When the down arrow is clicked, the hour is 
decreased. For example, 2006-01-22 19:00 
changes to 2006-01-22 18:00. 

 

220.  In the Value/Time frame, MB1 click on the 
‘Value Is’ combo box. 

In the Value Is combo box, the default 
value is Latest Value. The following options 
are also available: 

• Latest Value 
• Value for Selected Time 
• Min Value in Window 
• Max Value in Window 
• Value Change in Window 

 

221.  In the Elements frame, select ‘Temperature’ 
in the first combo box on the left. 
In the Elements frame, select ‘TA Air 
Temperature’ in the second combo box on 
the right. 
In the Filtering frame, MB1 click on the 
check box next to the button labeled 
‘Type/Source’. 

When the check box next to the 
‘Type/Source’ button is checked, data 
values display in the Hydroview GUI 
displaying temperature data. 
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222.  In the Filtering frame, MB1 click on the 

‘Type/Source’ button. 
When the ‘Type/Source’ button is clicked, a 
window appears displaying type sources. 
The list of type sources come from the 
ingestfilter table. Some of the common 
Type/Sources for Temperature are: 

• RG    GOES 
• RZ     Nonspecific Observed 

 

223.  In the Type/Source popup window, MB1 
click on ‘RG GOES’, if available. (If not 
available, then select any single 
type/source.)  MB1 click on ‘Apply’. 
Then MB1 click on the ‘Close’ button. 
 

If ‘RG’ was selected, any values that have a 
type/source of ‘RZ’ disappear. Some of the 
values displayed in the Hydroview GUI 
disappear. This occurs if there are some 
values displayed that have a Type/Source 
of ‘RZ’. 
If a different type/source was selected, any 
values that do not have that particular 
type/source disappear from the GUI 
When the ‘Close’ button is clicked, the 
Type/Source popup window closes. 

 

224.  In the Filtering frame, enable the checkbox 
next to the ‘Service Area…’ button. 
MB1 click on the ‘Service Area…’ button. 
Select the first HSA and make sure all of 
the other HSAs are unselected. 
MB1 click ‘Apply’. 
Then MB1 click the ‘Close’ button. 

When the checkbox is checked, some 
values displayed disappear from the GUI. 
When the ‘Service Area…’ button is clicked, 
a window appears displaying a list of HSAs. 
When the first HSA is selected and the 
‘Apply’ button is clicked, the values 
displayed on the map are for stations 
whose HSA is the same as the HSA the 
user selected in the popup window.  
When the ‘Close’ button is clicked, the 
Service Area popup window closes. 

 

225.  In the Filtering frame, enable the checkbox 
next to the ‘Data Source…’ button. 
MB1 click on the ‘Data Source…’ button. 
Select two of the options which appear in 
the popup window (Observer and DCP) and 
MB1 click ‘Apply’. 
Then MB1 click the ‘Close’ button. 

When the checkbox is checked, all of the 
values displayed disappear from the GUI. 
When the ‘Data Source…’ button is clicked, 
a new window appears displaying a list of 
telem types. This list includes all of the 
telem types from the telmtypes table and as 
well as ‘Observer’, ‘DCP’ and ‘undefined’. 
When the first two options (‘Observer’ and 
‘DCP’) are selected and the ‘Apply’ button 
is clicked, some of the values display on 
the GUI. The values that display have a 
telem_type value of ‘Observer’ or ‘DCP’ in 
the stnclass table. 
When the ‘Close’ button is clicked, the 
‘Data Source…’ popup window closes. 
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226.  In the Elements frame, MB1 click on the left 

combo box and select ‘River’. At the bottom 
of the GUI, MB1 click on the ‘Map’ button. 

When ‘River’ is selected in the left combo 
box in the Elements frame, the right combo 
box in the Elements frame is set to 
‘Primary’. When the ‘Map’ button is clicked, 
the GUI updates with river data for all the 
stations not filtered out. 

 

227.  In the Display frame, check the box labeled 
‘Color River Icons:’. 

The icons in the display change to 1 of 5 
colors: 

• Light green – river stage/flow for 
the station is below the 
action/flood levels 

• Yellow – river stage/flow for the 
station is at or above the action 
level but below the flood level 

• Red – river stage/flow for the 
station is at or above the flood 
level 

• Gray – stage/flow data could not 
be retrieved for the station 

• Dark green – the station has a 
value but the action/flood stage 
data are not available in the 
RiverStatus table. 

 

228.  In the Display frame, MB1 click on the 
‘River Color/Value Based On:’ combo box 
and select ‘Observed Value’. 

The values that display in the GUI are the 
observed values for each station for that 
particular date/time. 

 

229.  In the Display frame, MB1 click on the 
‘River Color/Value Based On:’ combo box 
and select ‘Forecast Value’. 

The values that display in the GUI are the 
largest forecast values for each station for 
each station for that particular date/time. 

 

230.  In the Display frame, MB1 click on the 
‘River Color/Value Based On:’ combo box 
and select ‘Max (Obs, Fcst)’. 

The value that displays in the GUI for each 
station is the maximum of the forecast or 
the observed value. 

 

231.  In the Display frame, MB1 click on the 
‘Display Values As:’ combo box and select 
‘Raw Value’. 

The value that displays in the GUI for each 
station is just the raw data value which 
comes from the database. 

 

232.  In the Display frame, MB1 click on the 
‘Display Values As:’ combo box and select 
‘Raw Value/Flood Level’. 

The values that display in the GUI for each 
station are the raw data values and the 
flood stage. The flood stage/level is the 
value of the fs field which is located in the 
Riverstat table. If a flood stage/level is not 
defined for a station, an ‘M’ displays above 
the raw data value. The flood stage/level 
value displays above the raw data value. 
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233.  In the Display frame, MB1 click on the 

‘Display Values As:’ combo box and select 
‘Raw Value/Stage Flow’. 

The values that display in the GUI for each 
station are the raw data values and a 
derived stage or flow value. The derived 
value is a flow if the raw value is a stage 
and vice versa. If a derived value is not 
defined for a station, an ‘M’ displays above 
the raw data value. The derived value 
displays above the raw data value.  

 

234.  In the Display frame, MB1 click on the 
‘Display Values As:’ combo box and select 
‘Flood Depart’. 

If the value is not missing, the value that 
displays in the GUI for each station is the 
current stage value minus the flood stage 
value. This value is the Flood Stage 
departure. If a flood stage is not defined for 
a particular station, then the station data is 
missing. 

 

235.  In the Display frame, MB1 click on the 
‘Display Values As:’ combo box and select 
‘Flood Depart/Level’. 

The values that display in the GUI for each 
station are the flood stage departure and 
the flood stage/level. The flood stage/level 
displays on top of the flood depart value. If 
a flood stage/level is not defined for a 
particular station, then the station data is 
missing. 

 

236.  In the Display frame, MB1 click on the 
‘Display Values As:’ combo box and select 
‘Raw Value’. 
MB1 click on the ‘Tabulate’ button. 

The Point Data Tabular Display appears 
showing all the stations not filtered out and 
the values that are currently displayed in 
the GUI. 

 

237.  In the Point Data Tabular Display window, 
MB1 click on the first station listed that has 
non-missing data.  
MB1 click on the ‘Time Series Graph’ 
button and select ‘Graph’ button. 
Close the Time Series Display and Control. 

When the ‘Time Series Graph’ button is 
clicked, the Time Series loads. 
The time series for the selected station 
displays in a graphical format.  
 

 

238.  In the Point Data Tabular Display window, 
MB1 click on the ‘Time Series Table’ 
button. 
Close the Time Series Tabular Time Series 
and Control. 

When the Time Series Table button is 
clicked, Time Series loads. 
The time series for the selected station 
displays in a tabular format. 

 

239.  In the Point Data Tabular Display window, 
MB1 click on the ‘Print’ button. 
 

The data displayed in the table prints.  
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240.  In the Point Data Tabular Display window, 

MB1 click on the ‘Save’ button. 
Enter ‘test_save.pdc’ in the ‘Selection’ 
textbox. 
MB1 click the ‘OK’ button. 

When the ‘Save’ button is clicked, a dialog 
window appears allowing the user to 
specify a location and filename.  
When the ‘OK’ button is clicked, the report 
is saved to the file “test_save.pdc” in the 
specified save directory 
(awips/hydroapps/whfs/local/data/report). 
The report contains data that is identical to 
the data displayed in the Point Data 
Tabular Display window. 

 

241.  In the Point Data Tabular Display window, 
MB1 click on the ‘Close’ button. 

The Point Data Tabular Display window 
closes and control is returned to the Point 
Data Control GUI. 

 

242.  In the Point Data Control GUI, MB1 click on 
the ‘Unmap’ button. 
 

When the ‘Unmap’ button is clicked, all of 
the values displayed in the Hydroview GUI 
are removed (unmapped). 

 

243.  In the Point Data Control GUI, MB1 click on 
the ‘Map’ button. 

When the ‘Map’ button is clicked, all of the 
station values that are currently not filtered 
out are mapped to the Hydroview GUI. The 
stations and data displayed are the same 
ones that were displayed during Step 48. 

 

244.  In the Point Data Control window, MB1 click 
on the ‘Close’ button. 

The Point Data Control window closes. 
 

 

245.  MB3 click and hold on the Hydroview 
Perspective tab and select ‘Close’. 

The Hydroview Perspective closes.  

246. Test – Time Step Mode 
247.  In CAVE, MB1 click on the Perspectives 

icon and select ‘Hydro’ from the dropdown 
menu if available. If not available, select 
‘Other…’. Then select ‘Hydro’ from the 
Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

248.  From the ‘MapData’ pull-down menu, 
select ‘Point Data Control…’. 

The Point Data Control window opens and 
the stations display in the Hydroview main 
window. 

 

249.  In the Presets/Query Mode Frame, MB1 
click on the ‘Time-Step’ radio button. 

The ‘Time Step’ radio button is filled in. The 
GUI changes in the ‘Elements’, 
‘Value/Time’, ‘Filtering’ and ‘Display’ 
sections. 

 

250.  In the Elements frame, MB1 click on the 
first combo box, the ‘Element Type Combo 
Box’.  

The available selections listed are: 
‘River’, ‘Rain’, ‘Snow’, ‘Temperature’, 
‘Humidity’ and ‘Wind’.  

 

251.  In the Elements First Combo Box, select 
‘River’.  

The selected element in the Elements 
Second Combo Box is ‘STAGE/POOL’. 
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252.  MB1 click on the ‘Elements Second Combo 

Box’ (right one). 
The available selections listed are: 
‘STAGE/POOL’, ‘FLOW/STORAGE’, 
‘DEPTH ABOVE FLOOD STAGE’ and 
‘PERCENT OF FLOOD FLOW’. 

 

253.  In the Elements frame, MB1 click on the 
‘Element Type Combo Box’ (left one) and 
select ‘Rain’. 

The selected element in the Element 
Combo Box is ‘INSTANTANEOUS’. 

 

254.  MB1 click on the ‘Element Combo Box’ 
(right one). 

The available selections listed are: 
‘INSTANTANEOUS’, ‘1-HOUR PRECIP 
TOTAL’, ‘3-HOUR PRECIP TOTAL’, ‘6-
HOUR PRECIP TOTAL’ and ‘24-HOUR 
TOTAL (12Z)’. 

 

255.  In the Elements frame, MB1 click on the 
‘Element Type Combo Box’ and select 
‘Snow’. 

The selected element in the Element 
Combo Box is ‘SNOW WATER EQUIV’. 

 

256.  MB1 click on the ‘Element Combo Box’ 
(right one). 

The available selections listed are: 
‘SNOW WATER EQUIV’ and ‘SWE – 24 
HOUR CHANGE’. 

 

257.  In the Elements frame, MB1 click on the 
‘Element Type Combo Box’ and select 
‘Temperature’. 

The selected element in the Element 
Combo Box is ‘TEMPERATURE’. 

 

258.  MB1 click on the ‘Element Combo Box’ 
(right one). 

The available selections listed are: 
‘TEMPERATURE’, ‘TEMP. 24 HOUR 
CHANGE’, ‘MAX TEMP’ and ‘MIN TEMP’. 

 

259.  In the Elements frame, MB1 click on the 
‘Element Type Combo Box’ and select 
‘Humidity’. 

The selected element in the Element 
Combo Box is ‘DEWPOINT’. 

 

260.  MB1 click on the ‘Element Combo Box’ 
(right one). 

The available selections listed are: 
‘DEWPOINT’, ‘DEWPT - 24 HR CHANGE’ 
and ‘RELATIVE HUMIDITY’. 

 

261.  In the Elements frame, MB1 click on the 
‘Element Type Combo Box’ and select 
‘Wind’. 

The selected element in the Element 
Combo Box is ‘WIND SPEED’. 

 

262.  MB1 click on the ‘Element Combo Box’ 
(right one). 

The available selections listed are: 
‘WIND SPEED’ and ‘WIND DIRECTION’. 

 

263.  In the Value/Time frame, MB1 click on the 
up and down arrow of the first set of arrows 
on the left side. 

When the up arrow is clicked, the day is 
increased. For example, 2006-01-22 18:00 
changes to 2006-01-23 18:00.  
When the down arrow is clicked, the day is 
decreased. For example, 2006-01-23 18:00 
changes to 2006-01-22 18:00. 
 
The data displayed on the Map changes. 
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264.  In the Value/Time frame, MB1 click on the 

up and down arrow of the second set of 
arrows on the right side. 

When the up arrow is clicked, the hour is 
increased. For example, 2006-01-22 18:00 
changes to 2006-01-22 19:00.  
When the down arrow is clicked, the hour is 
decreased. For example, 2006-01-22 19:00 
changes to 2006-01-22 18:00. 
 
The data displayed on the Map changes. 

 

265.  In the Elements section, choose the 
‘Temperature’ element type. 
 
In the Filtering frame, make sure the 
‘Type/Source’ check box is checked. 
 
MB1 click on the ‘Type/Source…’ button. 

When the ‘Type/Source’ button is clicked, a 
window appears displaying type sources. 
The list of type sources come from the 
ingestfilter table. Some of the common 
Type/Sources for Temperature are: 

• GOES - RG 
• LARC – RP 
• SNOTEL – RM 
• ALERT – RR 
• METAR - RZ 

 

266.  In the Type/Source popup window, MB1 
click on ‘GOES – RG’. Then MB1 click on 
‘Apply’. 
 

If ‘RG’ was selected, any values that have a 
type/source of ‘RZ’ disappear. (Verify by 
turning on the Display Section’s Param 
Code button.)  Some of the values 
displayed in the Hydroview GUI disappear. 
This occurs if there are some values 
displayed that have a Type/Source of ‘RZ’. 

 

267.  MB1 click the ‘Close’ button in the 
Type/Source dialog. 

The Type/Source dialog closes. 
 

 

268.  In the Filtering frame, enable the checkbox 
next to the ‘Service Area…’ button. 
MB1 click on the ‘Service Area…’ button. 
Select the first HSA and make sure all of 
the other HSAs are unselected. 
MB1 click on ‘Apply’. 

If the associated checkbox is checked, 
some values displayed disappear from the 
GUI. 
When the ‘Service Area…’ button is clicked, 
a window appears displaying a list of HSAs. 
When the first HSA is selected and the 
‘Apply’ button is clicked, the values 
displayed on the map is for stations whose 
HSA is the same as the HSA the user 
selected in the popup window.  

 

269.  MB1 click ‘Close’ in the Service Area 
dialog. 

The Service Area dialog closes.  

270.  In the Elements section, select the ‘RIVER’ 
Element Type. 

In the Filtering Section, there appears a 
‘Stations:’ option menu with ‘All’ as the 
default. 
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271.  In the Filtering Section, deselect all 

Type/Source and Service Area checkboxes 
(to make sure that stations are not 
unnecessarily being filtered out). 
 
In the Display Section, check the ‘Icon’ 
checkbox. 
 
Choose the ‘Stream’ option under the 
‘Stations’ option in the Filtering section. 

Only plain stream locations display. 
Triangles with NO rectangles are plain 
stream locations. 

 

272.  In the Filtering Section, select the 
‘Reservoir’ option. 

Only standard reservoir locations display. 
Triangles with rectangles under them 
represent reservoirs. 

 

273. Test - Common Filter and Display Options Procedure 
274.  In the Filtering frame, uncheck the ‘Show 

NonFcstPts’ checkbox. 
Only Forecast points display. A station is a 
forecast point if the station’s entry in the 
StnClass table has the character F in its 
disp_class field. A forecast point has a 
circle on top of the triangle. 

 

275.  Check the ‘Show NonFcstPts’ checkbox. All points that were filtered out from the 
previous steps are displayed. 

 

276.  In the Filtering frame, uncheck the ‘Show 
Missing’ checkbox. 

Only stations with non-missing values 
display in the GUI. 

 

277.  Check the ‘Show Missing’ checkbox. Stations with missing values display in the 
GUI (with ‘M’ for the value if that displays). 

 

278.  In the Filtering frame, enter ‘25’ in the 
textbox next to the ‘Value’ combo box. 
MB1 click on the ‘Value’ combo box and 
select ‘Value >=’. 
MB1 click on the ‘Value’ combo box and 
select ‘Value <=’. 
In the Filtering frame, MB1 click on the 
‘Value’ combo box and select ‘Any Value’. 

When the ‘Show Pts With:’ combo box is 
set to ‘Value >=’, any value that is greater 
than or equal to 25 displays in the GUI. 
When the ‘Value’ combo box is set to 
‘Value <=’, any value that is less than or 
equal to 25 displays in the GUI. 
When the ‘Value’ combo box is set to ‘Any 
Value’, all data values that are not filtered 
out display again in the GUI. 

 

279.  Enter ‘100’ in the textbox next to the ‘Elev’ 
combo box. 
MB1 click on the’ Elev’ combo box and 
select ‘Elev >=’. 
MB1 click on the ‘Elev’ combo box and 
select ‘Elev <=’. 
MB1 click on the ‘Elev’ combo box and 
select ‘Any Elev’. 

When the ‘Elev’ combo box is set to ‘Elev 
>=’, any station that has an elevation 
greater than or equal to 100 display in the 
GUI. 
When the ‘Elev’ combo box is set to ‘Elev 
<=’, any station that has an elevation less 
than or equal to 100 display in the GUI. 
When the ‘Elev’ combo box is set to ‘Any 
Elev’, all data values that are not filtered out 
display again in the GUI. 
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Step # Action Result Pass/Fail 
280.  In the Display frame, check and uncheck 

the following buttons. 
 
‘Value, Id, Name, Icon Name’ 
‘Time, Elevation, Param Code’ 

When a box for a data element is checked, 
that data element display on the map. 
 
A maximum of one of ‘Time’, ‘Elevation’, or 
‘Param Code’ can be selected at a time. 
The rest of the buttons can be selected in 
any combination. 

 

281.  MB1 click on the ‘Tabulate’ button. The Point Data Tabular Display appears 
showing all the stations not filtered out and 
the values that are currently displayed in 
the GUI. 

 

282.  In the Point Data Tabular Display window, 
MB1 click on the stations that have non-
missing values.  
MB1 click on the ‘Time Series Graph’ 
button. 
Close the Time Series Display window. 

When the ‘Time Series Graph’ button is 
clicked, the Time Series loads. The time 
series for the selected station displays in a 
graphical format. 

 

283.  In the Point Data Tabular Display window, 
MB1 click on the ‘Print’ button. 

The data displayed in the table prints.  

284.  In the Point Data Tabular Display window, 
MB1 click on the ‘Save’ button. 
Enter ‘test_save.pdc’ in the ‘Selection’ 
textbox. 
MB1 click on ‘OK’. 

When the ‘Save’ button is clicked, a dialog 
window appears allowing the user to 
specify a location and filename.  
When the ‘OK’ button is clicked, the report 
is saved to the file ‘test_save.pdc’ in the 
specified save directory 
(awips/hydroapps/whfs/local/data/report). 
The report contains data that is identical to 
the data displayed in the Point Data 
Tabular Display window. 

 

285.  In the Point Data Tabular Display window, 
MB1 click on the ‘Close’ button. 

The Point Data Tabular Display window 
closes and control is returned to the Point 
Data Control GUI. 

 

286.  In the Point Data Control GUI, MB1 click on 
the ‘Unmap’ button. 

When the ‘Unmap’ button is clicked, all of 
the values displayed in the Hydroview GUI 
are removed (unmapped). 

 

287.  In the Point Data Control GUI, MB1 click on 
the ‘Map’ button. 

When the ‘Map’ button is clicked, all of the 
station values that are currently not filtered 
out are mapped to the Hydroview GUI. 
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Step # Action Result Pass/Fail 
288.  Set the following options. Apply and close 

filter dialogs as needed. 
• In the Presets/Query Mode frame, 

the ‘Query Mode’ is set to ‘Ad 
Hoc’. 

• In the Elements frame, the 
‘Element Type’ (left) combo box is 
set to ‘River’. 

• In the Elements frame, the 
‘Element’ (right) combo box is set 
to ‘Primary’. 

• In the Value/Time frame, the 
‘Value Filters’ combo box is set to 
‘Latest Value’. 

• In the Filtering frame, the 
‘Type/Source’ button is 
unchecked. 

• In the Filtering frame, the ‘Service 
Area…’ checkbox is checked. 

o Select the first HSA. 
• In the Filtering frame, the ‘Data 

Source…’ checkbox is checked.  
• In the ‘Data Source…’, the dialog 

box is set to select ‘Observer 
Only’. 

• In the Filtering frame, the ‘Show 
NonFcstPts’ checkbox is checked. 

• In the Filtering frame, the ‘Show 
Missing’ checkbox is unchecked. 

• In the Filtering frame, the two 
Show Pts with combo boxes are 
set to ‘Any Value’ and ‘Any Elev’. 
The corresponding text boxes are 
desensitized. 

• In the Display frame, the ‘Value’, 
‘ID’ and ‘Icon’ checkboxes are 
checked. 
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Step # Action Result Pass/Fail 
289.  Continued from step 92: 

 
Set the following options. Apply and close 
filter dialogs as needed. 

• The ‘Name’ checkbox is 
unchecked. 

• In the Display frame, the ‘Time’ 
and ‘Elevationand Param Code’ 
radio buttons are unchecked. 

• In the Display frame, the ‘Color 
River Icons’ checkbox are 
checked. 

• In the Display frame, the ‘River 
Color/Value Based On:’ combo 
box is set to ‘Max(Obs, Fcst)’ 

• In the Display frame, the ‘Display 
Values As:’ combo box is set to 
‘Raw Value’. 

• In the Point Data Control GUI, 
MB1 click on the ‘Save…’ button. 

The Save Present Options dialog appears.  

290.  Enter ‘test_set’ in the ‘UniqueId:’ textbox 
under the New Information section. 
Enter ‘test option set’ in the ‘Description:’ 
textbox. 
Enter ‘2’ in the ‘Rank:’ textbox. 
MB1 click on the ‘Ok’ button. 

When the ‘Ok’ button is clicked, the Save 
Preset Options dialog box closes and the 
option set is saved to the pointdatapresets 
table in the IHFS database. 

 

291.  In the Point Data Control window, MB1 click 
on the ‘Close’ button. 
MB3 click and hold on the Hydroview tab. 
Select ‘Close’. 

The Point Data Control GUI and Hydroview 
Perspective close. 
 

 

292.  MB1 click on the Perspectives icon and 
select ‘Hydro’ from the dropdown menu if 
available. If not available, select ‘Other…’. 
Then select ‘Hydro’ from the Open 
Perspective dialog. 

The Hydro Perspective displays in CAVE.  

293.  From the ‘MapData’ pull-down menu, select 
‘Point Data Control…’. 

The Point Data Control window opens and 
the stations display in the Hydroview main 
window. 
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Step # Action Result Pass/Fail 
294.  In the Presets/Query Mode frame, change 

the value of the ‘Selected Preset:’ combo 
box to ‘test option set’. 

When ‘test option set’ is selected in the 
‘Selected Preset:’ combo box, all of the 
following is set in the GUI: 

• In the Presets/Query Mode frame, 
the ‘Selected Preset:’ combo box 
displays ‘test option set’. 

• The other settings are the same 
as mentioned in Action Steps 92 
and 93. 

 

295.  In the Presets/Query mode frame, MB1 
click on the ‘Delete’ button. 

When the ‘Delete’ button is clicked, the 
preset is deleted and removed from the 
pointdatapresets table upon the relaunch of 
Hydroview. 

 

296.  In the Point Data Control window, MB1 click 
on the ‘Close’ button. 

When the ‘Close’ button is clicked, the 
Point Data Control GUI closes. 

 

297.  Exit the Hydroview Perspective. The Hydroview Perspective closes.  
End of Point Data Control Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None. 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: Baseline_Hydrobase (OB8.3); 
Baseline_Hydrobase_OB8.1; Hydrologic Database; 
Check_Out_4.4.1_Hydrobase_OB8.1. 

• Software Test Plan for the Advanced Weather Interactive Processing System 
Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates that AWIPS provides the capability to execute the WFO Hydrologic 
Forecast System (WHFS) Hydrologic Database Manager (HydroBaseMgr). Hydrobase allows a 
WFO to manage the IHFS database that supports hydrologic forecasting. 

 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested . 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 

 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from 
the dropdown menu if available. If not 
available, select ‘Other…’. Then select 
‘Hydro’ from the Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  Under the ‘HydroApps’ menu, select the 
‘Launch Hydrobase…’ option. 

The HydroBase window opens, listing all of 
the forecast points in the site-specific 
database for the WFO. 

 

3.  From the ‘Sort By’ option, select each of the 
following options in succession: 
‘Station’ 
‘Name’ 
‘State, County’ 

The list is sorted according to the criteria 
selected. 

 

4.  Search for a station (e.g., BLUC1) by using 
the Search box in the lower right side of the 
panel. 

As each letter is added, the search is further 
defined. 

 

5.  Select ‘Add Location’ from the Location 
menu. 

The Add Location window opens with a 
template to add new locations. The Add 
Location window is on the Geophysical 
Page option. 

 

6.  Add a new location named ‘AWIP2’. See 
Appendix (end of document) image 1 for 
input. 

None.   

7.  Select ‘Apply’ and ‘OK’. The new location is added to the listing of 
forecast points in the HydroBase window. 

 

8.  Select ‘Modify Location’ from the Location 
menu. [See App. A, Fig. 1.] 

The Modify Location window opens with  
the data just entered. 

 

9.  Select Cancel. Window closes.  
10.  Select Contacts from the Location menu. The Contacts window opens.  
11.  MB1 click on New. Add the Contact and 

Phone information shown in Appendix 
image 2. Then MB1 click on ‘Apply’. 

Contacts are added. 
 
NOTE: Select New before each entry and 
Apply after each entry. 

 

12.  Select Ok to close the window. Window closes.  
13.  Reopen the window by selecting Contacts 

from the Location menu to verify that the 
information was added. Then select ‘Close’. 
[See App. A, Fig. 2.] 

Contacts are there. The window closes.  

14.  From the River Gage menu, select ‘River 
Gage’. 

The River Gage window opens. 
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Step # Action Result Pass/Fail 
15.  With the ‘Page’ option set to ‘Geophysical’, 

add information to this window from 
Appendix image 3. 

See Appendix image 3. 
 
NOTE: Application may crash if the Date of 
Rating field is left blank with the Page option 
set to Additional Info (DR #19887). 

 

16.  Select ‘Apply’ and ‘OK’ to close the window. The data is added and window closes.  
17.  Select ‘River Gage’ under the River Gage 

menu to reopen it. Verify that the information 
was added. [See App. A, Fig. 3.] 

The data is verifies as saved on the system.  

18.  Select ‘Cancel’. The window closes.  
19.  From the ‘River Gage’ menu, select ‘Crest 

History’ to display the Crest History window. 
The window opens.  

20.  MB1 click ‘New’. Add information to this 
window from Appendix Image 4 and Image 
5. Then MB1 click on ‘Apply’. 

See Appendix Image 4 and Image 5. 
 
NOTE: Select ‘New’ before each entry and 
‘Apply’ after each entry. 

 

21.  Select ‘OK’ to close the window. Information is saved and the window closes.  
22.  Select ‘Crest History’ from the ‘River Gage’ 

menu to verify that the information was 
added. Then select ‘Close’. [See App. A, 
Figures 4 and 5.] 

The data is verified as saved and the 
window closes. 

 

23.  From the ‘Location’ menu, select 
‘County/Zone UGC’. 

The County/Zone UGC window opens. This 
window contains counties affected for the 
forecast point plus all of the available 
counties in the area. 

 

24.  Add information to this window by selecting 
the county names in the ‘Available’ section 
and selecting the ‘Add’ button. 

The data is added.  

25.  Select ‘Apply’ and ‘OK’ to close the window. The data saved and the window closes.  
26.  Select ‘County/Zone UGC’ from the 

‘Location’ menu to reopen the window. 
Verify that the information was added. 

The data is verified as saved.  

27.  Select ‘Cancel’. The window closes.  
28.  Select ‘Flood Category’ from the ‘River 

Gage’ menu. 
The Flood Category window opens, showing 
definitions of the following flood types:  
Major, Moderate, and Minor. 

 

29.  Add information to this window from 
Appendix image 6. 

The data is added.  

30.  Select ‘OK’ to apply and close the window. The data is saved and the window closes.  
31.  Select ‘Crest History’ from the ‘River Gage’ 

menu. [See App. A, Figure 6.] 
The flood stage categories are depicted as 
colored lines (See Image 7 in the Appendix 
for an example). 

 

32.  Select ‘Close’. The window closes.  
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Step # Action Result Pass/Fail 
33.  From the ‘River Gage’ menu, select the 

‘Impact Statement’ option. [See App. A, Fig. 
7.] 

The Impact Statement window opens with 
the following types of information:  Impact 
Value, Impact PE, Begin, End, and 
Tendency. 

 

34.  MB1 click on ‘New’. Add information to this 
window from Appendix image 8. Then MB1 
click on ‘Apply’. 

The data is added. 
 
NOTE: Select ‘New’ before each entry and 
‘Apply’ after each entry. 

 

35.  Select ‘OK’ to close the window. The data is saved and the window closes.  
36.  Select ‘Impact Statement’ from the ‘River 

Gage’ menu to verify that the data were 
added. Then select ‘Cancel’. [See App. A, 
Fig. 8.] 

The data is verified as saved and the 
window closes. 

 

37.  Select a Reservoir in the Hydrologic 
Database.  
BDBC1 is an example of a reservoir on 
TBDW, WINC3 on TBW3. Other systems 
will have other stations selected. 

The station is selected. 
 
Note: Point Data Control on Hydroview may 
be used to locate other reservoirs. 

 

38.  Select ‘Reservoir’ from the ‘Reservoir’ 
menu. 

The Reservoir window opens with 
information on the selected reservoir. 

 

39.  Select ‘Cancel’.  The window closes.  
40.  From the ‘Setup’ on the menu bar option 

(right side of menu bar, next to Help), select 
the ‘Reference Fields’ option. 

The Reference Fields window opens 
containing a ‘Fields’ option and ‘Add’, 
‘Update’, and ‘Delete’ buttons. 

 

41.  Select ‘OK’ from the Reference Fields 
window. 

The window closes.  

42.  Select ‘AWIP2’ from the HydroBase window. ‘AWIP2’ is selected.  
43.  Select ‘Rating Curve’ from the ‘River Gage’ 

menu. 
The Rating Curve window opens. Verify that 
flood stage is a red line and the record flood 
stage is a blue line. 

 

44.  Select ‘Close’. The window closes.  
45.  Select ‘Flood Report’ from the ‘Reports’ 

menu. 
 

The Flood Report window opens with a flood 
report for the Area of Responsibility. 

 

46.  Select ‘Last 12 Months’ from the ‘Reporting 
Period’ option. 

A graphic history of flooding displays.  

47.  Select ‘Close’ from the Flood Report 
window. 

The window closes.  

48.  Select ‘AWIP2’ from the listing of forecast 
points, and select ‘Ingest Filter’ from the 
‘Data Ingest’ menu. 

The Data Ingest Filter window opens.  
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Step # Action Result Pass/Fail 
49.  Select ‘New’. In the ‘NEW Item’ section, add 

the following: 
 
Location:  AWIP2 
Physical Element :  HT Tailwater Elev 
Duration:  Instantaneous (0) 
TypeSource:  GOES (RG) 
Extremum:  Null Character (Z) 
 
Also, toggle on the ‘Master Switch’ button. 

The data is added.  

50.  Select ‘Apply’. 
  

‘AWIP2’ appears highlighted in the Ingest 
Filter Contents for Locations section. 

 

51.  Select ‘OK’. The window closes.  
52.  In the HydroBase window, select ‘Station 

List Filter Options’. 
The Station List Filter Options window 
opens. 

 

53.  Select an HSA under ‘Filter by HAS’. The item is selected.  
54.  Select ‘Apply’. The stations in the HydroBase window are 

filtered. Only stations in counties with the 
selected responsible WFO are shown. 

 

55.  Select ‘Exit’ from the ‘File’ menu of the 
HydroBase window. 

The HydroBase window closes.  

 End of Test   
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
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APPENDIX A. FIGURES 

 
Figure 1. Step 8 

 

 
Figure 2. Step 13 
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Figure 3. Step 17 

 

 
Figure 4. Step 22 
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Figure 5. Step 22 

 
 
 
 

 
Figure 6. Step 31 
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Figure 7. Step 33 

 
 
 
 
 

 
Figure 8. Step 36 
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1.0   SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1   Source Documents 
• None 

2.2  Reference Documents 
• Legacy NWS Test Cases: Baseline _SSHP_OB8.1; Checkout_SSHP_OB8.1. 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0   TEST CASE DESCRIPTION 
This test case demonstrates that AWIPS provides the capability to execute the WHFS Site 
Specific Hydrologic Prediction software (SSHP). The SSHP software allows a WFO to run a 
simple hydrologic model for a single point. 
 

3.1 Assumptions, Constraints, and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested.  
• Actions, Results, and Requirement highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 

3.2   Recommended Hardware 
See TO10 Software Test Plan. 
 

3.3   Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

3.4   Test Outputs 
The results outlined in section 4.0 are met. 
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4.0   TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from the 
dropdown menu if available. If not available, 
select ‘Other…’. Then select ‘Hydro’ from the 
Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  From the ‘MapData’ pull-down menu, select 
‘Site Specific…’. 

The Point Data Control window opens 
and the stations display in the Hydroview 
main window. 

 

3.  Select ‘Site Specific’ from the ‘Hydrology’ 
submenu. From the ‘Configuration’ menu of 
the SSHP GUI, select ‘Configure Fcst Points 
for SSHP’. 

The SSHP Config window comes up with 
the first record selected by default. 

 

4.  MB1 click on the ‘Clear’ button within the 
SSHP Config window. 

The values in the text boxes are cleared 
out. The Model Preference changes to 
API-MKC. The Source Preference 
changes to ‘LOCAL’. Posting time is set 
to ‘Not Posted Yet.’ 

 

5.  Enter the following values in the text fields 
after MB1 clicking ‘Clear’: 
LID:  ‘ABCD1’ 
Basin ID:  ‘ABCD1’ 
Model Preference:  ‘SAC-SMA’ 
Update Model States?:  unchecked 
Source Preference:  ‘RFC’ 
Use ET Demand Curve?:  unchecked 

Settings change.  

6.  MB1 click on ‘Save’ after entering the data. The table updates showing the new entry. 
The data displayed in the table is the 
same as what was entered in the text 
fields. 

 

7.  Select another LID from the table. The text fields in the GUI show the data 
of the LID selected. 

 

8.  Select the ‘ABCD1 LID’ from the table and 
MB1 click on ‘Delete’. When the confirmation 
dialog appears, select ‘Yes’. 

After selecting Yes, the Config is deleted 
and the table refreshes. 

 

9.  MB1 click on the ‘Close’ button The SSHP Config window closes and the 
Control Window becomes active. 

 

10.  From the ‘Extra’ menu, select ‘Run MAP 
Preprocessor’. 

The MAP Preprocessor runs in the status 
window. A log is created in the log 
directory. There are warnings about files 
missing and this is normal. For the files 
that do exist, data is inserted into the 
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Step # Action Result Pass/Fail 
ProcValue table with duration of 1001, 
and a PE of ‘PP’. The lid is the same as 
the Basin Id specified in the SSHPConfig 
Window. 

11.  MB1 click on the button labeled ‘Analysis 
Window’ from the Control Window. 

The Analysis window appears. The 
Rainfall-Runoff Model matches the one 
set within the SSHP Config window for 
that particular LID. 

 

12.  Change the Rainfall-Runoff Model to ‘SAC-
SMA’. 

If the station was set for the API-MKC 
model, the API-MKC settings panel 
changes to the SAC-SMA settings panel. 
The model run start time label should 
indicate the same time as the model state 
selected in the state drop-down box 
below it. The model run start time 
indicated by the vertical magenta line on 
the precip graph and the hydrographs 
should also match the model run start 
time. 

 

13.  MB1 click the ‘Refresh State List’ button. The contents of the state drop-down box 
are updated based on the contents of the 
database. If the previously selected state 
is still available, it is selected. Otherwise, 
the first item in the list is selected. If no 
states are available for that location in the 
database, there is a default state that is 
selected. It is named ‘BOGUS DEFAULT 
State’ to indicate the lack of proper data. 

 

14.  Draw some precip bars in the 1 Hour Mean 
Areal Precip Time Series graph. Then MB1 
click ‘Reload Precip.’ 

The precip bars appear as drawn. After 
clicking ‘Reload Precip’, the application 
reloads the precip time series with the 
data in the database. Missing data in the 
database appears as zero precip. The 
drawn precip bars disappear and are 
replaced with whatever mean areal precip 
(MAP) data is available for that basin. 

 

15.  MB1 click ‘Reload Stream Obs’. The latest observed stage readings 
displays in the hydrograph. This becomes 
more obvious, if 1) there is a live data 
feed with river stages and 2) another 
reading is added after the Analysis The 
window has been started. 

 

16.  Change the ‘Rainfall-Runoff Model’ option to 
‘API-MKC’. 

The API-MKC Settings Panel replaces 
the SAC-SMA Settings Panel. 

 

17.  Action:  MB1 click on the button labeled with Both graphs shift back in time by 24  
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Step # Action Result Pass/Fail 
a blue double left arrow (<<). hours 

18.  MB1 click on the button labeled with a blue 
double right arrow (>>). 

Both graphs shift forward in time by 24 
hours 

 

19.  MB1 click on the button labeled with a blue 
single left arrow (<). 

Both graphs shift back in time by 1 hour.  

20.  MB1 click on the button labeled with a blue 
single right arrow (>). 

Both graphs shift forward in time by 1 
hour. 

 

21.  MB1 click on the button labeled with a blue 
double right arrow (>>) 3 times. MB1 click the 
button with the circle icon. 

After clicking the double right arrow, both 
graphs shift forward in time by 72 hours. 
Then, after clicking the circle button, the 
graphs return to the ‘home’ position with 
the vertical magenta line approximately 
one-third of the graph display to the right 
of the left-most position. 

 

22.  MB1 click the ‘Scale to Flood Stage’ 
checkbox. 

When the checkbox is checked, the flood 
stage (if set in database) and the action 
stage (if set in database) displays as red 
and yellow horizontal lines, respectively, 
on the lower graph. When it is not 
checked, the red and yellow lines appear 
only if they are within the scaling range of 
the lower graph. For example, if the 
highest observed stage is 24.7 and the 
highest forecast stage is 25, then a flood 
stage of 52.6, is not displayed. However, 
if the flood stage is 20, then the flood 
stage and action stage appears. 

 

23.  MB1 click the ‘Show Obs Stages’ checkbox. When the checkbox is checked, the 
observed hydrograph (yellow circles) 
appears in the bottom graph. When it is 
not checked, the observed hydrograph 
does not appear. 

 

24.  MB1 click the ‘Show Minor Precip Lines’ 
checkbox. 

When the checkbox is checked, the 
dotted horizontal lines appear in the 
precip graph (upper graph). When it is not 
checked, the dotted horizontal lines do 
not appear. 

 

25.  MB1 click the ‘Show Minor Stage Lines’ 
checkbox. 

When the checkbox is checked, the 
dotted horizontal lines appear in the 
hydrograph (lower graph). When it is not 
checked, the dotted horizontal lines do 
not appear. 

 

26.  MB1 click anywhere above the zero line to 
the left of the vertical magenta line (model run 
time) on the upper graph. 

The vertical magenta line signifies the 
model run time. Since the user clicked to 
the left of the magenta line, it has no 
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Step # Action Result Pass/Fail 
effect on the stage graph below and no 
blue bars appear. 

27.  MB1 click anywhere above the zero line to 
the right of the vertical purple line (model run 
time) on the upper graph. 

A blue bar appears where the user 
clicked on the graph. Since the user 
clicked to the right of the vertical magenta 
line (model run time), the bottom graph 
changes accordingly. Any precipitation 
that is shown before the model run time 
(left of the vertical magenta line) is not 
used in calculating the runoff. 

 

28.  Directly under one of the previously created 
blue precip bars, MB1 click on the upper 
graph. 

The blue bar disappears after clicking 
below the zero line. 

 

29.  MB1 click and slowly drag anywhere above 
the zero line in the precip graph. After some 
mouse travel, release the mouse button. 

Precip bars are created where the mouse 
traveled. If the mouse moved too fast, 
some GUI event loss is expected and 
some precip bars will be missing. As each 
precip bar is created, the model is rerun. 
This is seen in the hydrograph (the lower 
graph). 

 

30.  Check the ‘Delay Rerun While Drawing’ 
check box in the Graph Controls Panel. MB1 
click and drag anywhere above the zero line 
in the precip graph. Release the mouse 
button. 

Precip bars are created where the mouse 
traveled. Less event loss should occur 
and the model is rerun only after the 
mouse button is released or the mouse 
cursor leaves the precip graph. 

 

31.  Above the zero line and to the right of the 
magenta vertical line, MB3 on the hydrograph 
(the lower graph). 

The forecast hydrograph (the connected 
green circles) changes to reflect the point 
where the user clicked. 

 

32.  MB1 click on the precip graph, creating a 
precip bar. 

The forecast hydrograph is recomputed, 
losing the change made in the previous 
step. 

 

33.  MB1 click on the button labeled ‘Capture 
Screen’. Enter picture1.jpg for the File Name. 
MB1 click on ‘Save’ after typing in the name. 

The Save dialog appears prompting the 
user for a filename. After entering 
picture1.jpg and clicking on the ‘Save’ 
button, the screen is captured to the 
specified filename and the save dialog 
closes. MB1 clicking ‘Cancel’ results in a 
dialog box informing the user that the 
image file was not saved. MB1 clicking 
‘OK’ returns the user to the Analysis 
window. 

 

34.  MB1 click on the button labeled ‘Control 
Window’. 

The SSHP Control Window appears in 
the foreground. The user is able to open 
up multiple analysis windows per Control 
Window. 
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Step # Action Result Pass/Fail 
35.  In the ‘Model Controls’ Panel, select ‘API-

MKC’ as the Rainfall-Runoff Model. 
The API-MKC Settings Panel displays. 

 
 

36.  In the API-MKC Settings Panel, check the 
‘Use Custom Time’ check box. 

The Model Run Start Time changes to the 
time indicated next to the check box. This 
changes the model run start time on the 
precip graph and the hydrograph. The 
only circumstance in which the Model 
Run Start Time Label disagrees with the 
selected product time is when this check 
box is checked and the selected custom 
time is different. 

 

37.  In the API-MKC Settings Panel, MB1 click on 
the time control next to the Use Custom Time 
check box. Change the time and MB1 click 
the ‘Apply’ button. 

A date-time editor window appears. The 
time changes as a result of clicking the up 
and down blue triangles. After clicking the 
‘Apply’ button, the model run start time 
changes to the newly selected time. This 
is reflected in the Model Controls Panel 
and the graphs.  

 

38.  In the API-MKC Settings Panel, uncheck the 
‘Use Custom Time’ check box. 

The Model Run Start Time returns to the 
value selected in the model state drop-
down box below the Model Run Start 
Time Label. 

 

39.  In the API-MKC Settings Panel, change the 
FFH value in the text box next to the 
‘FFH(inches):’ label to ‘155’. MB1 click the 
‘Apply’ button in the same panel. 

The forecast model is rerun and a new 
forecast stage time series displays in the 
hydrograph display. 

 

40.  In the API-MKC Settings Panel, change the 
Threshold Runoff value in the text box next to 
the ‘Threshold Runoff(inches):’ label. MB1 
click the ‘Apply’ button in the same panel. 

The model is rerun and a new forecast 
stage time series displays in the 
hydrograph display. 

 

41.  In the API-MKC Settings Panel, MB1 click the 
‘Reload FFH’ button. 

The previously selected FFH value load 
from the selected item in the state list 
placed in adjacent text box. The model 
has been rerun and the new forecast 
hydrograph displays. 

 

42.  In the API-MKC Settings Panel, MB1 click the 
‘Reload T. Runoff’ button. 

A new value (usually the same as the 
original) loads from the database placed 
in adjacent text box. The model has been 
rerun and the new forecast hydrograph 
displays. 

 

43.  In the Medel Controls Panel, change the 
Rainfall-Runoff model to ‘SAC-SMA’. MB1 
click on the button labeled ‘Edit Params’ from 
the Analysis window. 

The SacSma Parameters window 
appears. In the table, Basin ID, Source, 
and Valid Times are listed for each 
record. Clicking on any Basin ID 
populates the text fields with the 
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Step # Action Result Pass/Fail 
appropriate data. 

44.  MB1 click on the Valid Time Text Field of 
‘ABCD1’. 

The Date/Time Display appears providing 
the user with a GUI interface to set the 
date/time. Clicking on the up and down 
arrows increases and decreases the 
value respectively. The Date/Time 
Display takes account of Leap Years as 
well. MB1 clicking on ‘Apply’ sets the 
Valid Time to the selected time and 
closes the Date/Time Display. MB1 
clicking on ‘Cancel’ closes the Date/Time 
Display without changing the time. 

 

45.  MB1 click on the ‘Clear’ button. All of the text fields are cleared out. The 
Valid-Time text field is set to ‘yyyy-mm-dd 
hh:mm:ss’. 

 

46.  Enter the following data into the text fields. 
Then MB1 click on the ‘Save’ button:  

Basin ID:  ABCD1 
Source:  RFC 
Valid Time:  current time 
UZTWM:  15.0 
UZFWM:  15.0 
UZK:  0.3 
PCTIM:  0.04 
ADIMP:  0.3 
RIVA:  0.0 
ZPERC:  95.0 
REXP:  3.0 
LZTWM:  90.0 
LZFSM:  80.0 
LZFPM:  170.0 
LZSK:  0.225 
LZPK:  0.012 
PFREE:  0.1 
RSERV:  0.3 
SIDE:  0.0 
PEADJ:  1.0 
PXADJ:  1.0 
EFC:  0.0  

Settings changed.  

47.  MB1 click on the ‘Save’ button. If there is already a record in the table 
with the same Basin ID, Source, and 
Valid Time entered in the text fields, 
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Step # Action Result Pass/Fail 
clicking on Save updates the record with 
the changes from the text field. If the 
Basin ID, Source, or Valid Time are 
unique, clicking on Save inserts a new 
record. MB1 clicking on the Valid Time 
text field brings up a Date/Time GUI 
which was tested in step 16. MB1 click on 
the ‘Apply’ button within the Date/Time 
GUI to set the valid time to the current 
time. MB1 clicking on the ‘Save’ button 
inserts the new record into the database. 
The record is saved in the 
SacSmaParams table. 

48.  Select the record that was just inserted in the 
previous step. MB1 click on the ‘Delete’ 
button. 

A confirmation dialog box appears stating 
whether to delete the Param or not. MB1 
clicking ‘No’ returns the user back to the 
SacSma Parameters window. MB1 
clicking ‘Yes’ deletes the selected Param 
and refreshes the table. 

 

49.  MB1 click on the ‘Close’ button. The ‘SacSma Parameters’ window closes 
and the Analysis window reappears. 

 

50.  MB1 click on the button labeled ‘Edit States’ 
from the Analysis window. 

The SacSma State window appears. In 
the table, Basin ID, Source, and Valid 
Times are listed for each record. MB1 
clicking on any Basin ID populates the 
text fields with the appropriate data. 

 

51.  MB1 click on the ‘Valid Time/Basis Time Text 
Field’. 

The Date/Time Display appears providing 
the user with a GUI interface to set the 
date/time. MB1 clicking on the up and 
down arrows increases and decreases 
the value respectively. The Date/Time 
Display takes account of Leap Years as 
well. MB1 clicking on ‘Apply’ sets the 
Valid Time/Basis Time to the selected 
time and closes the Date/Time Display. 
MB1 clicking on Cancel closes the 
Date/Time Display without changing the 
time. 

 

52.  MB1 click on the ‘Clear’ button. All of the text fields are cleared out. The 
Valid-Time and Basis Time text fields are 
set to ‘yyyy-mm-dd hh:mm:ss’. 

 

53.  Enter the following data into the text fields. 
Then MB1 click on the ‘Save’ button: 

Basin ID:  ABCD1 
Source:  RFC 

The settings change.  
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Step # Action Result Pass/Fail 
Valid Time:  current time 
Basis Time:  current time 
UZTWC:  31.02 
UZFWC:  0.0090 
LZTWC:  31.94 
LZFSC:  0.01079483884 
LZFPC:  68.4223323 
ADIMC:  62.04 

54.  MB1 click on the ‘Save’ button. If there is already a record in the table 
with the same Basin ID, Source, and 
Valid Time entered in the text fields, MB1 
clicking on Save updates the record with 
the changes from the text field. If the 
Basin ID, Source, or Valid Time are 
unique, MB1 clicking on Save inserts a 
new record. MB1 clicking on the Valid 
Time text field bring up a Date/Time GUI 
which was tested in step 16. MB1 click on 
the ‘Apply’ button within the Date/Time 
GUI to set the valid time to the current 
time. MB1 clicking on the ‘Save’ button 
inserts the new record into the database. 
The record is saved in the SacSmaState 
table. 

 

55.  Select the record that was just inserted in 
step 53. MB1 click on the ‘Delete’ button. 

A confirmation dialog box appears stating 
whether to delete the State or not. MB1 
clicking ‘No’ returns the user back to the 
‘SacSma State’ window. MB1 clicking 
‘Yes’ deletes the selected State and 
refreshes the table. 

 

56.  MB1 click on the ‘Close’ button. The ‘SacSma State’ window closes and 
the Analysis window reappears. 

 

57.  MB1 click on the button labeled ‘MAPE 
Monthly Values’ from the Analysis window. 

The ‘Monthly Value Editor’ window will 
come up. In the table, Loc ID, PE, Dur, 
TS, Extremum, and Adjustment are 
displayed for each Location. MB1 clicking 
on any Loc ID populates the text fields 
below. Only records that have a PE value 
of EA display in the table. The PE text 
field is uneditable and is set to EA. 

 

58.  MB1 click on the ‘Clear’ button. All of the text fields are cleared out. The 
Posting Time changes to ‘Not Posted 
Yet.’  The Duration defaults to 1 hour. 
The Adjustment check box is unchecked. 
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Step # Action Result Pass/Fail 
59.  Enter the following data into the text fields. 

Then MB1 click on the ‘Save’ button: 
Basin ID:  ABCD1 
PE:  EA 
Duration:  3 hours 
TS:  FZ 
Extremum:  Z 
Adjustment:  Checked 
January:  0.7 
February:  0.5 
March:  0.4 
April:  0.2 
May:  0.3 
June:  1.2 
July:  1.1 
August:  1.1 
September:  1.1 
October:  0.9 
November:  0.8 
December:  0.8 

The settings change.  

60.  MB1 click on the ‘Save’ button. If there is already a record in the table 
with the same Basin ID, PE, Dur, TS, 
Extremum, and Adjustment entered in the 
text fields, MB1 clicking on Save updates 
the record with the changes from the text 
field. If the Basin ID, PE, Dur, TS, 
Extremum, or Adjustment is unique, MB1 
clicking on Save inserts a new record. 
MB1 clicking on the Valid Time text field 
brings up a Date/Time GUI which was 
tested in step 16. MB1 click on the ‘Apply’ 
button within the Date/Time GUI to set 
the valid time to the current time. MB1 
clicking on the ‘Save’ button inserts the 
new record into the database. The record 
is saved in the SacSmaState table. 

 

61.  Select the record that was just inserted in 
step 59. MB1 click on the ‘Delete’ button. 

A confirmation dialog box appears stating 
whether to delete the record or not. MB1 
clicking ‘No’ returns the user back to the 
Monthly Value Editor window. MB1 
clicking ‘Yes’ deletes the selected record 
and refreshes the table. 

 

62.  MB1 click on the ‘Close’ button. The Monthly Value Editor window closes  
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Step # Action Result Pass/Fail 
and the Analysis window reappears. 

63.  From the ‘View/Edit’ menu, select ‘Forecast 
Stage Editor’ from the Analysis window. 

The Forecast Stage Editor window 
appears. The Time, Stage, Discharge, 
and or missing value (if applicable) 
displays. The discharge is uneditable and 
is calculated from the given Stage value. 

 

64.  Select a stage and delete the value in the text 
box. Then MB1 click on another text box. 

After MB1 clicking on the second text 
box, the first text box automatically has a 
0.0 entered into it. The corresponding 
discharge value updates to reflect this 
change. 

 

65.  MB1 click on the ‘Missing Value?’ checkbox 
for the first row changed in Step 63. 

The Stage reloads its old value in place of 
the 0.00. The corresponding discharge 
value updates to reflect this change. 

 

66.  Change one of the Stage values to ‘45.0’. 
Then MB1 click on the ‘Apply’ button. 

The TimeSeries updates with the new 
data. The bottom graph reflects this 
change. 

 

67.  MB1 click on the ‘Close’ button. The Forecast Stage Editor window 
closes. 

 

68.  Note:  ‘Save FcstHeight’, ‘Save 
FcstDischarge..’ and ‘Save Evap’ all use the 
same GUI. As a result, the following steps 
test each window out. 
 
From the ‘Save’ menu, select ‘Save Forecast 
Stage’. 

The Save Forecast window appears. The 
Physical Element is set to HG for Save 
FcstHeight, QR for Save FcstDischarge, 
and EA for Save Evap. They cannot be 
edited. There is a Type Source (TS) and 
a SHEF Qualifier combo box. The 
Product ID text box is blank. The Basis 
Time and the Product Time are set to the 
current time. 

 

69.  Change the type source to ‘FG’. Change the 
SHEF Qualifier to ‘Z’. Enter ‘TestProduct’ in 
the Product ID. MB1 click on the ‘Save to 
Database’ button. 

If the insert is successful, a dialog 
appears stating so. If the insert fails, a 
dialog appears with an error message. 

 

70.  MB1 click on the ‘Close’ button. The Save Forecast window closes and 
the Analysis window appears. 

 

71.  Note:  ‘View Prior Runoff’ and ‘View Runoff’ 
both use the same GUI. As a result, the 
following steps test both windows out. 
 
From the ‘View/Edit’ menu, select ‘Prior 
Runoff Viewer’. 

The ‘Prior Computed Runoff’ window 
appears. The Time, Runoff and missing 
values display. If there is no prior runoff, 
nothing is displayed below the column 
headers. The missing value check boxes 
are disabled as they are not needed here. 

 

72.  MB1 click on the ‘Close’ button. The Prior Computed Runoff window 
closes and the Analysis window appears. 

 

73.  From the ‘View/Edit’ menu, select ‘Precip The Mean Areal Precip Editor window  
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Step # Action Result Pass/Fail 
Editor..’. appears. The Time, Precip, and missing 

values check boxes display. 

74.  MB1 click on any text field and change the 
value to 45.00’. Then MB1 click on another 
text field. Then MB1 click on the ‘Missing 
Value?’ checkbox for the first text field. 

The value of the text field changes to ‘-
9999.00’ when the user MB1 clicks on the 
second text field.  

 

75.  MB1 click on the ‘Apply’ button. The top graph reflects the change made 
in the Observed Mean Areal Precip 
Editor. If the changed value’s time is after 
the model start time, the bottom graph 
updates to reflect the change in the top 
graph. If the changed value’s time is 
before the model start time, the bottom 
graph does not change. 

 

76.  MB1 click on the ‘Close’ button. The Observed Mean Areal Precip Editor 
window closes and the Analysis window 
appears. 

 

77.  From the View/Edit menu, select 
‘Evapotraspiration Editor..’. 

The Mean Areal Potential Evaporation 
window appears. The Time, Evap and 
missing values check boxes display. 

 

78.  MB1 click on any text field and change the 
value to ‘45.00’. Then MB1 click on another 
text field. Then MB1 click on the ‘Missing 
Value?’ checkbox for the first text field. 

The value of the text field changes to 
‘45.00’ when the user MB1 clicks on the 
text field. The value remains the same 
when the user MB1 clicks on another text 
filed box. When user MB1 clicks on 
missing value the value changes to ‘-
9999.0’. 

 

79.  MB1 click on the ‘Apply’ button. The top graph reflects the change made 
in the Mean Areal Potential Evaporation 
window. If the changed value’s time is 
after the model start time, the bottom 
graph updates to reflect the change in the 
top graph. If the changed value’s time is 
before the model start time, the bottom 
graph does not change. 

 

80.  MB1 click on the ‘Close’ button. The Mean Areal Potential Evaporation 
window closes and the Analysis window 
appears. 

 

81.  Select ‘Close’ from SSHP Analysis window. The GUI closes.  
82.  Select ‘Exit Application’ from SSHP Control 

window. 
The GUI closes.  

End of Test 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1   Source Documents 
• None. 

2.2   Reference Documents 
• Legacy NWS Test Cases: Baseline_RiverMonitor (OB8.3). 
• Software Test Plan for the Advanced Weather Interactive Processing System 

Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates that the River Monitor Software can be successfully utilized. This 
test case also illustrates the Alert Alarm support. 
 

3.1   Assumptions, Constraints and Preconditions 
• TO10 software has been installed successfully 
• CAVE, EDEX and pgAdmin III are running 
• Data has been ingested  
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 

3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 

3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0  TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from 
the dropdown menu if available. If not 
available, select ‘Other…’. Then select 
‘Hydro’ from the Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  Under the ‘HydroApps’ menu, select the 
‘Launch River Monitor…’ option. 

The HydroBase window opens, listing all of the 
forecast points in the site-specific database for 
the WFO. 

 

3.  MB1 click ‘Display’  ‘Select Columns’. Column Selection window displays.  
4.  Choose one or more columns from the 

‘Allowed Items’ list. Then MB1 click on the 
‘Add’ button. 

The selected items list updates with the chosen 
columns.  

5.  Choose one or more columns from the 
‘Selected Items’ list. Then MB1 click on the 
‘Remove’ button. 

The selected items list updates with the 
removal of the chosen columns.  

6.  Choose one or more columns from the 
‘Selected Items’ list. Then MB1 click on the 
‘^’ or ‘v’ buttons. 

The columns position moves by one step up or 
down depending on the button clicked.  

7.  MB1 click the ‘Confirm’ button. The Column Selection window closes. The 
table updates to reflect the columns in the 
selected columns list. 

 

8.  MB1 click ‘Display’  ‘Select Columns’. The Column Selection window displays.  
9.  Choose one or more columns from the 

‘Allowed Items’ list. Then MB1 click on the 
‘Add’ button. 

The selected items list updates with the chosen 
columns.  

10.  MB1 click on ‘Cancel’. 
 

The column selection window closes. The 
displayed table is unchanged.  

11.  MB1 click ‘File’  ‘Save Settings’. The Save window opens to 
/awips/hydroapps/whfs/local/data/app/rivermon. 
The user can select a file name to save the 
settings. 
 

 

12.  Enter a filename and MB1 click the ‘Save’ 
button. 

The displayed settings are saved in the file 
selected.  

13.  MB1 click ‘File’  ‘Load Settings’. 
 
MB1 click ‘Cancel’ in the Open window. 

The Open window opens to 
/awips/hydroapps/whfs/local/data/app/rivermon. 
The user can select the path and file name to 
load settings. 
Verify the file saved in step 12 is there. 
After clicking ‘Cancel’, the Open window 
closes. 

 

14.  MB1 click ‘File’  ‘Load Office Settings’. The tree and the table update based on the 
information in the file.  
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Step # Action Result Pass/Fail 
15.  MB1 click ‘Display’  ‘Refresh’. The data in the table updates. The refresh 

panel updates to reflect the appropriate last 
and next refresh time. 

 

16.  MB1 click ‘File’  ‘Export Data To Text 
File’. 
 
MB1 click ‘Cancel’ in the Save window. 

The menu displays the save window which 
allows the user to choose the directory and file 
name for saving the table information. 

 

17.  MB1 click ‘Config’  ‘RiverMon Group’. The RiverMon Group window appears.  
18.  Type ‘FIRST’ in Group ID, ‘first group’ in 

group name, and ‘1’ in group ordinal. MB1 
click ‘Save’. 
 
The HSA is automatically set to the admin 
HSA and is uneditable. 

The RiverMon Group table in the database is 
inserted with this entry. Also, the information 
displays in the table in RiverMonGroup window. 

 

19.  Highlight the RiverMon Group created 
above in the table in RiverMon Group 
window. 
 
Modify the group name field as ‘first created 
group’ and MB1 click ‘Save’. 

The RiverMon Group table in the database 
updates and the information displays in the 
table in RiverMon Group window.  

 

20.  MB1 click the ‘Close’ button in the 
RiverMon Group window. 
Verify that the location tree and main table 
update to reflect the change. 

The RiverMon Group window closes.  
Verified. 

 

21.  MB1 click ‘Config’  ‘RiverMon Location’. The RiverMon Location window displays.   
22.  Select a location ID, a group, and 5 as 

location ordinal.  
MB1 click ‘Save’. 
MB1 click ‘Close’. 

The RiverMon Location table in the database 
updates with this entry and the information 
displays in the table in RiverMon Location 
window. The location tree and main table 
update to reflect the change. 

 

23.  Highlight the RiverMon Location created 
above in the table in RiverMon Location 
window. 
Modify the group ordinal to 4. 
MB1 click ‘Save’. 
MB1 click ‘Close’. 

The RiverMon Location table in the database 
updates and the information displays in the 
table in the RiverMon Location window. The 
location tree and main table update to reflect 
the change. 

 

24.  Highlight the RiverMon Location created 
above in the table in RiverMon Location 
window and MB1 click ‘Delete’. 

The entry is deleted from the RiverMon 
Location table and is removed from the table.   

25.  MB1 click the ‘Close’ button. The RiverMon Location window closes. Verify 
that the location tree and main table update to 
reflect the change. 

 

26.  MB1 click ‘Config’  ‘Derived Columns’. An editor with Derived Columns file opens.   
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Step # Action Result Pass/Fail 
27.  Change the information in a column and 

MB1 click ‘Save and Update Now’ in the 
main GUI. 
MB1 click ‘X’ on the DerivedColumns.txt 
window to close. 

The change is visualized.  

28.  MB1 click ‘Config’  ‘RiverMonitor PE 
Config’. 
 
MB1 click the ‘X’ on the DerivedColumns.txt 
window to close. 

An editor with the RiverMonitor PE Config file 
opens.  

29.  MB1 click ‘Display’  ‘Forecast Source’. A sub menu with radio buttons displays. Only 
one button can be selected at a time. 
 
NOTE: There should be a MaxFcst Value 
column listed in the table. If not, add that 
column as was done in Steps 2-6. There 
should be some values listed in the MaxFcst 
Value column. If not, select ‘Display’ -> ‘Latest 
Fcst Basis Time...’ from the River Monitor 
Application GUI menu, which opens the 
Latest Fcst Basis Time Filter GUI. Then enter 
a value greater than or equal to 72 and MB1 
click ‘Close’. MB1 click on the ‘MaxFcst Value’ 
column to sort to see if there are any values 
present. If there are still no values, check to 
see that hydro data are being ingested. 

 

30.  MB1 click ‘Display’  ‘Forecast Source’  
‘Choose FF’. 

Only forecast data type source FF displays in 
the table (E.g., some of the MaxFcst should be 
changed/deleted from that data column, but the 
site rows for the modified values should 
remain). 

 

31.  MB1 click ‘Display’  ‘Forecast Source’  
‘FZ’. 

Only forecast data type source FZ displays in 
the table. (E.g. some of the MaxFcst should be 
changed/deleted from that data column, but the 
site rows for the modified values should 
remain). 

 

32.  MB1 click ‘Display’  ‘Forecast Source’  
‘Ingest Filter’. 

Only forecast data type source that has a 
ranking per the ingest filter displays in the 
table. (E.g. the MaxFcst should be restored to 
the way they were at Step 29). 

 

33.  MB1 click ‘Display’  ‘Alert Alarm Valid 
Time’. 

The AlertAlarm valid time filter window 
displays.  

34.  Change the box value by MB1 clicking the 
‘^’ and ‘v’ buttons. Then close the window 
by MB1 clicking ‘Close’ or the ‘X’ on the 
upper right corner of the window. 

The value in the box is used to determine how 
much alert alarm data should be included in the 
AlertAlarm summary column in the main 
window. 
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Step # Action Result Pass/Fail 
35.  MB1 click ‘Display’  ‘VTEC Event 

EndTime’. 
The VTEC Event EndTime filter window 
appears.  

36.  Change the box value by MB1 clicking the 
‘^’ and ‘v’ buttons. Then close the window 
by MB1 clicking on the ‘Close’ button in the 
window or ‘X’ on the upper right corner of 
the window. 

The value in the box is used to determine the 
color of the VTEC Summary and Event 
EndTime cells included in the main window. 

 

37.  MB1 click ‘Display’  ‘UGCExpire Time’. The UGC Expire Time filter window appears.  
38.  Change the box value by MB1 clicking the 

‘^’ and ‘v’ buttons. Then close the window 
by MB1 clicking on the ‘Close’ button in the 
window or ‘X’ on the upper right corner of 
the window. 

The value in the box is used to determine the 
color of the UGC Expire Time cells included in 
the main window.  

 

39.  MB1 click ‘Display’  ‘Latest ObsTime’. The Latest ObsTime filter window appears.  
40.  Change the box value by MB1 clicking the 

‘^’ and ‘v’ buttons. Then close the window 
by MB1 clicking on the ‘Close’ button in the 
window or ‘X’ on the upper right corner of 
the window. 

The value in the box is used to determine the 
color of LatestObs Time, LatestObs Value, 
Latest StgValue, Latest StgTime, Latest 
FlowValue, Latest FlowTime cells in the main 
window. 

 

41.  MB1 click ‘Sort’  ‘HSA| Group| Location – 
Order’. 

Choosing this menu causes the displayed data 
to be sorted first by HSA (ascending order), 
then by group ordinal (ascending order), then 
by location ordinal (ascending order). 

 

42.  MB1 click ‘Details’  ‘Office Notes’. The Office Notes window appears. When this 
window displays, it highlights the first row (if 
any exist) that matched the location id of the 
station selected (if any) in the main window. 
Upon selecting the existing id in the combo 
box, its name, state and county display.  

 

43.  Choose an ID from the ID box, enter topic 
say ‘Rivermon’, enter note as say ‘flooding 
from tomorrow’, enter data time and expire 
time. Then MB1 click the ‘Save’ button. 

The Officenotes table in the database contains 
this entry. The posting time and update time is 
the current system time. Also the information 
displays in the upper portion of the Officenotes 
window. 

 

44.  Highlight the above created office notes in 
the upper portion of the Officenotes 
window, and modify the notes field as ‘may 
be flooding tomorrow’. Then MB1 click the 
‘Save’ button. 

The Officenotes table in the database updates 
with this change. The update time changes to 
current system time. Also the information 
displays in the upper portion of the Officenotes 
window. 

 

45.  Highlight the above created office notes in 
the upper portion of the Officenotes window 
and MB1 click on the ‘Delete’ button. 

The highlighted entry is deleted from the 
Officenotes table. The highlighted row is 
removed from the upper portion of the 
Officenotes window. 

 

46.  MB1 click the ‘Close’ button. The Officenotes window closes.  
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Step # Action Result Pass/Fail 
47.  MB1 click ‘Details’  ‘VTEC Events’. The Valid Time Event Code (VTEC) History 

window appears. When this window displays, it 
highlights the first row (if any exist) that 
matches the location id of the station selected 
(if any) in the main window. 

 

48.  MB1 click the ‘Close’ button. The Valid Time Event Code (VTEC) History 
window closes.  

49.  MB1 click ‘Details’  ‘AlertAlarm’. The AlertAlarm window appears. When this 
window displays, it highlights the first row (if 
any exist) that matches the location id of the 
station selected (if any) in the main window. 

 

50.  MB1 click the ‘Close’ button. The AlertAlarm window closes.  
51.  MB1 click ‘Details’  ‘Time Series Lite’. The TimeSeriesLite window appears only if a 

row is selected in the main window and it has 
latest obsvalue and/or maxfcst value displayed, 
or the forecast source option is not IngestFilter. 
If the row is not highlighted before choosing 
this option then a window asking the user to 
highlight the row will display.  

 

52.  MB1 click ‘File’  ‘Close’. The Time Series window closes.  
53.  MB1 click on the ‘Update Now’ button on 

the main window. 
The main window table updates with the 
current data from database. The last update 
time shows the current time. The next update 
time is the last update time + x minutes (where 
x is equal to the value in the spin box near 
update now button).  

 

54.  Change the value in the update box to ‘5’. 
Then MB1 click the ‘Update Now’ button. 

The main window table updates with the 
current data from database. The last update 
time shows the current time. The next update 
time is the last update time + 5 minutes. 

 

55.  Choose a location not displayed in the table 
in the left tree. Select the checkbox to show 
selected. 

The location information displays in the table.  

56.  Deselect the location in the left tree. 
Unselect the checkbox to show not 
selected. 

The location information does not display in the 
table.  

57.  Choose a group name in the left tree, and 
select the checkbox to show selected. 

All the location ids under this group are 
selected in the tree. All the location’s 
information displays on the table. 

 

58.  Deselect the group name in the left tree. 
Unselect the checkbox to show not 
selected. 

All the location ids under this group are 
deselected in the tree. All the location’s 
information does not display on the table. 
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Step # Action Result Pass/Fail 
59.  Choose a HSA in the left tree. Select the 

checkbox to show selected. 
All the groups under this HSA and the location 
ids under these groups are selected in the tree. 
All the location’s information displays on the 
table. 

 

60.  Deselect the HSA in the left tree. Unselect 
the checkbox to show not selected. 

All the groups under this HSA and the location 
ids under these groups are deselected in the 
tree. All the location’s information does not 
display on the table. 

 

61.  MB1 click on any of the column header in 
the table. 

All the rows are sorted based on the data in the 
column that is clicked.   

62.  Extend/Shrink the width of the columns, by 
dragging the column border with MB1. 

The column width extends/shrinks based on 
the direction of the MB1 drag.  

63.  Move the order of the columns displayed by 
MB1 clicking on the column header, 
dragging it and placing it in another 
position. 

The column is placed to the new position the 
user places the column.  

64.  MB1 click ‘File’  ‘Save Settings’. The 
save window opens and the user can select 
the path and file name to save the settings. 
 
MB1 click the ‘Save’ button. 

The currently displayed settings like displayed 
columns, their order, sort information, fcst ts 
option, alertalarm valid time look up hours are 
saved in the file selected.  

 

65.  MB1 click ‘File’  ‘Load Office Settings’. This causes the settings file 
RiverMonitorSettings.txt (if it exists) file to be 
read and the display updated according to its 
contents. The tree and the table update based 
on the information in the file. If the file doesn’t 
exist then the message displays in a window. 

 

66.  MB1 click ‘File’ -> ‘Load Settings’. Select 
the file created in step 64. 
 
MB1 click on the ‘Open’ button. 

The display of the main window has the look 
and feel as it was just before performing step 
64. 

 

67.  MB1 click ‘File’ -> ‘Exit’ or close the window 
by MB1 clicking on the ‘X’ in the upper right 
corner of the window. 

This causes the application to exit.  

End of Test 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: Baseline_HydroTS (OB8.3); 
Baseline_HydroTS_OB8.1; Checkout_HydroTS_OB8.1. 

• Software Test Plan for the Advanced Weather Interactive Processing System 
Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates that AWIPS provides the capability to execute the WHFS Hydro 
Time Series. The Hydro Time Series allows a WFO to monitor hydrologic points of interest by 
providing the interface to information necessary for daily hydrologic monitoring and forecasting. 
Hydro Time Series allows for the observation of X_Y plots, and tabular listing of stage data and 
precipitation data. This test case also verifies, through the Time Series tool, the ingest and 
storage of precipitation data in the IHFS database. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested . 
• The Test Group is set up. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  
 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from the 
dropdown menu if available. If not available, 
select ‘Other…’. Then select ‘Hydro’ from the 
Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  MB1 click ‘Time Series Graphs/Tables…’ 
from the Live Data submenu. 

The Time Series dialog opens.  

3.  In the Search box, search for a reservoir 
forecast point with data. 
Hydroview can help the user do this by 
selecting ‘Live Data’ -> ‘Stations Reporting 
Status/Latest Observations…’. 

The station selected is highlighted in the 
box below. 

 

4.  Select the ‘Table’ button. The Tabular Time Series window opens.  
5.  In the top of the Tabular Time Series 

window, highlight a ‘Loc, PE, Dur,  
TS, E’ combination line that has data.  

If a line that has data was chosen, the data 
is displayed in the middle of the window. 

 

6.  Select the ‘Close’ button in the Tabular Time 
Series window. 

The Tabular Time Series window closes.  

7.  Near the bottom of the Time Series window, 
highlight all the lines with a PE (Physical 
Element) starting with ‘H’ (e.g., HG and HT) 
or any with data. 
Hold the Ctrl key down and MB1 click each 
item to highlight multiple lines. 

One or more lines are highlighted.  

8.  Select the ‘Graph’ button. The Time Series Display window opens 
with the available physical element data 
represented as time series. 

 

9.  From the Graph menu, select ‘Toggle Off the 
Show Latest Forecast Only’ option. 

Time series for forecasts with earlier basis 
times are displayed, if any. 

 

10.  From the Graph menu, select ‘Data and 
Categories’ from the Scale Stages cascading 
menu. 
 

If flood categories are defined in 
HydroBase for the station, they will be 
displayed as yellow, red, and blue 
horizontal lines. The y-axis scale may 
adjust to fit the flood stages.  

 

11.  From the Graph menu, select ‘Data Only’ 
from the Scale Stages cascading menu. 

Only the data appear, and the y-axis scale 
may adjust to fit the data. 

 

12.  From the options menu, select ‘Points’ from 
the Plot cascading menu. 
 
 

The lines connecting the points in the time 
series plots disappear. The time series 
data are represented by points only. 

 

13.  From the Edit menu, select ‘Select Trace’. The mouse icon becomes a hand when 
hovering over a line, signifying that it is 
ready to select a trace. 
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Step # Action Result Pass/Fail 
14.  Select a time series by MB1 clicking on the 

trace of a time series. 
 

All the time series are represented by 
points and lines. The time series selected 
is highlighted in white, signifying that it can 
be edited. 

 

15.  Select ‘Insert’ from the Edit menu. 
Then MB1 click on about half a dozen places 
around the active trace. 

Points are added where the mouse button 
is clicked. 
A line connects the points.  

 

16.  Select ‘Delete’ from the Edit menu. 
Then MB1 click on a point in the active time 
series. 

The point selected is deleted.  

17.  Select ‘Move’ from the Edit menu. The Move option is selected.  
18.  MB1 click and drag a point on the active time 

series. 
The point can be moved vertically but not 
horizontally. 

 

19.  Select ‘Cancel Changes’ from the Edit menu. All the changes in the graph that were 
made in Steps 15–18 are undone, and the 
time series returns to its original state 

 

20.  From the Edit menu, select ‘Select Trace’. The mouse icon becomes a hand when 
hovering over a line, signifying that it is 
ready to select a trace. 

 

21.  Select a time series by MB1 clicking on a 
trace of a time series. 
 

All the time series are represented by 
points and lines. The time series selected 
is highlighted in white, signifying that it can 
be edited. 

 

22.  Select ‘Insert’ from the Edit menu. 
Then MB1 click on about half a dozen places 
around the active trace. 

Points are added where the mouse button 
is clicked. 
A line connects the points.  

 

23.  Select ‘Save’ from the Edit menu. A Save window opens.  
24.  Select ‘Cancel’ in the Save window. The Save window closes. 

The changes in the trace are not saved to 
the database. 

 

25.  Select ‘Quit’ from the File menu of the Time 
Series Display window. 

The Time Series Display closes.  

26.  In the Time Series window,  
MB1 click the Mode dropdown arrow (Station 
Selection) and select ‘Predefined Group’. 

The Time Series window changes to 
Predefined Group mode. 

 

27.  Select ‘TestGroup’. 
Then MB1 click the ‘Table’ button.  
Note: This step assumes the TestGroup was 
set up prior to running this step. 

The Tabular Time Series window opens 
with data for the predefined groups of 
stations. 

 

28.  MB1 click the ‘Close’ button in the Tabular 
Time Series window. 

The Tabular Time Series window closes.  
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Step # Action Result Pass/Fail 
29.  Select ‘Graph’ in the Time Series window. The Time Series Display window opens. 

The Time Series Display window shows 
data for stations defined in the 
/awips/hydroapps/whfs/local/data/app/Time 
Series/group_definition.cfg configuration 
file. 

 

30.  Press the ‘PgDown’ key. The second page of data defined in the 
configuration file is shown (if there are two 
pages). 

 

31.  Select ‘Quit’ from the File menu in the  
Time Series Display window. 
 

The Time Series Display window closes.  

32.  MB1 click the ‘Close’ button in the Time 
Series window. 

The Time Series window closes.  

End of Test 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: Baseline_Riverpro (OB8.3); 
Baseline_Riverpro_OB8.1; Baseline_WANMHS_OB8.1; 
Baseline_RiverproNWRWAVES_OB8.1; Checkout_Riverpro-OB8.1. 

• Software Test Plan for the Advanced Weather Interactive Processing System 
Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case tests and verifies the functionality found within the current version of the WHFS 
RiverPro Product Formatter application known as RiverPro. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from the 
dropdown menu if available. If not available, 
select ‘Other…’. Then select ‘Hydro’ from the 
Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  Under the ‘HydroApps’ menu, select the ‘Launch 
RiverPro…’ option. 

The main RiverPro River Product 
Formatter window opens in 
OPERATIONAL Mode, listing ‘Products 
to Generate’ panel with recommended 
type of product (Statement/Warning) and 
‘Forecast Groups/Points for 
RVS,FLS,FLW’ panel with the points 
included in the recommended type of 
product.  

 

3.  From the ‘Product to Generate’ selection panel, 
select one non-recommended product. For 
example, if the recommended product is ‘Flood 
Statement Default’ (FLS), then select ‘River 
Statement Default’ (RVS). 

The non-recommended product is 
highlighted. 

 

4.  MB1 click the ‘Recomm for Current Product’ 
button in the RiverPro main window. 

The forecast points included in the 
highlighted product are selected in the 
‘Forecast Groups/Points to Include’ 
selection panel. If none are highlighted, 
select a few points. 

 

5.  From the ‘settings’ menu in the RiverPro main 
window, select ‘Recompute recommendations’  

Compute internally the recommendations 
by using current information. It is possible 
that no display changes in the ‘Product to 
Generate’ and ‘Forecast Groups/Point to 
Include’ panels.  

 

6.  From the ‘Settings…’ menu in the RiverPro main 
window, select ‘Reset to recommended’. 

The recommended product is highlighted 
(FLS as described above) in the ‘Product 
to Generate’ panel.  
The forecast points included in the 
recommended product are highlighted in 
the ‘Forecast Groups/Points for 
RVS,FLS,FLW’ panel. 

 

7.  From the ‘Settings…’ menu in the RiverPro main 
window, select ‘Select HSA…’ 

The Office Selection window opens. It 
displays the offices’ id, number of 
forecast points and number of product 
definitions in that office. 
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Step # Action Result Pass/Fail 
8.  Select the other office and MB1 click ‘OK’ in the 

Office Selection window. (NOTE: there might be 
only one office to select) 

The Office Selection window closes. 
 
The main RiverPro window updates its 
listing ‘Products to Generate’ panel with 
recommended type of product 
(Statement/Warning) and ‘Forecast 
Groups/Points for RVS,FLS,FLW’ panel 
with the points included in the 
recommended type of product  for the 
new office. 

 

9.  From the ‘Settings…’ menu in the RiverPro main 
window, select ‘Select HSA…’ again.  

The Office Selection window opens. 
 

 

10.  Select the original office in the Office Selection 
window, MB1 click ‘OK’. 

The Office Selection window closes. 
The main RiverPro window updates its 
listing ‘Products to Generate’ panel with 
recommended type of product 
(Statement/Warning) and ‘Forecast 
Groups/Points for RVS,FLS,FLW’ panel 
with the points included in the 
recommended type of product  for the 
original office. 

 

11.  From the ‘ForecastPoint’ menu in the RiverPro 
main window, select ‘Show recommendations…’. 
Should include information on VTEC if used a 
VTEC product. 

The Recommendation/ 
Previous Product Information window 
opens. It displays the recommended 
product information, previous and current 
VTEC information and issued products 
information. 

 

12.  Select ‘Close’. The Recommendation/ 
Previous Product Information window 
closes. 

 

13.  From the ‘Product to Generate’ panel in the  River 
Pro main window, select ‘River Statement Default  
Product’ (RVS). 

The RVS product is highlighted. 
 

 

14.  From the ‘ForecastGroups/Points for RVS, FLS, 
FLW’ panel in the RiverPro main window, select 
some forecast points.  

If a forecast point is selected, only that 
point is highlighted. If a group is selected, 
all the forecast points in that group are 
highlighted.  

 

15.  From the ‘Forecast Point’ menu in the RiverPro 
main window, select ‘Show river data…’. 

The Forecast Point Stage/Discharge 
information window opens. It displays the 
observed and forecast data, flood 
threshold information for each forecast 
point. 

 

16.  From the Forecast Point Stage/Discharge 
information window, select ‘View Table’. 

The Time Series Control window open. 
(Note: sometimes the Tabular window 
opens at the same time, could be a 
potential minor DR.) 
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Step # Action Result Pass/Fail 
17.  Select ‘Table’. The Tabular Time Series window opens  
18.  Select ‘Close’ on the Time Series Control window 

and Tabular Time Series window 
Both windows close.  

19.  From the Forecast Point Stage/Discharge 
Information window, select ‘View graph’. 

The Time Series Control window open.  

20.  Select ‘Graph’. Time Series Display window opens.  
21.  Select ‘Close’ on the Time Series Control window 

and ‘Quit’ from the ‘File’ menu in the Time Series 
Display window. 

Both windows close.  

22.  Select ‘Close’ from the Forecast Point 
Stage/Discharge Information window. 

The window closes.  

23.  From the ‘ForecastPoint’ menu in the RiverPro 
main window, select ‘Show reference info…’. 

The Reference Information window 
opens. It displays the forecast points’ 
information such as associated county, 
zone, state, river, group, HSA and its 
primary backup and secondary backup 
service offices. 

 

24.  From the Reference Information window, select 
‘Close’. 

The window closes.  

25.  From the ‘Logs’ menu in the RiverPro main 
window, select ‘Current session errors/info…’. 

The text editor opens with name as 
‘rpf_message.log.xxx’. It displays the 
application’s log message with the latest 
information is at the bottom of this text 
file. 

 

26.  Select ‘Quit’ from the ‘File’ menu in the text editor. The text editor closes.  
27.  From the ‘Product to Generate’ panel, select ‘FLS 

(Flood Statement Default)’ 
The Flood Statement Default is 
highlighted. 

 

28.  Select some groups/points from the ‘Forecast 
Groups/Points for RVS,FLS,FLW’ panel. 

If a forecast point is selected, only that 
point is highlighted. If a group is selected, 
all the forecast points in that group are 
highlighted.  

 

29.  From the ‘Settings’ menu in the RiverPro main 
window, select ‘Modify product sections’. 

The Product Generation Settings window 
opens. 

 

30.  From the ‘General Settings’ section, select the 
‘Official’ and ‘Non-segmented’ buttons.  

The buttons are selected.  

31.  Select ‘Apply’, then ‘Close’ in the Product 
Generation Settings window. 

The settings are saved and the Product 
Generation Settings window closes. 

 

32.  From the ‘Product’ menu, select ‘Create…’ to 
create a statement. 

A text editor window opens with the 
filename ‘work_product.xxx’ which 
contains FLS product. 

 

33.  Type some test comments to the end of the 
product. Select ‘Save As’ from the ‘File’ menu in 
the text editor. 

The file is saved.  

34.  Select ‘Quit’ from the ‘File’ menu of the text editor 
window. 

The text editor widow closes.  
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35.  From the ‘Issue’ menu in the main RiverPro 

window, select ‘Issue Product…’. 
 

The Product Issuance window opens 
asking the user if they would like to issue 
this generated product. 

 

36.  Select ‘Send’ in the ‘Product Issuance’ window.  The Product Issuance window closes and 
a second Product Issuance window 
opens with message stating ‘Product 
issued and definitions reset to 
recommended’. 

 

37.  Select ‘OK’ in the second Product Issuance 
window. 

The product is sent out.  

38.  From the ‘Product’ menu, select 
‘View/Corrected/Send Previous Product’. 

The View/Corrected/Send Previous 
Product window opens with the most 
recent product highlighted. 

 

39.  Select ‘View Product’ from the 
View/Corrected/Send Previous Product window 
and verify that the test comments from above are 
in the FLS product. 

The Product Viewer window opens and 
shows the FLS product including the test 
comments. 

 

40.  Select ‘OK’ in the RiverPro Product View window. The Product View window closes.  
41.  Select ‘Close’ in the View/Corrected/Send 

Previous Product window. 
The View/Corrected/Send Previous 
Product window closes. 

 

42.  From the ‘Logs’ menu in the RiverPro main 
window, select ‘Daily product issuances…’. 

The text editor opens with name as 
‘rpf_issue.log.xxx’. It displays the daily 
product issuance log message for the just 
issued product. 

 

43.  Select ‘Quit’ from ‘File’ menu in the text editor. The text editor closes.  
44.  From an lx1 terminal window, check the 

handleOUP.log file at 
/data/logs/fxa/display/localhost:0.x/<yyymmdd>, 
and the distributeProduct logs at 
/data/logs/fxa/display/<yyyymmdd>.Make sure 
the logs are updated with the product just sent 
from RiverPro. 

Logs have been updated. 
 
Note: x is either 0, 1 or 2 depending on 
which display that Riverpro is running. 

 

45.  Open NWRWAVES GUI by MB1 clicking to open 
the start-up menu and under Hydro Apps select 
NWRBrowser. Make sure the product you just 
sent is under the pending column. Open it and 
verify its contents (date, time, data, text) 

Product is under the Pending column and 
it is verified.  
 
Note: If you don’t see the product there, 
most likely is because it is not included in 
the NWRWAVES triggers text file located 
under: /data/fxa/siteConfig/textApps 
 
Steps 43 and 44 can be executed for 
verification after each product is sent. 

 

46.  From the ‘Product to Generate’ panel, select 
‘FLW (Flood Statement Warning)’. 

The Flood Statement Warning is 
highlighted. 
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47.  Select some groups/points from the ‘Forecast 

Groups/Points for RVS,FLS,FLW’ panel. 
If a forecast point is selected, only that 
point is highlighted. If a group is selected, 
all the forecast points in that group are 
highlighted.  

 

48.  From the ‘Settings’ menu, select ‘Modify product 
sections’. 

 The Product Generation Settings window 
opens. 

 

49.  In the ‘General Settings’ section of the Product 
Generation Settings window, for ‘Product Text 
Case’, select ‘Mixed Case’. 

The ‘Mixed Case’ button is selected.  

50.  In the ‘Product Sections/Subsections to Include’ 
section of the Product Generation Settings 
window, select ‘Product Header’. 

 The Product Header Settings window 
opens. 

 

51.  In the Product Header Settings window, edit the 
‘Issuance Number’, ‘Expiration Date’, and ‘TimeZ’ 
with valid values, and note the changes. 

The ‘Issuance Number’, ‘Expiration Date’, 
and ‘TimeZ’ with valid values are 
modified and noted. 

 

52.  Select ‘Apply’ and ‘Close’ in the Product Header 
Settings window. 
Open template and make sure changes are 
applied. 

The changes are applied and the Product 
Header Settings window closes.  

 

53.  In the ‘General Settings’ section of the Product 
Generation Settings window, select the ‘Official’ 
and ‘Segmented’ buttons. In the ‘By:’ options 
menu, select ‘Forecast Point’.  

  

54.  Select ‘Apply’, then ‘Close’ in the Product 
Generation Settings window. 

These changes for settings are saved 
and the Product Generation Settings 
window closes. 
 

 

55.  From the ‘Product’ menu on the main RiverPro 
window, select ‘Create…’. 

The text editor window opens with the 
statement incorporating the chosen 
settings.  

 

56.  Add test comments, select ‘Save As’ then quit. The window closes.  
57.  From ‘Issue’ menu in the RiverPro main window, 

select ‘Issue Product…’. 
The Product Issuance window opens 
asking the user if they would like to issue 
this generated product. 

 

58.  Select ‘Send’ in the Product Issuance window.  
 
 

 

The Product Issuance window closes and 
a second Product Issuance window 
opens with message ‘Product issued and 
definitions reset to recommended’. 

 

59.  Select ‘OK’ in the second Product Issuance 
window. 

The product is sent out.  

60.  From the ‘Products’ menu in the RiverPro main 
window, select ‘View/Corrected/Send Previous 
Product’. 

The View/Corrected/Send Previous 
Product window opens and the most 
recent product is highlighted. 
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61.  Select ‘View product’ for the issued FLW product 

in the View/Corrected/Send Previous Product 
window. 

The text editor opens, check the changes 
made in the Product Header section. 
Make sure variable changes display in 
the template. 

 

62.  Select ‘OK’ in product viewer. The window closes.  
63.  Select Close from ‘View/Corrected/Send Previous 

Product’. 
The window closes.  

64.  From the ‘Product to Generate’ panel, select 
‘FLW (Flood Statement Warning)’. Select some 
groups/points from the ‘Forecast Groups/Points 
for RVS,FLS,FLW’ panel. From the ‘Settings’ 
menu in the RiverPro main menu, select ‘Modify 
product sections…’. 

The Product Generation Settings window 
opens. 

 

65.  In the ‘General Settings’ section of the Product 
Generation Settings window, select the 
‘Segmented’ button. In the ‘Product 
Sections/Subsection to Include’ panel in the 
Product Generation Settings window, include all 
product sections and all three forecast point 
subsections by selecting an order. Choose the 
sections in any order, and note the order from the 
pull down option menu next to the section. Do not 
duplicate the order. 

The options are selected.  

66.  From ‘Product Generation Settings’, MB1 click 
each section/subsection button. Select a template 
in the opened window.  
For example, MB1 click the ‘Headline’ button, pick 
a template in the Headline Section Settings 
window, MB1 click the ‘View’ button to review the 
template content and make a note of it. Then 
select ‘Apply’ and ‘OK’. 

The Product xxx Section Settings window 
opens. E.g. Product Headline Section 
Settings window. 
Open a text editor to review the selected 
template if the ‘View’ button is clicked. 
After ‘Apply’ and ‘OK’, the settings are 
saved and the Product xxx Section 
Settings window closes. 

 

67.  Select the ‘Impact Statement’ button from the 
‘Product Generation Settings’ panel. 

The Impact Statement Sub-Section 
Settings window opens, allowing the 
tester to customize the impact statement 
search parameters to select the impact 
statements. 
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68.  Select each of the following options in turn, and 

note any changes made: 
a. Reference Stage/Flow: select one of the 
following: Current Observed, Max Forecast or 
Current Obs/Max Fcst 
b. Stage Window sliders (-5.0 - 5.0): change the 
slider 
c. Maximum Depth below Flood Stage slider  (-
10.0 – 0): change the slider 
d. Search Type: select one of the following: 
Closest in Stage/Flow Window, Highest in 
Stage/Flow Window or All Below Upper 
Stage/Flow 
 
The items b and c above can be replaced by 
specifying flow parameters instead of stage as 
the followings. 
b. Flow Window: enter the percentage values for 
the lower and upper limits 
c. Max Offset below Flood Flow: enter the 
percentage value for the maximum offset   
 
Note, the impact statement search parameters 
can be based on stage or flow. 

  

69.  From the Impact Statement Sub-Section Settings 
window, select the ‘Apply Parameters’ button and 
then the ‘Apply’ button. 

If there is impact statement found for the 
forecast point based on these 
parameters, the results are: 
a. The line of data 
(ImpactStg/Flow|Start|End|Tendency) is 
highlighted in the ‘Settings for Selected 
Forecast Point’ list window.  
b. The ‘Impact(s) to Use’ field is filled with 
the impact values.  
c. The impact statement related to the 
highlighted ‘ImpactStg/Flow’ is displayed 
in the bottom window list. 
d. The ‘Text for Stage/Flow’ text box 
displays the highlighted ‘ImpactStg/Flow’ 
value. 

 

70.  From the Impact Statement Sub-Section Settings 
window, select ‘OK’. 

The Impact Statement Sub-Section 
Settings window closes. 

 

71.  From the Product Generation Settings window, 
select the ‘Crest Comparison’. 

The Comparison Subsection Sub-Section 
Settings window opens, allowing the 
tester to edit parameters to select 
historical comparisons. 
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72.  Select each of the following options in turn, and 

note any changes made:  
a. Reference Stage/Flow: select one of Current 
Obs/Max Fcst, Current Observed and Max 
Forecast 
b. Stage Window sliders (-5.0 – 5.0): change the 
slider 
c. Maximum Depth below Flood Stage slider (-
10.0 – 0.0): change the slider 
d.Year Lookback slider (-150 - 0): change the 
slider 
e. Search Type options: select one of the five 
items 
 
The items b and c above can be replaced by 
specifying flow parameters instead of stage as 
the followings. 
b. Flow Window: enter the percentage values for 
the lower and upper limits 
c. Max Depth below Flood Flow: enter the 
percentage value for the maximum offset   
 
Note, the crest comparison search parameters 
can be based on stage or flow 

  

73.  From the ‘Crest Comparison Sub-Section 
Settings’, select the ‘Apply Parameters’ button 
and then the ‘Apply’ button.  

If there is crest comparison found for the 
forecast point based on these 
parameters, the results are: 
a. The ‘Crest to Use’ field is filled with the 
crest stage/flow and the date the crest 
happened 
b. The line of data Crest 
Stg/Flow|CrestDate is highlighted 

 

74.  From the Crest Comparison Sub-Section Settings 
window, select ‘OK’. 

The ‘Crest Comparison Sub-Section 
Settings window closes. 

 

75.  Select ‘Apply’ and ‘Close’ in Product Generation 
Settings. 

Selected.  

76.  From the ‘Settings’ menu in the RiverPro main 
menu, select ‘Save to settings file…’ to save 
settings into file. 

The Save Product Settings window 
opens, allowing the tester to save the 
selected definitions with a Description: 
e.g RVS - Test RVS, a FileName as 
rvs_new.pcc.<SITE>, where SITE is the 
site localization ID in capital letters. 

 

77.  Select ‘OK’ in the Save Product Settings window.  The Saving Product Definition window 
opens and display message: ‘Do you 
wish to overwrite …’. 
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78.  From Saving Product Definition window, select 

‘OK’. 
Overwrite the previous version of 
flw_new.pcc.<SITE> 
The Saving Product Definition window 
closes. 

 

79.  From the ‘Product’ menu in the main RiverPro 
menu, select ‘Create…’. 

The text window opens. The modified 
RVS product is created and displayed in 
the text editor window. Segments for 
individual forecast points have been 
created. The point-based segments are 
separated by ‘$$’ character. 
The tabular section includes information 
for all included forecast points. The 
segment for each forecast point starts 
with the UGC code, followed by the MND 
date/time and includes the Roundup 
subsection, Impact Statement subsection 
and Crest Comparison subsection if the 
river stages/flows are within the ranges 
chosen from the Impact Statement and 
Crest Comparison windows. The 
Headline, Summary of Groups, Call to 
Action and Hydromet Basis sections do 
not appear in the segmented section of 
the product, they are ordered by the order 
number selected in the Product 
Generation Settings window. 

 

80.  From ‘File’ menu in the text editor, select ‘Quit’. The text editor closes.  
81.  From the ‘Product to Generate’ selection panel in 

the RiverPro main window, select ‘River 
Statement Default (RVS)’. 

The RVS product is highlighted.  

82.  Select some groups/points from the ‘Forecast 
Groups/Points for RVS,FLS,FLW’ selection panel 
in the main RiverPro window. 

If a forecast point is selected, only that 
point is highlighted. If a group is selected, 
all the forecast points in that group are 
highlighted. 

 

83.  From the ‘Settings’ menu in the RiverPro main 
window, select ‘Modify product sections…’. 

The Product Generation Settings window 
opens. 

 

84.  In the ‘General Settings’ panel of the Product 
Generation Settings window, select the ‘Official’ 
and ‘Segmented’ buttons. In the ‘By:’ options 
menu, select ‘County’. 

  

85.  In the ‘Product Sections/Subsections to Include’ 
panel of the Product Generation Settings window, 
include all product sections and all three forecast 
point subsections by selecting an order. Choose 
the sections in any order, and note the order from 
the pull down option menu next to the section. Do 
not duplicate the order. 
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86.  From ‘Product Generation Settings’, MB1 click 

each sections/subsections buttons. Select a 
template in the opened window. For example, 
MB1 click the ‘Headline’ button, pick a template in 
the ‘Headline Section Settings’ window, MB1 click 
the ‘View’ button to review the template content 
and make a note of it. Then select ‘Apply’ and 
‘Close’. 

The Product xxx Section Settings window 
opens. E.g. Product Headline Section 
Settings window. 
Open a text editor to review the selected 
template if the ‘View’ button is clicked. 
After ‘Apply’ and ‘OK’, the settings are 
saved and the Product xxx Section 
Settings window closes. 

 

87.  Select ‘Apply’ and ‘Close’ in the Product 
Generation Settings window. 

The settings are saved and the Product 
Generation Settings window closes. 

 

88.  From the ‘Product’ menu in the RiverPro main 
window, select ‘Create…’. 

The text editor window opens with the 
RVS product segmented by counties.                          
The tabular section includes information 
for all included forecast points grouped by 
counties. The county-based segments 
are separated by ‘$$’ character. The 
segment for each county starts with  
UGC code, follows by MND date/time and 
includes the ‘Summary of Groups’ 
section, roundup subsection, Impact 
Statement subsection and Crest 
Comparison subsection if the river 
stage/flow are within the ranges chosen 
from the Impact Statement and Crest 
Comparison windows. The Headline, Call 
to Action and Hydromet Basis sections do 
not appear in the segmented part of the 
product, they are ordered by the order 
number selected in the Product 
Generation Settings window. 

 

89.  From the ‘File’ menu in the text editor, select 
‘Quit’. 

The text editor closes.  

90.  From the ‘Product to Generate’ selection panel in 
the RiverPro main window, select ‘Flood 
Statement Default’ (FLS). 

The ‘Flood Statement Default’ option is 
highlighted. 

 

91.  Select some points from the ‘Forecast 
Groups/Points for RVS/FLS/FLW’ selection panel. 

If a forecast point is selected, only that 
point is highlighted. If a group is selected, 
all the forecast points in that group are 
highlighted. 

 

92.  From the ‘Settings’ menu in the RiverPro main 
window, select ‘Modify product sections’.  

The Product Generation Settings window 
opens with five sections that are 
contained in the statement and allows the 
tester to select the order in which they 
are to appear. 
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93.  Select all the product sections and all three 

forecast point subsections by selecting an order 
of appearance from the option menu next to each 
product section. Do not duplicate an order. 
Choose sections in any order, and note the order. 

  

94.  From ‘Product Sections/Subsections to Include’ 
panel in the Product Generation Settings window, 
MB1 click each sections/subsections buttons. 
Select a template in the opened window. For 
example, MB1 click the ‘Headline’ button, pick a 
template in the ‘Headline Section Settings’ 
window, MB1 click the ‘View’ button to review the 
template content and make a note of it. Then 
select ‘Apply’ and ‘Close’. 

The Product xxx Section Settings window 
opens. E.g. Product Headline Section 
Settings window. 
Open a text editor to review the selected 
template if the ‘View’ button is clicked. 
After ‘Apply’ and ‘Close’, the settings are 
saved and the Product xxx Section 
Settings window closes. 

 

95.  Under ‘General Settings’ in the Product 
Generation Settings window, select the ‘Official’, 
‘Segmented’ buttons and ‘Forecast Group’ from 
the ‘By:’ option menu. 

  

96.  Select ‘Apply’ and ‘Close’ in the Product 
Generation Settings window. 

The settings are saved and the Product 
Generation Settings window closes. 

 

97.  From the ‘Product’ menu in the RiverPro main 
window, select ‘Create…’ to create the product. 

  

98.  Respond ‘OK’ if the Product Creation Warning 
window opens. 

The text editor window opens with the 
Flood Statement Default (FLS) product 
segmented by groups of forecast points. 
Segments for groups of forecast points 
have been created. These segments are 
separated by ‘$$’ characters. 
 
The segment for each group starts with 
UGC code, follows by MND date/time, 
and includes the ‘Summary of Groups’ 
section, roundup subsection, Impact 
Statement subsection and Crest 
Comparison subsection if the river 
stage/flow are within the ranges chosen 
from the Impact Statement and Crest 
Comparison windows. These sections do 
not appear in the exact order as 
previously chosen. Usually the Summary 
Body (in Summary section) appears on 
the top of the segmented section.  
 
The Headline, Tabular, Call to Action and 
Hydromet Basis sections do not appear in 
the segmented part of the product, they 
are ordered by the order number selected 
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in the Product Generation Settings 
window. 

99.  From the ‘File’ menu in the text editor, select 
‘Quit’.  

The text editor closes.  

100.  From the ‘Product to Generate’ selection panel in 
the RiverPro main window, select VTEC Flood 
Statement Default (FLS). 

The ‘VTEC Flood Statement Default’ 
product is highlighted. 

 

101.  Select some points from the ‘Forecast 
Groups/Points for RVS/FLS/FLW’ selection panel. 

If a forecast point is selected, only that 
point is highlighted. If a group is selected, 
all the forecast points in that group are 
highlighted. 

 

102.  From the ‘Settings’ menu in the RiverPro main 
window, select ‘Modify product sections…’. 

The Product Generation Settings window 
opens. 

 

103.  From ‘Product Sections/Subsections to Include’ 
panel in the ‘Product Generation Settings’ 
window, MB1 click each sections/subsections 
buttons. Select a template in the opened window. 
For example, MB1 click the ‘Headline’ button, pick 
a template in the ‘Headline Section Settings’ 
window, MB1 click the ‘View’ button to review the 
template content and make a note of it. Then 
select ‘Apply’ and ‘Close’. 

The Product xxx Section Settings window 
opens. E.g. Product Headline Section 
Settings window. 
Open a text editor to review the selected 
template if the ‘View’ button is clicked. 
After ‘Apply’ and ‘Close’, the settings are 
saved and the Product xxx Section 
Settings window closes. 

 

104.  From the ‘Generated Settings’ panel in the 
Product Generation Settings window, MB1 click 
the ‘Official’, ‘Segmented’ buttons, and ‘Forecast 
Point’ for the ‘By:’ option menu, MB1 click the 
‘Use VTEC’ button, pick one of the key identifier 
(O/E/X/T). 

  

105.  Select ‘Apply’ and ‘Close’ in the Product 
Generation Settings window. 

The settings are saved and the Product 
Generation Settings window closes. 

 

106.  From the ‘Settings’ menu in the RiverPro main 
window, select ‘Modify VTEC settings…’. 

The Valid Time Event Coding (VTEC) 
Settings window opens. It displays the 
VTEC information for the proposed 
events and previous issued events. The 
forecast point shown on the top of the 
‘Proposed Events’ and the ‘Previous 
Events’ list windows are highlighted. 

 

107.  From the Valid Time Event Coding (VTEC) 
Settings window, select the ‘Check Selected’ 
button. 

The VTEC QC Check Report window 
opens to display the errors/warnings for 
the highlighted forecast point in the 
‘Proposed Events’ list window. 

 

108.  Select ‘Close’ from the VTEC QC Check Report 
window. 

The window closes.  
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109.  From the Valid Time Event Coding(VTEC) 

Settings window, select the ‘Check All’ button. 
The VTEC QC Check Report window 
opens to display the errors/warnings for 
all the forecast points included in the 
‘Proposed Event’ list window. 

 

110.  Select ‘Close’ from the VTEC QC Check Report 
window. 

The VTEC QC Check Report window 
closes. 

 

111.  From the ‘Cause:’ option menu in the Valid Time 
Event Coding (VTEC) Settings window, select 
another immediate cause. 

The new immediate cause displays in the 
option menu. 

 

112.  Select the ‘Update Cause for All’ button in the 
Valid Time Event Coding(VTEC) Settings window. 

The ‘Cause’ fields for all forecast points 
are updated to the new immediate cause 
in the ‘Proposed Event’ list window. 

 

113.  From the ‘Action:’ option menu in the Valid Time 
Event Coding (VTEC) Settings window, select 
another action code. 

The new action code displays in the 
‘Action:’ option menu. 

 

114.  Select the ‘Update’ button in the Valid Time Event 
Coding (VTEC) Settings window. 

The ‘Act.Ph.Sig.ETN’ field is updated with 
the new action code for the highlighted 
forecast point in the ‘Proposed Events’ 
list window. (Note: if the product was 
already issued and this is a continuation 
or extension of and FL.Y, then it should 
not say ‘.NEW.’ in the VTEC line and the 
ETN should be the one from the original 
issued product and not a new one). 

 

115.  Select ‘Close’ from the Valid Time Event Coding 
(VTEC) Settings window. 

The Valid Time Event Coding(VTEC) 
Settings window closes. 

 

116.  From ‘Product’ menu in the RiverPro main 
window, select ‘Create…’. 

The text editor window opens with the 
VTEC Flood Statement Default (FLS) 
product segmented by forecast points. . 

 

117.  Respond ‘Close’ if ‘VTEC QC Check Report’ 
window opens. 

These segments are separated by ‘$$’ 
characters. 
The segment for each point starts with 
UGC code, follows by VTEC P-VTEC  
and H-VTEC lines (defined as /…/), and 
includes MND date/time,  the Roundup 
subsection, Impact Statement subsection 
and Crest Comparison subsection if the 
river stage/flow are within the ranges 
chosen from the Impact Statement and 
Crest Comparison windows. 
The Headline, Tabular, Call to Action and 
Hydromet Basis sections do not appear in 
the segmented part of the product, they 
are ordered by the order number selected 
in the Product Generation Settings 
window. 
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118.  From the ‘File’ menu in the text editor, select 

‘Quit’.  
The text editor closes.  

119.  From the ‘Product to Generate’ selection panel in 
the RiverPro main window, select ‘NWR Flood 
Warning Default’. 
 
If testing on TBW4 (Alaska OCONUS), stop and 
go to Step 133. 

The NWR Flood Warning Default is 
highlighted. 
 
 
NOTE: NWR products are not configured 
for testing on TBW4. 

 

120.  Select ‘All’ from the ‘Forecast Groups/Points for 
RVS/FLS/FLW’ selection panel in the RiverPro 
main window. 

All forecast points in the ‘Forecast 
Groups/Points for RVS, FLS, FLW’ panel 
are highlighted. 

 

121.  From the ‘Product’ menu in the RiverPro main 
window, select ‘Create…’. 

The text window opens.  

122.  Respond ‘OK’ if the Product Creation Warning 
window opens. 

The product is displayed in the text editor 
window with the following information: 
Number of NWR towers considered for 
each tower, the call sign, city name, and 
WFO. Any locations that are to be 
included for that particular tower are 
listed, and the actual product for those 
locations is displayed. 

 

123.  In the text editor, add some test comments at the 
end of each tower product. 

  

124.  Select ‘Save’ from the ‘File’ menu in the text 
editor. 

  

125.  From the ‘File’ menu in the text editor, select 
‘Quit’. 

The text editor closes.  

126.  From the ‘Issue menu’ in the RiverPro main 
window, select ‘Issue Product…’. 

The Product Issuance dialog opens, 
confirming that the tester wants to issue 
the NWR Flood Warning Default product. 

 

127.  Select ‘Send’ in the ‘Product Issuance’ window. Another Product Issuance dialog opens, 
confirming issuance of the NWR Flood 
Warning Default product(s). 

 

128.  Select ‘OK’ in the second Product Issuance 
window. 

The Product Issuance dialog closes.  

129.  From the ‘Product’ menu in the RiverPro main 
window, select ‘View/Corrected/Send Previous 
Product’. 

The View/Corrected/Send Previous 
Product window opens, and the most 
recent product is highlighted. 

 

130.  Select ‘All Products’ from the ‘List:’ option menu. 
The products can be filtered by ‘VTEC Products’, 
‘Non-VTEC Products’, ‘NWR Products’ or ‘All 
Products’. 

All issued products display as 
ProductId/TimeZ/Type. 

 

131.  Select ‘View Product’ for the just issued NWR 
Flood Warning Default product, and verify the 
edits in it. 
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Step # Action Result Pass/Fail 
132.  Select ‘OK’ in the ‘Product Viewer’. The Product Viewer window closes.  
133.  Select ‘Close’ in the View/Corrected/Send 

Previous Product window. 
The View/Corrected/Send Previous 
Product window closes. 

 

134.  From the ‘Product’ menu in the RiverPro main 
window, select ‘Exit’ to close the RiverPro 
application. 

RiverPro main window closes.  

135.  This concludes the test case Done.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None. 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: Baseline_HYDRO_WHFS_MPE_OB8.1. 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case tests and verifies the functionality found within the WHFS MPE Data Viewer 
application known as MPE Editor. As new functionality is added to this application, these test 
procedures will be updated to contain the steps required to test this new functionality. The MPE 
FieldGen application is also demonstrated in this test case. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested . 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  
 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on 

the Perspectives icon and select ‘MPE’ 
from the dropdown menu if available. If 
not available, select ‘Other…’. Then select 
‘MPE’ from the Open Perspective dialog. 

The MPE Perspective and MPE Choose 
Data Period window display in CAVE. 

 

2.  On the Choose Data Period window, 
select the date along the top of the 
window and the hour from the MPE 
Options. MB1 click the ‘Display MPE 
Data’ button. 

A MPE field for the selected date and 
hour displays in the MPE viewer. 

 

3.  From the ‘Help’ pull-down menu (on the 
right side top corner of the window), select 
‘About’. 

An About window displays the 
application’s name, version number and 
date. 

 

4.  Select ‘OK’ from the About window. The About window closes.  
5.  From the ‘File’ pull-down menu, select 

‘Save As Gif’. 
The Save As GIF window launches.  

6.  In the Save as GIF window, use the Filter 
and Directories selection boxes to choose 
a directory to save a GIF screen capture. 
In the Selection box, enter the name of 
the file (including the directory) followed 
by the ‘.gif’ file extension. For best results 
move the Save as GIF window off of the 
MPE display. Click ‘OK’. 

The Save As GIF window closes. 
 
 
The file is saved in 
/awips/hydroapps/whfs/local/data/image/x
xxx.gif 

 

7.  In a terminal, go to the directory in which 
the screen capture was saved. Use the 
display command to display the GIF file. 

The MPE screen capture displays.  

8.  From the ‘File’ pull-down menu, select 
‘Print Image’. 
 
Note: You can print in color (lp2) printer 
by uncomment out the ‘whfs_print_color 
and whfs_printcommand_LX’ tokens 
under 
/awips/hydroapps/.Apps_defaults_site file. 

The MPE image is sent to the printer 
specified by the whfs_printcommand_LX 
token. By default it is printed on lp1 (gray) 
printer. 

 

9.  From the ‘File’ pull-down menu, select 
‘Print Reverse Image’. 

The MPE image is sent to the printer 
specified by the whfs_printcommand_LX 
token. The image displays in reverse 
video (i.e., black as white and white as 
black). 

 

10.  From the ‘Tools’ pull-down menu, select 
‘Point Zoom’. Then click ‘Out’. 

The center of the geographic display 
zooms out. 

 

11.  From the ‘Tools’ pull-down menu, select 
‘Point Zoom’. Then click ‘In’.  

The center of the geographic display 
zooms in. 
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Step # Action Result Pass/Fail 
12.  Draw a rectangle on the geographic 

display by holding down and dragging 
MB1. Then from the ‘Tools’ pull-down 
menu, select ‘Areal Zoom’. 

The geographic display zooms in on the 
rectangular area drawn by the MB1 
button. 

 

13.  From the ‘Tools’ pull-down menu, select 
‘Areal Zoom’ again. 

The display returns to its previous zoom 
level. 

 

14.  From the ‘Tools’ pull-down menu, select 
‘Pan’. Then click ‘Up’. 

The geographic display moves North.  

15.  From the ‘Tools’ pull-down menu, select 
‘Pan’. Then click ‘Down’. 

The geographic display moves South.  

16.  From the ‘Tools’ pull-down menu, select 
‘Pan’. Then click ‘Right’. 

The geographic display moves East.  

17.  From the ‘Tools’ pull-down menu, select 
‘Pan’. Then click ‘Left’. 

The geographic display moves West.  

18.  From the ‘Tools’ pull-down menu, select 
‘Recenter’. 

The cursor changes from an arrow into a 
leftward pointing hand that indicates that 
recenter functionality is active. 

 

19.  Click on an area that is not in the center of 
the display. 

The display recenters on the selected 
area. 

 

20.  From the ‘Tools’ pull-down menu, select 
‘Recenter’ again. Then click on the area 
that was originally at the center of the 
display. 

The geographic display returns to its 
previous viewing state and center. 

 

21.  From the ‘Tools’ pull-down menu, select 
‘Tool Bar’. 

A tool bar appears just below the row of 
pull-down menus. The icons shown 
perform the same functions as the Zoom 
and Pan options found in the ‘Tools’ pull-
down menu. 

 

22.  From the ‘Tools’ pull-down menu, select 
‘Tool Bar’ again. 

The tool bar disappears.  

23.  From the ‘Gages’ pull-down menu, select 
‘Show Gage Identifiers’. 

Alphanumeric gage labels appear on the 
MPE display. 

 

24.  From the ‘Tools’ pull-down menu, select 
‘Set Font’. Then try selecting different font 
sizes. 

The alphanumeric gage labels change 
size. 

 

25.  From the ‘Gages’ pull-down menu, select 
‘Show Gage Identifiers’. 

The gage labels disappear from the 
display. 

 

26.  From the ‘Tools’ pull-down menu, select 
‘Set Colors’. 

The Color Thresholds window appears.  

27.  On the Color Thresholds window, select 
the ‘<MINIMUM’ item from the list. Select 
‘BLUE1’ from the color name list at the 
bottom of the window and click the ‘Save 
To User Set’ button. 

Black areas within the MPE data field on 
the MPE display turn blue. 
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Step # Action Result Pass/Fail 
28.  On the Color Thresholds window, select 

the ‘<MINIMUM’ item from the list. Select 
‘BLACK’ from the color name list at the 
bottom of the window and click the ‘Save 
To User Set’ button. 

The blue areas within the MPE data field 
on the MPE display turn back to black. 

 

29.  Close the Color Thresholds window. The Color Thresholds window closes.  
30.  On the ‘Tools’ pull-down menu, select 

‘View’. Then click ‘Split Screen’. 
The MPE display splits into two 
geographic areas, each with its own 
legend. 

 

31.  On the ‘Tools’ pull-down menu, select 
‘View’. Then click ‘Full Screen’. 

The MPE display shows one geographic 
area with only one legend. 

 

32.  On the ‘Tools’ pull-down menu, select 
‘Clear Data’. 

A dialog box indicating that the data has 
not been saved displays. Click ‘OK’ in this 
dialog box. 

 

33.  On the ‘Tools’ pull-down menu, verify the 
‘Restore Initial’ option exists.  

Verified.  

34.  On the ‘Tools’ pull-down menu, verify the 
‘Find Station’ option exists. 

Verified.  

35.  From the ‘Projections’ pull-down menu, 
select ‘Polar Stereographic’. 

The geographic display uses a Polar 
Stereographic projection. 

 

36.  From the ‘Projections’ pull-down menu, 
select ‘HRAP’. 

The geographic display uses a HRAP 
projection. 

 

37.  From the ‘Projections’ pull-down menu, 
select ‘Flat Lat/Lon’. 

The geographic display uses a Flat 
Latitude/Longitude projection. 

 

38.  From the ‘Overlays’ pull-down menu, 
select ‘Streams/Lakes’. Then click ‘No 
Streams/Lakes’. 

No streams or lakes display on the 
geographic display. 

 

39.  From the ‘Overlays’ pull-down menu, 
select ‘Streams/Lakes’. Then click ‘All 
Streams/Lakes’. 

All streams and lakes display on the 
geographic display if defined in the 
Overlay Configuration file. 

 

40.  From the ‘Overlays’ pull-down menu, 
select ‘Basin Boundaries’. 

This toggles the display of Basin 
Boundary outlines on the geographic 
display if defined in the Overlay 
Configuration file. 

 

41.  From the ‘Overlays’ pull-down menu, 
select ‘Counties’. 

This toggles the display of County outlines 
on the geographic display if defined in the 
Overlay Configuration file. 

 

42.  From the ‘Overlays’ pull-down menu, 
select ‘County Warning Areas’. 

This toggles the display of CWA outlines 
on the geographic display if defined in the 
Overlay Configuration file. 

 

43.  From the ‘Overlays’ pull-down menu, 
select ‘RFC Boundaries’. 

This toggles the display of RFC Boundary 
outlines on the geographic display if 
defined in the Overlay Configuration file. 

 

44.  From the ‘Overlays’ pull-down menu, 
select ‘States’. 

This toggles the display of State Borders 
on the geographic display if defined in the 
Overlay Configuration file. 
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Step # Action Result Pass/Fail 
45.  From the ‘Overlays’ pull-down menu, 

select ‘Zones’. 
This toggles the display of Zones on the 
geographic display if defined in the 
Overlay Configuration file. 

 

46.  From the ‘Overlays’ pull-down menu, 
select ‘Cities/Towns’. 

This toggles the display of City locations 
on the geographic display if defined in the 
Overlay Configuration file. 

 

47.  From the ‘Overlays’ pull-down menu, 
select ‘Highways/Roads’. Then click 
‘Highways’. 

All Highways display on the geographic 
display if defined in the Overlay 
Configuration file. 

 

48.  From the ‘Overlays’ pull-down menu, 
select ‘Highways/Roads’. Then click 
‘None’. 

No Highways or Roads display on the 
geographic display. 

 

49.  From the ‘Overlays’ pull-down menu, 
select ‘HRAP’. 

This toggles the display of the HRAP grid 
on the geographic display if defined in the 
Overlay Configuration file. 

 

50.  From the ‘Overlays’ pull-down menu, 
select ‘Lat/Lon Lines’. 

This toggles the display of Latitude and 
Longitude lines on the geographic display 
if defined in the Overlay Configuration file. 

 

51.  From the ‘Overlays’ pull-down menu, 
select ‘Time Zones’. 

This toggles the display of Time Zone 
boundaries on the geographic display if 
defined in the Overlay Configuration file. 

 

52.  From the ‘Overlays’ pull-down menu, 
select ‘Radar Locations’. 

This toggles the display of Radar 
locations on the geographic display if 
defined in the Overlay Configuration file. 

 

53.  From the ‘Overlays’ pull-down menu, 
select ‘Radar Rings’. 

This toggles the display of the outline of 
the Radar’s coverage area on the 
geographic display if defined in the 
Overlay Configuration file. Note the colors 
of the radar rings. A red radar ring 
indicates that there is no data for that 
radar site. A green radar ring indicates 
that there is data for the radar site. 

 

54.  On the Overlays pull-down menu, verify 
the ‘Basin Names’, ‘Hydro Service Areas’, 
and ‘Maps Foreground’ options exist. 

Verified.  

55.  From the ‘MPEcontrol’ pull-down menu, 
select ‘Previous Hour’. 

A dialog box indicating that this hour’s 
MPE field has not been saved displays. 
Select ‘OK’ from this dialog to display the 
previous hour’s MPE field. 

 

56.  From the ‘MPEcontrol’ pull-down menu, 
select ‘Next Hour’. 

A dialog box indicating that this hour’s 
MPE field has not been saved displays. 
Select ‘OK’ from this dialog to display the 
next hour’s MPE field. 

 

57.  From the ‘MPEcontrol’ pull-down menu, 
select ‘Choose Hour’. 

The Choose Data Period window 
displays. 
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Step # Action Result Pass/Fail 
58.  From the Choose Data Period window, 

click the ‘Close Window Button’. 
The Choose Data Period window closes.  

59.  From the ‘MPEcontrol’ pull-down menu, 
select ‘Save Best Estimate Top’. 

The currently displayed MPE field is 
saved as the best estimate QPE. To verify 
this, go to 
/awips/hydroapps/precip_proc/local/data/
mpe/qpe and verify the time stamp on the 
xmrg file for this hour. 

 

60.  From the ‘MPEcontrol’ pull-down menu, 
the ‘Save Best Estimate Bottom’ option 
only applies when in split screen mode. 
When in split screen mode, this option 
saves the MPE field displayed in the lower 
window as the best estimate QPE. 

The MPE field displayed is saved as the 
best estimate QPE. 

 

61.  From the ‘MPEcontrol’ pull-down menu, 
select ‘Regenerate Hour Fields’. 

The Regenerate Hour Fields Dialog 
window displays. 

 

62.  From the ‘Regenerate Hour Fields Dialog’ 
window, click ‘Yes’. 

MPE Fieldgen is rerun for the displayed 
hour’s MPE data. To verify this, go to 
/awips/hydroapps/precip_proc/local/data/
mpe/rmosaic and verify the timestamp on 
the RMOSAIC file for this hour. 

 

63.  From the ‘Precipfields’ pull-down menu, 
select ‘Radar Mosaic’. 

The Radar Mosaic Precip Field displays.  

64.  From the ‘Precipfields’ pull-down menu, 
select ‘Average Radar Mosaic’. 

The Average Radar Mosaic field displays. 
If the ‘Average Radar Mosaic’ option is 
grayed out, then AVGRMOSAIC is not 
listed in either the mpe_generate_list 
token or the mpe_base_radar_mosaic 
token. 

 

65.  From the ‘Precipfields’ pull-down menu, 
select ‘Max Radar Mosaic’. 

The Maximum Radar Mosaic field 
displays. If the ‘Max Radar Mosaic’ option 
is grayed out, then MAXRMOSAIC is not 
listed in either the mpe_generate_list 
token or the mpe_base_radar_mosaic 
token. 

 

66.  From the ‘Precipfields’ pull-down menu, 
select ‘Field Bias Radar Mosaic’. 

The Field Bias Radar Mosaic displays. If 
the ‘Field Bias Radar Mosaic’ option is 
grayed out, then BMOSAIC is not listed in 
the mpe_generate_list token or 
MMOSAIC is not listed in the 
mpe_generate_list token. 

 

67.  From the ‘Precipfields’ pull-down menu, 
select ‘Local Bias Radar Mosaic’. 

The Local Bias Radar Mosaic displays. If 
the ‘Local Bias Radar Mosaic’ option is 
grayed out, then LMOSAIC is not listed in 
the mpe_generate_list token or 
MLMOSAIC is not listed in the 
mpe_generate_list token. 
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Step # Action Result Pass/Fail 
68.  From the ‘Precipfields’ pull-down menu, 

select ‘Gage Only Analysis’. 
The Gage Only Analysis displays. If the 
‘Gage Only Analysis’ option is grayed out, 
then GAGEONLY is not listed in the 
mpe_generate_list token. 

 

69.  From the ‘Precipfields’ pull-down menu, 
select ‘Satellite Precip’. 

The Satellite Precipitation field displays. If 
the ‘Satellite Precip’ option is grayed out, 
then SATPRE is not listed in the 
mpe_generate_list token. 

 

70.  From the ‘Precipfields’ pull-down menu, 
select ‘Local Bias Satellite Precip’.  

The Local Bias Satellite Precipitation field 
displays. If the ‘Local Bias Satellite Precip’ 
field option is grayed out, then LSATPRE 
is not listed in the mpe_generate_list 
token. 

 

71.  From the ‘Precipfields’ pull-down menu, 
select ‘Multisensor Mosaic’. 

The Multisensor Mosaic displays. If the 
‘Multisensor Mosaic’ option is grayed out, 
then MMOSAIC is not listed in the 
mpe_generate_list token. 

 

72.  From the ‘Precipfields’ pull-down menu, 
select ‘Local Bias Multisensor Mosaic’. 

The Local Bias Multisensor Mosaic 
displays. If the ‘Local Bias Multisensor 
Mosaic’ option is grayed out, then 
LMOSAIC is not listed in the 
mpe_generate_list token. 

 

73.  From the ‘Precipfields’ pull-down menu, 
select ‘Triangulated Local Bias Mosaic’. 

The Triangulated Local Bias Mosaic 
displays. If the ‘Triangulated Local Bias 
Mosaic’ option is grayed out, then 
P3LMOSAIC is not listed in the 
mpe_generate_list token. 

 

74.  From the ‘PrecipFields’ menu, select ‘Best 
Estimate QPE’. 

The Best Estimate QPE field displays.  

75.  From the ‘Basefields’ pull-down menu, 
select ‘Local Span’. 

The Local Span Field displays if 
LMOSAIC or MLMOSAIC is listed in the 
mpe_generate_list token. 

 

76.  From the ‘Basefields’ pull-down menu, 
select ‘Local Bias’. 

The Local Bias Field displays if LMOSAIC 
or MLMOSAIC is listed in the 
mpe_generate_list token. 

 

77.  From the ‘Basefields’ pull-down menu, 
select ‘Height Field’. 

The Height Field displays.  

78.  From the ‘Basefields’ pull-down menu, 
select ‘Radar Coverage Field’. 

The Radar Coverage Field displays.  

79.  From the ‘Basefields’ pull-down menu, 
select ‘Gage Triangles’. 

The Gage Triangles displays if 
P3LMOSAIC is specified in the 
mpe_generate_list token. (note**: it is 
grayed out) 

 

80.  On the ‘Gages’ pull-down menu, verify the 
‘QC Precipitation’ option exists. 

Verified.  
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Step # Action Result Pass/Fail 
81.  On the ‘Gages’ pull-down menu, verify the 

‘QC Temperature’ option exists. 
Verified.  

82.  On the ‘Gages’ pull-down menu, verify the 
‘QC Freezing Level’ option exists. 

Verified.  

83.  On the ‘Gages’ pull-down menu, verify the 
‘Save Level 2 Data’ option exists. 

Verified.  

84.  From the ‘Precipfields’ pull-down menu, 
select ‘Gage Only Analysis’. 

The Gage Only Analysis displays.  

85.  From the ‘Gages’ pull-down menu, select 
‘Add Pseudo Gage’. 

The mouse pointer turns into a left 
pointing hand. 

 

86.  MB1 click on a location inside the 
currently displayed ‘Gage Only Analysis’ 
field. 

The Add Pseudo Gage window appears.  

87.  Using the Pseudo Gage Accumulation 
slider bar on the Add Pseudo Gage 
window, choose ‘0.50 inches’ and click 
the ‘OK’ button. 

The Add Pseudo Gage window closes.  

88.  From the ‘MPEcontrol’ pull-down menu, 
select Regenerate Hour Fields. Select 
‘Yes’ in the pop up confirmation window. 

The MPE_ Fieldgen process is run for the 
chosen hour. After MPE_ Fieldgen has 
run, the Gage Only Analysis field is 
regenerated. The field appears to be 
altered in the vicinity of the newly created 
pseudo gage.  

 

89.  From the ‘Gages’ pull-down menu, select 
‘Gage Table’. 

The Gage Table displays.  

90.  Select ‘by Gage Value’ from the ‘Gage 
Table Sort Gages’ menu. 

The gages are sorted by descending 
value. 

 

91.  Select by ‘by Radar ID’ from the ‘Gage 
Table Sort Gages’ menu. 

The gages are grouped and sorted by 
ascending Radar ID. 

 

92.  Select ‘by Gage ID’ from the ‘Gage Table 
Sort Gages’ menu. 

The gages are grouped and sorted by 
ascending Gage ID. 

 

93.  From the ‘Gages’ pull-down menu, select 
‘Show Gage Identifiers’. 

The gage identifiers are drawn on the 
MPE display. 

 

94.  From the ‘Gages’ pull-down menu, select 
‘Show Gage Values’. 

The gage values are drawn on the MPE 
display. 

 

95.  Find a zero-valued gage on the MPE 
display and locate this gage in the Gage 
Table window. 

The gage is located.  

96.  In the Edit column, modify the value of 
this gage to a large non-zero amount. 

The value of the gage is modified to a 
large non-zero amount. 

 

97.  Select ‘Quit’ from the ‘Control’ menu in the 
Gage Table window. 

The Gage Table closes. The edited gage 
value is saved. Note**: Value is not saved 

 

98.  From the ‘MPEcontrol’ pull-down menu, 
select ‘Regenerate Hour Fields’. 

The Rerun FieldGen Dialog window 
displays. 
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Step # Action Result Pass/Fail 
99.  From the Rerun FieldGen Dialog window, 

click ‘Yes’. 
MPE_ Fieldgen is rerun for the hour’s 
MPE data being displayed. After MPE_ 
Fieldgen has run, the MPE window shows 
the results of the gage edit on the Gage 
Only Analysis precipitation field. 

 

100.  From the ‘Gages’ pull-down menu, select 
‘Show Missing Gages’. Then select ‘All 
Missing’ from the ‘Missing Gages’ 
submenu. 

Gages with missing values display in the 
MPE window with values of ‘M’. There 
may not be any. 

 

101.  From the ‘Gages’ pull-down menu, select 
‘Gage Color’ -> ‘Solid Color’. 

The gage identifiers and gage values 
display in a sandy brown color. 

 

102.  Select ‘Display 7 x 7’ from the ‘Gages’ 
pull-down menu. 

The pointer changes shape so that the 
user can choose a gage. 

 

103.  MB1 click near a gage. The tester should 
choose a gage in an area that has 
precipitation. 

A Display 7x7 Gage Editing Utility window 
opens for the precipitation gage closest to 
the area selected. 

 

104.  In the Display 7x7 Gage Editing Utility 
window, slide the Edit Gage Value bar 
partially to the right. Then select ‘Set 
Value’. 

The change is accepted. The gage value 
shown directly beneath the gage identifier 
in the Display 7x7 Gage Editing Utility 
window updates to the value chosen on 
the Edit Gage Value slider bar. 

 

105.  From the Display 7x7 Gage Editing Utility 
window, select ‘Close’. 

The Display 7x7 Gage Editing Utility 
window closes. 

 

106.  Select ‘Regenerate Hour Fields’ from the 
‘MPEcontrol’ pull-down menu. 

The Rerun FieldGen Dialog window 
appears. 

 

107.  Select ‘Yes’ in the Rerun FieldGen Dialog 
window. 

The MPE_ Fieldgen process is run for the 
chosen hour. After MPE_ Fieldgen has 
run, the MPE window shows the results of 
the gage edit on the Gage Only Analysis 
precipitation field. 

 

108.  From the Polygons pull-down menu, 
select ‘Draw Polygons’. 

The option is selected.  

109.  Using single MB1 clicks, draw a polygon 
on the displayed MPE data field.  

A line connecting the polygon vertices 
defined by the MB1 click points is drawn 
on the MPE display. 

 

110.  Perform a single MB3 click to close the 
polygon. 

The displayed polygon outline is closed by 
a line connecting the last polygon vertex 
to the first polygon vertex. The Edit 
Precipitation window displays. 

 

111.  From the Edit Precipitation window, select 
a nonzero value on the Adjust 
Precipitation Value slider. Then click the 
‘Set’ button below the slider. 

The drawn polygon fills with a solid color 
representing the value chosen on the 
Adjust Precipitation Value slider. 

 

112.  From the Edit Precipitation window, select 
‘Close’. 

The Edit Precipitation window closes.  
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Step # Action Result Pass/Fail 
113.  From the ‘Polygons’ pull-down menu, 

select ‘Delete Polygons’. 
The Delete Polygons window displays. In 
its text field, there should be an entry for 
the polygon just drawn. 

 

114.  In the Delete Polygons window, select the 
entry corresponding to the polygon just 
created. Click the ‘Undisplay’ button. 

The polygon is removed from the MPE 
display. Its displayed flag is set from ‘T’ to 
‘F’. 

 

115.  In the Delete Polygons window, select the 
‘Display’ button. 

The polygon is shown on the MPE 
display. Its displayed flag is set from ‘F’ to 
‘T’. 

 

116.  In the Delete Polygons window, select 
‘Delete’. 

The polygon is permanently removed from 
the MPE display. Its entry is removed 
from the Delete Polygons window. 

 

117.  In the Delete Polygons window, select 
‘Close’. 

The Delete Polygons window closes.  

118.  From the ‘Polygons’ pull-down menu, 
select ‘Draw Polygons’. 

The option is selected.  

119.  Using single MB1 clicks, draw a polygon 
on the displayed MPE data field. Try to 
draw the polygon around one or more 
areas of precipitation on the MPE display. 

A line connecting the polygon vertices 
defined by the MB1 click points is drawn 
on the MPE display. 

 

120.  Perform a single MB3 click to close the 
polygon. 

The displayed polygon outline is closed by 
a line connecting the last polygon vertex 
to the first polygon vertex. The Edit 
Precipitation window displays. 

 

121.  On the Edit Precipitation window, set the 
‘Adjust Precipitation Value’ to a value 
midway between the highest and lowest 
precipitation values contained within the 
polygon. For example, if the polygon 
encompasses precipitation amounts 
ranging from 0 to 0.50 inches, then set the 
slider bar to 0.25 inches. 

The slider bar is set.  

122.  On the Edit Precipitation window, click the 
‘Raise’ button. 

All values within the edit polygon drawn 
on the MPE display which are below the 
value selected on the Adjust Precipitation 
slider bar are raised to the slider bar 
value. All values within the edit polygon 
which are above the value set on the 
slider bar are left unchanged. 

 

123.  Using single MB1 clicks, draw another 
polygon on the displayed MPE data field. 
Try to draw the polygon around one or 
more areas of precipitation on the MPE 
display. Try to draw this polygon so it 
does not overlap the previously drawn 
polygon. 

A line connecting the polygon vertices 
defined by the MB1 click points is drawn 
on the MPE display. 
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Step # Action Result Pass/Fail 
124.  Perform a single MB3 click to close the 

polygon. 
The displayed polygon outline is closed by 
a line connecting the last polygon vertex 
to the first polygon vertex. The Edit 
Precipitation window displays. 

 

125.  On the Edit Precipitation window, set the 
Adjust Precipitation Value slider bar to a 
value midway between the highest and 
lowest precipitation values contained 
within the polygon. For example, if the 
polygon encompasses precipitation 
amounts ranging from 0 to 0.50 inches, 
then set the slider bar to 0.25 inches. 

The slider bar is set.  

126.  On the Edit Precipitation window, click the 
‘Lower’ button. 

All of the values within the polygon which 
have a value higher than the value 
selected on the Adjust Precipitation Value 
slider bar are lowered to the slider bar 
value. All values within the polygon which 
have a value lower than the value on the 
slider bar are left unchanged. 

 

127.  On the Edit Precipitation window, set the 
Adjust Precipitation Value slider bar to 
0.50. Click the ‘Scale’ button. 

All values within the previously drawn 
polygon are reduced by half (multiplied by 
0.50). 

 

128.  On the Edit Precipitation window in the 
Select Field to Substitute section, select 
an MPE field different from the one 
currently shown in the MPE display. Click 
the ‘Substitute’ button.  

Precipitation data from the selected field 
are placed into the previously drawn 
polygon. 

 

129.  On the Edit Precipitation window, select 
the ‘Close’ button. 

The Edit Precipitation window closes.  

130.  From the ‘Climo’ pull-down menu, select 
the ‘Monthly Prism Precip’ option. 

PRISM data representing average 
precipitation for the current month display 
in the MPE display. 

 

131.  From the ‘Misc’ pull-down menu, select 
the ‘Display Bias Table’ option. 

The Edit Bias Table window displays.  

132.  From the Edit Bias Table window, click a 
button corresponding to a radar site in the 
radar column. 

A window appears listing the number of 
gage/radar pairs, the mean gage value, 
the mean radar value, and the resulting 
bias for each of 10 memory spans. 

 

133.  In the Edit Bias Table window, for a radar 
site, modify the bias value by entering a 
new value in the text field located to the 
right of the radar id button. 

The ‘NO’ label in the manually specified 
box should change to ‘YES’. 

 

134.  From the radar-specific memory span 
window, select ‘Close’. 

The radar-specific memory span window 
closes. 

 

135.  From the ‘Edit Bias’ table, click the ‘Close’ 
button. 

The Edit Bias table closes.  
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Step # Action Result Pass/Fail 
136.  Select ‘Review Hourly Radar’ from the 

‘Misc’ pull-down menu. 
The Radar Sites window displays. It 
contains a list of all of the radars which 
contribute to the MPE analysis. 

 

137.  Select a radar site from the Radar Sites 
window. Then select ‘OK’. 

The four paned Single Radar Site window 
displays. Clockwise from the upper left 
pane, it displays the Raw Radar, Radar 
Climatology, Radar Coverage Map, and 
the Mean Field Bias Corrected Radar for 
the selected radar site for the selected 
hour. 

 

138.  From the Single Radar Site window 
‘Options’ pull-down menu, select ‘Edit 
Bias Value’. 

The Edit Bias Value window appears.  

139.  On the Edit Bias Value window, use the 
slider bar to adjust the bias value for the 
radar for which the Single Site Radar 
window was opened. Click the ‘OK’ 
button. 

The Edit Bias Value window closes.  

140.  On the Single Radar Site window 
‘Options’ pull-down menu, select ‘Ignore 
Radar’. 

The ‘Ignore Radar’ option on the Single 
Radar Site window Options pull-down 
menu relabels to ‘Unignore Radar’. 

 

141.  On the Single Radar Site window 
‘Options’ pull-down menu, select 
‘Unignore Radar’. 

The ‘Unignore Radar’ option on the Single 
Radar Site window ‘Options’ pull-down 
menu relabels to ‘Ignore Radar’. 

 

142.  On the Single Radar Site window 
‘Options’ pull-down menu, select ‘Display 
Adaptable Param’. 

The Adaptation Parameter Viewer 
displays. It shows the adaptation 
parameters for the selected radar site. 

 

143.  On the Adaptation Parameter Viewer 
window, click the ‘Close’ button. 

The Adaptation Parameter Viewer window 
closes. 

 

144.  On the Single Radar Site window 
‘Options’ pull-down menu, select ‘Display 
Supplemental Data’.  
Note**: It is grayed out. 

The Supplemental Data Viewer displays. 
This shows the supplemental data for the 
selected radar. 

 

145.  On the Supplemental Data Viewer, select 
the ‘Close’ button. 

The Supplemental Data Viewer closes.  

146.  Select ‘Close’ from the ‘Control’ menu of       
the Single Radar Site window. 

The Single Radar Site window closes.  

147.  From the ‘Misc’ pull-down menu, select 
‘Time Lapse’. Then select ‘6 Hr’ from the 
‘Time Lapse’ submenu. 

The currently displayed MPE field will time 
lapse over the past 6 hours worth of data. 

 

148.  From the ‘Misc’ pull-down menu, select 
‘Time Lapse’. Then select ‘End Loop’ from 
the ‘Time Lapse’ submenu.  
Note**: It is grayed out. 

The 6 hour time lapse ends. The MPE 
field from the original date and hour 
displays. 

 

149.  From the ‘Misc’ pull-down menu, select 
‘Multi-Hour QPE’. 

The Multi-Hour Precipitation Accumulation 
window displays.  
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Step # Action Result Pass/Fail 
150.  From the Multi-Hour Precipitation window, 

select ‘Accumulation Interval Setup’ and 
set the duration to 24 hours. From the 
Accumulation Display Control, click the 
‘Show Data’ button. 

The MPE display shows an accumulation 
of the past 24 hours worth of Best QPE 
fields. 

 

151.  From the Multi-Hour Accumulation 
window, select the ‘Close’ button. 

The Multi-Hour Precipitation Accumulation 
window closes. 

 

152.  Close the MPE Perspective. The MPE Perspective closes.  
Test – MPE Output for Display in CAVE 
153.  In CAVE, Mouse Button (MB) 1 click on 

the Perspectives icon and select ‘MPE’ 
from the dropdown menu if available. If 
not available, select ‘Other…’. Then select 
‘MPE’ from the Open Perspective dialog. 

The MPE Perspective and MPE Choose 
Data Period window display in CAVE. 

 

154.  In the Choose Data Period window, adjust 
the ‘Hours’ field and click ‘Display MPE 
Data’ button to check if there is data 
(image) shown for that hour. It is better to 
have data for the test. But if not, it is still 
ok. 
 
Note: Write down the 
year/month/data/hour from the Choose 
Data Period for later validation. 

The data (image) for the selected hours 
displays. 

 

155.  Under the ‘Polygons’ menu, select ‘Draw 
Polygons’. 

The polygon is selected.  

156.  MB1 click on the black area of the screen 
repeatedly to draw a circle or oval shape. 
Then MB3 click to join the end of the 
shape. 

The Edit Precipitation window displays.  

157.  Adjust the precipitation value to the 
desired position by using the slider bar. 
Click on the ‘Set’ button. Then select the 
‘Close’ button. 

The new polygon (shape) drawn displays 
on the screen. 

 

158.  Under the ‘MPEControl Menu’ in the main 
window, select ‘Save Best Estimate Top’. 

The polygon is saved.  

159.  Navigate to the OHD xmrg files located at 
/awips/hydroapps/precip_proc/local/data/
mpe/qpe. Look for the xmrg file with the 
date/time written in step 154 (e.g., 
xmrgmmddyyyyhhz) 

The xmrg file should match.  

160.  Navigate to the generated GRIB files in 
/awips/hydroapps/precip_proc/local/data/
mpe/qpe_grib. Look for the grib file with 
the date/time written in step 154. (e.g., 
yyyymmddhhz.grib) 

The grib file should match.  
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Step # Action Result Pass/Fail 
161.  Toggle to the D2D Perspective. The D2D Perspective and associated 

main window opens. 
 

162.  Click on the ‘Scale’ drop-down menu and 
select ‘Region’ or ‘State’. 

The selected scale displays.  

163.  Under ‘NCEP/Hydro’ menu, go to the 
‘Hydro’ section and select ‘QPE >> 1 hour 
WFO Local MPE’. 

The ‘1 hour WFO Local MPE’ option is 
selected. 

 

164.  Click on the icon ‘<’ (Step Back) to the 
date/time written in step 154. 

The polygon (shape/image) from step 158 
displays. 

 

165.  Close the MPE Perspective The MPE Perspective closes.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
SYSR   
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO8 Test Case Skew-T 1.0 

2.2 Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• Section 6 of the AWIPS D-2D User’s Manual Build 8.1. 
• Existing AWIPS 1 test procedures:  

– D2D_RAOB_1.4.1.1 
– Check_out_4.1.2_Skew-T_OB8.1 

• The Silver Spring NWS AWIPS I test bed application. 
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case is to verify that local and model Skew-T displays load and are editable. Upgrades 
from comparison to Bufkit and N-Sharp are also demonstrated. The interface and function with 
the Meteo Library are demonstrated by inference.  
 

3.1 Assumptions, Constraints, and Preconditions 
• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested. 

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The images and data will be displayed in CAVE. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In the D-2D Perspective, under the Upper Air 

dropdown menu, select an available RAOB to 
display a sounding and hodograph. 

A Skew-T tab appears with the most recent 
sounding for the selected site displayed in 
the large pane. A map in the upper left 
corner indicating its geographic location. 
Sounding parameters are listed in the lower 
right quadrant of the display. 

 

2.  Verify the Skew-T window displays: 
– upper air sounding data 
– meteorological indices and values (Note: 

this step verifies (by inference) the Skew-
T calls on meteolib functions 

– an inset map with the sounding location 
plotted 

– a 24 hour temperature change chart 
– a Hodograph (Note: Not for model data) 
– isobars, isotherms, dry adiabats, moist 

adiabats, and saturation mixing ratio lines 

The Skew-T window displays the upper air 
sounding data, the listed meteorological 
indices and values, an inset map with the 
plotted sounding location, a 24 hour 
temperature change chart, a Hodograph, 
and isobars, isotherms, dry adiabats, moist 
adiabats, and saturation mixing ratio lines. 

 

3.  Select Mouse Button (MB) 2 on the Skew-T 
product ID in the product legend. 

The Interactive Skew-T and Hodograph are 
now editable.  
‘Skew-T Controls’ and ‘Skew-T Parameters’ 
windows open. 
Specific points appear on the Skew-T and 
Hodograph, which can be altered. 

 

4.  The ‘Skew-T Controls’ and ‘Skew-T 
Parameters’ windows may be closed. 
To edit the Skew-T, press and hold MB1 on a 
point on the temperature curve and drag. 

The selected point changes and the 
temperature line adjust to the new value.  
Note that the data points are constrained to 
maintain their original pressure, so they can 
only be moved horizontally. 

 

5.  Select and hold MB3 on one of the points on 
the temperature line. Then select ‘Delete 
Vertex’ from the menu. 

The point is deleted from the temperature 
and dew point lines. The temperature and 
dew point curves modify interpolating 
between the data points above and below 
the deleted point. 

 

6.  Repeat steps 4 and 5 for the dew point line. The dew point curve is edited. A point is 
deleted from the temperature and dew point 
lines. The temperature and dew point 
curves modify interpolating between the 
data points above and below the deleted 
point. 

 

7.  Activate the sampling tool and hover the 
cursor on the Skew-T chart. 
Verify the following data from the original 
sounding is displayed: 

The parcel data and graphical point data 
are displayed adjacent to the cursor. 
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Step # Action Result Pass/Fail 
Parcel Data 
– Pressure (mb) 
– Height (m and ft) 
– Temperature (C and F) 
– Dew Point Temperature (C and F) 
– Wind direction (degrees) and wind speed 

(kts) 
– u (m/s) 
– v (m/s) 
– Theta (K) 
– Theta-e (K) 
– Mixing Ratio [w] (g/kg) 
 
Graphical Point Data 
– Pressure (mb) 
– Temperature (C and F) 
– Theta (K) 
– Theta-e (K) 
– Mixing Ratio [w] (g/kg)  

8.  Zoom into the Hodograph. 
Then select MB1 on a point in the Hodograph, 
and drag to a new location. 

The Hodograph point is moved. 
 

 

9.  Select and hold MB3 on one of the points on 
the Hodograph line. Then select ‘Delete 
Vertex’ from the menu. 

The point is deleted from the Hodograph 
line. 

 

10.  Close the Skew-T tab. The Skew-T tab closes. The Map tab 
displays. 

 

11.  Repeat steps 2-7 and 10 for a sounding from 
model data as requested via the Volume 
Browser. 

The edits are successful (refer to the result 
column in steps 3-8 and 11). 

 

End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
CAVE_TO8_015 CAVE shall provide the capability to display a Skew-T product  
CAVE_TO8_015.1 The Skew-T product shall contain Upper Air sounding data  
CAVE_TO8_015.2 The Skew-T product shall contain a list of meteorological indices and 

associated values derived from the Upper Air sounding data 
 

CAVE_TO8_015.3 The Skew-T product shall contain an inset map with the location of the 
plot origin 

 

CAVE_TO8_015.4 The Skew-T product shall contain a 24 Hour Temperature Change chart  
CAVE_TO8_015.5 CAVE shall allow the user to modify the Upper Air sounding  
CAVE_TO8_015.8 CAVE shall allow the user to modify the temperature profile  
CAVE_TO8_015.8.1 CAVE shall allow the user to modify the temperature profile using 

mouse button 1 
 

CAVE_TO8_015.8.2 The modified temperature point shall find its resting place on a 
horizontal axis along its original pressure level 

 

CAVE_TO8_015.8.7 CAVE shall allow the user to remove a vertex point on the temperature 
profile using mouse button 3 

 

CAVE_TO8_015.8.8 The Skew-T temperature profile shall modify accordingly, interpolating 
between the point above and the point below a removed vertex point 

 

CAVE_TO8_015.9 CAVE shall allow the user to modify the dew point temperature  
CAVE_TO8_015.9.1 CAVE shall allow the user to modify the dew point temperature profile 

using mouse button 1 
 

CAVE_TO8_015.9.2 The modified dew point temperature point shall find its resting place on 
a horizontal axis along its original pressure level 

 

CAVE_TO8_015.9.7 CAVE shall allow the user to remove a vertex point on the dew point 
temperature profile using mouse button 3 

 

CAVE_TO8_015.9.8 The Skew-T dew point temperature profile shall modify accordingly, 
interpolating between the point above and the point below a removed 
vertex point 

 

CAVE_TO8_015.12 The Skew-T product shall contain a hodograph  
CAVE_TO8_015.13 CAVE shall allow the user to modify the hodograph profile using the 

cursor 
 

CAVE_TO8_015.14.3 CAVE shall allow the user to delete a point from the hodograph using 
mouse button 3 

 

CAVE_TO8_015.16 CAVE shall allow the user to sample the data on the Skew-T    
CAVE_TO8_015.16.1 The sample data shall display the parcel data for the level on which the 

cursor lies 
 

CAVE_TO8_015.16.2 The sample data shall display the graphical point data for the level on 
which the cursor lies 

 

AWIPS_TO8_029 AWIPS shall contain a library of functions in the D2D meteolib baseline 
with APIs 

 

 



 

This document includes data that shall not be duplicated, used, or disclosed – in whole or in part – outside the Government for 
any purpose other than to the extent provided in contract DG133W-05-CQ-1067. However, the Government shall have the right 
to duplicate, use, or disclose the data to the extent provided in the contract. This restriction does not limit the Government’s right 
to use information contained in this data if it is obtained from another source without restriction. The data subject to this 
restriction are contained in all sheets. 

HARD COPY UNCONTROLLED 

Test Case Guardian (Alert Visualization) 
for  

Contract DG133W-05-CQ-1067 
Advanced Weather Interactive Processing System (AWIPS) 

Operations & Maintenance 
 

AWP.TE.SWCTR/TO10-0016 
 
 

Prepared for: 

U.S. Department of Commerce 
NOAA/NWS Acquisition Management Division 

SSMC2, Room 11220 
1325 East-West Highway 
Silver Spring, MD 20910 

Prepared by: 

Raytheon Company 
STC Office 

6825 Pine Street 
Omaha, NE 68106  

 

 

 



Test Case Guardian (Alert Visualization) (Draft)  DCN AWP.TE.SWCTR/T010-0016 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0016 / 21 Nov. 2008 i 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Submitted By:  

 

___________________________________________________________ ___________ 
Test Engineer         Date 
 
 
 
 
Approved By: 

 
___________________________________________________________ __________ 
Program Manager        Date 
 
 
___________________________________________________________ __________ 
Mission Assurance Quality       Date 



Test Case Guardian (Alert Visualization) (Draft)  DCN AWP.TE.SWCTR/T010-0016 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0016 / 21 Nov. 2008 ii 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Change History 
Revision Date Affected Pages Explanation of Change 

Draft 21 Nov. 2008 ALL Initial Draft 
 

 



Test Case Guardian (Alert Visualization) (Draft)  DCN AWP.TE.SWCTR/T010-0016 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0016 / 21 Nov. 2008 iii 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Table of Contents 
Page 

1.0 SCOPE ................................................................................................................................ 4 
2.0 APPLICABLE DOCUMENTS .......................................................................................... 5 

2.1 Source Documents ........................................................................................................ 5 
2.2  Reference Documents .................................................................................................. 5 

3.0 TEST CASE DESCRIPTION ............................................................................................. 6 
3.1  Assumptions, Constraints and Preconditions ............................................................... 6 
3.2  Recommended Hardware ............................................................................................. 6 
3.3  Test Inputs .................................................................................................................... 6 
3.4  Test Outputs ................................................................................................................. 6 

4.0 TEST SCENARIO .............................................................................................................. 7 
5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)................. 19 
 
 

List of Figures 
Page 

Figure 1. Test Script For Alert Visualization (Test Step 52) ........................................................ 18 



Test Case Guardian (Alert Visualization) (Draft)  DCN AWP.TE.SWCTR/T010-0016 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0016 / 21 Nov. 2008 4 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 
 

2.2 Reference Documents 
• Legacy NWS Test Cases: Baseline_Guardian_Basic_1; 

Baseline_Guardian_Config_2. 
• Software Test Plan for the Advanced Weather Interactive Processing System 

Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS 1 test bed application. 
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the capability of the AWIPS system to communicate with the end 
user via Guardian and the capability of the AWIPS system to allow the end user to configure 
communication messages with Guardian. Test steps 105-117 demonstrate the “Do Not Disturb” 
enhancement developed during TO10. 
 
3.1 Assumptions, Constraints and Preconditions 

• TO10 software has been installed successfully 
• CAVE, EDEX and pgAdmin III are running 
• Data has been ingested  
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action  Result Pass/Fail 
1.  Mouse Button (MB) 3 click on the Guardian 

(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

2.  In the upper right of the configuration GUI 
are buttons for each of the three screens, 
select one (not the one you are on). 

Alert Visualization moves to another screen.   

3.  Observe the current configuration listed in 
the upper middle of the configuration GUI. 

The top middle of the GUI displays the name of 
the workstation default configuration. 

 

4.  At the top the GUI, MB1 click the ‘Save 
As…’ button. 
Enter ‘wx-delivered-76’ in the text box and 
MB1 click ‘Save’. 

A dialog box appears stating that ‘delivered’ as 
a reserved term. 

 

5.  MB1 click ‘OK’. The dialog box closes.  
6.  MB1 click the ‘Save As…’ button. 

Enter a unique name (e.g., ‘Test1’) and 
then MB1 click the ‘Save’ button. 

The new configuration loads. The top middle of 
the GUI displays the name of the new 
configuration. 

 

7.  In the Layout section of the configuration 
GUI, select Q4 from the pull-down menu. 

The number of text lines changes to four: two on 
top and two on bottom, as displayed in the 
Message Text Layout: section. This displays on 
the Alert Visualization layout after closing the 
configuration dialog. 

 

8.  MB1 click a category then MB1 click the 
layout configuration box in which the 
messages should be displayed. 
Repeat for all categories. 

The categories display the cell number 
corresponding to the layout configuration boxes 
selected. 

 

9.  In the Common Settings for all 
Sources/Priorities section of the 
configuration GUI, set the blink duration to 
‘30’ and the audio duration to ‘0’ 
(perpetual). 

The values are set.  

10.  Select all check boxes in the Common 
Settings for all Sources/Priorities section. 

All check boxes are selected.  

11.  MB1 click ‘Save and Close’. 
 

The Alert Visualization configuration GUI closes, 
saving the settings. 

 

12.  Then wait up to one minute for a message 
to popup. 
When a message pops up, verify: 
-No Audio sounded when the message 
appeared 
-The Text Message contains the category, 
priority, and source key (e.g., 12:54 PM (5) 
| WORKSTATION | WORKSTATION: Alerts 
Took: 24 ms to process 181 messages) 

Verified.  
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Step # Action  Result Pass/Fail 
13.  Close the Alert Visualization pop-up.  

Then MB3 click on the Alert Visualization 
icon. 
MB1 click on ‘Configuration…’. 

The Alert Visualization Configuration GUI 
appears. 

 

14.  Unselect all the check boxes in the 
Common Settings for all Sources/Priorities 
section. 

All check boxes are unselected.  

15.  Set the length of message log box to ‘2’. The length of message log box is set.  
16.  MB1 click the ‘Save & Close’ button. The Alert Visualization configuration GUI closes, 

saving the settings. 
 

17.  Then wait several minutes for messages to 
popup. 
After several messages pops up, verify only 
2 messages are listed in the log list. 

Verified.  

18.  MB1 click the ‘Acknowledge All’ button to 
close the Alert Visualization window. 
Then MB3 click on the Guardian (Alert 
Visualization going forward) icon. 
MB1 click on ‘Configuration…’. 

The Alert Visualization Popup Message Dialog 
window closes. 
The Alert Visualization Configuration GUI 
appears. 

 

19.  Set the length of message log box to ‘10’. The length of message log box is set to ‘10’.  
20.  MB1 click the ‘Save & Close’ button. The Alert Visualization configuration GUI closes, 

saving the settings. 
 

21.  Then wait several minutes for messages to 
popup. 
After several messages pops up, verify 10 
messages are listed in the log list. 

Verified.  

22.  Close the Alert Visualization text box. Then 
MB3 click on the Alert Visualization icon. 
MB1 click on ‘Configuration…’. 

The Alert Visualization Configuration GUI 
appears. 

 

23.  In the Sources section of the configuration 
GUI, observe that FFMP is highlighted in 
light blue. 

FFMP is highlighted in light blue.  

24.  MB3 click on ‘FFMP’, and select Omit 
Monitor, and with MB3 select SNOW.  
 
NOTE: If a warning dialog appears, MB1 
click ‘YES’ to close. 

FFMP highlight turns yellow and the FF icon is 
no longer visible on Alert Visualization, but 
SCAN, FOG, SAFESEAS, & SNOW are visible. 
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Step # Action  Result Pass/Fail 
25.  MB3 click FFMP, and select ‘Include 

Monitor’. 
Then MB3 click ‘SNOW’. 
 
Check that FFMP, SCAN, FOG, 
SAFESEAS, & SNOW are present on an 
XT (Text) terminal.  
 
NOTE: If a warning dialog appears, MB1 
click ‘YES’ to close. 

FFMP highlight turns light blue and the FF icon 
becomes visible on Alert Visualization along 
with SCAN, FOG, SAFESEAS, & SNOW. 
 

 

26.  Create a new source by MB1 clicking on 
‘New’ in the Sources section of the 
configuration GUI, entering DEL_TEST, 
and MB1 clicking ‘Save’. 

A new source called DEL_TEST is created.  

27.  MB3 click on the ‘DEL_TEST’. 
Then select ‘Delete’. 

The source is deleted.  

28.  MB3 click on ‘FFMP’. Observe that delete is not an option.  
29.  Observe the icons on Alert Visualization. Aside from the Alert Visualization logo, there 

should be 5 small icons shown, about 20x30 
pixels. 

 

30.  Create a new source called GDN_TEST, if 
it does not already exist. 

The GDN_TEST source is created.  

31.  With GDN_TEST selected, change the 
priority options in the Priorities section of 
the configuration GUI. Simply press in 
some of the options such as: text, blink 
text, popup, audio, & action. 
Hint: For popups, you may press in the 
button, click on the triangle, and add in the 
name of a bitmap located in 
/awips/fxa/data/. 
Hint: For an action, you must enter a path 
of a script. I suggest entering the following: 
/data/local/GDN_TEST_CFG/gdn_action.
sh 
The script will simply output a test file on 
the workstation when called by Alert 
Visualization: /tmp/gdn_action.txt. 
The script is shown at the bottom of this 
test case. 

Options change.  

32.  Enter the following in the Monitor Bitmap 
text box: 
error.xbm 

Text is added  
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Step # Action  Result Pass/Fail 
33.  Enter the following in the Monitor 

Executable text box: 
/data/local/GDN_TEST_CFG/gdn_monito
r.sh 
The script is shown at the bottom of this 
test case. 

Text is added  

34.  Select on another source. Message dialog will appear saying configuration 
was not saved. 

 

35.  Select No to not continue Message dialog is closed and configurations are 
preserved. 

 

36.  Click Apply Changes, Save, Close. Edits are saved.  
37.  Double click the new icon that has 

appeared. It should be a light gray X 
surrounded by black. 

NA  

38.  In a terminal window type the following: cat 
/tmp/gdn_monitor.txt. 

Text should appear and the time stamp in the 
text should match the current time. 

 

39.  Open a terminal window by clicking the left 
mouse button on the KDE desktop and 
selecting terminal. 

A terminal window opens.  

40.  Ensure that one instance of Alert 
Visualization is running by issuing the 
following command: 
# ps –wef | grep –i guard 
If you would like to check the status on all 
workstations (suggested) issue the 
following command. It is best run on DX1. It 
would better the test if most or all of the 
workstations were logged into KDE. 
 
 cd /data/local/GDN_TEST_CFG 
 ./gdn_proc.sh 
 
The script is listed at the bottom of this test 
case. 

One instance of Alert Visualization is running 
per workstation per user logged into KDE. 

 

41.  Ensure that the Alert Visualization 
application is viewed as a small, thin, and 
long application. By default it is usually 
located at the bottom of the middle monitor 
(:0.0). It should have launched 
automatically when KDE started.  

Alert Visualization is viewed as a small, thin, 
and long application.  
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Step # Action  Result Pass/Fail 
42.  Ensure that Alert Visualization is always on 

top. Click and drag Alert Visualization and 
other windows and applications around to 
see if Alert Visualization remains on top. 
Use the left mouse button to click and drag 
other apps and right mouse button for Alert 
Visualization. 

Alert Visualization remains on top.  

43.  Ensure that there are tips available by 
clicking the left mouse button on the i icon 
next to the Alert Visualization logo. 

A list of tips is displayed.  

44.  Ensure that icons from SCAN, FOG, FFMP, 
SAFESEAS, & SNOW are displayed and 
that moving the mouse over them shows 
test. 

SCAN, FOG, FFMP, SNOW & SAFESEAS are 
displayed and config screens can be launched. 

 

45.  Double click on the FFMP (FF) icon with 
mouse button one. 

Config GUI opens.  

46.  Close the FFMP GUI. Config GUI closes.  
47.  While you are executing this test case, 

ensure that Alert Visualization receives 
messages from multiple sources. 

Alert Visualization receives messages from 
multiple sources. 

 

48.  Left click on the desk top & select the Start 
D2D from the list. 

The D2D system launches.  

49.  Produce an error message for just your 
workstation. Ensure that another 
workstation is logged into. Create and error 
message by finding a product that is 
unavailable in D2D and selecting it. Usually 
when the data inventory is unavailable the 
menu time (“green time”) is shown as 
dashes. Another option is to select the One 
Time Request for the radar menu and then 
closing it using the ‘X’ at the upper right of 
the GUI. 

A pop-up message is displayed on your 
workstation only. 

 

50.  Load the test configuration: 
 
With mouse button one, press the Alert 
Visualization icon; select retrieve; select 
willl_gdn_conf; and select retrieve. 

Action completed with no errors. 
If willl_gdn_conf is not available, then on a 
terminal window: 
 
a. cd /data/local/GDN_TEST_CFG 
cp willl_gdn_conf.gcf 
/data/fxa/workFiles/Alert Visualization/. 

 

51.  Before closing the configuration GUI, verify 
that in the top middle of the GUI the 
configuration is now set to: willl_gdn_conf. 

New configuration is loaded.  
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Step # Action  Result Pass/Fail 
52.  Use test script to test Alert 

Visualization: 
Open a terminal window and enter the 
following commands: 
 cd /data/local/GDN_TEST_CFG 
 ./gdn_message.sh 
The script is listed at the bottom of this test 
case. [See Fig. 1.] 

All steps of the test script are executed as 
expected. 

 

Blinking 
53.  Mouse Button (MB) 3 click on the Guardian 

(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

54.  In the Alert Visualization configuration GUI, 
assign ‘Workstation’ to cell 1 in the Layout 
section. 

Workstation is assigned to cell 1  

55.  Assign all other categories to other cells or 
set to ‘None’. 

All other categories are set to cells 2, 3, 4, or 
None. 

 

56.  Under the Sources & Priorities section, 
select ‘Workstation’. 
Then select/check all checkboxes (Text, 
Blink, Popup, Audio, and Log). 

All checkboxes are selected.  

57.  Set the audio to each priority by MB1 
clicking ‘…’ and selecting a sound file. 

The sound files are assigned.  

58.  Verify the sound files were assigned by 
hovering over the associated check box. 

A line appears with the assigned sound file.  

59.  Select all other Sources and ensure the 
checkboxes for Priorities 3, 4, and 5 are 
unchecked. 

All checkboxes for Priorities 3, 4, and 5 are 
unchecked. 

 

60.  Select/check all Text Message checkboxes 
in the Common Settings section. 

The ‘Show Priority’, ‘Show Source Key’, and 
‘Show Category’ checkboxes are selected. 

 

61.  Select/check the ‘Expand Popup 
Information’ option. 

The ‘Expand Popup Information’ option is 
selected. 

 

62.  Set the following: 
– Length of Message Log to ‘30’ 
– Blink Duration to ‘10’ 
– Audio Duration to ‘10’ 

The Length of Message Log is set to ‘30’. 
The Blink Duration is set to ‘10’. 
The Audio Duration to ‘10’. 

 

63.  MB1 click ‘Save and Close’. 
Then wait up to one minute for a message 
to popup. 

The Alert Visualization configuration GUI closes, 
saving the settings. 
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Step # Action  Result Pass/Fail 
64.  When a message pops up, verify: 

– The Audio sounded when the message 
appeared. 

– Cell one blinked for 10 seconds when the 
message appeared in the Alert 
Visualization bar. 

– The Text Message contains the category, 
priority, and source key (e.g., 12:54 PM 
(5) | WORKSTATION | WORKSTATION: 
Alerts Took: 24 ms to process 181 
messages). 

Verified.  

65.  MB1 click ‘Acknowledge All’ in the popup 
window. 

The popup window closes.  

Text Messages 
66.  Mouse Button (MB) 3 click on the Guardian 

(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

67.  In the Alert Visualization configuration GUI, 
in the Common Settings section, select only 
the ‘Show Priority’ checkbox. 

The ‘Show Priority’ checkbox is selected.  

68.  MB1 click ‘Save and Close’. 
Then wait up to one minute for a message 
to popup. 

The Alert Visualization configuration GUI closes, 
saving the settings. 

 

69.  When a message pops up, verify: 
– The Audio sounded when the message 

appeared 
– Cell one blinked for 10 seconds when the 

message appeared in the Alert 
Visualization bar 

– The Text Message contains only the 
priority (e.g., 12:54 PM (5) Alerts Took: 
24 ms to process 181 messages) and not 
the source key or category. 

Verified.  

70.  MB1 click ‘Acknowledge All’ in the popup 
window. 

The popup window closes.  

71.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

72.  In the Alert Visualization configuration GUI, 
in the Common Settings section, select only 
the ‘Show Source Key’ checkbox. 

The ‘Show Source Key’ checkbox is selected.  

73.  MB1 click ‘Save and Close’. 
Then wait up to one minute for a message 
to popup. 

The Alert Visualization configuration GUI closes, 
saving the settings. 

 



Test Case Guardian (Alert Visualization) (Draft)  DCN AWP.TE.SWCTR/T010-0016 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0016 / 21 Nov. 2008 14 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Step # Action  Result Pass/Fail 
74.  When a message pops up, verify: 

– The Audio sounded when the message 
appeared 

– Cell one blinked for 10 seconds when the 
message appeared in the Alert 
Visualization bar 

– The Text Message contains only the 
source key (e.g., 12:54 PM 
WORKSTATION: Alerts Took: 24 ms to 
process 181 messages) and not the 
priority or category. 

Verified.  

75.  MB1 click ‘Acknowledge All’ in the popup 
window. 

The popup window closes.  

76.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

77.  In the Alert Visualization configuration GUI, 
in the Common Settings section, select only 
the ‘Show Category’ checkbox. 

The ‘Show Category’ checkbox is selected.  

78.  MB1 click ‘Save and Close’. 
Then wait up to one minute for a message 
to popup. 

The Alert Visualization configuration GUI closes, 
saving the settings. 

 

79.  When a message pops up, verify: 
– The Audio sounded when the message 

appeared 
– Cell one blinked for 10 seconds when the 

message appeared in the Alert 
Visualization bar 

– The Text Message contains only the 
category (e.g., 12:54 PM 
WORKSTATION | Alerts Took: 24 ms to 
process 181 messages) and not the 
priority or source key. 

Verified.  

80.  MB1 click ‘Acknowledge All’ in the popup 
window. 

The popup window closes.  

81.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

82.  In the Alert Visualization configuration GUI, 
in the Common Settings section, unselect all 
Text Message checkboxes. 

No Text Message checkboxes are selected.  

83.  MB1 click ‘Save and Close’. 
Then wait up to one minute for a message 
to popup. 

The Alert Visualization configuration GUI closes, 
saving the settings. 
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Step # Action  Result Pass/Fail 
84.  When a message pops up, verify: 

– The Audio sounded when the message 
appeared 

– Cell one blinked for 10 seconds when the 
message appeared in the Alert 
Visualization bar 

– The Text Message does not contain the 
priority, source key, or category (e.g., 
12:54 PM Alerts Took: 24 ms to process 
181 messages). 

Verified.  

85.  MB1 click ‘Acknowledge All’ in the popup 
window. 

The popup window closes.  

Foreground/Background Color 
86.  Mouse Button (MB) 3 click on the Guardian 

(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

87.  Under the Sources section box in the 
Sources & Priorities section, select 
‘WORKSTATION’. 

‘WORKSTATION’ is selected.  

88.  In the Source & Priorities section, MB1 click 
‘…’ under Priority 5 of the 
Foreground/Background. 

The Alert Visualization Color Dialog window 
appears. 

 

89.  Set the text color and background color. 
Then MB1 click the ‘Apply Colors’ button. 

The Alert Visualization Color Dialog window 
closes. 
The ‘MSG’ block is colored to that set in the 
Alert Visualization Color Dialog window. 

 

90.  Repeat the previous step for Priorities 0 
through 4. 

The Alert Visualization Color Dialog window 
closes. 
The ‘MSG’ block is colored to that set in the 
Alert Visualization Color Dialog window. 

 

91.  MB1 click ‘Save and Close’. 
Then wait up to one minute for a message 
to popup. 

The Alert Visualization configuration GUI closes, 
saving the settings. 
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Step # Action  Result Pass/Fail 
92.  When a message pops up, verify: 

– The Audio sounded when the message 
appeared 

– Cell one blinked for 10 seconds when the 
message appeared in the Alert 
Visualization bar 

– Cell one is colored to that set in the Alert 
Visualization Color Dialog window, and 
inverts the colors upon blinking 

– The Text Message does not contain the 
priority, source key, or category (e.g., 
12:54 PM Alerts Took: 24 ms to process 
181 messages). 

Verified.  

Alert Visualization Bar Manipulation 
93.  MB1 click and hold the crossed gold double 

end arrow symbol on the left side of the 
Alert Visualization bar, and drag it to a 
location away from its current position. 

The Alert Visualization bar moves accordingly.  

94.  MB1 click and hold the double ended gold 
arrow symbol on the right side of the Alert 
Visualization bar to expand or contract the 
Alert Visualization bar. 

The Alert Visualization bar expands or contracts 
horizontally accordingly. 

 

Alert Visualization Logs 
95.  With a message displayed in cell one, MB1 

click the ‘^’ button to the right of the cell one 
text window. 

The ‘Log list for: Workstation’ window appears 
listing the log entries. 

 

96.  Double MB1 click on an entry line. A Details window opens that may or may not 
contain any information depending on the 
priority (e.g., Priority 5 returns a blank Details 
window, while a Priority 0 or 1 returns 
information). 

 

97.  Close the Details window. The Details window closes.  
98.  MB1 click the ‘Clear’ button in the log list 

window. 
All messages in the log list window are 
removed. 

 

99.  MB1 click the ‘Close’ button on the log list 
window. 

The log list window closes.  

Alert Visualization Popup Message Dialog 
100.  On the Alert Visualization Popup Message 

Dialog window, MB1 click the ‘Show Log’ 
button. 

The popup expands to display the log list of 
messages. 

 

101.  Double MB1 click on an entry line. A Details window opens that may or may not 
contain any information depending on the 
priority (e.g., Priority 5 returns a blank Details 
window, while a Priority 0 or 1 returns 
information). 
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Step # Action  Result Pass/Fail 
102.  Close the Details window. The Details window closes.  
103.  Select/highlight a message by MB1 clicking 

on a message. 
Then MB1 click the ‘Acknowledge Selected’ 
button. 

The message is removed from the log.  

104.  MB1 click the ‘Acknowledge All’ button. The Alert Visualization Popup Message Dialog 
window closes. 

 

Do Not Disturb Functionality 
105.  Mouse Button (MB) 3 click on the Guardian 

(Alert Visualization going forward) icon. 
Then MB1 click on ‘Do Not Disturb’. 

The Do Not Disturb functionality is activated.  

106.  Wait up to one minute for a message to 
popup.  
– When a message pops up, verify: 
– The Alert Visualization (AV) symbol 

begins to blink, alternating with a red ‘X’ 
– A popup balloon appears with the 

number of unacknowledged messages 
– Messages continue to appear and blink 

in the Alerts Visualization bar 

Verified.  

107.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Do Not Disturb’. 

The Do Not Disturb functionality is deactivated. 
The Alert Visualization Popup Message Dialog 
window appears. 

 

108.  MB1 click the ‘Show Log’ button. All unacknowledged messages appear.  
109.  MB1 click ‘Acknowledge All’ button. The Alert Visualization Popup Message Dialog 

window closes. 
 

110.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 

 

111.  In the Layout section, select the 
‘System_Tray’ option. 
Then MB1 click the ‘Save & Close’ button. 

The Alert Visualization configuration GUI closes, 
saving the settings. 

 

112.  Wait up to one minute for a message to 
popup.  
When a message appears, verify: 
– Messages appear in the Alerts 

Visualization Popup Messages Dialog 
window 

– Messages appear in a popup balloon on 
or near the System Tray 

Verified.  

113.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Configuration…’. 

The Alert Visualization configuration GUI 
appears. 
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Step # Action  Result Pass/Fail 
114.  Unselect all popup checkboxes for all 

Sources and all Priorities. 
All popup checkboxes are unselected.  

115.  Ensure the System_Tray layout option is 
selected. 
Then MB1 click the ‘Save & Close’ button. 

The Alert Visualization configuration GUI closes, 
saving the settings. 

 

116.  Mouse Button (MB) 3 click on the Guardian 
(Alert Visualization going forward) icon. 
Then MB1 click on ‘Do Not Disturb’. 

The Do Not Disturb functionality is activated.  

117.  Wait up to a minute. 
When a message appears, verify: 
– A popup balloon appears on or near the 

System Tray 
– No Alert Visualization Popup Message 

Dialog window appears 
– The Alert Visualization (AV) symbol 

remains static (no blinking ‘X’ appearing 
in alternating fashion) 

Verified.  

End of Test 
 

gdn_action.sh 
#!/bin/bash 
#  
# This script was created to test Guardian (DCS 3244-3247). 
 
echo "Guardian has called this script at `date -u` - Action Test" 
> /tmp/gdn_action.txt 
gdn_monitor.sh 
#!/bin/bash 
#  
# This script was created to test Guardian (DCS 3244-3247). 
 
echo "Guardian has called this script at `date -u` - Monitor Test" 
> /tmp/gdn_monitor.txt 

Figure 1:  Test Script for Alert Visualization (test step 52) 
 



Test Case Guardian (Alert Visualization) (Draft)  DCN AWP.TE.SWCTR/T010-0016 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0016 / 21 Nov. 2008 19 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSRxxxx TBD  
SYSRxxxx   
SYSRxxxx   
 



 

This document includes data that shall not be duplicated, used, or disclosed – in whole or in part – outside the Government for 
any purpose other than to the extent provided in contract DG133W-05-CQ-1067. However, the Government shall have the right 
to duplicate, use, or disclose the data to the extent provided in the contract. This restriction does not limit the Government’s right 
to use information contained in this data if it is obtained from another source without restriction. The data subject to this 
restriction are contained in all sheets. 

HARD COPY UNCONTROLLED 

Test Case Radar Graphics and Text Products 
for  

Contract DG133W-05-CQ-1067 
Advanced Weather Interactive Processing System (AWIPS) 

Operations & Maintenance 
 

AWP.TE.SWCTR/TO10-0017 

Prepared for: 

U.S. Department of Commerce 
NOAA/NWS Acquisition Management Division 

SSMC2, Room 11220 
1325 East-West Highway 
Silver Spring, MD 20910 

 

Prepared by: 

Raytheon Company 
STC Office 

6825 Pine Street 
Omaha, NE  68106  

 
21 November 2008 

 

 

 



Test Case Radar Graphics and Text Products (Draft)  DCN AWP.TE.SWCTR/T010-0017 
 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0017 / 21 Nov. 2008 i 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Submitted By:  

 

___________________________________________________________ ___________ 
Test Engineer         Date 
 
 
 

 

Approved By: 

 
___________________________________________________________ __________ 
Program Manager        Date 
 
 
___________________________________________________________ __________ 
Mission Assurance Quality       Date 



Test Case Radar Graphics and Text Products (Draft)  DCN AWP.TE.SWCTR/T010-0017 
 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0017 / 21 Nov. 2008 ii 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Change History 

Revision Date Affected Pages Explanation of Change 
Draft 21 Nov.2008 ALL Initial Draft 
 

 



Test Case Radar Graphics and Text Products (Draft)  DCN AWP.TE.SWCTR/T010-0017 
 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0017 / 21 Nov. 2008 iii 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

Table of Contents 
Page 

1.0 SCOPE .................................................................................................................................1 
2.0 APPLICABLE DOCUMENTS ...........................................................................................2 

2.1  Source Documents ........................................................................................................2 
2.2  Reference Documents ...................................................................................................2 

3.0 TEST CASE DESCRIPTION ..............................................................................................3 
3.1  Assumptions, Constraints and Preconditions ................................................................3 
3.2  Recommended Hardware ..............................................................................................3 
3.3  Test Inputs .....................................................................................................................3 
3.4  Test Outputs ..................................................................................................................3 

4.0 TEST SCENARIO ...............................................................................................................4 
5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)....................7 
 
 



Test Case Radar Graphics and Text Products (Draft)  DCN AWP.TE.SWCTR/T010-0017 
 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0017 / 21 Nov. 2008 1 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 
 

2.2 Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates a subset of radar graphics products from the Graphics submenu.  This 
test case also verifies the display of radar text products within the Text Workstation. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested.  
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders.  

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.   

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  From the menu bar on CAVE’s D-2D display, 

select ‘koax’ -> ‘koax Graphics’ -> ‘Storm 
Track (STI)’. 

The ‘Storm Track (STI)’ product displays in 
CAVE. 

 

2.  Mouse Button (MB) 1 click the ‘Clear’ button 
on the toolbar. 

The main pane in the D2D Perspective clears 
to a blank map. 

 

3.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Hail Index 
(HI)’. 

The ‘Hail Index (HI)’ product displays in 
CAVE. 

 

4.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

5.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Tornado 
Vortex Sig (TVS)’. 

The ‘Tornado Vortex Sig (TVS)’ product 
displays in CAVE. 

 

6.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

7.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Latest 
TVS Rapid Update (TRU)’. 

The ‘Latest TVS Rapid Update (TRU)’ 
product displays in CAVE. 

 

8.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

9.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘All Tilts 
TRU’. 

The ‘All Tilts TRU’ product displays in CAVE.  

10.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

11.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> 
‘Mesocyclone (MD)’. 

The ‘Mesocyclone (MD)’ product displays in 
CAVE. 

 

12.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

13.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Legacy 
Mesocyclone (M)’. 

The ‘Legacy Mesocyclone (M)’ product 
displays in CAVE. 

 

14.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

15.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Digital 
Mesocyclone (DMD)’. 

The ‘Digital Mesocyclone (DMD)’ product 
displays in CAVE. 

 

16.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 
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Step # Action Result Pass/Fail 
17.  From the menu bar on CAVE’s D-2D display, 

select ‘koax’ -> ‘koax Graphics’ -> ‘Latest 
Meso Rapid Update (MRU)’. 

The ‘Latest Meso Rapid Update (MRU)’ 
product displays in CAVE. 

 

18.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

19.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘All Tilts 
MRU’. 

The ‘All Tilts MRU’ product displays in CAVE.  

20.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

21.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Comb Att 
Table (1km CZ)’. 

The ‘Comb Att Table (1km CZ)’ product 
displays in CAVE. 

 

22.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

23.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Comb Att 
Table (4km CZ)’. 

The ‘Comb Att Table (4km CZ)’ product 
displays in CAVE. 

 

24.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

25.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Svr Wx 
Prop (SWP)’. 

The ‘Svr Wx Prop (SWP)’ product displays in 
CAVE. 

 

26.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

27.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘VAD Wind 
Profile (VWP)’. 

The ‘VAD Wind Profile (VWP)’ product 
displays in CAVE. 

 

28.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

29.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘Vel Az 
Display (VAD)’. 

The ‘Vel Az Display (VAD)’ product displays 
in CAVE. 

 

30.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

31.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘NEXRAD 
Unit Status’. 

The ‘NEXRAD Unit Status’ product displays in 
CAVE. 

 

32.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

33.  Select ‘koax’ -> ‘koax 4 Bit Products’ -> ‘koax 
4bit Reflectivity’ -> ‘0.5 Refl’. 

The 0.5 Radar Reflectivity product displays in 
the main pane. 
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Step # Action Result Pass/Fail 
34.  Select the Points toolbar button to display the 

points A-J in the main pane of the D-2D 
display. 

The Points A-J display in the main pane.  

35.  Modify the location of Point A to a position on 
a reflectivity echo. (Ground clutter may be 
used if no precipitation is displayed.) 

The position of Point A is modified.  

36.  From the menu bar on CAVE’s D-2D display, 
select ‘koax’ -> ‘koax Graphics’ -> ‘point A’. 

The Cell Trends product for point A displays 
in CAVE. 

 

37.  MB1 click the ‘Clear’ button on the toolbar. The main pane in the D2D Perspective clears 
to a blank map. 

 

38.  Open a text window by selecting ‘Tools’ -> 
‘Text Window…’. 

The Text Display Window opens.  

39.  In the ‘AFOS Cmd:’ text box, enter 
‘OMAMDPOAX’ and press the Enter key. 

The ‘OMAMDPOAX’ product displays in the 
Text Window. 

 

40.  MB1 click the ‘Clear’ button in the Text 
Window. 

The Text Window clears.  

41.  In the ‘AFOS Cmd:’ text box, enter 
‘OMAOHPOAX’ and press the Enter key. 

The ‘OMAOHPOAX’ product displays in the 
Text Window. 

 

42.  MB1 click the ‘Clear’ button in the Text 
Window. 

The Text Window clears.  

43.  In the ‘AFOS Cmd:’ text box, enter 
‘OMASTPOAX’ and press the Enter key. 

The ‘OMASTPOAX’ product displays in the 
Text Window. 

 

44.  MB1 click the ‘Clear’ button in the Text 
Window. 

The Text Window clears.  

45.  In the ‘AFOS Cmd:’ text box, enter 
‘OMATVSOAX’ and press the Enter key. 

The ‘OMATVSOAX’ product displays in the 
Text Window. 

 

46.  MB1 click the ‘Clear’ button in the Text 
Window. 

The Text Window clears.  

47.  In the ‘AFOS Cmd:’ text box, enter 
‘OMAVWPOAX’ and press the Enter key. 

The ‘OMAVWPOAX’ product displays in the 
Text Window. 

 

48.  MB1 click the ‘Clear’ button in the Text 
Window. 

The Text Window clears.  

End of Test 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 
2.2 Reference Documents 

• TO10 Software Test Plan for the Advanced Weather Interactive Processing 
System Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the ability to request data via command line scripts. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested.  
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action  Result Pass/Fail 
1.  Launch a terminal window.  Terminal window is at user prompt.  
2.  ssh root@awips-int1 You are prompted for password.  
3.  Enter password to log in. 

(May need to su - awips to use cli) 
cd /awips/edex/opt/esb/tools/cli 
(May change when install is determined) 

You are at the awips-int1 # sign prompt in 
the directory with the command line 
interfaces scripts. 

 

4.  Launch a second terminal window. Terminal window is at user prompt.  
5.  ssh root@awips-int1 You are prompted for password.  
6.  Enter password to log in. 

cd /awips/edex/mule/logs 
(Directory path may change) 

You are at the awips-int1 # sign prompt in 
the directory with the log files. 

 

7.  ls –l  
 

Verify the log file is listed. 
This window will be used to view the log 
entries. 

 

8.  tail -f <log file> The log file displays the entries.  
9.  In the first window execute the following: 

./uengine -h 
Prints a usage message.  

10.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

11.  In the first window execute the following: 
./uengine –m runner –r python 

Sets the execution mode to use the runner 
python. 

 

12.  In the first window execute the following: 
./uengine –s MESSAGE “Hello from Omaha “ 
> data/Hello World.txt 

Message is written. The runner python that 
was set in the previous command line is 
used. 

 

13.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

14.  In the first window execute the following: 
./uengine –m runner –r jscript 

Sets the execution mode to use the runner 
jscript. 

 

15.  In the first window execute the following: 
./uengine –s MESSAGE “Hello from Omaha “ 
> data/Hello World.txt 

Message is written. The runner jscript that 
was set in the previous command line is 
used. 

 

16.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

17.  In the first window execute the following: 
./uengine –m maintain 

Sets the execution mode to maintain.  

18.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

 The following options will not be initially implemented. 
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Step # Action  Result Pass/Fail 
19.  In the first window execute the following: 

./uengine –o read 
Maintenance operation to read. 
Need to add steps for add, delete, and 
update. 

 

20.  In the first window execute the following: 
./uengine –p AFOS PIL 

Product Identifier. 
Need to add steps for Data URI. 

 

 Force an error condition. 
21.  In the first window execute the following: 

./uengine  
Creates an error and returns the error 
messages. 

 

22.  In the second window view the log file for the 
error entries associated with the command 
executed in the previous step. 

The log file shows the error entries for the 
command executed. 

 

23.  <ctrl> c to exit the log file. The log file is exited.  
24.  Exit to log out and close the second window. The second window is closed.  
25.  Exit to log out and close the first window. The first window is closed.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR The AWIPS II Command Line Tool Suite shall include a command line interface 

to the uEngine script runner.  
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None. 

 
2.2 Reference Documents 

• TO10 Software Test Plan for the Advanced Weather Interactive Processing 
System Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case illustrates that the text database command line interface and options work in 
AWIPS II as it does in the legacy AWIPS I system; reading and writing data to the text database. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested . 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  
 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  Launch a terminal window.  Terminal window is at user prompt.  
2.  ssh root@awips-int1 You are prompted for password.  
3.  Enter password to log in. 

(May need to su - fxauser to use cli) 
cd /awips/edex/opt/esb/tools/cli 
(May change when install is determined) 

You are at the awips-int1 # sign prompt in 
the directory with the command line 
interfaces scripts. 

 

4.  Launch a second terminal window. Terminal window is at user prompt.  
5.  ssh root@awips-int1 

 
You are prompted for password.  

6.  Enter password to log in. 
cd /awips/edex/mule/logs 
(Directory path may change) 

You are at the awips-int1 # sign prompt in 
the directory with the log files. 

 

7.  ls –l  
 

Verify the log file is listed. 
This window will be used to view the log 
entries. 

 

8.  tail -f <log file> The log file displays the entries.  
9.  In the first window execute the following: 

./textdb –r AFOSCmd 
Read data from the text database.  

10.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

11.  Open the pgadmin database window and 
select the ??? database. 

The database tables are displayed.  

12.  Query the database The data displayed matches the data 
displayed in the first terminal window. 

 

13.  In the first window execute the following: 
./textdb –rd AFOSCmd 

Displays latest products with product count 
and product lengths. 

 

14.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

15.  In the first window execute the following: 
./textdb –rw wmoid  (ex. SAUS43) 

Read data from the text database using all 
or part of TTAAII. 

 

16.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

17.  In the first window execute the following: 
./textdb –rs site  (ex. KOAX) 

Read data from the text database using all 
or part of CCCC. 

 

18.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

19.  In the first window execute the following: 
./textdb –rt ddhhmm 

Read data from the text database using all 
or part of date/time group ddhhmm (day, 
hour, minute). 

 

20.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 
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Step # Action Result Pass/Fail 
21.  In the first window execute the following: 

./textdb –ri NNNXXX  (ex. TEX T09 or 18A 
A11) 

Read data from the text database using all 
or part of AWIPS ID NNNXXX. 

 

22.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

23.  In the first window execute the following: 
./textdb –rb bbb (ex. NOR) 

Read data from the text database using bbb.  

24.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

25.  In the first window execute the following: 
./textdb –rh HH 

Read data from the text database with 
special headers. 

 

26.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

27.  In the first window execute the following: 
./textdb –w productID 

Write to the text database.  

28.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

29.  Query the database The productID in the first terminal window is 
stored in the database. 

 

30.  In the first window execute the following: 
./textdb –t productID {productID…} 

Write time of last version(s).  

31.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

32.  In the first window execute the following: 
./textdb –tU productID {productID…} 

Write time of last version(s).  

33.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

34.  In the first window execute the following: 
./textdb –A productID 

Get all times for one productID.  

35.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

36.  In the first window execute the following: 
./textdb –AU productID 

Get time for one productID.  

37.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

38.  In the first window execute the following: 
./textdb –v productID versions 

Change the number of versions to keep in 
the database. 

 

39.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 
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Step # Action Result Pass/Fail 
40.  Query the database The number of versions in the database has 

been changed. 
 

41.  In the first window execute the following: 
./textdb –s –a SS XXX CCC 

Add another ID to the SS.NNN lookup list 
(state, [SS], XXX, and CCC are character 
sequences). 

 

42.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

43.  Query the database The addition of the state ID to the database 
is verified. 

 

44.  In the first window execute the following: 
./textdb –s –d SS XXX CCC 

Delete an ID from  the SS.NNN lookup list 
(state, [SS], XXX, and CCC are character 
sequences). 

 

45.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

46.  Query the database The deletion of the state ID to the database 
is verified. 

 

47.  In the first window execute the following: 
./textdb –s –r SS 

Display current list for state in SS.NNN 
lookup list (state is a character sequence). 

 

48.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

49.  Query the database The listing of the state IDs in the database 
matches the listing in the first window. 

 

50.  In the first window execute the following: 
./textdb –ldad –a productID script 

Add the productID and the script path to the 
watchWarn table for sending to LDAD. 

 

51.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

52.  Query the database The addition of the productID into the 
database is verified. 

 

53.  In the first window execute the following: 
./textdb –ldad –d productID script 

Delete the productID and the script path to 
the watchWarn table for sending to LDAD. 

 

54.  In the second window view the log file for 
the entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

55.  <ctrl> c to exit the log file. The log file is exited.  
56.  Exit to log out and close the window. The window is closed.  
57.  Query the database The deletion of the productID from the 

database is verified. 
 

58.  Exit the database and close the window. The database is exited and closed.  
59.  Exit to log out and close the first window. The window is closed.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR The AWIPS II Command Line Tool Suite shall include a command line interface 

to the textdb script runner.  
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None. 

 
2.2 Reference Documents 

• TO10 Software Test Plan for the Advanced Weather Interactive Processing 
System Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case illustrates that the handleOUP command line interface and options work in AWIPS 
II as it does in the legacy AWIPS I system. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

• Pre-positioned data may be necessary. Transmission capability will be tested 
with the TO11 software delivery. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 



Test Case HandleOUP Command Line Interface (Draft)  DCN AWP.TE.SWCTR/T010-0020 
 

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0020 / 21 Nov. 2008 4 
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document. 

HARD COPY UNCONTROLLED 

4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
 handleOUP.pl is a Perl script that is executed when a product is transmitted or sent. The script 

is called by other scripts. Its function is to send the product to the WAN, store the product in the 
database, and archive the product. 

 

1.  Launch a terminal window.  Terminal window is at user prompt.  
2.  ssh root@<server> You are prompted for password.  
3.  Enter password to log in. 

(May need to su - awips to use cli) 
cd /awips/edex/opt/esb/tools/cli 

You are at the <server> # sign prompt in 
the directory with the command line 
interfaces scripts. 

 

4.  Launch a second terminal window. Terminal window is at user prompt.  
5.  ssh root@<server> 

 
You are prompted for password.  

6.  Enter password to log in. 
cd /awips/edex/mule/logs 
(Directory path may change) 

You are at the <server> # sign prompt in 
the directory with the log files. 

 

7.  In the first window execute the following: 
handleOUP –w <wmo special message type> 
<awips ID> <product pathname> 

Executes handleOUP script with the 
option of wmo special message type (ex: 
AMD, COR, RTD). 

 

8.  In the second window view the log file for the 
entries associated with the command executed in 
the previous step. 

The log file shows the entries for the 
command executed. 

 

9.  In the first window execute the following: 
handleOUP –m <awips ID> <product pathname> 

Executes handleOUP script with the 
option of test mode. 

 

10.  In the second window view the log file for the 
entries associated with the command executed in 
the previous step. 

The log file shows the entries for the 
command executed. 

 

11.  In the first window execute the following: 
handleOUP –r <AFOS routing code> <awips ID> 
<product pathname> 

Executes handleOUP script with the 
option of AFOS routing code (ex: LOC, 
DEF, CEN, CES, CSW, EAS, SOU, 
WES, ALL, 000). 

 

12.  In the second window view the log file for the 
entries associated with the command executed in 
the previous step. 

The log file shows the entries for the 
command executed. 

 

13.  In the first window execute the following: 
handleOUP –d <User supplied date/time stamp 
‘DDHHMM’> <awips ID> <product pathname> 

Executes handleOUP script with the 
option user supplied date/time stamp. 

 

14.  In the second window view the log file for the 
entries associated with the command executed in 
the previous step. 

The log file shows the entries for the 
command executed. 

 

15.  Transmit a product to a stubbed location using 
handleOUP CLI.  

A product is sent to the directory 
specified in the command line. 

 

16.  Close all terminal windows. Windows are closed.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR The AWIPS II Command Line Tool Suite shall include a command line 

interface to the handleOUP script runner. 1-16 
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Change History 

Revision Date Affected Pages Explanation of Change 
Draft 21 Nov.2008 ALL Initial Draft 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None. 

 
2.2 Reference Documents 

• TO10 Software Test Plan for the Advanced Weather Interactive Processing 
System Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case illustrates the AWIPS II subscription capability that replaces the AWIPS I database 
trigger capability; the test is accomplished via inspection of the file system and/or logs. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• Data has been ingested. 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  
 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  Launch a terminal window.  Terminal window is at user prompt.  
2.  ssh root@awips-int1 You are prompted for password.  
3.  Enter password to log in. 

(May need to su - awips to use cli) 
cd /awips/edex/opt/esb/tools/cli 
(May change when install is determined) 

You are at the awips-int1 # sign prompt in the 
directory with the command line interfaces 
scripts. 

 

4.  Launch a second terminal window. Terminal window is at user prompt.  
5.  ssh root@awips-int1 You are prompted for password.  
6.  Enter password to log in. 

cd /awips/edex/mule/logs 
(Directory path may change) 

You are at the awips-int1 # sign prompt in the 
directory with the log files. 

 

7.  ls –l  
 

Verify the log file is listed. 
This window will be used to view the log 
entries. 

 

8.  tail -f <log file> The log file displays the entries.  
9.  In the first window execute the following: 

./subscription –t timer –r jscript –p <name> 
Identifies the type of trigger (timer), the 
uEngine script (jscript), and the pattern (P5 
regex) of the trigger data to match. 

 

10.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

11.  In the first window execute the following: 
./subscription –t data –r python –p <name> 

Identifies the type of trigger (data), the 
uEngine script (python), and the pattern (P5 
regex) of the trigger data to match. 

 

12.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

13.  In the first window execute the following: 
./subscription –t manual –r python –p 
<name> 

Identifies the type of trigger (manual), the 
uEngine script (python), and the pattern (P5 
regex) of the trigger data to match. 

 

14.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

15.  In the first window execute the following: 
./subscription –o read 

Requests a listing of all subscriptions.  

16.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

17.  In the first window execute the following: 
./subscription –r python –o add –t timer –p 
“<name>” 

Adds the subscription <name> using the 
python uEngine and a timer trigger. 

 

18.  In the second window view the log file for the 
entries associated with the command 

The log file shows the entries for the 
command executed. 
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Step # Action Result Pass/Fail 
executed in the previous step. 

19.  In the first window execute the following: 
./subscription –r python –o update –t manual 
–p “<name>” 

Updates the subscription <name> using the 
python uEngine and changing the trigger to 
manual. 

 

20.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

21.  In the first window execute the following: 
./subscription –r python –o delete –p 
“<name>” 

Deletes the subscription <name>.  

22.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

23.  In the first window execute the following: 
./subscription –r python –o add –t timer –p 
“0.+.+.+.+”  –s MESSAGE “Hello from 
Omaha “ > data/Hello World.txt 

The subscription 0.+.+.+.+ is added using the 
python runner, with a timer trigger, and 
identifies a substitution to be performed within 
the script prior to execution. 

 

24.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

25.  In the first window execute the following: 
./subscription –r system –f  <path/name> 

Identifies the external script <path/name> to 
be executed using the system runner. 

 

26.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

27.  In the first window execute the following: 
./subscription –r system –f  <path/name> -c 
argument(s) 

Identifies the argument(s) to pass to the 
external script <path/name> that is executed 
using the system runner. 

 

28.  In the second window view the log file for the 
entries associated with the command 
executed in the previous step. 

The log file shows the entries for the 
command executed. 

 

 Force an error condition.  
29.  In the first window execute the following: 

./subscription –o read –p “/obs/.+/MTAR/.+” 
Creates an error and returns the error 
message “The directory MTAR does not 
exist”. 

 

30.  In the second window view the log file for the 
error entries associated with the command 
executed in the previous step. 

The log file shows the error entries for the 
command executed. 

 

31.  <ctrl> c to exit the log file. The log file is exited.  
32.  exit to log out and close the second window. The second window is closed.  
33.  exit to log out and close the first window. The first window is closed.  
End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR The AWIPS II Command Line Tool Suite shall include a command line interface 

to the subscription script runner. 
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Change History 

Revision Date Affected Pages Explanation of Change 
Draft 21 Nov.2008 ALL Initial Draft 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 
2.2 Reference Documents 

• TO10 Software Test Plan for the Advanced Weather Interactive Processing 
System Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0   TEST CASE DESCRIPTION 
This test case verifies the management of the Hydro token fields using localization. 
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX, and pgAdmin III are running. 
• Data has been ingested . 
• Actions, Results, and Requirements highlighted in yellow indicate 

requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case.  Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.   

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘MPE’ from 
the dropdown menu if available.  If not 
available, select ‘Other…’.  Then select 
‘MPE’ from the Open Perspective dialog. 

The MPE Perspective and MPE Choose 
Data Period window display in CAVE. 

 

2.  MB1 click on the ‘Projections’ menu and 
select ‘Flat Lat/Lon’. 

The region extending from the Central and 
Southern High Plains east to the Central 
and Southern Mississippi River Valley 
displays on a flat projection. 

 

3.  MB1 click on the ‘Projections’ menu and 
select ‘Polar Stereographic’. 

The region extending from the Central and 
Southern Rocky Mountains east to the 
southern Great Lakes and points south 
displays on a Polar Stereographic 
projection. 

 

4.  Open a terminal and navigate to the 
Apps_default file 
(awips/caveData/common/site/OAX/hydro). 
Edit the Apps_default file by modifying the 
hv_center lat/lon values.  Then save the 
changes. 

The modified hv_center lat/lon values are 
saved. 

 

5.  Close the MPE Perspective. The MPE Perspective and MPE Choose 
Data Period window close. 

 

6.  MB1 click on the Perspectives icon and 
select ‘MPE’ from the dropdown menu if 
available.  If not available, select ‘Other…’.  
Then select ‘MPE’ from the Open 
Perspective dialog. 

The MPE Perspective and MPE Choose 
Data Period window display in CAVE. 

 

7.  MB1 click on the ‘Projections’ menu and 
select ‘Flat Lat/Lon’. 

The region displays centered on the 
modified lat/lon center point on a flat 
projection. 

 

End of Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
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1.0 SCOPE 
See the TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO8 Test Case SOA_Plug-Ins 1.0. 
• TO9 Test Case SOA_Plug-Ins 2.0. 
• FCM-S2-1994 (Redbook Graphics). 

 

2.2 Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• Existing AWIPS 1 and AWIPS 2 test procedures. 
• The AWIPS D-2D User’s Manual Build 8.1. 
• The Silver Spring NWS AWIPS 1 test bed application.  
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case primarily demonstrates the capability of Service Oriented Architecture (SOA) 
plug-ins delivered during TO10. It builds on the TO8 and TO9 test cases and includes the test 
procedures from TO8 and TO9.  Plug-ins to be delivered and tested during TO10 can be found 
beginning with Step 120. 
 
The capability to ingest, store and display Red Book Vector Products will also be tested. 

3.1 Assumptions, Constraints and Preconditions 
• TO10 software has been installed successfully. 
• AWIPS test driver installed and functional. 
• CAVE, EDEX and pgAdmin III are running. 
• An internet connection is available. 
• Live data flow containing the data types to be tested. Canned data can be 

substituted if the live data flow does not contain the data required to test a 
specific plug-in. 

• The system has been running for at least 48 hours. 
• The correct display of the data infers that the functionality of decode, ingest 

and storage is working correctly. 
• Data decode, ingest, and storage validation accomplished during the 

Preliminary Delivery Test (PDT); results available in the PDT report. 
• Localization previously set. 
• TO10 testing begins at step 120. Regression testing of steps 1-119 occurred 

prior to DT. Therefore, capability tested and delivered during TO8 (Steps 1-
71) and TO9 (Steps 72-119) remain intact and will not be executed during the 
TO10 DT.  

• Actions, Results, and Requirements highlighted in yellow indicate 
requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents.  

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.  

3.4 Test Outputs 
The images and data will be displayed in CAVE for Redbook products. The AWIPS test driver 
will be used to display the ingested plug-in data.
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4.0 TEST SCENARIO 

Step Action Result Pass/Fail 
1.  From the test workstation open CAVE.  CAVE successfully launches. The 5-D panel 

(4 smaller panels on the left and one larger 
main panel) displays.  

 

2.  Zoom so that a CONUS-sized area displays 
centered on approximately Kansas City.  

The main panel displays an area centered 
on the CONUS that includes some of 
Mexico and Canada.  

 

DISPLAY LIGHTNING 
3.  From the CAVE menu bar click Mouse Button 

(MB) 1 ‘Obs’ and then ‘Lightning’ (located under 
Hazards). 

A menu displays that contains the following 
5 options: 1hr Lgtng Plot, 15min Lgtng Plot, 
15min Pos/Neg Lgtng Plot, 5min Lgtng Plot, 
and 1min Lgtng Seq. 

 

4.  Select 1hr Lgtng Plot. A lightning plot containing the previous 1 
hour lightning strikes displays on the main 
panel.  

 

5.  Select ‘Clear’ from the menu bar. The loaded lightning display is removed.  
6.  Select ‘15min Lgtng Plot’. A lightning plot containing the previous 15 

minutes of lightning strikes displays on the 
main panel.  

 

7.  Select ‘Clear’ from the menu bar. The loaded lightning display is removed.  
8.  Select ‘15min Pos/Neg Lgtng Plot’. A display of positive and negative strikes for 

the past 15 minutes displays.  
 

9.  Select ‘Clear’ from the menu bar. The loaded lightning display is removed.  
10.  Select ‘5min Lgtng Plot’. A lightning plot containing the previous 5 

minutes of lightning strikes displays on the 
main panel. The DTG of the display should 
be within the past 5 minutes (depending on 
data receipt). 

 

11.  Select ‘Clear’ from the menu bar. The loaded lightning display is removed.  
12.  Select ‘1min Lgtng Seq’. Lightning strikes in one minute intervals for 

the past 5 minutes displays. The DTG for 
the display should be within the past 5 
minutes (depending on data receipt). 

 

13.  Select ‘Clear’ from the menu bar. The loaded lightning display is removed.  
DISPLAY SATELLITE 
14.  From the Satellite menu use MB1 and select ‘IR 

Window’. 
An IR image displays. IR satellite imagery 
can be displayed through the menu bar. 

 

15.  Select ‘Clear’ from the menu bar. Satellite images are removed.  
16.  From the Satellite menu use MB1 and select 

‘Visible’. 
A visible image displays. Visible satellite 
imagery can be displayed through the menu 
bar. 

 

17.  Select ‘Clear’ from the menu bar. Satellite images are removed.  
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Step Action Result Pass/Fail 
18.  From the Satellite menu use MB1 and select 

‘Water Vapor’. 
A water vapor image displays. Water vapor 
satellite imagery can be displayed through 
the menu bar. 

 

19.  Select ‘Clear’ from the menu bar. Satellite images are removed.  
DISPLAY GRIB 

20.  Open the Volume Browser by MB1 ‘Volume’, 
‘Browser’. 

The Volume Browser display GUI appears.  

21.  

Display parameters from the latest ECMWF 
model run by selecting ‘ECMWF-HiRes’ for the 
grid. For the Fields select temperature and 
height. For Planes select ‘500mb’. Load the 
selections. Note: Other available parameters can 
be substituted. 

Contoured 500mb level temperature and 
height fields from the latest available 
ECMWF model run displays. ECMWF grib 
data can be displayed. 

 

22.  1. Select Clear from the menu bar. 
2. In the Volume Browser select ‘Edit’, ‘Clear 

All’. 

1. Gridded display is removed from the 
main pane. 

2. Volume Browser entries are removed. 

 

23.  Display parameters from the latest NAM model 
run by selecting an available NAM model for the 
grid. For the Fields select ‘Forcing’, ‘Omega’. For 
Planes select ‘700mb’. Load the selection. Note: 
Other available parameters can be substituted. 

Contoured 700mb level omega fields 
(vertical velocity) from the latest available 
NAM model run displays. NAM grib data can 
be displayed. 

 

24.  1. Select Clear from the tool bar. 
2. In the Volume Browser select ‘Edit’, ‘Clear 

All’. 

1. Gridded display is removed from the 
main pane. 

2. Volume Browser entries are removed. 

 

25.  Display parameters from the latest GFS model 
run by selecting ‘GFS40’ for the grid. For the 
Fields select ‘Moist’ and ‘RH’. For Planes select 
‘Surface’ (under Misc). Load the selection. Note: 
Other available parameters can be substituted. 

Contoured fields of surface RH from the 
latest available GFS-40 model run displays. 
GFS grib data can be displayed. 

 

26.  1. Select ‘Clear’ from the menu bar. 
2. In the Volume Browser select ‘Edit’, ‘Clear All’. 

1. Gridded display is removed from the main 
pane. 
2. Volume Browser entries are removed. 

 

27.  Display parameters from the latest RUC model 
run by selecting an available RUC model for the 
grid. For the Fields select Temperature and 
Height. For the Planes select ‘350mb’. Load the 
selection. 

Contoured 350mb temperature and height 
contours from the latest available RUC 
model display. RUC grib data can be 
displayed. 

 

28.  1. Select ‘Clear’ from the menu bar. 
 2. In the Volume Browser select ‘Edit’, ‘Clear All’. 

1. Gridded display is removed from the main 
pane. 
 2. Volume Browser entries are removed. 

 

29.  Close the Volume Browser. Select ‘Volume’ from 
the menu bar.  

A drop down menu labeled “Volume” 
appears. A listing of bundled (families) of 
grib model data displays. 
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Step Action Result Pass/Fail 
30.  From ‘Volume’ on the menu bar select ‘ECMWF’ 

located under Families. 
A bundled set of ECMWF parameters 
displays. ECMWF grib data can be 
displayed from the Volume drop-down list. 

 

31.  Select ‘Clear’ from the menu bar. Gridded display is removed from the main 
pane. 

 

32.  From ‘Volume’ select ‘NAM40’ located under 
Families. 

A bundled set of NAM 40 parameters 
displays. NAM 40 grib data can be 
displayed from the Volume drop-down list. 

 

33.  Select ‘Clear’ from the menu bar. Gridded display is removed from the main 
pane. 

 

34.  Select ‘GFS40’ located under Families. A bundled set of GFS parameters displays. 
GFS grib data can be displayed from the 
Volume drop-down list. 

 

35.  Select ‘Clear’ from the menu bar. Gridded display is removed from the main 
pane. 

 

36.  Select ‘RUC’ located under Families. A bundled set of RUC-80 parameters 
displays. RUC grib data can be displayed 
from the Volume drop-down list. 

 

37.  Select ‘Clear’ from the menu bar. Gridded display is removed from the main 
pane. 

 

DISPLAY RAOB 
38.  Select ‘Upper Air’ from the menu bar. Under the 

RAOB section select Omaha, NE (KOAX). 
The latest RAOB for Omaha, NE, displays. 
A hodograph and 24 hour temperature 
change graph also appear (the latter not 
active). Note: Derived parameters will not 
display. 

 

39.  Close the skew-T tab. Under ‘Upper Air’ select 
‘UA Plots’, and ‘700hPa’ located under RAOB. 

A plot display over the US for 700hPa from 
the latest RAOB data appears. 

DR #823 

40.  Clear the display. Select the ‘Points’ icon from the 
menu bar. Approximately center point A over 
Chicago, IL.  

A pre-determined set of points appear, 
normally lettered beginning with A. Point A 
is moved and centered over Chicago. 

 

41.  Open the Volume Browser by MB1 ‘Volume’, 
‘Browser’. 

The Volume Browser display GUI appears.  

42.  Select ‘Sounding’ from the Volume Browser tool 
bar. 

Volume Browser is set to sounding mode.  

43.  From the volume browser select the following: 
Grid-GFS40; Sounding (under Thermo); Points-A. 
Select ‘Load’. 

A sounding based on gridded data for Point 
A displays. It contains a hodograph and 24-
hr temperature change (both not active). 
Values for various parameters available in 
the data base also display. Finally, the 
asterisk in the map is centered over 
Chicago, where point A was moved.  
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Step Action Result Pass/Fail 
DISPLAY AIRCRAFT 
Because the display of aircraft data has not been incorporated into CAVE, a test driver will be used to 
demonstrate the aircraft plug-in exists.  

 

44.  Close the Skew-T display. Bring up the test driver 
in a web browser by going to:  
http://awips-int1:8080/uEngineWeb/ . 

Test driver displays.  

45.  Select ‘ASCII Data’. Open Request/Response 
Message. Edit the Request window entry to 
display the following script: 
 
include(“PIREPRequest.js”); 
var dataRequest = new PIREPRequest(); 
dataRequest.setCount(10); 
dataRequest.execute(); 
 
Select ‘Request Product’. 

The last 10 PIREP reports are returned. 
Aircraft plug-in exists and is operational. 

 

46.  Rerun the above step with data from the following 
script: 
Include(“AIREPrequest.js”); 
var dataRequest = new AIREPRequest(); 
dataRequest.setCount(10); 
dataRequest.execute(); 

The last 10 AIREP reports are returned. 
Aircraft plug-in exists and is operational. 

 

MDCRS plots will be delivered in TO 9. Therefore, the next two steps cannot be executed.  
47.  Next, Under ‘Aircraft’ select ‘MDCRS plots’. A display by flight levels in 5000 feet 

increments appears for available MDCRS 
plots. 

 

48.  Select ‘250-300 hft’. A display of available MDCRS plots 
between FL 250 – 300 appear. 

 

DISPLAY MARITIME  
49.  Ensure a cleared, CONUS map is selected as the 

display area. From the menu bar select ‘Obs’. 
Under the Maritime category select ‘Fixed Buoys’. 

The latest observations from fixed buoys 
displays. 

 

50.  Clear the display. Under ‘Obs’ select ‘Moving 
Maritime’. 

The latest observations from ships and 
floating buoys displays. 

 

51.  Clear the display. Under ‘Obs’ select ‘MAROB’. The latest MAROB data displays  
DISPLAY RADAR 
52.  Clear the display. From the tool bar select 

‘Radar’, ‘kdvn’, ‘kdvn 4 Bit Products’, ‘kdvn 4 bit 
four panel’. 

A listing of available four panel radar 
displays appears. 

 

http://awips-int1:8080/uEngineWeb/
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Step Action Result Pass/Fail 
53.  Select the 0.5/1.5/2.4/3.4 Z/SRM panels. A four panel radar display appears in the 

main panel. The displays are for 0.5, 1.5, 
2.4, and 3.4 tilts. Note: not all panels may 
load if data is not available. Another station 
may be selected. 

 

54.  Close the 4-panel display. Select ‘kmpx’ under 
Radar. Select ‘kmpx 4 Bit Products’, ‘Comp Ref 
4bit (CZ), 

A composite reflectivity radar image for 
Minneapolis displays. 

 

55.  Clear the display and repeat above step for 
‘Storm Total Precip’. Note: STP may not be 
available, depending on the weather occurring at 
the site. 

A display of storm total precip displays.  

56.  Clear the display and select under Radar ‘kfsd’, 
‘kfsd Derived’, ‘Echo Tops (ET)’. 

A display of the echo tops for Sioux Falls 
displays. 

 

57.  Clear the display and under the koax localization 
select ‘koax 4 Bit Products’, ‘koax 4bit 
Reflectivity’, ‘1.5 Refl’. 

The latest radar image, 1.5 tilt, for koax 
localization displays. 

 

58.  Repeat for ‘2.4 Refl’. The latest radar image, 2.4 tilt, for koax 
localization displays. 

 

59.  Repeat for ‘3.4 Refl’. The latest radar image, 3.4 tilt, for koax 
localization displays. 

 

DISPLAY TAF and TEXT 
60.  From the menu bar select ‘Tools’, ‘Text Window’. A text display window opens.   
61.  In the AFOS Cmd: enter ‘OMATAFOMA’. Return. A terminal area forecast (TAF) for the 

selected station displays. AWIPS II contains 
a TAF plug-in that allows for the storage and 
retrieval of TAF data. 

 

62.  Clear the display. In the text window, AFOS Cmd:  
enter ‘OMAAFDOMA’. Return. 

A text bulletin displays. Text products can 
be displayed; a text plug-in exists. 

 

DISPLAY METAR 
63.  Clear the display. In the AFOS Cmd: enter 

‘OMAMTROMA’. 
A series of raw metar observations for 
Nebraska displays. Raw METAR 
observations can be retrieved and 
displayed. 

 

64.  Close the text window. Ensure a “clear” map 
centered on the CONUS is displayed in the main 
panel. Select ‘Obs’ from the CAVE menu bar. 

A drop down menu bar displays providing a 
list of observation types that can be 
displayed. 

 

65.  Select ‘Surface Plot’. The latest available decoded and ingested 
observations are displayed over the 
CONUS. 

 

66.  Clear the display. Under ‘Obs’, select ‘Other 
Plots’, ‘Surface Synoptic Plots’. Note: Loop 
and/or zoom as necessary. 

The latest available surface plots from 
synoptic formatted observations displays. 
CAVE contains a synoptic plug-in.  
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Step Action Result Pass/Fail 
67.  Open a pgAdmin III session. Select the int1 DB. 

Under metadata open ‘Schemas’, ‘awips’, 
‘Tables’. 

A listing of the database tables displays.  

68.  Using MB3 click on ‘obs’. The DB Property and associated Value for 
obs displays.  

 

69.  Perform a SQL query by selecting the ‘View the 
data in the selected object.’ Icon located in the 
menu bar containing icons. 

A display of the metadata stored in the 
observation database displays.  

 

70.  Examine the column headers. Look for the 
following headers: autostationtype, 
sealevelpress, mintemp24hr, maxtemp24hr, 
precip1hour, precip6hour, and 
presschange3hour. 

These are all examples of columns that 
contain values found in the remarks section 
of METAR observations. 

 

71.  Scroll down through the columns. When remarks 
are reported, values will be found in these 
columns. Open the observation in the “message” 
column to confirm the value is found in the 
remarks section, RMK. 

METAR remarks are decoded and stored in 
the AWIPS database. 

 

End of TO8 Test 
 

Begin TO9 Test  
DISPLAY PROFILER DATA DECODED FROM BUFR 
72.  To determine if profiler data is being ingested and 

stored open pgAdmin. Run the following SQL 
query: 
              select * from prodata; 

A listing of ingested profiler data appears. 
This data has been decoded from BUFR 
and stored. 

 

73.  Select and annotate two stations from the 
stationid character column. 
Selected Station ids: __________________ 

Profiler station id selected.  

74.  Open the AWIPS test driver. This will be used to 
query the database and view the selected two 
profiler data. 
          http://awips-int1:8080/uEngineWeb/  

The AWIPS Test Driver Interface Connected 
to AWIPS-int1 opens. 

 

75.  Open the Request/Response Message and enter 
the following query (first delete the request in the 
“Request:” window). Replace the XXXXX with 
one of the two station numbers selected above. 
 
include("ProfilerRequest.js");  
var dataRequest = new ProfilerRequest();  
dataRequest.addParameter("stationId","XXXXX");  
dataRequest.execute(); 

A Request/Response message is entered.  

http://awips-int1:8080/uEngineWeb/
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Step Action Result Pass/Fail 
76.  Select “Request Product”. Profiler data for the selected station are 

retrieved from the database and displayed.  
Profiler data are being stored in the DB. 

 

77.  Repeat steps 75 and 76 for the second point 
selected. 

Profiler data for the selected station are 
retrieved from the database and displayed.  
Profiler data are being stored in the DB. 

 

DISPLAY MODEL SOUNDING DATA DECODED FROM BUFR 
78.  To determine if model sounding data are being 

ingested and stored open pgAdmin run the 
following SQL query: 
              select * from modelsounding; 

A listing of all model sounding data that has 
been ingested appears.  These data have 
been decoded from BUFR and stored. 

DR 
#1425 

79.  Scroll down. Under “GFS” reporttype select and 
record two sets of latitudes and longitudes. 
Selected Lat/Longs: __________________ 

Two data points are chosen from the GFS 
model that will be used to retrieve data. 

 

80.  If not already displayed, open the AWIPS test 
driver. This will be used to query the database 
and view the selected two profiler data. 
          http://awips-int1:8080/uEngineWeb/  

The AWIPS Test Driver Interface Connected 
to AWIPS-int1 opens. 

 

81.  Open the Request/Response Message and enter 
the following query (first delete the request in the 
“Request:” window). Replace the XX.XX and 
YYY.YY with one of the two data points selected 
above. 
 
include("ModelSoundingRequest.js");  
var dataRequest = new 
ModelSoundingRequest();  
dataRequest.addParameter("reportType","GFS");  
dataRequest.addParameter ("latitude","XX.XX"); 
dataRequest.addParameter ("longitude","-
YYY.YY"); 
dataRequest.execute(); 

A Request/Response message is entered.  

82.  Select “Request Product”. GFS data for the entered data point 
displays. GFS model sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

83.  Repeat steps 81 and 82 for the second point 
selected. 

GFS data for the entered data point 
displays. GFS model sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

http://awips-int1:8080/uEngineWeb/
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Step Action Result Pass/Fail 
84.  The next several steps repeat the above model 

sounding test steps but use the ETA model. To 
determine if model sounding data for the ETA 
model are being ingested and stored open 
pgAdmin, run the following SQL query: 
              select * from modelsounding; 

A listing of all model sounding data that has 
been ingested appears. 

 

85.  Scroll down. Under “ETA” reporttype select and 
record two sets of latitudes and longitudes. 
Selected Lat/Longs: __________________ 

Two data points are chosen from the ETA 
model that will be used to retrieve data. 

 

86.  In the test browser, open the Request/Response 
Message and enter the following query (first 
delete the request in the “Request:” window). 
Replace the XX.XX and YYY.YY with one of the 
two data points selected above. 
 
include("ModelSoundingRequest.js");  
var dataRequest = new 
ModelSoundingRequest();  
dataRequest.addParameter("reportType","ETA");  
dataRequest.addParameter ("latitude","XX.XX"); 
dataRequest.addParameter ("longitude","-
YYY.YY"); 
dataRequest.execute(); 

A Request/Response message for ETA data 
is entered. 

 

87.  Select “Request Product”. ETA data for the entered data point 
displays. ETA model sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

88.  Repeat steps 86 and 87 for the second point 
selected. 

ETA data for the entered datapoint displays. 
ETA model sounding data are being 
decoded and ingested into the AWIPS II 
database. 

 

DISPLAY SATELLITE SOUNDING DATA (GOES and POES) DECODED FROM BUFR 
89.  To determine if satellite sounding data from 

GOES satellites are being ingested and stored 
open pgAdmin, run the following SQL query: 
              select * from goessounding; 

A listing of all satellite sounding data from 
GOES satellites that has been ingested 
appears. 

 

90.  Scroll down. Select and record two sets of 
latitudes and longitudes. 
Selected Lat/Longs: __________________ 

Two data points are chosen from the GOES 
satellite soundings that will be used to 
retrieve data. Note the wmoheader column 
and that GOES file headers fall under the 
JUTX* WMO header. 
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Step Action Result Pass/Fail 
91.  If not already displayed, open the AWIPS test 

driver. This will be used to query the database 
and view the satellite sounding data. 
          http://awips-int1:8080/uEngineWeb/  

The AWIPS Test Driver Interface Connected 
to AWIPS-int1 opens. 

 

92.  Open the Request/Response Message and enter 
the following query (first delete the request in the 
“Request:” window). Replace the XX.XX and 
YYY.YY with one of the two data points selected 
above. 
 
include("GOESSoundingRequest.js");  
var dataRequest = new 
GOESSoundingRequest();  
dataRequest.addParameter ("latitude","XX.XX"); 
dataRequest.addParameter ("longitude","-
YYY.YY"); 
dataRequest.execute(); 

A Request/Response message for GOES 
Satellite data is entered. 

 

93.  Select “Request Product”. GOES Satellite sounding data ingested from 
BUFR format for the entered data point 
displays. GOES Satellite sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

94.  Repeat steps 92 and 93 for the second point 
selected. 

GOES Satellite sounding data ingested from 
BUFR format for the entered data point 
displays. GOES Satellite sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

95.  To determine if satellite sounding data from 
POES satellites are being ingested and stored 
open pgAdmin, run the following SQL query: 
              select * from poessounding; 

A listing of all satellite sounding data from 
POES satellites that has been ingested 
appears. 
Note: May need to manually ingest POES 
data.  DR deals with storing POES data in a 
clustered environment. 

DR 
#1425 

96.  Scroll down. Select and record two sets of 
latitudes and longitudes. 
Selected Lat/Longs: __________________ 

Two data points are chosen from the POES 
satellite soundings that will be used to 
retrieve data. Note the wmoheader column 
and that POES file headers fall under the 
IUTX* WMO header. 

 

97.  If not already displayed, open the AWIPS test 
driver. This will be used to query the database 
and view the satellite sounding data. 
          http://awips-int1:8080/uEngineWeb/  

The AWIPS Test Driver Interface Connected 
to AWIPS-int1 opens. 

 

http://awips-int1:8080/uEngineWeb/
http://awips-int1:8080/uEngineWeb/
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Step Action Result Pass/Fail 
98.  Open the Request/Response Message and enter 

the following query (first delete the request in the 
“Request:” window). Replace the XX.XX and 
YYY.YY with one of the two data points selected 
above. 
 
include("POESSoundingRequest.js");  
var dataRequest = new 
POESSoundingRequest();  
dataRequest.addParameter ("latitude","XX.XX"); 
dataRequest.addParameter ("longitude","-
YYY.YY"); 
dataRequest.execute(); 

A Request/Response message for POES 
Satellite data is entered. 

 

99.  Select “Request Product”. POES Satellite sounding data ingested from 
BUFR format for the entered datapoint 
displays. POES Satellite sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

100.  Repeat steps 98 and 99 for the second point 
selected. 

POES Satellite sounding data ingested from 
BUFR format for the entered datapoint 
displays. POES Satellite sounding data are 
being decoded and ingested into the AWIPS 
II database. 

 

DISPLAY MODEL OUTPUT STATISTICS (MOS) DECODED FROM BUFR 
101.  To determine if profiler data is being ingested and 

stored open pgAdmin. Run the following SQL 
query: 
              select * from bufrmos; 

A listing of ingested mos data appears.  

102.  Select and annotate two stations from the 
stationid character column. 
Selected Station ids: __________________ 

MOS station id selected.  

103.  Open the AWIPS test driver. This will be used to 
query the database and view the selected two 
profiler data. 
          http://awips-int1:8080/uEngineWeb/  

The AWIPS Test Driver Interface Connected 
to AWIPS-int1 opens. 

 

104.  Open the Request/Response Message and enter 
the following query (first delete the request in the 
“Request:” window). Replace the XXXXX with 
one of the two station numbers selected above. 
 
include("BUFRMOSRequest.js");  
var dataRequest = new BUFRMOSRequest();  
dataRequest.addParameter("stationId","XXXXX");  
dataRequest.execute(); 

A Request/Response message is entered.  

http://awips-int1:8080/uEngineWeb/
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Step Action Result Pass/Fail 
105.  Select “Request Product”. Data for the MOS station entered for the 

stationed displays. BUFR formatted MOS 
data are being decoded and ingested into 
the AWIPS II database. 

 

106.  Repeat steps 104 and 105 for the second point 
selected. 

Data for the MOS station entered for the 
stationed displays. BUFR formatted MOS 
data are being decoded and ingested into 
the AWIPS II database. 

 

RED BOOK PRODUCTS. THE NCEP/HYDRO DROPDOWN MENU IN CAVE CONTAINS SELECTIONS TO 
DISPLAY RED BOOK PRODUCTS. A RANDOM SAMPLING WILL BE TESTED. 

107.  Open CAVE. Under the NCEP/HYDRO menu 
drop down select “SPC Convective Outlooks”, 
“Day 1 Convective Outlook”. 

The Day 1 Convective Outlooks displays. 
Compare to SPC, http://www.spc.noaa.gov/. 
Areal coverage should be approximately the 
same for both areas.  

 

108.  Clear display.  Repeat for the Day 3 Convective 
Outlook. 

The Day 3 Convective Outlook displays. 
Compare to SPC, http://www.spc.noaa.gov/. 
Areal coverage should be approximately the 
same for both areas. 

 

109.  Clear display.  Still in CAVE, under the 
NCEP/HYDRO menu drop down select “Fire 
Weather”, “Fire Wx Outlook – Day 2”. 

The Day 2 Fire Weather Outlook displays. 
Compare to SPC, http://www.spc.noaa.gov/ 
, Fire Wx Forecasts. Areal coverage should 
be approximately the same for both.  

 

110.  Still in CAVE, under the NCEP/HYDRO menu 
drop down select “Precip & Stability”, “Radar 
Summary”. 

The latest available radar contours of 
intensity displays. Compare to same display 
on AWIPS I. 

 

111.  Clear display.  Still in CAVE, under the 
NCEP/HYDRO menu drop down select “Temps 
and Weather” located under NCO and then “Sfc 
Geo Wind Plot”. 

The latest available surface geostrophic 
wind plot displays. Compare to same display 
on AWIPS I. 

 

112.  Clear display.  Still in CAVE, under the 
NCEP/HYDRO menu drop down select “Threat 
Chart”, “Soil/Wildfire Fcst”. 

The Weekly Drought Monitor displays. 
Compare to same display on AWIPS I. 

 

RISK REDUCTION. As a risk reduction for TO10, preliminary development work for hydrology started in TO9 will be 
demonstrated in the following steps. A formal risk reduction demonstration will be presented as part of TO10.  

113.  Open a terminal and log into the mule logs 
directory (/awips/edex/mule/logs).  Perform an ls 
on the directory. 

A listing of the mule logs displays.  User can 
access the mule logs.  

 

114.  Perform the following in-line command: 
cat <Latest log> | grep IngestSrv-shef | grep -v "0 
records" | grep records  
Substitute the latest log file for <Latest log> 

A series of ingest logs for SHEF data 
appears.  It shows that SHEF data is being 
ingested into the DB. 

 

115.  To show that SHEF plug-in has been created and 
data are being stored, Open pgAdmin III. 

The pgAdmin III application opens.  

http://www.spc.noaa.gov/
http://www.spc.noaa.gov/
http://www.spc.noaa.gov/
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Step Action Result Pass/Fail 
116.  In pgAdmin III under Databases select “awips-

db”, “hd_ob81oax”, “Schemas”, “public”, and 
“Tables”. 

A listing of the SHEF tables contained in the 
database appears. 

 

117.  Using the right mouse button highlight “height”. 
Select “View Data” and “View All Roles”. 

A listing of the SHEF data for the table 
selected displays and is current. SHEF data 
are being stored. 

 

118.  Repeat the above two steps for the table 
containing the parameter “rawpp”. 

A listing of the SHEF data for the table 
selected displays and is current. SHEF data 
are being stored. 

 

119.  Repeat steps 116 and 117 for the table 
containing the parameter “curpp”. 

A listing of the SHEF data for the table 
selected displays and is current. SHEF data 
are being stored. 

 

End of TO9 Test 
 

Begin TO10 Test  
30 Hour TAF - Ingest 

120.  To determine if 30 hour TAF data is being 
ingested and stored, open pgAdmin III. Select the 
database ‘metadata’ and ‘awips’.  

The database is opened.  

121.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from taf where stationid in  (‘KMKE’, 
‘KBWI’, ‘KBOS’) ; 

A listing of selected ingested TAF data 
appears.  

 

122.  Run the following SQL query: 
select datauri from taf where stationid = ‘KMKE’; 
 
cntrl C the datauri to copy into the next SQL 
query: 
select * from taf_change_groups where parentid 
like ‘<cntrl V datauri from previous query>’ order 
by sequenceid; 

TAF data for the selected station are 
displayed.  TAF data are being stored in the 
DB. 

 

123.  View the changegroup field for the date/times of 
each group.  

The TAF is for 30 hours and the date/times 
are in the 30-hr format. 

 

124.  Repeat steps 122 and 123 for stationid ‘KBOS’. The 30 hour TAF for a second station is 
displayed. 

 

METAR to SHEF (IHFS) 
125.  Open a pgAdmin III session. Select the int1 DB. 

Under ‘hd_ob83krf’ open ‘Schemas’, ‘awips’, 
‘Tables’. 

A listing of the ‘hd_ob83krf’ database tables 
displays. 

 

126.  Using MB3 click on ‘latestobsvalue’ table and 
select ‘View Data’.  

The entries in the latestobsvalue table 
displays.  

 

127.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  
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Step Action Result Pass/Fail 
128.  Open the “Execute arbitrary SQL queries” 

window and run the following SQL query: 
select * from latestobsvalue where product_id like  
‘%METAR’ order by lid asc; 

The latest observations from the METAR 
reporting stations are displayed grouped by 
location. 

 

129.  Select a station with several rows. Record the 
values in the ‘lid’, ‘pe’, ‘ts’, ‘obstime’, and ‘value’ 
columns. 

lid: __________________________ 
pe : __________________________ 
ts: ___________________________ 
obstime: ______________________ 
value: ________________________ 
 

 

130.  In the pgAdmin III int1 DB session, select 
‘metadata’ and open ‘Schemas’, ‘awips’, Tables’. 

A listing of the ‘metadata’ database tables 
displays. 

 

131.  Using MB3 click on ‘obs’ table and select ‘View 
Data’.  

The entries in the ‘obs’ table displays.   

132.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

133.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from obs where stationid like  ‘<%lid from 
previous steps>’; 

The observation data from the METAR 
reporting station are displayed. 

 

134.  Compare the values to the corresponding values 
recorded above. 

Data from METAR observations are stored 
in the SHEF and metadata databases. 

 

Synoptic to SHEF (IHFS) 
135.  Open a pgAdmin III session. Select the int1 DB. 

Under ‘hd_ob83krf’ open ‘Schemas’, ‘awips’, 
‘Tables’. 

A listing of the ‘hd_ob83krf’ database tables 
displays. 

 

136.  Using MB3 click on ‘latestobsvalue’ table and 
select ‘View Data’.  

The entries in the latestobsvalue table 
displays.  

 

137.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

138.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from latestobsvalue where product_id like  
‘%Synoptic’ order by lid asc; 

The latest observations from the Synoptic 
reporting stations are displayed grouped by 
location. 

 

139.  Select a station with several rows. Record the 
values in the ‘lid’, ‘pe’, ‘ts’, ‘obstime’, and ‘value’ 
columns. 

lid: __________________________ 
pe : __________________________ 
ts: ___________________________ 
obstime: ______________________ 
value: ________________________ 
 

 

140.  In the pgAdmin III int1 DB session, select 
‘metadata’ and open ‘Schemas’, ‘awips’, Tables’. 

A listing of the ‘metadata’ database tables 
displays. 
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Step Action Result Pass/Fail 
141.  Using MB3 click on ‘obs’ table and select ‘View 

Data’.  
The entries in the ‘obs’ table displays.   

142.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

143.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from obs where stationid like  ‘<%lid from 
previous steps>’; 

The observation data from the Synoptic 
reporting station are displayed. 

 

144.  Compare the values to the corresponding values 
recorded above. 

Data from Synoptic observations are stored 
in the SHEF and metadata databases. 

 

SHEF to IHFS 
145.  Open a pgAdmin III session. Select the int1 DB. 

Under ‘hd_ob83krf’ open ‘Schemas’, ‘awips’, 
‘Tables’. 

A listing of the ‘hd_ob83krf’ database tables 
displays. 

 

146.  Using MB3 click on ‘latestobsvalue’ table and 
select ‘View Data’.  

The entries in the latestobsvalue table 
displays.  

 

147.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

148.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from latestobsvalue where product_id like  
‘<select a SHEF product>’ order by lid asc; 

The latest data from the SHEF observations 
are displayed grouped by location. 

 

149.  Select a station with several rows. Record the 
values in the ‘lid’, ‘pe’, ‘ts’, ‘obstime’, and ‘value’ 
columns. 

lid: __________________________ 
pe : __________________________ 
ts: ___________________________ 
obstime: ______________________ 
value: ________________________ 
 

 

150.  In the pgAdmin III int1 DB session, select 
‘metadata’ and open ‘Schemas’, ‘awips’, Tables’. 

A listing of the ‘metadata’ database tables 
displays. 

 

151.  Using MB3 click on ‘obs’ table and select ‘View 
Data’.  

The entries in the ‘obs’ table displays.   

152.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

153.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from obs where stationid like  ‘<%lid from 
previous steps>’; 

The data from the SHEF observation are 
displayed. 

 

154.  Compare the values to the corresponding values 
recorded above. 

Data from SHEF observations are stored in 
the IHFS database. 
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Step Action Result Pass/Fail 
Precipitation Processing (to IHFS) 

155.  Open a pgAdmin III session. Select the int1 DB. 
Under ‘hd_ob83krf’ open ‘Schemas’, ‘awips’, 
‘Tables’. 

A listing of the ‘hd_ob83krf’ database tables 
displays. 

 

156.  Using MB3 click on ‘latestobsvalue’ table and 
select ‘View Data’.  

The entries in the latestobsvalue table 
displays.  

 

157.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

158.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from latestobsvalue where product_id like  
‘<select a SHEF product>’ order by lid asc; 

The latest data from the SHEF observations 
are displayed grouped by location. 

 

159.  Select a station with the Physical Element (PE) 
value of ‘PP’. Record the values in the ‘lid’, ‘ts’, 
‘obstime’, and ‘value’ columns. 

lid: __________________________ 
ts: ___________________________ 
obstime: ______________________ 
value: ________________________ 
 

 

160.  In the pgAdmin III int1 DB session, select 
‘metadata’ and open ‘Schemas’, ‘awips’, Tables’. 

A listing of the ‘metadata’ database tables 
displays. 

 

161.  Using MB3 click on ‘obs’ table and select ‘View 
Data’.  

The entries in the ‘obs’ table displays.   

162.  Scroll down the entries and verify the date/times 
are current. 

Current data is stored.  

163.  Open the “Execute arbitrary SQL queries” 
window and run the following SQL query: 
select * from obs where stationid like  ‘<%lid from 
previous steps>’; 

The data from the SHEF observation are 
displayed. 

 

164.  Compare the values to the corresponding values 
recorded above. 

Precipitation Data from SHEF observations 
are stored in the IHFS database. 

 

165.  Open the Hydro Perspective. The Hydro screen is displayed.  
166.  On the map, select the location used above. On 

the menu bar, select LiveData, Station Reporting 
Status/ Latest Observations. 

The latest observations for the selected site 
are displayed. 

 

167.  Verify the Precipitation (PP) value corresponds to 
the value in the database tables. 

Values are the same.  

168.  Close all windows. Windows are closed.  
File Purger 

169.  Open a terminal window. The terminal window opens.  
170.  Navigate to the log files and verify the IHFS 

purge process has been successfully completed. 
Verified.  

171.  Open pgAdmin and navigate to the IHFS tables. The IHFS tables are available.  
172.  Verify there is no data older than the set purge 

time. 
Verified.  
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Step Action Result Pass/Fail 

173.  
In the terminal window, navigate to the 
Precipitation File system and verify the purge has 
run. 

Verified.  

End of TO10 Test 
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5.0 TO8 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
CAVE_TO8_18.22 CAVE shall display the Fixed Buoys plot product 49 
CAVE_TO8_18.23 CAVE shall display the Moving Maritime plot product 50 
CAVE_TO8_18.24 CAVE shall display the MAROB station plot product 51 
ADE_TO8_024 AWIPS shall contain Plug-Ins that decode and store data and metadata 3-46 

49-72 
ADE_TO8_024.1 AWIPS shall contain a bin Lightning Plug-in 3-13 
ADE_TO8_024.1.1 The bin-Lightning Plug-in shall decode lightning metadata 3-13 
ADE_TO8_024.1.2 The bin-Lightning Plug-in shall store lightning metadata in the metadata 

repository 
3-13 

ADE_TO8_024.1.3 CAVE shall display lightning data 3-13 
CAVE_TO8_016.1 CAVE shall display 1 hour binary lightning plots 4 
CAVE_TO8_016.2 CAVE shall display 15 minute binary lightning plots 6 
CAVE_TO8_016.3 CAVE shall display 15 minute positive/negative binary lightning plots 8 
CAVE_TO8_016.4 CAVE shall display 5 minute binary lightning plots 10 
CAVE_TO8_016.5 CAVE shall display 1 minute binary lightning sequence 12 
ADE_TO8_024.2 AWIPS shall contain a GINI Satellite Plug-in 14-19 
ADE_TO8_024.2.1 The GINI Satellite Plug-in shall decode GINI Satellite metadata 14-19 
ADE_TO8_024.2.2 The GINI Satellite Plug-in shall store GINI Satellite metadata in the 

metadata repository 
14-19 

ADE_TO8_024.2.3 CAVE shall display GINI Satellite data 14-19 
ADE_TO8_024.3 AWIPS shall contain a Grib Plug-in 20-37 
ADE_TO8_024.3.1 The Grib Plug-in shall decode Grib metadata 20-37 
ADE_TO8_024.3.2 The Grib Plug-in shall store Grib metadata in the metadata repository 20-37 
ADE_TO8_024.3.3 CAVE shall display decoded Grib data 20-37 
ADE_TO8_024.4 The Grib Plug-in shall decode grib data necessary for the correct 

operation of the AWIPS II system 
20-37 

ADE_TO8_024.4.1 The Grib Plug-in shall decode ECMWF data 20-37 
ADE_TO8_024.4.2 The Grib Plug-in shall decode NAM data 20-37 
ADE_TO8_024.4.3 The Grib Plug-in shall decode GFS data 20-37 
ADE_TO8_024.4.4 The Grib Plug-in shall decode RUC data 20-37 
ADE_TO8_024.5 AWIPS shall contain a RAOB (BUFR) Plug-in 38-43 
ADE_TO8_024.5.1 The RAOB (BUFR) Plug-in shall decode RAOB metadata 38-43 
ADE_TO8_024.5.2 The RAOB (BUFR) Plug-in shall store RAOB metadata in the metadata 

repository 
38-43 

ADE_TO8_024.5.3 CAVE shall display RAOB data 38-43 
ADE_TO8_024.6 AWIPS shall contain a Text Plug-in  62 
ADE_TO8_024.6.1 The Text Plug-in shall decode text data  62 
ADE_TO8_024.7 AWIPS shall contain an Aircraft Plug-in 44-46 
ADE_TO8_024.7.1 The Aircraft Plug-in shall decode Aircraft metadata 44-46 
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Number Description Test Step(s) 
ADE_TO8_024.7.1.1 The Aircraft Plug-in shall decode AIREP Aircraft metadata 44-46 
ADE_TO8_024.7.1.2 The Aircraft Plug-in shall decode RECCO Aircraft metadata 47-48 
ADE_TO8_024.7.1.3 The Aircraft Plug-in shall decode PIREP Aircraft metadata 44-46 
ADE_TO8_024.7.2 The Aircraft Plug-in shall store Aircraft metadata in the metadata 

repository 
44-46 

ADE_TO8_024.7.2.1 The Aircraft Plug-in shall store AIREP Aircraft metadata in the metadata 
repository 

44-46 

ADE_TO8_024.7.2.2 The Aircraft Plug-in shall store RECCO Aircraft metadata in the 
metadata repository 

47-48 

ADE_TO8_024.7.2.3 The Aircraft Plug-in shall store PIREP Aircraft metadata in the metadata 
repository 

44-46 

ADE_TO8_024.7.3 CAVE shall display Aircraft data 44-46 
ADE_TO8_024.7.3.1 CAVE shall display AIREP Aircraft data 44-46 
ADE_TO8_024.7.3.2 CAVE shall display RECCO Aircraft data 47-48 
ADE_TO8_024.7.3.3 CAVE shall display PIREP Aircraft data 44-46 
ADE_TO8_024.8 AWIPS shall contain a Synoptic Plug-in 66 
ADE_TO8_024.8.1 The Synoptic Plug-in shall decode Synoptic metadata 66 
ADE_TO8_024.9 AWIPS shall contain a Maritime Plug-in 49-51 
ADE_TO8_024.9.1 The Maritime Plug-in shall decode Maritime metadata 49-51 
ADE_TO8_024.9.1.1 The Maritime Plug-in shall decode ship synoptic Maritime metadata 49-51 
ADE_TO8_024.9.1.2 The Maritime Plug-in shall decode buoy synoptic Maritime metadata 49-51 
ADE_TO8_024.9.1.3 The Maritime Plug-in shall decode CMAN synoptic Maritime metadata 49-51 
ADE_TO8_024.9.1.4 The Maritime Plug-in shall decode MAROB Maritime metadata 49-51 
ADE_TO8_024.9.2 The Maritime Plug-in shall store Maritime metadata in the metadata 

repository 
49-51 

ADE_TO8_024.9.2.1 The Maritime Plug-in shall store ship synoptic Maritime metadata in the 
metadata repository 

49-51 

ADE_TO8_024.9.2.2 The Maritime Plug-in shall store buoy synoptic Maritime metadata in the 
metadata repository 

49-51 

ADE_TO8_024.9.2.3 The Maritime Plug-in shall store CMAN synoptic Maritime metadata in 
the metadata repository 

49-51 

ADE_TO8_024.9.2.4 The Maritime Plug-in shall store MAROB Maritime metadata in the 
metadata repository 

49-51 

ADE_TO8_024.9.3 CAVE shall display Maritime data 49-51 
ADE_TO8_024.9.3.1 CAVE shall display ship synoptic Maritime data 49-51 
ADE_TO8_024.9.3.2 CAVE shall display buoy synoptic Maritime data 49-51 
ADE_TO8_024.9.3.3 CAVE shall display CMAN synoptic Maritime data 49-51 
ADE_TO8_024.9.3.4 CAVE shall display MAROB Maritime data 49-51 
ADE_TO8_024.10 AWIPS shall contain a Radar Plug-in 52-59 
ADE_TO8_024.10.1 The Radar Plug-in shall decode Radar metadata 52-59 
ADE_TO8_024.10.2 The Radar Plug-in shall store Radar metadata in the metadata 

repository 
52-59 
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Number Description Test Step(s) 
ADE_TO8_024.10.3 CAVE shall display Radar data 52-59 
ADE_TO8_024.11 AWIPS shall contain a TAF Plug-in 60-61 
ADE_TO8_024.11.1 The TAF Plug-in shall decode TAF metadata 60-61 
ADE_TO8_024.11.2 The TAF Plug-in shall store TAF metadata in the metadata repository 60-61 
ADE_TO8_024.12 AWIPS shall contain a METAR Plug-in 63-65, 67-71 
ADE_TO8_024.12.1 The METAR Plug-in shall decode METAR metadata 63-65, 67-71 
ADE_TO8_024.12.2 The METAR Plug-in shall store METAR metadata in the metadata 

repository 
63-65, 67-71 

ADE_TO8_024.12.3 CAVE shall display METAR data 63-65, 67-71 
AWIPS_T08_030.4 The AWIPS system shall ingest METAR (WMO FM-15) observation 

data 
63-65, 67-71 

AWIPS_T08_030.5 The AWIPS system shall ingest SPECI (WMO FM-16) observation data 63-65, 67-71 
AWIPS_T08_030.6 Refine the ADE 1.0 Metar plug-in by extending decoding into the 

remarks 
63-65, 67-71 

AWIPS_T08_031.1 AWIPS shall ingest binary lightning data 3-13 
AWIPS_T08_031.2 AWIPS shall decode binary lightning data 3-13 
AWIPS_T08_031.3 AWIPS shall store binary lightning data 3-13 
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6.0 TO9 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR2074 The AWIPS system shall implement Redbook Vector Rendering. 107-112 
SYSR2087 The AWIPS system shall implement the BUFR Decoder for Profiler 

Data. 72-77 

SYSR2088 The AWIPS system shall implement the BUFR Decoder for Model 
Soundings. 78-88 

SYSR2089 The AWIPS system shall implement the BUFR Decoder for Satellite 
Soundings. 89-100 

SYSR2090 The AWIPS system shall implement (ingest and storage) the Red Book 
Vector Products for products viewable from D2D menus. 107-112 
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7.0 TO10 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
SYSR   
SYSR   
SYSR   
SYSR   
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1.0 SCOPE 
See Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None 

 

2.2 Reference Documents 
• TO10 Software Test Plan for the Advanced Weather Interactive Processing 

System Project, Contract #DG133W-05-CQ-1067, January 2009. 
• The AWIPS D-2D User’s Manual Build 8.1. 
• The Silver Spring NWS AWIPS 1 test bed application.  
• Release OB8.2 of the Weather Event Simulator (WES). 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the stability of the software by running continuously with a KOAX 
filtered SBN live data flow while monitoring system resources for usage and log files for critical 
errors.  This test case also involves running CAVE periodically checking for retrieval of current 
data.  This test case is verified at the local Omaha test site on the test hardware prior to or during 
PDT.  The test results are recorded in the Test Report. Stability issues exposed during the test, if 
any, are analyzed and required corrections determined. Corrections that cannot be applied prior 
to Delivery Testing are reported. As is the case with other tests, critical defects that prevent 
testing and evaluation of TO10 delivery functionality will be corrected prior to acceptance of the 
delivery. Non-critical defects (those for which a reasonable work around can be provided, or 
which does not prevent subsequent testing) will be corrected during TO11 or a subsequent Task 
Order as appropriate. 
 

3.1 Assumptions, Constraints, and Preconditions 
• TO10 software has been installed successfully on the test cluster and the test 

workstations 
• EDEX is running on both nodes of the cluster  
• Live data from a SBN data feed with filtering for KOAX  
• Monitoring cron for system resources running 
• Mule and activemq log files configured to persist through the entire test 

interval 

3.2 Recommended Hardware 
See Software Test Plan. 
 

3.3 Test Inputs 
Test inputs are defined by the SBN acquisition patterns which will be set to KOAX.  A copy of 
the file defining the acquisitions patterns will be included in the test report. 
 

3.4 Test Outputs 
• Copy of SBN data acquisition patterns 
• System resources will be logged and stored  

– Linux “uptime” logged on each node 
– Daily “ps –ef|grep java” logged  on each node with timestamps 
– Daily “ls –lR” of hdf5 tree logged with timestamp 
– Daily file count of the “processing” directory logged with timestamps 
– Daily JMX snapshots of mule and activemq heap memory 
– Default SysStat system resource monitoring logged 

• Mule Log files will be stored 
• ActiveMQ Log files will be stored 
• Issue analysis report, if required. 
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4.0 TEST SCENARIO 

Step Action Result Pass/Fail 
1.  Start and let EDEX run without 

interruption for 14 days. 
EDEX continues running for 14 days  

2.  Run CAVE daily on a workstation 
to display satellite, radar, and 
model data. 

CAVE displays current satellite, radar, and 
model data 

 

3.  After the 14 day test period 
examine the system resources 
and log files to verify EDEX and 
CAVE are still running. 

Mule logs indicate data is being ingested.  
System resources are still available  

 

4.  Collect logs and monitoring data. 
 

Logs and monitoring data become part of the 
test report. 

 

End of test. 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
CAVE_TO8_040 AWIPS II shall ingest data continuously for 15 days without requiring a 

restart. 
ALL 
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• None. 

 
2.2 Reference Documents 

• Legacy NWS Test Cases: Baseline_HYDRO_WHFS_Hydroview (OB8.3); 
Baseline_HYDRO_WHFS_Hydroview_OB8.1; 
Baseline_HYDRO_PointData.Control; Checkout_4.4.2_Hydroview_OB8.1. 

• Software Test Plan for the Advanced Weather Interactive Processing System 
Project, Contract #DG133W-05-CQ-1067, January 2009. 

• The Silver Spring NWS AWIPS I test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates that the Rate of Change (ROC) Checker successfully computes the 
rate of change for a specified time series of observational data.  The ROC value is checked 
against three ROC thresholds: QC, alarm, and alert.  
 
3.1 Assumptions, Constraints, and Preconditions 

• TO10 software has been installed successfully. 
• CAVE, EDEX and pgAdmin III are running. 
• No data for the selected site to be tested has been ingested or is purged. 
• Four files of canned river stage data are available to be ingested; this data shall allow the 

user to test the three ROC thresholds. 
• Actions, Results, and Requirements highlighted in yellow indicate requirements and/or 

capabilities to be included in the scope of future task orders.  They are included here for 
purposes of continuity and traceability with the original AWIPS I test case documents. 

 
3.2 Recommended Hardware 
See TO10 Software Test Plan. 
 
3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case.  Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases.   

 
3.4 Test Outputs 
The results outlined in section 4.0 are met. 
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4.0 TEST SCENARIO 

Step # Action Result Pass/Fail 
1.  In CAVE, Mouse Button (MB) 1 click on the 

Perspectives icon and select ‘Hydro’ from the 
dropdown menu if available.  If not available, 
select ‘Other…’.  Then select ‘Hydro’ from the 
Open Perspective dialog. 

The Hydro Perspective displays in CAVE.  

2.  For a pre-selected river gage, ingest a file 
containing river stage data to set the ‘base’ 
river stage. 

The river stage data file is ingested.  

3.  Ingest a second file with data well above the 
base river stage set in step 2.  

The file is thrown out as the QC checker 
identifies the data as exceeding a threshold. 

 

4.  Ingest a third file with data above the base 
river stage set in step 2 that is within 
tolerance to alert the user with an advisory 
message. 

An alert message appears with an advisory 
message regarding the change in the river 
stage. 

 

5.  Close the message window. The message window closes.  
6.  Ingest a fourth file with data above the base 

river stage set in step 2 that is within 
tolerance to alarm the user with a warning 
message. 

An alarm message appears with a warning 
message regarding the change in the river 
stage. 

 

7.  Close the message window. The message window closes.  
8.  MB3 click and hold on the Hydro Perspective 

tab and select ‘Close’. 
The Hydro Perspective closes.  

End of Hydroview Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
SYSR TBD  
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1.0 SCOPE 
See TO10 Software Test Plan. 
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2.0 APPLICABLE DOCUMENTS 

2.1 Source Documents 
• TO8 Test Case Volume Browser 1.0 

 

2.2 Reference Documents 
• Legacy NWS Test Cases: 

– D2D_Prod_Load_1.4.1.22 
– Baseline_D2D_VB_Plan_1.4.1.2 
– Baseline_D2D_VB_Time_1.4.1.9_V2 
– Baseline_D2D_VB_T-Z_1.4.1.6 
– D2D_VB_XvsZ_1.4.1.7 
– D2D_VB_Xsect_1.4.1.4 
– Baseline_D2D_VB_Sound_1.4.1.8_V2 
– ECMWF Medium Range_DCS3377-OB8.1 

• TO10 Software Test Plan for the Advanced Weather Interactive Processing 
System Project, Contract #DG133W-05-CQ-1067, January 2009. 

• Section 3 of the AWIPS D-2D User’s Manual Build 8.1 
– Release OB8.3 of the Weather Event Simulator (WES) 

• The Silver Spring NWS AWIPS 1 test bed application. 
• Rational RequisitePro. 
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3.0 TEST CASE DESCRIPTION 
This test case demonstrates the capability of CAVE to display a representative sample of plan 
view, time series, time-height, variable versus height, cross section and sounding model products 
from available numerical models. The capability to recall radar products through the Volume 
Browser is introduced in TO10. A representative sample of products is demonstrated in the 
following test procedures. 
 

3.1 Assumptions, Constraints and Preconditions 
• TO10 software has been installed successfully 
• CAVE, EDEX and pgAdmin III are running 
• Data has been ingested  
• The test for TO10 begins at step 42 

– Depending on the status of the ORPG prototyping in TO10 (TO11 
delivery) some radar functionality from the volume browser may not be 
available. 

• Actions, Results, and Requirements highlighted in yellow indicate 
requirements and/or capabilities to be included in the scope of future task 
orders. They are included here for purposes of continuity and traceability with 
the original AWIPS I test case documents.  

 

3.2 Recommended Hardware 
See TO10 Software Test Plan, Section 2.2. 
 

3.3 Test Inputs 
Section 4.0 contains the test procedures for this test case. Sections 2.2 – 2.9 of the TO10 
Software Test Plan contain general test inputs applicable to all TO10 test cases. 
 

3.4 Test Outputs 
The images and data will be displayed in CAVE. 
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4.0 TEST SCENARIO 

Step Action Result Pass/Fail 
Start of TO8 Test 
Plan View 

1.  In CAVE, click ‘Volume’ -> ‘Browser…’. The Volume Browser opens.  
2.  In the Volume Browser select ‘Plan view’ from the 

pull-down menu if not already selected. 
The options within the Volume 
Browser change when ‘Plan view’ is 
selected. 

 

3.  Using ‘Time’ (in the menu bar of the Volume 
Browser), select an available grid product under the 
‘Sources’ and ‘Fields’ sections. 
Under the ‘Planes’ section, select ‘Surface’. 
Then click the ‘Load’ button. 

The gridded data appears displaying 
the contours of the gridded product. 

 

4.  Verify the full model run is displayed by increasing the 
frame count to 64 and looping the gridded data. 

The data loops chronologically 
through the model run. 

 

5.  Clear the CAVE display. The display in CAVE clears.  
Cross Section 

6.  From the Volume Browser ‘Tools’ menu, select 
‘Baselines’. 

The Interactive Baselines appear.  

7.  Choose a baseline that is to be used to make the 
cross section and edit the baseline accordingly (if 
desired).  
Record the line ID letter ____ 

Line and/or vertex moves to desired 
location.  
 

 

8.  From the Volume menu, select ‘Browser’ if the 
Volume Browser is not already open. 

The Volume Browser window opens.  

9.  In the Volume Browser select ‘Cross-section’ from the 
pull-down menu labeled ‘Plan View’. 

The options within the Volume 
Browser change. 

 

10.  Using ‘Time’ and ‘Log 1050-150’ (in the menu bar of 
the Volume Browser), select an available grid product 
under the ‘Sources’ and ‘Fields’ sections. 
Under the ‘Planes’ section, select the chosen 
baseline. 
Then click the ‘Load’ button. 

The cross section appears displaying 
the contours of the gridded product. 

DR #811 
DR #866 

11.  Verify the full model run is displayed by increasing the 
frame count to 64 and looping the gridded data. 

The data loops chronologically 
through the model run. 

 

12.  Stop the loop. The loop stops.  
13.  Zoom into the cross section. The user is able to zoom into the 

cross section. 
 

14.  Close the Cross Section tab. The Cross Section tab closes. CAVE 
returns to the map within the ‘Maps’ 
tab with the baselines displayed. 
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Step Action Result Pass/Fail 
15.  In the Volume Browser, using ‘Space’ and ‘Log 1050-

150’ (in the menu bar of the Volume Browser), select 
an available grid product under the ‘Sources’ and 
‘Fields’ sections. 
Under the ‘Planes’ section, select ‘All Lat’ under the 
‘Lat’ menu. 
Then click the ‘Load’ button. 

The cross section appears displaying 
the contours of the gridded product. 

 

16.  Verify the full model run is displayed by looping the 
gridded data. 

The data loops chronologically 
through space. 

 

17.  Close the Cross Section tab. 
Then clear the CAVE display. 

The Cross Section tab closes. CAVE 
displays a blank map within the ‘Map’ 
tab. 

 

Time Height 
18.  From the Volume Browser ‘Tools’ menu, select 

‘Points’. 
The Interactive Points appear.  

19.  Choose a point that is to be used to make the Time 
height plot. Edit the point if necessary.   
Record the point’s ID letter: ___ 

Point moves to desired location.   

20.  In the Volume Browser, select ‘Time height’ from the 
pull-down menu. 

The options within the Volume 
Browser change. 

 

21.  In the Volume Browser, using ‘left’ and ‘Log 1050-150’ 
(in the menu bar of the Volume Browser), select an 
available grid product under the ‘Sources’ and ‘Fields’ 
sections. 
Under the ‘Planes’ section, select the chosen point. 
Then click the ‘Load’ button. 

The Time height product appears 
displaying the variable with respect to 
time. CAVE displays the data with the 
initialized model time (0HR) on the 
right and the latest valid time on the 
left. 

DR #811 
DR #866 

22.  Close the Time Height tab. The Time Height tab closes. CAVE 
returns to the map within the ‘Map’ tab 
with the Points displayed. 

 

23.  In the Volume Browser, using ‘right’ and ‘Log 1050-
150’ (in the menu bar of the Volume Browser), select 
an available grid product under the ‘Sources’ and 
‘Fields’ sections. 
Under the ‘Planes’ section, select the chosen point. 
Then click the ‘Load’ button. 

The Time height product appears 
displaying the variable with respect to 
time. CAVE displays the data with the 
initialized model time (0HR) on the left 
and the latest valid time on the right. 

DR #811 
DR #866 
DR #867 

24.  Close the Time Height tab. 
Clear the display within CAVE. 

The Time Height tab closes. CAVE 
displays a blank map within the ‘Map’ 
tab. 

 

Variable vs. Height 
25.  On the CAVE toolbar select the Points button. The Interactive Points appear.  
26.  Choose a point that is to be used to make the variable 

versus height plot. Edit the point if necessary.   
Record the point’s ID letter: ___ 

Point moves to desired location.  DR #810 
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Step Action Result Pass/Fail 
27.  In the Volume Browser, select ‘Var vs Hgt’ from the 

pull-down menu. 
The options within the Volume 
Browser change. 

 

28.  In the Volume Browser, using ‘Log 1050-150’ (in the 
menu bar of the Volume Browser), select an available 
grid product under the ‘Sources’ and ‘Fields’ sections. 
Under the ‘Planes’ section, select the chosen point. 
Then click the ‘Load’ button. 

The Variable vs. Height product 
appears displaying a graph of the 
variable with respect to height. 

DR #811 
DR #866 

29.  View all the frames (model forecast times) by using 
the arrow keys on the keyboard or toolbar. 

The variable will display as a line 
increasing or decreasing with height. 

 

30.  Close the Var vs Hgt tab. 
Clear the display within CAVE. 

The Var vs Hgt tab closes. CAVE 
displays a blank map within the ‘Map’ 
tab. 

 

Sounding 
31.  On the CAVE toolbar select the Points button. The Interactive Points appear.  
32.  Choose a point that is to be used to make the 

sounding plot. Edit the point if necessary.   
Record the point’s ID letter: ___ 

Point moves to desired location.   

33.  In the Volume Browser, select ‘Sounding’ from the 
pull-down menu. 

The options within the Volume 
Browser change. 

 

34.  In the Volume Browser, select an available grid 
product under the ‘Sources’ section. Select ‘Sounding’ 
in the ‘Fields’ section under the ‘Thermo’ dropdown 
menu. 
Under the ‘Planes’ section, select the chosen point. 
Then click the ‘Load’ button. 

The Sounding product appears 
displaying a Skew-T for the selected 
point. 

DR #866 

35.  View all the frames (model forecast times) by using 
the arrow keys on the keyboard or toolbar. 

Each Sounding displays. DR #826 

36.  Close the Skew-T tab. 
Clear the display within CAVE. 

The Skew-T tab closes. CAVE 
displays a blank map within the ‘Map’ 
tab. 

 

Time Series 
37.  On the CAVE toolbar select the Points button. The Interactive Points appear.  
38.  Choose a point that is to be used to make the Time 

height plot. Edit the point if necessary.   
Record the point’s ID letter: ___ 

Point moves to desired location.   

39.  In the Volume Browser, select ‘Time series’ from the 
pull-down menu. 

The options within the Volume 
Browser change. 

 

40.  In the Volume Browser, using the selected point, 
select an available grid product under the ‘Sources’ 
and ‘Fields’ sections. 
Under the ‘Planes’ section, select ‘Surface’ from the 
‘Misc’ dropdown menu. 
Then click the ‘Load’ button. 

The Time series product appears 
displaying the variable with respect to 
time. CAVE displays the data with the 
initialized model time (0HR) on the left 
and the latest valid time on the right. 

DR #866 
DR #867 
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Step Action Result Pass/Fail 
41.  Close the Time Series tab. 

Clear the display within CAVE. 
Close the Volume Browser. 

The Time Series tab closes.  
CAVE displays a blank map within the 
‘Map’ tab. 
The Volume Browser closes. 

 

End of TO8 Test 
 

Start of TO10 Test 
42.  In CAVE, MB1 click ‘Volume’ -> ‘Browser…’. The Volume Browser opens.  

Reflectivity 
43.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Reflectivity 
Planes: 0.5 km AGL 

The 0.5 km AGL Reflectivity data 
displays in the main pane. 

 

44.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
45.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Radial Velocity 
46.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Radial Velocity 
Planes: 0.5 km AGL 

The 0.5 km AGL Radial Velocity data 
displays in the main pane. 

 

47.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
48.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Tilt Angle 
49.  In the Volume Browser, select the following: 

Sources: NAM 40 
Fields: Tilt Angle 
Planes: 0.5 deg 

The 0.5 deg NAM Tilt Angle data 
displays in the main pane. 

 

50.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
51.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Col. Max Reflectivity 
52.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Col Max Refl 
Planes: Layer 

The Layer Col Max Reflectivity data 
displays in the main pane. 

 

53.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
54.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
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Step Action Result Pass/Fail 
Spectrum Width 

55.  In the Volume Browser, select the following: 
Sources: Radar 
Fields: Spectrum Width 
Planes:0.5 km AGL 

The 0.5 km AGL Spectrum Width data 
displays in the main pane. 

 

56.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
57.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Diff. Reflectivity 
58.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Diff Refl 
Planes:0.5 km AGL 

The 0.5 km AGL Diff. Reflectivity data 
displays in the main pane. 

 

59.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
60.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Corr. Coefficient 
61.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Corr Coeff 
Planes: 0.5 km AGL 

The 0.5 km AGL Corr. Coefficient 
data displays in the main pane. 

 

62.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
63.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Spec. Diff. Phase 
64.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Spec Diff Phase 
Planes: 0.5 km AGL 

The 0.5 km AGL Spec. Diff. Phase 
data displays in the main pane. 

 

65.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
66.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Hydrometeor Class 
67.  In the Volume Browser, select the following: 

Sources: Radar 
Fields: Hydrometeor Class 
Planes: 0.5 km AGL 

The 0.5 km AGL Hydrometeor Class 
data displays in the main pane. 

 

68.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
69.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
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Step Action Result Pass/Fail 
Feature Strength 

70.  In the Volume Browser, select the following: 
Sources: DMD 
Fields: Feature Strength 
Planes: Layer 

The Layer DMD Feature Strength 
data displays in the main pane. 

 

71.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
72.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Feature Diameter 
73.  In the Volume Browser, select the following: 

Sources: DMD 
Fields: Feature Diameter 
Planes: Layer 

The Layer DMD Feature Diameter 
data displays in the main pane. 

 

74.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
75.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Shear Magnitude 
76.  In the Volume Browser, select the following: 

Sources: NAM40 
Fields: Shear Mag 
Planes: 850mb 

The NAM40 850mb Shear Magnitude 
data displays in the main pane. 

 

77.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
78.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Gate to Gate Shear 
79.  In the Volume Browser, select the following: 

Sources: DMD 
Fields: Gate2Gate Shr 
Planes: Lo Layer 

The Lo Layer DMD Gate to Gate 
Shear data displays in the main pane. 

 

80.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
81.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

Feature Motion 
82.  In the Volume Browser, select the following: 

Sources: NAM Bufr 
Fields: Feat Mot 
Planes: Surface 

The NAM Bufr Surface Feature 
Motion data displays in the main 
pane. 

 

83.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
84.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
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Step Action Result Pass/Fail 
Divergence 

85.  In the Volume Browser, select the following: 
Sources: NAM40 
Fields: Divergence 
Planes: 850mb 

The NAM40 850mb Divergence data 
displays in the main pane. 

 

86.  MB1 click the ‘Clear’ button on the CAVE toolbar. The main display clears.  
87.  In the Volume Browser select ‘Edit’, ‘Clear all’. The prior Volume Browser selections 

are cleared. 
 

End of TO10 Test 
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM) 

Number Description Test Step(s) 
CAVE_TO8_002 CAVE shall contain a Volume Browser with the look 

and feel, and functionality of the current AWIPS 1 
Volume Browser 

ALL 

CAVE_TO8_002.10 The Volume Browser shall allow the user to select 
items displayed within the Volume Browser 

4 

CAVE_TO8_002.12 The Volume Browser shall allow the user to display 
Baselines in CAVE using MB1 

7 

CAVE_TO8_002.13 The Volume Browser shall allow the user to display 
Points in CAVE using MB1 

19 

CAVE_TO8_002.15 The Volume Browser shall allow the user to select 
settings 

3,10,21,28,34,40 

CAVE_TO8_002.15.1 The Volume Browser shall allow the user to select the 
Plan view option using MB1 

3 

CAVE_TO8_002.15.2 The Volume Browser shall allow the user to select the 
Cross Section option using MB1 

10 

CAVE_TO8_002.15.3 The Volume Browser shall allow the user to select the 
Time height option using MB1 

21 

CAVE_TO8_002.15.4 The Volume Browser shall allow the user to select the 
Var vs Hgt option using MB1 

28 

CAVE_TO8_002.15.5 The Volume Browser shall allow the user to select the 
Sounding option using MB1 

34 

CAVE_TO8_002.15.6 The Volume Browser shall allow the user to select the 
Time series option using MB1 

40 

CAVE_TO8_002.16 The Volume Browser shall allow the user to display 
data within the Volume Browser 

4,11,22,24,29,35,41 

CAVE_TO8_002.16.1 The Volume Browser shall display data in the Plan 
View setting with reference to Time 

4 

CAVE_TO8_002.16.3 The Volume Browser shall display data in the Cross 
Section setting with reference to Time 

11 

CAVE_TO8_002.16.4 The Volume Browser shall display data in the Cross 
Section setting with reference to Space 

16 

CAVE_TO8_002.16.6 The Volume Browser shall display data in the Time 
Height setting 

22,24 

CAVE_TO8_002.16.8 The Volume Browser shall display Time Series data 41 
CAVE_TO8_002.16.10 The Volume Browser shall display Sounding data 35 
CAVE_TO8_002.16.11 The Volume Browser shall display Variable vs Height 

data 
29 

CAVE_TO8_002.17 The Volume Browser shall allow the user to display 
data in CAVE 

4,11,22,24,29,35,41 
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Number Description Test Step(s) 
CAVE_TO8_002.17.1 CAVE shall display Plan View data with reference to 

Time as requested through the Volume Browser 
4 

CAVE_TO8_002.17.3 CAVE shall display data in Cross Sections with 
reference to Time as requested through the Volume 
Browser 

11 

CAVE_TO8_002.17.4 CAVE shall display data in Cross Sections with 
reference to Space as requested through the Volume 
Browser 

16 

CAVE_TO8_002.17.5 CAVE shall display Time Height data chronologically 
from right to left as requested through the Volume 
Browser 

22 

CAVE_TO8_002.17.6 CAVE shall display Time Height data chronologically 
from left to right as requested through the Volume 
Browser 

24 

CAVE_TO8_002.17.7 CAVE shall display Time Series data as requested 
through the Volume Browser 

41 

CAVE_TO8_002.17.8 CAVE shall display Sounding data as requested 
through the Volume Browser 

35 

CAVE_TO8_002.17.9 CAVE shall display Variable vs. Height data as 
requested through the Volume Browser 

29 

CAVE_TO8_002.23 The Volume Browser window shall have the capability 
to remain open after the selected products in the 
Product Selection List are loaded 

4,11,22,24,29,35,41 

CAVE_TO8_006 CAVE shall provide the capability to display cross-
sections 

11 

CAVE_TO8_006.1 Cross-sections shall be accessible through the 
volume browser, Plan View default tab 

10 

CAVE_TO8_006.2 Cross-section shall allow the user to view gridded 
data as vertical slices along specific baselines 

11 

CAVE_TO8_006.6 Cross-sections shall display gridded model data 11 
CAVE_TO8_006.7 The user shall be able to view a time-height cross 

section of a full run of gridded model data for a 
specific location 

22 

CAVE_TO8_006.7.1 Generation of Time-height cross-section displays shall 
be available through the Points submenu 

22 

CAVE_TO8_006.8 The user shall be able to zoom into the cross section 14 
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